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Documentation Warranty

THE MATERIAL CONTAINED IN THIS DOCUMENT IS PROVIDED "AS IS," AND IS SUBJECT TO BEING CHANGED, WITHOUT NOTICE,
IN FUTURE EDITIONS. FURTHER, TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, KEYSIGHT DISCLAIMS ALL
WARRANTIES, EITHER EXPRESS OR IMPLIED WITH REGARD TO THIS MANUAL AND ANY INFORMATION CONTAINED HEREIN,
INCLUDING BUT NOT LIMITED TO THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE.
KEYSIGHT SHALL NOT BE LIABLE FOR ERRORS OR FOR INCIDENTAL OR CONSEQUENTIAL DAMAGES IN CONNECTION WITH THE
FURNISHING, USE, OR PERFORMANCE OF THIS DOCUMENT OR ANY INFORMATION CONTAINED HEREIN. SHOULD KEYSIGHT AND
THE USER HAVE A SEPARATE WRITTEN AGREEMENT WITH WARRANTY TERMS COVERING THE MATERIAL IN THIS DOCUMENT
THAT CONFLICT WITH THESE TERMS, THE WARRANTY TERMS IN THE SEPARATE AGREEMENT WILL CONTROL.

U.S. Government Rights

U.S. Government Rights. The Software is “commercial computer software,” as defined by Federal Acquisition Regulation
(“FAR”) 2.101. Pursuant to FAR 12.212 and 27.405-3 and Department of Defense FAR Supplement (“DFARS”) 227.7202,
the U.S. government acquires commercial computer software under the same terms by which the software is customarily
provided to the public. Accordingly, Keysight provides the Software to U.S. government customers under its standard
commercial license, which is embodied in its End User License Agreement (EULA), a copy of which can be found at
http://www keysight.com/find/sweula. The license set forth in the EULA represents the exclusive authority by which the U.S.
government may use, modify, distribute, or disclose the Software. The EULA and the license set forth therein, does not
require or permit, among other things, that Keysight: (1) Furnish technical information related to commercial computer
software or commercial computer software documentation that is not customarily provided to the public; or (2) Relinquish
to, or otherwise provide, the government rights in excess of these rights customarily provided to the public to use,
modify, reproduce, release, perform, display, or disclose commercial computer software or commercial computer
software documentation. No additional government requirements beyond those set forth in the EULA shall apply, except
to the extent that those terms, rights, or licenses are explicitly required from all providers of commercial computer
software pursuant to the FAR and the DFARS and are set forth specifically in writing elsewhere in the EULA. Keysight shall
be under no obligation to update, revise or otherwise modify the Software. With respect to any technical data as defined
by FAR 2.1017, pursuant to FAR 12.211 and 27.404.2 and DFARS 227.7102, the U.S. government acquires no greater than
Limited Rights as defined in FAR 27.401 or DFAR 227.7103-5 (c), as applicable in any technical data.
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KEYSIGHT SOFTWARE END-USER LICENSE
AGREEMENT

ATTENTION: THIS SOFTWARE IS SUBJECT TO THE END-USER LICENSE AGREEMENT (“EULA”) SET FORTH
BELOW.

TO INSTALL OR USE THE SOFTWARE, YOU MUST FIRST AGREE TO THE EULA BELOW. IF THE EULA IS
PRESENTED TO YOU ELECTRONICALLY AND IF YOU HAVE READ, UNDERSTAND AND AGREE TO BE BOUND BY
THE TERMS OF THE EULA, CLICK “AGREE”. IF THE EULA IS PRESENTED TO YOU IN A HARD COPY FORMAT, BY
POWERING ON AND USING THE INSTRUMENT OR MACHINE, YOU AGREE THAT YOU HAVE READ, UNDERSTAND
AND AGREE TO BE BOUND BY THE TERMS OF THE EULA.

1. Translations. Translations of this EULA are found at: www.keysight.com/find/sweula .

2. Software. “Software” means a single copy of one or more computer programs, whether stand-alone or bundled with other
products, and related documentation, including any online or electronic documentation, data and license files.

3. License Grant. Keysight Technologies, Inc. (“Keysight”) grants you a limited, non-exclusive license to use, in accordance
with one of the license types listed below, the Software, for the Term (as defined below), subject to the terms and conditions
herein:

3.1 Node Locked (“fixed”) license. If you have obtained a Node Locked license, you may install one copy of the
Software on

one instrument or machine and use the Software only on that instrument or machine for your internal business use.

3.2 Transportable license. If you have obtained a Transportable license, you may use one copy of the Software on
any single

instrument or machine at one time for your internal business use. You may move such Software to a different
instrument or

machine for your internal business use provided only one copy is in use at any one time.

3.3  Floating (“concurrent use”) license. If you have obtained a Floating license, you may install one or more copies
of the

Software on any instrument or machine within your internal computer network for your internal business use
provided the total

number of users who are accessing and/or using any of the Software at the same time does not exceed the
maximum

number of licensed users.
You may find the type of license you obtained, the Term of your license, and the licensed number of users (if applicable) in
documentation associated with the Software. “Term” means either a set amount of time (an expiring license) or a Perpetual

license. “Perpetual” means the lifetime of the instrument or machine. In the absence of documentation specifying the
applicable license, you have a fixed license with a Perpetual Term.
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4. License Restrictions.

4.1 No Copies. You may not make copies or adaptations of the Software except for backup and archival purposes or
when copying
or adaptation is an essential step in the licensed use of the Software including correction of errors. You must
reproduce all copyright and other legal notices in the original Software on all permitted copies or adaptations. You
may not copy the Software onto any public or distributed network.

4.2 No Reverse Engineering. You may not decompile, reverse engineer, disassemble, attempt to derive the source
code of, decrypt, modify, or create derivative works of the Software (except to the extent any foregoing restriction is
prohibited by applicable mandatory law or by licensing terms governing the use of open source components that
may be included with the Software).

4.3 No Circumvention. The Software may include technological measures, whether in the Software or in bundled
hardware or both, that are designed to prevent or detect unlicensed use of the Software. Circumvention of these
technological measures is prohibited, except as expressly permitted by applicable law. Any attempt to circumvent
technological measures may render the Software or certain features unusable or unstable, and may prevent you
from updating or upgrading the Software.

4.4 Limited Use. Notwithstanding anything to the contrary herein, you may not use Software to make or distribute
your own or a third party’s application, a principal purpose of which, as reasonably determined by Keysight, is to
perform the same or similar functions as the Software or which replaces any component of the Software.

5. Third Party Software.

5.1 General. The Software may contain third party software subject to third party notices and/or additional terms and
conditions. Such required third party software notices and/or additional terms and conditions can be found in the
documentation associated with the Software. You have all rights necessary to use the Software as permitted in
Sections 3 and 4. To the extent your use exceeds the grants and restrictions in Sections 3 and 4, third party license
terms take precedence and will apply.

5.2 Separation of Components. Except as required by included open source software licenses, the Software is
licensed as a single product and its component parts may not be separated for any other use except to the extent
expressly otherwise licensed.

53 Additional Terms for Microsoft Windows Embedded Software . Microsoft Windows for Embedded Systems
may be included with the instrument or machine. If so, your grant under this license prohibits accessing or using
any Desktop Functions other than through, in support of and operating as part of the software and/or functions that
provide the primary functionality of the instrument or machine. “Desktop Functions” means consumer or business
tasks or processes, including word processing, spreadsheets, database, scheduling and personal finance.

6. Upgrades. This EULA does not entitle you to receive upgrades, updates or technical support. Upgrades, updates and
technical support services may be purchased separately. The terms of this EULA govern any software updates or upgrades
provided by Keysight unless replaced and/or supplement Software is accompanied by a separate license agreement in
which case the terms of that license agreement will govern. Any comments, suggestions, improvements or other
communications from you to Keysight regarding the Software (“Feedback”) may be used by Keysight without compensation
or attribution.

7. Ownership. The Software and all copies thereof are licensed and not sold to you. The Software and all copies thereof
are owned and copyrighted by Keysight or its third party suppliers and protected by copyright laws and other intellectual
property laws and treaties. Keysight and its third party suppliers retain all right, title and interest in the Software. Keysight
and its third party suppliers may protect their respective rights in the Software in the event of any violation of this EULA.

8. High Risk Activities. The Software is not specifically written, designed, manufactured or intended for use in the planning,

construction, maintenance or direct operation of a nuclear facility, nor for use in on line control or fail safe operation of
aircraft navigation, control or communication systems, weapon systems or direct life support systems.
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9. Transfer. You may not sell or otherwise transfer the Software except as expressly specified below. Licensed users are
Licensee's employees, authorized agents, representatives, and subcontractors acting on behalf of Licensee for Licensee's
internal business use. You may not rent, lease, lend, allow for commercial time sharing, or otherwise permit access to the
Software to any unlicensed third party or entity. You may not transfer the license granted to you here unless you obtain
Keysight's prior written authorization, deliver all copies of the Software to the transferee along with this EULA, and pay any
applicable fees. For all transfers, the transferee must accept this EULA as a condition to any transfer and your license to
use the Software will terminate upon transfer. Entitlement to receive technical support services for the Software may be
transferred provided that you obtain Keysight's prior written consent and pay any applicable fees. This section regarding
transfer applies only to the extent permissible under applicable mandatory laws.

10. Term and Termination. This EULA shall continue for the Term unless terminated by Keysight as provided herein.
Keysight may terminate this license upon notice for breach of this EULA. Upon expiration or termination, you must
immediately destroy all copies of the Software.

11. Export Requirements. If you export, re-export or import Software, technology or technical data licensed hereunder, you
assume responsibility for complying with applicable laws and regulations and for obtaining required export and import
authorizations. Keysight may terminate this license immediately if you are in violation of any applicable laws or regulations.

12. Audit and Security Mechanisms. You agree that Keysight may restrict the number of copies you are using by security
servers, security keys/modules, a hardware lock device, license administration software, a license authorization key to
control access to the Software or other security mechanism and you consent to such use. You may not take any steps to
avoid or defeat the purpose of any such measures. Use of the Software without the lock device or authorization key
provided by Keysight is prohibited. Keysight may take all legal steps to eliminate unlicensed use and piracy of their
Software. In this context, the Software may include a security mechanism to detect installation or use of unlicensed copies
of the Software, and collect and transmit data about suspected unlicensed copies. Data collected does not include any
customer data created with the Software. By using the Software, you consent to such detection and collection of data, as
well as its transmission and use if suspected unlicensed copies are detected. Upon reasonable notice and reasonable
suspicion of unlicensed use, Keysight may conduct during normal business hours (with the auditor’s costs being at
Keysight's expense) an audit of your compliance with this EULA. If an audit reveals underpayments then you will pay to
Keysight such underpayments. If underpayments discovered exceed five (5) percent of the contract price, you will reimburse
Keysight for the auditor costs.

13. U.S. Government Rights. The Software is “commercial computer software,” as defined by Federal Acquisition
Regulation (“FAR”) 2.101. Pursuant to FAR 12.212 and 27.405-3 and Department of Defense FAR Supplement (“DFARS”)
227.7202, the U.S. government acquires commercial computer software under the same terms by which the software is
customarily provided to the public. Accordingly, Keysight provides the Software to U.S. government customers under its
standard commercial license, which is embodied in this EULA. The license set forth in this EULA represents the exclusive
authority by which the U.S. government may use, modify, distribute, or disclose the Software. This EULA and the license set
forth herein, does not require or permit, among other things, that Keysight: (1) Furnish technical information related to
commercial computer software or commercial computer software documentation that is not customarily provided to the
public; or (2) Relinquish to, or otherwise provide, the government rights in excess of these rights customarily provided to the
public to use, modify, reproduce, release, perform, display, or disclose commercial computer software or commercial
computer software documentation. If you are a U.S. government customer, you acknowledge that you have reviewed the
Software and the terms of this EULA and agree that the license provided for herein is consistent with Federal law and
otherwise satisfies the U.S. government needs. In addition, if you are a U.S. government customer you agree that this EULA
reflects the entirety of the terms of Keysight's customary commercial license applicable to U.S. government customers. No
additional government requirements beyond those set forth in this EULA shall apply, except to the extent that those terms,
rights, or licenses are explicitly required from all providers of commercial computer software pursuant to the FAR and the
DFARS and are set forth specifically in writing elsewhere in this EULA. Keysight shall be under no obligation to update,
revise or otherwise modify the Software.

14. WARRANTY. TO THE EXTENT ALLOWED BY APPLICABLE MANDATORY LAW, AND EXCEPT TO THE EXTENT
KEYSIGHT HAS PROVIDED A SPECIFIC WRITTEN WARRANTY APPLICABLE TO THIS SOFTWARE, THIS SOFTWARE
IS PROVIDED TO YOU "AS IS" WITHOUT WARRANTIES OR CONDITIONS OF ANY KIND, WHETHER ORAL OR
WRITTEN, EXPRESS OR IMPLIED. KEYSIGHT, ON BEHALF OF ITSELF ITS SUBSIDIARIES, AFFILIATES AND
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SUPPLIERS SPECIFICALLY DISCLAIMS ANY IMPLIED WARRANTIES OR CONDITIONS OF MERCHANTABILITY,
SATISFACTORY QUALITY, NON-INFRINGEMENT AND FITNESS FOR A PARTICULAR PURPOSE. SHOULD THE
SOFTWARE PROVE DEFECTIVE, YOU ASSUME THE ENTIRE RISK AND COST RESULTING FROM OR RELATING TO
THE DEFECT. SOME JURISDICTIONS DO NOT ALLOW EXCLUSIONS OF IMPLIED WARRANTIES OR CONDITIONS,
SO THE ABOVE EXCLUSION MAY NOT APPLY TO YOU. YOU MAY HAVE OTHER RIGHTS THAT VARY ACCORDING
TO APPLICABLE MANDATORY LAW.

15. LIMITATION OF LIABILITY. TO THE EXTENT ALLOWED BY APPLICABLE MANDATORY LAW, IN NO EVENT WILL
KEYSIGHT OR ITS SUBSIDIARIES, AFFILIATES OR SUPPLIERS BE LIABLE FOR ANY SPECIAL, INCIDENTAL,
CONSEQUENTIAL OR OTHER DAMAGES (INCLUDING DOWNTIME COSTS, LOSS OF DATA, RESTORATION COSTS
OR LOST PROFITS) REGARDLESS OF WHETHER SUCH CLAIMS ARE BASED ON CONTRACT, TORT, WARRANTY
OR ANY OTHER LEGAL THEORY, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. YOUR USE OF THE
SOFTWARE IS ENTIRELY AT YOUR OWN RISK. NOTWITHSTANDING THE FOREGOING, IN THE EVENT THE
SOFTWARE IS PROVIDED TO YOU AT NO CHARGE, KEYSIGHT OR ITS SUBSIDIARIES, AFFILIATES OR SUPPLIERS
SHALL HAVE NO LIABILITY FOR DIRECT DAMAGES. SOME JURISDICTIONS DO NOT ALLOW THE EXCLUSION OR
LIMITATION OF LIABILITY FOR DAMAGES, SO THE ABOVE LIMITATION MAY NOT APPLY TO YOU.

16. Applicable Law. Disputes arising in connection with this EULA will be governed by the laws of the United States and of
the State of California, without regard to choice of law provisions. The United Nations Convention for Contracts for the
International Sale of Goods will not apply to this EULA.

17. Unenforceability. To the extent that any provision of this EULA is determined to be illegal or unenforceable, the
remainder of this EULA will remain in full force and effect.

18. Entire Agreement. Certain program, data and license files in the Software may be subject to supplemental license
terms found in the documentation associated with the Software or directly in the files to which the supplemental terms apply.
This EULA constitutes the entire agreement between you and Keysight with respect to the Software, and supersedes any
previous communications, representations or agreements between the parties, whether oral or written, except if you have a
separate written, valid agreement that is executed by both parties and the terms of such agreement conflict with the terms
contained herein, in which case the terms of such agreement apply. This EULA may not be changed except by an
amendment signed by an authorized representative of each party.

This information is
subject to change
without notice.

© Keysight
Technologies, 2013 —
2017

Published in USA,
February 1, 2017
www.keysight.com
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VNA User Accounts and Passwords

Important: When the VNA power is switched on, it AUTOMATICALLY logs into Windows using
the default user name and password. You do NOT need to log on. This gives anyone full access to the
analyzer. The following steps can be taken to increase security of your VNA.

e Require users to logon when the VNA computer is turned ON - Learn how.

e Setup individual accounts on the VNA with varying level of access - Learn how.

See Also: User-Specific VNA Settings

Please read about Anti-virus protection for your VNA

Existing User Accounts

The following user accounts already exist on new VNAs.

User Name Password Type Description
Instrument measure4u Administrator Auto Log On is activated by
default.
Administrator  Keysight4u!  Built-in For user maintenance purpose.
Administrator

Note: The user name is not case sensitive. The password is case sensitive.

Note: The VNA local policies are set so that, if logon is required, you must retype the user name (and
password) every time. Do not change the local policies on the VNA.

Add or Change User Accounts, Passwords, and require Logon

If the analyzer is in a secure environment, you can setup VNA users by name and grant various levels
of access.

You can designate a person as the administrator and then configure the VNA to allow others to use it
with reduced permissions. That is, other people can be signed on to use the analyzer but they will not
have the ability to perform all of the administrative functions that you can as the administrator.

The following are examples of some of the functions that can be performed with these account types:
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¢ Administrator - Can download and install firmware. The administrator can modify system-wide settings in the
operating system.

e Standard User - Can fully use the VNA to make measurements and save state and data files. Standard
Users can NOT install firmware.

How to add a user account and require logon

Windows 7

Click Start, then Control Panel

Click User Accounts

Click Manage another account.

CAUTION: Although allowed by Windows, do NOT allow
an Administrator account without a password. Internet viruses
look for, and exploit, this condition.

Click Create a new account.
Enter an account name.
Select an account type.

Click Create Account.

Mame the account and chogse an account type

This name will appear on the Welcome screen and on the Start menu.
Mew account name

= Standard user

Standard account users can wse most software and change system settings that de
not affect other users or the security of the computer.

 Administrator

Administrators have complete access to the computer and can make any desired
changes. Based on notification sattings, administrators may be asked to provide
their password or confirmation before making changes that affect other users.

We recommeand that you protect every account with a strong password,

Why is a standard account recommendead?

Create Account | Cancel

Optional: Click Create a password to require the user to
enter a password when logging on.
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Windows 10
To add a new account:
Click Start > Settings > Accounts >

Other people > Add someone else to this
PC.

Enter the requested information then
select Next.

To change an existing account:

Click on the user account.

Click Change account type.

Under Account type, select Standard
User or Administrator.

Click OK.

User-Specific VNA Settings
Almost all persistent settings in the VNA are global (apply to all users).

The following exceptions reset to their defaults when a new user account is setup:

e Global PassFail Display State

e Recently used files list

e Global Power Limits

e Equation Editor — most recently used import dlis

e Preferences:

e Power Sweep Retrace Mode
e Is Power On During Retrace
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Recovering from VNA Solid State Drive Problems

The leading cause of VNA failures is problems with the VNA Solid State Drive (SSD). These problems
are usually preventable (see Preventing VNA SSD Problems), and in many cases, recoverable. The
following could save you weeks of downtime and the cost of replacing your VNA SSD.

The information is available on the Installation Guide. See https://www.keysight.com/manuals/e5080b or
https://www.keysight.com/manuals/e5080a.

If your VNA does experience a Solid State Drive problem, you will not be able to access this Help file,
but you may be able to access the Internet from another computer.
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Microsoft Windows Considerations

In this topic:

e Microsoft Windows on the VNA
e Using USB
e LAN Connections
e Mouse Configuration
¢ Windows Theme
e Printing
See Also
Windows File Locations

Your Programs on Windows

Microsoft EULA

Microsoft Windows on the VNA

The VNA is shipped from the factory with Windows® Embedded Standard 7 or Windows® 10
operating system. This OS supports both 32-bit and 64-bit applications.

VERY IMPORTANT Protect your hard drive!

The leading cause of VNA failures is problems with the VNA Solid State Drive (SSD). These problems
are usually preventable, and in many cases, recoverable. Learn more about protecting your VNA.

Using USB

The VNA has USB ports on the front panel and on the rear panel. The main advantages of USB are
“hot” connects and disconnects and fast data transfer speeds. Electronic Calibration modules are also
available with USB connections.

The first time you plug a device into a USB port there is some wait time. Windows reports it is
identifying the hardware, then searching for the correct driver, then installing the driver (if it was
found).
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Connecting that same device back into that same port later is quick and easy, but if you move the
device to a different USB port, you will have to wait through the hardware ID and driver search again.

Learn about USB limitations.

LAN Connections

Windows supports DHCP and fixed IP addressing. Also, “Hot” connect and disconnect of the LAN
cable, as well as a visual indicator of LAN status in system tray area, makes LAN connections more
intuitive. In addition, the Hardware Wizard helps users with system hardware configuration.

Mouse Configuration

By default, Windows does not allow you to select to make the button on the right the one you use for
primary functions such as selecting and dragging. To change any mouse properties, click Start >
Control Panel > Mouse. In the Mouse Properties dialog box, select any settings that you would like to
change, click Apply and then click OK.

Windows Themes
The VNA application is designed for, and best viewed in, Keysight Technologies theme. To change
the theme:

1. Minimize the VNA application.

2. Right-click on the Desktop, then click Personalize

3. Use the scrollbar, then select a Theme.

Printing

Adding a printer should be done outside of the VNA application. Learn more.
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Windows File Locations

State files and most data file storage locations:

e Windows 7 or Windows 10: D:\

Firmware executable file locations:

e Windows 7 or Windows 10: c:\program files (x86)\Keysight\network analyzer

Support file locations

o Windows 7 or Windows 10: c:\programdata\Keysight\network analyzer
These file locations can be queried remotely.
SCPI Command: SYSTem:CONFigure:DIRectory?

See Also

Your Programs on Windows
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Connector Care

Proper connector care is critical for accurate and repeatable measurements. The following information
will help you preserve the precision and extend the life of your connectors - saving both time and
money.

e Connector Care Quick Reference Guide

e Connector Cleaning Supplies

e Safety Reminders

e About Connectors

e (Gaging Fundamentals

e Connector Care Procedures

See Also

mmWave Connector Care at http://na.support.keysight.com/pna/connectorcare/Connector_Care.htm

Preventing Test Port Connector Damage

Handling and Storing Connectors

Do Do Not

Keep connectors clean Touch mating-plane surfaces

Protect connectors with plastic end caps Set connectors contact-end down

Keep connector temperature same as analyzer Store connectors loose in box or drawer

Visual Inspection

Do Do Not
Inspect connectors with magnifying glass. Use a connector with a bent or broken center
conductor

Look for metal debris, deep scratches or dents
Use a connector with deformed threads

Cleaning Connectors
Do Do Not

Clean surfaces first with clean, dry compressed air Use high pressure air (>60 psi)
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Use lint-free swab or brush Use any abrasives
Use minimum amount of alcohol Allow alcohol into connector support beads

Clean outer conductor mating surface and threads Apply lateral force to center conductor

Gaging Connectors
Do Do Not

Inspect and clean gage, gage master and device ~ Use an out of specification connector
tested

Hold connector gage by the dial
Use correct torque wrench

zero gage before use

Use multiple measurements and keep record of

readings
Making Connections
Do Do Not
Align connectors first Cross thread the connection
Rotate only the connector nut Twist connector body to make connection
Use correct torque wrench Mate different connector types

Connector Care and Cleaning Supplies

Description Web Site

Swabs http://www .berkshire.com/swabs.shtml
Lint Free Cloths- Air dusters http://www.ccrwebstore.com
Isopropyl http://www.techspray.com

Nitrilite Gloves and Finger Cots http://www.techni-tool.com

Safety Reminders

When cleaning connectors:

e Always use protective eyewear when using compressed air or nitrogen.

¢ Keep isopropyl alcohol away from heat, sparks and flame. Use with adequate ventilation. Avoid contact with
eyes, skin and clothing.

e Avoid electrostatic discharge (ESD). Wear a grounded wrist strap (having a 1 MQ series resistor) when
cleaning device, cable or test port connectors.

¢ Cleaning connectors with alcohol shall only be done with the instruments power cord removed, and in a well-
ventilated area. Allow all residual alcohol moisture to evaporate, and the fumes to dissipate prior to
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energizing the instrument.

About Connectors

e Connector Service Life
e Connector Grades and Performance
e Adapters as Connector Savers

e Connector Mating Plane Surfaces

Connector Service Life

Even though calibration standards, cables, and test set connectors are designed and manufactured to the
highest standards, all connectors have a limited service life. This means that connectors can become
defective due to wear during normal use. For best results, all connectors should be inspected and
maintained to maximize their service life.

Visual Inspection should be performed each time a connection is made. Metal particles from
connector threads often find their way onto the mating surface when a connection is made or
disconnected. See Inspection procedure.

Cleaning the dirt and contamination from the connector mating plane surfaces and threads can extend
the service life of the connector and improve the quality of your calibration and measurements. See
Cleaning procedure.

Gaging connectors not only provides assurance of proper mechanical tolerances, and thus connector
performance, but also indicate situations where the potential for damage to another connector may
exist. See Gaging procedure.

Proper connector care and connection techniques yield:
* Longer Service Life *  Higher Performance +  Better Repeatability
Connector Grades and Performance

The three connector grades (levels of quality) for the popular connector families are listed below. Some
specialized types may not have all three grades.

e Production grade connectors are the lowest grade and the least expensive. It is the connector grade most
commonly used on the typical device under test (DUT). It has the lowest performance of all connectors due
to its loose tolerances. This means that production grade connectors should always be carefully inspected
before making a connection to the analyzer. Some production grade connectors are not intended to mate
with metrology grade connectors.
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¢ Instrument grade is the middle grade of connectors. It is mainly used in and with test instruments, most
cables and adapters, and some calibration standards. It provides long life with good performance and tighter
tolerances. It may have a dielectric supported interface and therefore may not exhibit the excellent match of a
metrology grade connector.

e Metrology grade connectors have the highest performance and the highest cost of all connector grades.
This grade is used on calibration standards, verification standards, and precision adapters. Because it is a
high precision connector, it can withstand many connections and disconnections and, thus, has the longest
life of all connector grades. This connector grade has the closest material and geometric specifications. Pin
diameter and pin depth are very closely specified. Metrology grade uses an air dielectric interface and a
slotless female contact which provide the highest performance and traceability.

Note: In general, Metrology grade connectors should not be mated with Production grade connectors.

Adapters as Connector Savers

Make sure to use a high quality (Instrument grade or better) adapter when adapting a different
connector type to the analyzer test ports. It is a good idea to use an adapter even when the device under
test is the same connector type as the analyzer test ports. In both cases, it will help extend service life,
and protect the test ports from damage and costly repair.

The adapter must be fully inspected before connecting it to the analyzer test port and inspected and
cleaned frequently thereafter. Because calibration standards are connected to the adapter, the adapter
should be the highest quality to provide acceptable RF performance and minimize the effects of
mismatch.

Connector Mating Plane Surfaces

An important concept in RF and microwave measurements is the reference plane. For a network
analyzer, this is the surface that all measurements are referenced to. At calibration, the reference plane
is defined as the plane where the mating plane surfaces of the measurement port and the calibration
standards meet. Good connections (and calibrations) depend on perfectly flat contact between
connectors at all points on the mating plane surfaces (as shown in the following graphic).

Mating Plane Surfaces

Type-N (f) Type-N (m)
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Gaging Fundamentals

Connector gages are important tools used to measure center conductor pin depth in connectors.
Connector pin depth, measured in terms of recession or protrusion, is generally the distance between
the mating plane and the end of the center conductor, or the shoulder of the center conductor for a

stepped male pin.

Typical Connector Gage
RECESSION  PROTRUSION

Ty

| e

(AL
Ll

=

Recession and Protrusion

Pin depth is negative (recession) if the center conductor is recessed below the outer conductor mating
plane, usually referred to as the "reference plane". Pin depth is positive (protrusion) if the center
conductor projects forward from the connector reference plane.

Pin Depth
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1. Recession of female contact
2. Recession of male pin shoulder

Difference with Type-N Connectors

Type-N connectors have the mating plane of the center conductors offset from the connector reference
plane. In this case the zero setting "gage masters" generally offset the nominal distance between the
center conductor mating plane and the connector reference plane.

When to Gage Connectors

e Before using a connector or adapter the first time.
e When visual inspection or electrical performance suggests the connector interface may be out of range.

e After every 100 connections, depending on use.

Connector Gage Accuracy

Connector gages (those included with calibration and verification kits), are capable of performing
coarse measurements only. This is due to the repeatability uncertainties associated with the
measurement. It is important to recognize that test port connectors and calibration standards have
mechanical specifications that are extremely precise. Only special gaging processes and electrical
testing (performed in a calibration lab) can accurately verify the mechanical characteristics of these
devices. The pin depth specifications in the Keysight calibration kit manuals provide a compromise
between the pin depth accuracy required, and the accuracy of the gages. The gages shipped with
calibration and verification kits allow you to measure connector pin depth and avoid damage from out-
of-specification connectors.

Note: Before gaging any connector, the mechanical specifications provided with that connector or
device should be checked.

To Gage Connectors
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1. Wear a grounded wrist strap (having a 1 MQ series resistor).
2. Select proper gage for device under test (DUT).
3. Inspect and clean gage, gage master, and DUT.

4. Zero the connector gage.

a. While holding gage by the barrel, carefully connect gage master to gage. Finger-tighten connector nut
only.

b. Use proper torque wrench to make final connection. If needed, use additional wrench to prevent gage
master (body) from turning. Gently tap the barrel to settle the gage.

c. The gage pointer should line up exactly with the zero mark on gage. If not, adjust "zero set" knob until
gage pointer reads zero. On gages having a dial lock screw and a movable dial, loosen the dial lock

screw and move the dial until the gage pointer reads zero. Gages should be zeroed before each set of
measurements to make sure zero setting has not changed.

d. Remove gage master.

5. Gage the device under test.

a. While holding gage by the barrel, carefully connect DUT to gage. Finger-tighten connector nut only.

b. Use proper torque wrench to make final connection and, if needed, use additional wrench to prevent
DUT (body) from turning. Gently tap the barrel to settle the gage.

c. Read gage indicator dial for recession or protrusion and compare reading with device specifications.

Caution: If the gage indicates excessive protrusion or recession, the connector should be marked for disposal or sent out for
repair.

6. For maximum accuracy, measure the device a minimum of three times and take an average of the readings.
After each measurement, rotate the gage a quarter-turn to reduce measurement variations.

7. If there is doubt about measurement accuracy, be sure the temperatures of the parts have stabilized. Then
perform the cleaning, zeroing, and measuring procedure again.

Connector Care Procedures

e Inspecting Connectors

e Cleaning Connectors
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e Making Connections
e Using a Torque Wrench

e Handling and Storing Connectors

To Inspect Connectors
Wear a grounded wrist strap (having a 1 MCQ series resistor).

Use a magnifying glass (>10X) and inspect connector for the following:

e Badly worn plating or deep scratches

e Deformed threads

e Metal particles on threads and mating plane surfaces
e Bent, broken, or mis-aligned center conductors

e Poor connector nut rotation

Caution: A damaged or out-of-specification device can destroy a good connector attached to it even on
the first connection. Any connector with an obvious defect should be marked for disposal or sent out
for repair.

To Clean Connectors

1. Wear a grounded wrist strap (having a 1 MQ series resistor).

2. Use clean, low-pressure air to remove loose particles from mating plane surfaces and threads. Inspect
connector thoroughly. If additional cleaning is required, continue with the following steps.

3. Moisten—do not saturate—a lint-free swab with isopropyl alcohol. See Cleaning Supplies for recommended
type.

4. Clean contamination and debris from mating plane surfaces and threads. When cleaning interior surfaces,
avoid exerting pressure on center conductor and keep swab fibers from getting trapped in the female center
conductor.
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Let alcohol evaporate—then use compressed air to blow surfaces clean.
Inspect connector. Make sure no particles or residue remains.

If defects are still visible after cleaning, the connector itself may be damaged and should not be used.
Determine the cause of damage before making further connections.

To Make Connections

. Wear a grounded wrist strap (having a 1 MQ series resistor).

Inspect, clean, and gage connectors. All connectors must be undamaged, clean, and within mechanical
specification.

Carefully align center axis of both devices. The center conductor pin—from the male connector—-must slip
concentrically into the contact finger of the female connector.

—FHR-<—f{h

Carefully push the connectors straight together so they can engage smoothly. Rotate the connector nut (not
the device itself) until finger-tight, being careful not to cross the threads.

HOLD

5. Use a torque wrench to make final connection. Tighten until the "break" point of the torque wrench is

reached. Do not push beyond initial break point. Use additional wrench, if needed, to prevent device body
from turning.

37



To Separate a Connection

1. Support the devices to avoid any twisting, rocking or bending force on either connector.
2. Use an open-end wrench to prevent the device body from turning.

3. Use another open-end wrench to loosen the connector nut.

4. Complete the disconnection by hand, turning only the connector nut.

5. Pull the connectors straight apart.

To Use a Torque Wrench

1. Make sure torque wrench is set to the correct torque setting.

2. Position torque wrench and a second wrench (to hold device or cable) within 90° of each other before
applying force. Make sure to support the devices to avoid putting stress on the connectors.

HOLD

CORRECT INCORRECT METHOD  (TOO MUCH LIFT)
METHOD

3. Hold torque wrench lightly at the end of handle—then apply force perpendicular to the torque wrench handle.
Tighten until the "break" point of the torque wrench is reached. Do not push beyond initial break point.
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TORQUING DIRECTION

STOP WHEN HANDLE BEGINS TO YIELD

To Handle and Store Connectors

¢ Install protective end caps when connectors are not in use.

o Never store connectors, airlines, or calibration standards loose in a box. This is a common cause of
connector damage.

e Keep connector temperature the same as analyzer. Holding the connector in your hand or cleaning connector
with compressed air can significantly change the temperature. Wait for connector temperature to stabilize

before using in calibration or measurements.

e Do not touch mating plane surfaces. Natural skin oils and microscopic particles of dirt are difficult to remove
from these surfaces.

e Do not set connectors contact-end down on a hard surface. The plating and mating plane surfaces can be
damaged if the interface comes in contact with any hard surface.

e Wear a grounded wrist strap and work on a grounded, conductive table mat. This helps protect the analyzer
and devices from electrostatic discharge (ESD).
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VNA Front-Panel Tour

Click on an area of the image to learn more.

LCD Touchscreen Instrument  Knob

Navigation
Response
Numeric
Utility
Stimulus
USB Hub
Power Switch Front-panel Test Ports
Access Jumpers
Ground Terminal Ground Terminal
E5080A Test Port Portion
Ground Terminal Test Ports Ground Terminal

E5080B Test Port Portion
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Ground Terminal Test Ports Ground Terminal

See Also

e Display area

e Rear-panel Tour

e E5080 Rear Panel

Power Switch

Push Power button for powering ON and OFF the VNA.

LED status: Normal: Green, Off: Orange, Shutdown: Orange + Green
Learn to power ON and OFF the VNA.

LCD Touchscreen

VNA is equipped with a 12.1-inch TFT color, touch-sensitive LCD screen for displaying traces, scales,
settings, softkeys and other measurement related information. The touchscreen LCD allows to
manipulate softkeys by touching the LCD screen directly. For more on the LCD touchscreen, see
Screen Display Tour .

Note:
Do not press the surface of the LCD touchscreen with a sharp object (e.g., a nail, pen, or screwdriver).
Pressing the surface with a sharp-pointed object will damage the LCD screen surface or cause the

screen to fail.

Valid pixels are 99.998 % and more. Below 0.002 % of fixed points of black, blue, green or red are not
regarded as failure.

Test Ports
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The models are available with 2 or 4 test ports.
See Specs for more information about the Test port connectors and Input damage levels.

The LED of each test port shows the source output status. When the signal comes from the port, its
LED is lighted. For ES080B, when the port is assigned as the source, its LED is lighted.

USB Hub

This USB hub contains four USB ports to power your VNA peripherals. There are also four USB ports
on the rear panel.

Limitation: The total power consumption for all eight USB ports is limited to 4.0 amps. If this limit is
exceeded, all USB ports are disabled until a device is removed and power consumption falls below the
limit. When first connected, Keysight ECal modules 8509x and N4431 draw significantly more current
than other modules.

Note:

The FIRST TIME each USB device (ECal module, power sensor, and so forth) by serial number is
connected to a specific VNA USB port, you must be logged in to the VNA with an Administrator
account. Learn how .

When a New Hardware Found dialog appears, click OK to install the device.

After being installed, when that same USB device is connected to that same USB port, you can be
logged in to the VNA with a Limited/User account.

Ground terminal

Connect a banana-type plug to this terminal for grounding to the VNA chassis.

No probe power

Probe power is NOT provided on VNA models. Learn more about Active Probing

Hardkeys

INSTRUMENT Keys

Manages the Traces and Channels on the VNA display.
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Hard Key  Invokes these Softkeys
Prev  Makes the previous Trace/Channel/Window active.
Next Makes the next Trace/Channel/Window active.
Trace Invokes the Traces softkey menu which allows you to manage traces.
Channel Invokes the Channels softkey menu which allows you to manage channels.
Display Invokes the Display softkey menu which allows you to manage display functions.
Setup Invokes the Setup softkey menu which allows you to set up a measurement.

RESPONSE Keys

Performs operations on measurement traces after data is measured - not including Data Analysis

operations.

Hard Key

Invokes these Softkeys - Click to learn more

Meas

S-Param

e Meas Class

Balanced

e Balanced Source/Topology

Receivers
Waves
Auxiliary
Meas Setup

e Conversions

e Correction

e Trace Hold

e Equation Editor
e Memory

e Time Domain

e Pulse Setup

Format

Format 1

e Format
e Group Delay Aperture
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Format 2

Scale

Main

Autoscale

Scale

Reference Level
Reference Position
Scale Coupling

Electrical Delay

Delay Time

Delay Distance
Distance Units

Velocity Factor

Media -Waveguide/coax
Waveguide cutoff freq

Constants

System Z0
Phase Offset
Mag Offset
Mag Slope

Math

Memory

Data/ Memory Math
Normalize

Data Math

Display

8510 Mode

Analysis

Conversions
Equation Editor
Statistics
Uncertainty Analysis

Limits
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e Limit Table

Time Domain

e Transform

e Start Time

e Stop Time

e Center Time

e Span Time

e TD Mode

e TD Toolbar

e Time Domain Setup

Time Gating

e Gating

o Gate Start

e Gate Stop

e Gate Center
e Gate Span
e Gate Type

e Gate Shape
e Gating Setup

Avg BW  Main

e Averaging

e Averaging Restart
e Average Type

¢ |F Bandwidth

e LF Auto BW

Smoothing

e Smoothing
e Smooth Percent
e Smooth Points

Delay Aperture

e Aperture Percent
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e Aperture Points
e Aperture Frequency

Cal Main

e Basic Cal

e Other Cals

e CalAll

e Smart Cal

e ECal

e Response Cal

e Source Power Cal

e Correction

e Src Power Correct
e Interpolation

e Correction Methods

e Properties

Port Extension

e Select

e Port Extension

e Time

e Distance

e Velocity Factor

e DC Loss

e Port Extensions

e Auto Port Extension

Cal Sets & Cal Kits
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o Cal Set

e Cal Set Viewer

e Cal Kit

e ECal

e Cal Pod

e Uncertainty Setup

Fixtures

Apply Fixtures

Power Comp

Fixture Setup

Cal Plane Manager

e Auto Fixture Removal

Marker

Markers 1-7
Markers 8-15

Marker Setup

e Delta

e Discrete

e Type

e Format

e Coupled

e Marker Display
o Marker Table

o All Off

Marker Functions
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e Marker -> Start

e Marker -> Stop

e Marker -> Center

e Marker -> Span

e Marker -> Ref Level
e Marker -> Delay

o Marker -> CW Freq

e Marker -> SA

Search Main

e Max Search
e Min Search
e Domain

e Domain Start
e Domain Stop
e Tracking

e Peak Search
e Peak Right >> Search
e << Peak Left Search

e Next Peak Search
e Threshold
e Excursion

e Peak Polarity

Tracking

Target

e Target Search
e Target Right >> Search

e << Target Left Search
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Target Value
Transition

Tracking

Multi Peak & Target

Multi Peak Search
Peak Threshold
Peak Excursion
Peak Polarity

Multi Target Search
Target Value
Transition

Tracking

Bandwidth & Notch

Bandwidth Search

BW Ref To Marker/Peak
BW Level

Notch Search

Notch Ref To Marker/Peak
Notch Level

Tracking

Comp & Sat

Compression Search

Comp Level
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e Saturation Search
e Pmax Backoff

e Tracking

Normal Op Pt

Normal Op Search

Backoff

Pin Offset

Tracking

STIMULUS Keys

Controls settings that determine what data (stimulus range), and how data (sweep type and triggering),
1s measured.

Hard Key  Invokes these Softkeys - Click to learn more

Freq Frequency Range

Frequency Offset Mode

Power Main

e Power level

e RF Power

e Start Power

e Stop Power

e Power and Attenuators

Port Power

e Select

e Power level
e Start Power
e Stop Power
e Source State

e Coupling

Leveling & Offsets
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e Select

e Slope

o Offset

e Limit

e Offsets and Limits
e ALC Hardware

e Receiver Leveling

Sweep Main

e Number of Points
e Sweep Type

o Start

e Stop

e X-axis Type

e Sweep Setup

Sweep Timing

e Sweep Time

e Dwell Time

e Sweep Delay

e Sweep Mode

e Sweep Sequence
o FastSweep

Source Control

e Frequency Offset
e Pulse Setup

e Balanced Source
e Phase Control

e DC Source

Segment Table

e Add Segment

e Insert Segment
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e Delete Segment
e Delete All Segments
e Segment Table

e Show Table

Trigger Main

e Hold

e Single

e Groups

e Continuous

e Manual Trigger
o Restart

e Trigger Source

e Trigger

UTILITY Keys

Performs global VNA operations.

Hard Key Invokes these Softkeys - Click to learn more

Save File Recall

Recall
e Recall State

e Recall Register
e Recall Calset
e Recall Data

e Recall Order

Save State

e Save State

e Auto Save

e Save State As
e Save Register
e Save Type

e Delete State
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Save Other

Save Calset
Save Data

Save Screen
Save User Preset

Manage Files

Macro

Favorite 1

Favorite 2

Favorite 3

Macro 1

Macro 2

Macro 3

Key Setup

Macro Setup
Clear Favorites

System

Main

Show Taskbar
Move App to Back
Minimize Application
Exit

Security

Control Panel
Manage Files

System Setup

Next/Prev Keys
Preferences
Sound

Remote Interface
LAN Status
Code Emulation
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Print

Print
Print to file
Page Setup

Print Colors

Help

e NA Help

On The Web

Error Display

View Error Log

About NA

Service

e Update Firmware

e Verification

¢ Adjustment Routines

Diagnostics
e Option Enable

Undo Main

e Undo
e Redo
e Clear Undo History

Help  Launches the Help file.

Preset Main

e Preset
e User Preset

e Confirm Preset

ENTRY Keys

54




Hard Key  Invokes these Softkeys

OK Closes a dialog box and enters any values made in the dialog box.

Cancel Closes a dialog box.

Bk Sp Back Space. Backs up the cursor and deletes any previous selection.

0to9 Selects values for measurement settings, then press Enter or G/n - M/u - k/m to
complete the selection.

T/p Completes the value selection, assigning a unit of measurement.

G/n

e G/n (Giga/Nano) E12 or E-12
M/u

e M/u (Mega/micro) E6 or E-6
k/m

e k/m (kilo/milli) E3 or E-3

Enter Enters the values that you select for the measurement settings.

Decimal Enters a decimal point to designate fractions of a whole number.
point

+/-  Plus - Minus Toggles between a positive and negative value entry if it is the first
key pressed in the entry.

Knob
Rotate to increase or decrease the value of the active entry.

Navigation Keys

These keys allow you to navigate through menus and dialog boxes and select choices from the active
entry toolbar.

Hard Key  Invokes these Softkeys

Left / Right Moves left and right through menus.

Moves tab-left and tab-right within dialog boxes.

Up/Down Moves up and down through menus.

Behaves as follows in a dialog box:

¢ Modifies a numeric value
e Moves through items in a drop-down list

e Moves through options buttons in a group of option buttons

Click Makes a selection just like a mouse click.
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Screen Tour

Click on image areas to learn more.

Marker Readout

Active Entry Trace Status

Teyt Ch1| Wil | WS || BW=100 | No Cor
RFCn | UpdateCn | InRef

Entry Toolbar

er 1. RF 0.0000 dBm

Softkeys Hardkeys
SoftTabs

Hardkeys |

Receivers

Waves

LCL | iS04

I T

Window Number Status Bar

See Also

e Marker Drag
e Expanded Mouse capabilities

e Learn how to Customize the Screen

Stimulus Range

Softkey Toolbar

About the Touchscreen
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The VNA is equipped with a 12.1-inch Hi resolution, color, touch-sensitive LCD screen for displaying
traces, softkeys, and other measurement related information. The touch screen LCD allows you to make
measurement settings by touching the LCD screen directly with a finger.

Important

e Do not press the surface of the LCD screen with a sharp object such as a pen. This will damage the LCD
screen surface or cause the screen to fail.

e Occasionally, a few pixels may appear on the screen as a fixed point of blue, green or red. This is not a
failure of the LCD screen and does not affect the performance of your product.

e Because of the LCD screen, burn-in is not likely. In addition, we do not recommend using a screen-saver
on the VNA.

How to Calibrate or turn ON | OFF the Touchscreen

Prugramming Commands }

Using Hardkey /SofiTab /Softkey

To turn Touchscreen ON or OFF:

1. Press Display > Display Setup .

2. Click Touchscreen to turn ON/OFF.

The touchscreen ON |OFF setting remains until changed again from this menu, the Preferences
dialog , or remotely.

Active Entry

Allows you easily select the tools. Learn more.

Trace Status

Provides details of each trace in the window. Highlighted trace indicates the active trace. Learn more.
Entry Toolbar

Along with the softkeys, allows numeric values to be entered for settings. Learn about all toolbars.
Marker Readout

Provides stimulus and response information for markers. Learn about customizing the marker readout
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area. See also Marker Drag.

Softkeys

The combination of hardkeys and softkeys allows easy access to all VNA features without a mouse.
SoftTabs

Pressing these tabs will display corresponding softkeys.

Hardkeys

Performs interface operations that are equivalent to those of keys in the INSTRUMENT keys,
RESPONSE keys, STIMULUS keys and UTILITY keys on the front panel of VNA. Learn more.

Window Number

Provides window identification which is useful for remote programmers.
Status Bar

Provides detail about all aspects of the status of the analyzer. Learn more.
Stimulus Range

Displays the start and stop values of the sweep range.

Softkey Toolbar

These icons provide shortcuts to quickly select the softkey tools. Learn more.
Marker Drag

Drag a displayed marker across the trace using a r mouse. Learn more.

Expanded Mouse Capabilities

e Cursor changes to a “hand” when hovering over a clickable object.

¢ Right-click on the Entry toolbar to launch a mouse-compatible numeric pad.

Windows
¢ Right-click or long press on a window area to make selections pertaining to that window.

e Double-click on a window area to maximize the window. To return to original window configuration, right-click
on window area, then click Tile .
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e Left-click on X-axis annotation to select the active channel/trace.

¢ Right-click on X-axis annotation and click Start/Stop/Center to change stimulus properties. Applications are
not fully supported.

e Quickly change Scale, Reference Level, and Position. Learn how.
¢ Right-click on Y-axis annotation and click Scale to change Scale.

e Drag a trace from one window to another. Click or touch either the trace or the Trace Status . Drag the trace
to another window, then release the mouse or lift your finger.

Traces

e Left-click a trace or Trace Status to make it the selected trace.

e Double-click on a trace or Trace Status to maximize the trace. Double-click again to return to the original
trace configuration.

e Set a preference to always widen the active trace.
e Set a preference to briefly widen the active trace.

e Drag a trace from one window to another. Click or touch either the trace or the Trace Status . Drag the trace
to another window, then release the mouse or lift your finger.

Markers

¢ Right-click on a trace or Trace Status to add a marker.

¢ Right-click a marker to make selections pertaining to that marker, such as Marker Search or Function.

Softkeys

e Use the Touchscreen or adjacent buttons to select from eight dynamic softkey menu choices.

e To Show the softkeys, press any front-panel hardkey and the corresponding softkey menu will be launched.

Softkey Annotations
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Item  Description

Menu ... Selection launches a dialog box.
Menu ¥ Selection launches another level of softkeys.
— Indicates the item (marker, trace, window) is ON. Any number of objects can
Item

be ON.

Item — Indicates the item (marker, trace, window) is OFF. Click to turn item ON.

Item & Indicates the item IS selected.

Item ¢ Indicates the item is NOT selected. Click to select. Only one item in the

collection can be ON.
* Ttem Enter value in Entry toolbar.
Item

on |OFF Capitalization indicates the current setting.

61



E5080A Rear Panel / E5080B Rear and Side Panel

Click on an area of the image to learn more.

E5080A

GPIB
Talker/Listener USB Device
Line Switch
ine wwitc VGA Connector
Fan | Line Power USB Hub
| |
ol
@ Lo,
I."I'.‘]l.‘:l [wlnzs \?{%Q [oiwe) ‘%%fﬁﬂﬂ [Ehl‘pig;gggﬁ_
ooo%c:lclc\o -:-?D{—?:ia ouu”nﬁﬁbﬁ-u sTelnintn o E;E%% iijol:aﬁac?o@c'\;
y y
- == =
o= & B

L =T

Ehandainigny

ﬂnﬂa%

o1

@

High Stability
Frequency
Reference

Auxiliary
Input Ports

10MHz Ref In & Ref Qut

E5080B

Bias Input
Ports

Fuse for Bias

Input Ports

62

LAN Connector

Handler /O Connector

Measure Trigger In

Auxiliary Trigger Out
Solid State Drive

Certificate of
Authenticity Label

Serial Number Plate



Serial Number Certificate of Handler I/0 Measure Trigger Auxiliary Trigger Out

Plate Authenticity Label Connector Ready

Measure Trigger In

Device Test I/0

Application I/0

High Stability Frequency
Reference (Ref Oven)

Line Power

puitiary Auxlliary Bias Input Ports 10MHz Ref In & Ref Out

Output Ports  Input Ports

Solid State Drive VGA Connector

USB (USBTMC)
Interface Port

Display Port

EHNUA O 3O 38
HEMD G e NEHINLL

Ethernet Port

USB Hub

GPIB
Talker/Listener
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Fan

The cooling fan for controlling the temperature inside the VNA. This fan exhausts heated air from
inside the analyzer to the outside.

Line Switch

Applicable in ES080A only. This switch must always keep it ON ( | ).

Caution: Do not use this switch to turn off (O) the mains. Doing so may cause the VNA to fail. For
more information, see the description of the Line Power.

Line Power

The receptacle to which the power cable is connected.

Note: To connect the device to a power source (outlet), use the supplied three-prong power cable with
a ground conductor. The plug attached to the power cable (on the power outlet side or device side of
the cable) serves as the disconnecting device (device that cuts off power supply) of the VNA. The
power supply must be cut off to avoid such danger as electric shock, pull out the power cable plug (on
the power outlet side or device side of the cable). For the procedure for turning off the mains in normal
use, see the description in Power Switch.

See Specifications

External Reference Signal Input Port (10MHz Ref In)

When a 10 MHz external reference signal is detected at this port, it will be used as the instrument
frequency reference instead of the internal frequency reference.

Notes: When the external frequency reference signal is input to this connector, the measurement signal
from the VNA is automatically phase-locked to the reference signal. When an input signal is not
present, the frequency reference signal inside the VNA is automatically used. The ExtRef (in blue back
ground color) on the instrument status bar is displayed when the system is phase-locked to the external
reference signal and IntRef (in gray back ground color) when not phase-locked.

When using Option 1ES (high stability frequency reference), connect this connector to the High
Stability Frequency Reference Output Connector (Ref Oven, Option 1ES only) by using the BNC(m)-
BNC(m) cable included with the option.
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Specification  Value

Connector BNC(f) connector
type
Input signal 10MHz + 10ppm, - 3
to+ 10 dBm

See SCPI command that detects an external reference signal at this connector.

See Specifications

Internal Reference Signal Output Port (10MHz Ref Out)

A connector for outputting the internal frequency reference signal from the VNA in order to use by
others test equipment. By connecting this output connector to the external reference signal input
connector of another device, the device can be phase-locked to the internal reference signal of the VNA
and used under this condition.

Specification  Value

Connector type  BNC(f)
connector

Output signal 10MHz + 7ppm,
0 dBm + 3dB

Output impedance 50 ohm
(Typical)

See Specifications

High Stability Frequency Reference Output Port (Ref Oven, Option 1E5 only)

When Option 1E5 (high stability frequency reference) is installed, the reference signal is output from
this connector. See Specifications

Specification  Value

Connector type BNC connector,
female

Output signal 10MHz + 1ppm, 0
(Typical) dBm minimum

Note: When Option 1ES5 (high stability frequency reference) is installed, connect this connector to the
External Reference Signal Input Connector (10MHz Ref In) by using the BNC(m)-BNC(m) cable
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included with the option.

Auxiliary Input Ports (AUX IN)

The Auxiliary Input Ports are used to input DC signal for DC signal measurement .

Auxiliary Output Ports (AUX OUT)

The Auxiliary Output Ports are used to output DC signal for an external device DC control .

GPIB (General Purpose Interface Bus) Controller and Talker/Listener Port
The VNA can be a GPIB Controller and Talker/Listener.

The connection of an external controller through GPIB connector allows you to configure an automatic
measurement system. This GPIB connector is used only for controlling the VNA from an external
controller. Use USB/GPIB interface to control other devices from the VNA. You cannot control other
devices from the VNA through this GPIB connector. Learn more.

USB (USBTMC) Device

Through this port, you are able to control the VNA from external controllers. For more information on
the measurement system using the USB port, see the Remote Control of SCPI USB Devices Connected
toa VNA .

Specification  Value

Connector type  Universal serial
bus (USB) jack,
type B (4 contact
positions),
Female

Compliance USBTMC-
Standards USB488 and
USB2.0

VGA Connector/Display Port (Video)

A terminal which an external color monitor (display device) can be connected. By connecting a color
monitor to this terminal, the same information shown on the LCD touchscreen of the main body can be
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displayed on an external color monitor.

USB (Universal Serial Bus) Hub

This USB hub contains four USB ports to power VNA peripherals. There are also four USB ports on
the front panel.

The four USB are provide that can use for connecting to ECal (Electronic Calibration) module, USB,
Multiport test set or a printer. Connecting a designated ECal module to this port enables ECal
measurements to be taken. Connecting a compatible printer to this port enables screen information on
the VNA to be printed.

Limitation: The total power consumption for all eight USB ports is limited to 4.0 amps. If this limit is
exceeded, all USB ports are disabled until a device is removed and power consumption falls below the
limit. When first connected, ECal modules 8509x and N4431 draw significantly more current than
other modules. See Specifications .

See Important First-time USB connection note .

LAN (Local Area Network) Connector

A terminal for connecting the VNA to a LAN enables you to access the solid state drive of this
instrument from an external PC or to control this instrument by using SICL-LAN or telnet.

This 10/100Base-T Ethernet connection has a standard 8-pin configuration and auto selects between the
two data rates.

Material Handler 1/O

The terminal which is an automatic machine (handler) used on a production line is connected. See
details.

Measure (External) Trigger In
When enabled, VNA is triggered by signals on this connector.

A connector to which measure trigger signals are input. This connector detects the downward transition
from the HIGH state in TTL signals as the trigger signal. To use this connector to generate a trigger,
you must set the trigger source to "external" (key operation: Trigger > Main > Trigger Source >
External ).

Connector type: BNC connector, female. Learn more.
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Measure Trigger Ready

Applicable in ES080B only. When enabled, VNA outputs a 'READY" signal on this connector to other
devices. Learn more.

Auxiliary Trigger Out

When enabled, VNA outputs signals on these connectors either before or after a measurement. Learn
more.

Solid State Drive (SSD)

There are two options for SSD.

e Non removable SSD option (applicable in ES080A)
e Removable SSD option (applicable in ES080A and ES080B)
See Service Guide and to learn how to remove the SSD. (Internet connection required)

See Preventing VNA Solid State Drive Problems

Certificate of Authenticity Label

The label showing the information of the Certificate of Authenticity of Windows.

Serial Number Plate

The label showing the product number, serial number and the installed option number. The accessary
and system rack options are not listed on this label. (CFGxxx or ATOxxx in the first line is for
Keysight Use Only.)

Bias Input Ports

This BNC female connector allows external bias to be applied at the test ports.
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Source
or

Receiver

e e
Termination
Reference Test

Receiver

gl

I_I
Bias Input Ports Fuse

Port1/Port2/Port3/Portd

Connect your DC Power Supply to a pply Bias Input to the VNA ports through the BNC connectors.

Caution: Do not apply DC voltage exceeding 35 volt.

Fuse for Bias Input Ports

Specification  Description

Fuse Rating 0.5A/125V

Part Number 2110-1439
(ES080A Only)

e The bias fuses are rated for 0.5A. You are responsible to ensure that devices connected to the test port do
NOT draw more current than 0.5A. This will occur, for example, if a calibration SHORT is connected to the

test port with bias power ON.

¢ The VNA will meet all of its RF specifications with bias up to 200 mA (E5080A) or 300 mA (E5080B). As the
DC bias is increased, corrected source match and directivity will degrade at low RF frequencies.
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Powering the VNA ON and OFF

The following is described in this topic:

e How to Log Off, Shut Down, or Restart the VNA
e ON Mode

e Shutdown

Notes: During boot up of Windows or of the Network Analyzer application program, do NOT press
keys on the front panel, rotate the RPG knob, or connect a USB device. Doing so MAY lead to a front
panel lockup state.

If the VNA front-panel keypad or USB ports are not responding, SHUTDOWN or RESTART the
VNA.

How to Log Off, Shut Down or Restart the VNA.

1. Minimize the VNA application
2. Click Window Start.

3. Choose from the following:

e Shut down
e Log off (closes programs)

e Restart (shutdown and start)

OR

1. Press the front-panel VNA power button (only for Shutdown).

Note: ONLY if the VNA is locked and you cannot operate the mouse or keypad - Press and hold
the power button for at least four seconds. This practice should be avoided! Repeated shutdowns
in this manner WILL damage the solid state drive. Learn more about damaging the VNA solid state drive.
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ON Mode

e To turn ON the VNA press the power button.

e The power indicator will change to green when power is ON.

Shutdown Mode

¢ In shut down mode the current instrument VNA is NOT automatically saved before the VNA is powered OFF.

¢ When the VNA is again powered ON, a full system boot-up is performed and the VNA powers-up in the
preset settings.

e A password may be required to resume VNA operation after being in Shutdown mode. Learn more.

e To guarantee that your measurements meet the VNA specified performance, allow the VNA to warm-up for
90 minutes after the power indicator has turned green.

e The power indicator will change to yellow when power is OFF.

Note: If the VNA is locked and you cannot operate the mouse or keypad, shut down the VNA by
pressing and holding the power button for at least four seconds.

This practice should be avoided! Repeated shutdowns in this manner WILL damage the solid state
drive. Learn more about damaging the VNA solid state drive.

Unplugging the VNA

e Remove the power cord from the VNA ONLY when the power indicator is yellow, in either Hibernate or
Shutdown mode. If the power cord is removed while the power indicator is green (VNA ON), damage to the
solid state drive is possible.

e The indicator will remain yellow for several seconds after the power cord has been removed.
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Traces, Channels, Windows, and Sheets on the Analyzer

It is critical to understand the meaning of the following terms as they are used on the analyzer.

Traces - Managing (Trace Manager)

Channels - Managing

Windows - Managing

Sheets - Managing

Other Quick Start topics

Traces

Traces are a series of measured data points. There is no theoretical limit to the number of traces.
However, the practical limit is the maximum number of windows times the maximum number of traces per
window (24).

In addition, one memory trace can be stored and displayed for every data trace.Learn more about Math /
Memory traces.

Trace settings affect the presentation and mathematical operations of the measured data.

The following are Trace settings:

Parameter

e Format and Scale

e Smoothing

e Correction ON / OFF
e Electrical Delay

¢ Phase Offset

e Trace Math

e Markers
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e Time Domain (Opt S93010A/B/010)

Managing Traces

e How to Add a trace

e How to Select a trace

e How to Delete a trace

e How to Move a trace

e How to Maximize a trace

e How to perform Trace Hold (Max or Min)

e How to Create a new trace

e How to Change the trace parameter

e How to display a custom trace title (separate topic)

e How to display a wide active trace (separate topic)

How to Add a trace

The only measurements that can be selected are those in the same measurement class as is currently
assigned to the channel. To select a measurement other than these, first select the appropriate
measurement class to a new or existing channel. Learn how.

A trace must be selected (active) before its trace settings can be changed.

How to know which trace is Active?

Using Hardkey/SoftTab/Softkey Using a mouse
1. For Traces 1-7, press Trace > Trace 1-7 > click left side Trace 1-7 small 1. Right click in the grid
button box and then select
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(Example: Click on left side Trace 1 small button and Trace 1 is active New Trace....
when it turns green, so Trace 1 added).

For Traces 8-15, press Trace > Trace 8-15 > click left side Trace 8-15
small button
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(Example: Click on left side Trace 9 small button and Trace 9 is active
when it turns green, so Trace 1 is added).

3. Another method of adding traces is by pressing Trace > Trace 1-7 >
New Traces....

4. For other traces numbers, press Trace > Trace Setup > Add Trace,

then select New Trace, New Trace + Channel, New Trace + Window,
New trace + Channel + Window, or New Traces....

Prugramming Commands= }

How to Select a Trace

The only measurements that can be selected are those in the same measurement class as is currently
assigned to the channel. To select a measurement other than these, first select the appropriate
measurement class to a new or existing channel. Learn how.

A trace must be selected (active) before its trace settings can be changed.

How to know which trace is Active?

Using Hardkey/SoftTab/Softkey Using a mouse

1. Press Trace > Trace Setup > Select. 1. Click on Trace Status label of any
trace above the grid box.
2. Select a trace number which corresponds to the desired

measurement parameter.
Programminq Commands= }
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How to Delete a Trace

Using Hardkey/SoftTab/Softkey Using a mouse
1. For Traces 1-7, press Trace > Trace 1-7 > click left side 1. Right-click the Trace Status label
Trace 1-7 small button above the grid box, then click Delete

76



(Example: Click on left side Trace 1 small button and Trace.
Trace 1 is inactive when it is not green).

2. For Traces 9-16, press Trace > Trace 8-15 > click left
side Trace 8-15 small button
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(Example: Click on left side Trace 9 small button and
Trace 9 is inactive when it is not green).

3. For other traces numbers, press Trace > Trace Setup >
Delete Trace, then select a trace number.

Pru-grannning Commands }

How to Move a trace to a different Window

You can DRAG a trace from one window to another, or...
Using Hardkey/SoftTab/Softkey Using a mouse

1. Press Trace > Trace Setup > Trace Manager... 1. Right-click the Trace Status label above
the grid box, then click Trace Manager...
2. Under the Window Column, reassign the active
trace to another window number at the pulldown 2. Under the Window Column, reassign the
then click OK. active trace to another window number at
the pulldown then click OK.

For some models
For some models,

1. Press Trace > Trace Setup > Move Trace....
1. Right-click the Trace Status label above
2. Select a window number in the following dialog, and the grid box, then click Move Trace....
then click OK.
2. Select a window number in the following
dialog, and then click OK.

Pru-grannning Commands }

Trace Manager dialog box help
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Trace l Meas Il Class Channel | Window | Sheet
1 5N STD 1 1 1
2 sDD11 STD 1 1 1
3 S21 STD 1 1 1
4 Compln21 GCA 2 3 2
5 NF NFA 3 3 2
6 S STD 2 4 3

Undo | Redo OK | Cancel Help

Trace Manager allows the user to see and modify all traces/channels/windows/sheets/formats in one
table. The changes are updated immediately.

There is one row for each trace. By Clicking on a column heading will display the rows in
ascending or descending order as defined by that column.

A row is selected by clicking on any cell in the row and the popup menu for the cell will appear.
Multiple rows can be selected by click-drag-release. All selected rows will be highlighted and
popup menu for the column will appear.

Undo Reverse back to the previous settings

Redo Change the settings again

Trace Column
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I Trace J Meas | Class | Channel | Window | Sheet
S11 STD 1 1 1
JD11 STD 1 1 1
New Trace... 321 sTD 1 1 1
Delote Trace ipin21 GCA 2 3 2
NF NFA 3 3 2
Table Columns... 311 sTD 4 4 3
2 1
Undo | | Redo oK | | Cancel ‘ | Help

User is not able to edit trace numbers. User may select multiple rows; this allows user to
delete multiple traces using the popup menu.

There is a special case where the trace entry in the row is empty. This is used to show when there is
an empty window. If the users select this row and choose "Delete Trace", it will delete the empty
window; this is a convenient feature; it is deleting a null trace.

New Trace To add a new trace. Selecting the cell will open the '""Meas" dialog.
Delete Trace The selected trace will be deleted.

Table Columns A pop up dialog is opened which allows user to define the columns visible in
the table. The default table column is: Meas/Class/Channel/Windows/Sheet.

Meas Column

Selecting the cell will open the "Meas" dialog. User cannot select multiple rows from a Meas cell.

Class Column
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Gain Compression
Single Tone IMD
Moise Figure Cold Source

Spectrum Analyzer
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TDR

7] Show sctuo dik
] Confirm changes New Channel | | 0K | | cancel Help

o Redo oK ] | Cancel ] | Help

Selecting the cell will open the "Measurement Class" dialog. User cannot select multiple rows from
a Class cell.

When the measurement class is changed, all traces numbers on the currently active channel will be
assigned to the new measurement class. The window and sheet settings will be the same, but the
"Meas" setting will be changed to default values for the selected class.

Channel Column

Trace Ma
.-
I Trace | Meas j Class I Channel Window I Sheet |
1 S11 STD Channel 1 = 1 1
2 SDD11 STD Channel 1 1 1
3 s21 sSTD Channel 2 1 1
Channel 3

4 Compln21 GCA Channel 4 3 2
T NF NFA New Channel 3 2
6 st1 stp  NewChCopy 14 3

- - Delete Channel _|[§3 1

nde Redo I Cancel l | Help

Selecting the cell will open a pulldown, and will select the row. User can click and drag to select
multiple rows.

User may use the pulldown to reassign the active trace to another channel and delete the active
channel.

When the channel for a trace is changed, the "Meas" setting will likely be changed.
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Window Column

l Trace ‘ Meas Class Channel Window j Sheet |
1 SN STD 1 Window 1 ~ 1
2 SDD11 STD 1 Window 1
3 s21 STD 1 Window 2
Window 3
4 Compln21 GCA 2 Window 4
) NF NFA 3 New Window
6 S STD 4 L

Layout = 1 Window
Layout = 1 Tr per Win
Layout = 1 Ch per Win

Delete Window

nd Redo OK I Cancel l | Help

Selecting the cell will open a pulldown, and will select the row. User can click and drag to select
multiple rows.

User may use the pulldown to reassign the active trace to another window, delete the active window
and all traces on that window and change the layout of the windows.

If the active row has no trace assigned, then the window pulldown will not allow user to change the
window number.

Sheet Column

» | Trace Ma
»
[ Trace | Meas I Class I Channel Window I Sheet |
1 511 STD 1 1 Sheet 1 -
2 SDD11 STD 1 1 Sheet 1
3 s21 STD 1 1 Sheet 2
Sheet 3
4 Compln21 GCA 2 3 New Sheet
5 NF NFA 3 3 R
Layout = 1 Sheet
6 SN STD 4 4
Layout = 1 Tr per Sh
- 2 Layout = 1 Ch per Sh
Layout = 1 Win per Sh
Delete Sheet
Undo I Redo \ Cancel ] ‘ Help

Selecting the cell will open a pulldown, and will select the row. User can click and drag to select
multiple rows.

User may use the pulldown to reassign the active trace to another sheet, delete the active sheet and
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all traces on that sheet and change the layout of the sheets.

If the active row has no trace assigned, then the sheet pulldown will not allow user to change the

sheet number.

Format Column

8 Trace Manager

Trace Meas
S11
SDD11
S21
Complin21
NF
B

[ I e N

Undo

Class
STD
STD
STD
GCA
NFA
SA

Channel

1

W N = -

Window

1

1
1
3
3
4
2

Sheet

JEFR) QY IR N QS T

Cancel

*

Format
LogM ~
LinM
Phase
Phasel
Imag
Real
Polar
Smith
Inv Smith
SWR
Delay
kelvin
fahrenheit
celsius
PhaseP
Impedance
Volt

Selecting the cell will open a pulldown, and will select the row.

User may use the pulldown to select the trace formats. When the measurement class is SA, the
selectable formats are only LinM and LogM.
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Move Trace dialog box help (ES080A only)

Maove Trace @

Mowve Trace 2 to window

Window 2
Window 3
MNew Window

‘ OK H Cancel | ‘ Help |

Note: Only ONE trace can be moved at a time.

1. Click the Trace Status label to select the trace to move.

2. Move Trace N to window - Transfer the selected trace to any Window listed or to a New Window.

Trace Max
How to maximize the active trace - the active trace is the ONLY trace on the screen display. All other
traces are hidden.
Using Hardkey/SoftTab/Softkey Using a mouse

1. Press Trace > Trace Setup > Trace Maximize (ON). 1. Right-click the Trace Status label
With Trace Max (ON), select a different trace to make above the grid box, then click

that trace visible. Trace Maximize.

2. ;I'an;?ke all traces visible again, select Trace Maximize 2 Double click on the active trace

to make all traces visible again.

Prugramming Commands }
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Trace Hold

How to hold the active trace at the maximum or minimum points.

Using Hardkey/SoftTab/Softkey Using a mouse

Not available
1. Trace > Trace Setup > Trace Hold > OFF |
Max | Min.

2. Restart resets the trace.

Prugramming Commands= }

Maximum/Minimum trace hold can be applied with several conditions:

Feature is applicable to any data trace, but NOT to memory traces.

When the stimulus or any data post processing setting is changed, the trace hold data will be reset.
These settings include:

e Smoothing on/off.

. Smoothing Aperture.

. Gating on/off.

. Transform on/off.

. Conversion state change, conversion type change.
. Data Math Function (Data/Mem) change.

. Equation Editor state change, formula change.

. Parameter change.

o Formatting change.

e Minimum/maximum comparison is done with formatted data. For Smith and Polar formats,
absolute data is used and not phase.

e Trace hold data can be recalled.
¢ Data save files formats
o SnP does NOT save trace hold data

o Citifile, CSV, MDF, PRN DOES save trace hold data
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Note: Citifiles can be recalled and viewed in the VNA.

e Use SCPI commands to get trace hold data. If trace hold is active, then the data returned from
the remote interfaces will be the trace hold data.

Channels

Channels contain traces. The analyzer can have up to maximum 500 independent channels.

Note: Actual maximum number of channel depends on the setup. A large number of NOPs and traces
limit the maximum number of channel.

Channel settings determine how the trace data is measured . All traces that are assigned to a channel
share the same channel settings. A channel must be selected (active) to modify its settings. To select a
channel, click the Trace Status button of a Trace in that channel. The following are channel settings:

Frequency range
e Power level
e Calibration
¢ |F Bandwidth
e Number of Points
o Sweep Settings
e Average
e Trigger (some settings are global)
Managing Channels
How to Select a Channel
A channel must be selected (active) before its settings can be changed.

To make a channel active, select a trace in that channel or click the Trace Status button of a Trace in
that channel.

86



How to Add a channel
Using Hardkey/SoftTab/Softkey Using a mouse

Not available
1. Press Channel > Channel 1-8 > click left side

Channel 1-8 small button
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(Example: Click on left side Channel 1 small
button and Channel 1 is active when it turns
green, so Channel 1 is added).

2. For other channel numbers, press Channel >
Channel Setup > Add Channel, then select
New Trace + Channel or New Trace +
Channel + Window.

No programming commands are available for this feature

How to Delete a channel
Using Hardkey/SoftTab/Softkey Using a mouse

Not available
1. Press Channel > Channel 1-8 > click left side

Channel 1-8 small button
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(Example: Click on left side Channel 1 small
button and Channel 1 is inactive when it is not
green).

2. For other channel numbers, press Channel >
Channel Setup > Delete Channel, then select

a channel.
Pru-gra.mming Commands ’

Windows

Windows are used for viewing traces.

e The analyzer can show an UNLIMITED number of windows on the screen with the following limitations:
e The SCPI status register can track the status of up to 576 traces.

e Each window can contain up to 24 traces.
¢ Windows are completely independent of channels.

e See Customize the analyzer screen to learn how to make other window settings.

The following is a window containing two traces. Both traces use the same channel 1 settings as
indicated by the annotation at the bottom of the window.

Wl
T

The window number shows in the lower-left corner of the window. The following shows window 5.

Ch1: Start 1.00000 GHz =
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Managing Windows

How to Add a window

Using Hardkey/SoftTab/Softkey Using a mouse
1. Press Display > Window 1-8 > click left side Channel 1-8 small 1. Right-click any area of grid
button box and then select New
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(Example: Click on left side Window 1 small button and Window 1 is Window.
active when it turns green, so Window 1 is added).

2. For other windows, press Display > Window Setup > Add
Window, then select New Window, New Trace + Window, or New
Trace + Channel + Window.

Prugramming Commands= }

How to Delete a Window
Using Hardkey/SoftTab/Softkey Using a mouse

1. Press Display > Window 1-8 > click left side Channel 1-8 1. Right-click any area of grid box and
small button then select Close Window.
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(Example: Click on left side Window 1 small button and
Window 1 is inactive when it is not green).

2. For other windows, press Display > Window Setup >
Delete Window, then select a window.

Pru-grannning Commands }

How to Move a Window to a different Sheet

Note: This featue is NOT available on M948xA and E5S080A.
Using Hardkey/SoftTab/Softkey

1. Select a Window to move.
2. Press Display > Window Setup > Move Window...

3. Select a sheet number in the following dialog, and then click OK.

Prugramming Commands= }

Move Window dialog box help

Maove Window ﬁ

Mowve Window 2 to Sheet

Sheet 3
MNew Sheet

‘ OK H Cancel | ‘ Help |

Note: Only ONE window can be moved at a time.

1. Move Window N to Sheet N- Transfer the selected window to any sheet listed or to a New Sheet.
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How to Change Window Layout
Note: This featue is NOT available on M948xA and E5S080A.

This is a window auto-layout option, for quicker selection instead of selecting the trace, channel,
window and sheet separately. 7 auto-layout options are available.
Using Hardkey/SoftTab/Softkey

1. Press Display > Window Setup > Window Layout.

2. Select 1 Window, 2 Windows, 3 Windows, 4 Windows, 1 Trace per Window, 1 Channel per

Window, or Tile Windows.
Prugramming Commands=s }

How to maximize the active window - the active window is the ONLY window on the screen display.
All other windows are hidden.

Using Hardkey/SoftTab/Softkey Using a mouse
1. Press Display > Window Setup > Window Max (ON). With 1. Right-click in any area of the
Window Max (ON), select a different window to make that grid box and then select
window visible. Maximize.

2. To make all windows visible again, select Window Max (OFF).

Prugramming Commands= }

Sheet

Sheets are used to group VNA windows. The sheet tabs provide an easy way to switch multiple display
settings quickly.

Features and actions that can performed with tabbed sheets:

Add/Delete/Select sheet

Move window to sheet

Measurement can be performed on traces/channels in inactive sheets

Easy setup for channel per window
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e Easy setup for channel per sheet

Managing Sheet

How to Add Sheet
Using Hardkey/SoftTab/Softkey Using a mouse

1. Press Display > Sheet Setup > Add Sheet. 1. Click on the sheet tab.

2. The select one a New Sheet, New Trace +
Sheet or New Trace + Channel + Sheet.

Prugramming Commands ’

How to Delete a Sheet
Using Hardkey/SoftTab/Softkey Using a mouse

1. Press Display > Sheet Setup > Delete Sheet. 1. Click on the sheet tab.

2. Then select a sheet.

Prugramming Commands=s }

How to View a Sheet
Using Hardkey/SoftTab/Softkey Using a mouse

1. Press Display > Sheet Setup > Select. 1. Click on the sheet tab.

2. Then select a sheet.

Prugramming Commands= }

How to Change Sheet Title
Using Hardkey/SoftTab/Softkey

1. Press Display > Sheet Setup > Sheet Title....

2. In the pop up Sheet title box, enter the title and click OK.

Programminq Commands= }
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How to Change Sheet Layout

This is a sheet auto-layout option, for quicker selection instead of selecting the trace, channel,
window and sheet separately. 4 auto-layout options are available.
Using Hardkey/SoftTab/Softkey

1. Press Display > Sheet Setup > Sheet Layout.

2. Select 1 Sheet, 1 Trace per Sheet, 1 Channel per Sheet, or 1 Window per Sheet.

Pru-gramming Commands ’
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Quick Start Dialog

Quick start is a simple wizard which helps to setup the settings for typical measurements. This feature
allows users to select from a set of pre-configured measurement layouts.

How to Open Quick Start Dialog Box

Using Hardkey/SoftTab/Softkey

1. Press Setup > Main > Quick Start....

Prugramming Commands= }

The measurement comprises the following THREE steps.

Step 1: Layout Templates

You are able to select a layout template for typical measurements.

" Quick Start S|
1-Port 511 I
S-Faram
2Pan P All 4 S11 S S11| B4z
S-Param 11 =3 ]

S-P Ss Sy S31| S
R| B R1 = EE‘I Receiver
Pawer Frequency Power Fraquency R, B
Sweep Swaap Offset
Time g S11 Time Misr Match
Demain L Gain
841 Freg
| Create in new channal
'Display Smith Chart K Cancel | Help-4000 ‘

4| If "Create in new channel" checkbox is enabled, a new channel and window(s) will be created.
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If "Create in new channel" checkbox is disabled, when a template is selected then the active
channel will be used for the new measurements. If the active trace is displayed in a window with traces
on other channels, then the trace will be deleted and a new window(s) will be opened for the new
measurements.

“/ If "Display Smith Chart" checkbox is enabled, the active trace in a window will turn to display
Smith Chart.

If "Display Smith Chart" checkbox is disabled, no changes on the active trace in a window.

Step 2: Stimulus Settings Dialogs

This step is used to set stimulus for the measurement.

Creates S11 and S21 measurements in a single channel and
window.

fs
Frequency Seeep Settings

.
Swaap
Stan Frequancy 100000000 MHz = Pemwar 0 dBm
.‘Emp Fn:qm:nr.y 26500000000 GHz | IF Banchaadth 100,00 kHz
Center Frequency 13255000000 GHz | Mumber of Points 201

Span Frequency  26.450000000 GHz |-

Sweep Type Lin F resquency -

S- Calibrate this satup | CHE Cancel Halp

Parameters

LE

Option  Enter:
Required:

None
o Start/Stop frequency

Center Frequency

Span Frequency

Sweep Type: Lin or Log Frequency

Power
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Differential

(Balanced)
Option
Required:
None

¢ |F Bandwidth

e Number of Points

Learn more about S-parameter measurements.

Creates Sdd11 and Sdd21 measurements in a single channel and

window.

i
Frequency Jeveep Settings

Swaap
Stan Frequency  10.000000 MHz

Stop Frequency  26.500000000 GHz |
Center Frequency  13.255000000 GHz |-

Span Frequency 26450000000 GHz E

Sweep Type Lin F resquency

Calibrate this setup

Enter:

e Start/Stop frequency
e Center Frequency

e Span Frequency

Pererar
IF Bandwaidih

Mumber of Points

[ox ]

e Sweep Type: Lin or Log Frequency

e Power

e |F Bandwidth

e Number of Points

0 dBm

100,00 kHz

20

Cancel

Learn more about Differential (Balanced) measurements.

Halp

20

Creates R1 and B receiver measurements in a single channel and
window. This allows you to view the DUT input power (R1) and

output (B) power.
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Power

Frequency
Sweep

Option
Required:
None

fs
Frequency Seeep Settngs

Swaap
Stan Frequancy 100000000 MHz

Stop Frequency  26.500000000 GHz |
Center Frequency 13255000000 GHz .

Span Frequancy  26.490000000 GHz |

Sweep Type Lin F resquency

Calibrate this setup

LE

Enter:

e Start/Stop Frequency
e Center Frequency

e Span Frequency

Pererar
IF Bandwidth

Mumber of Points

[ox ]

e Sweep Type: Lin or Log Frequency

e Power

e |F Bandwidth

e Number of Points

Learn more about Power Sweep measurements.

0 dBm

100,00 kHz

201

Cancel

= ]|

Halp

Creates a power sweep while viewing R1, B, and S21
measurements in a single channel and window. This allows you to
view the DUT input power (R1), output power (B), and DUT gain

(S21).
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CW Frequency

IF Bandwidth
Power
Mumber of Points
Power
Sweep
Option
Required: [l Calibrate this setup | oK I l Cancel ‘ | Help I
None '
Enter:
e Start/Stop Power
e CW Frequency
e |F Bandwidth
e Number of Points
Learn more about Power Sweep measurements.
Creates Frequency Offset Measurement while viewing R1 and B
receivers in a single channel and window.
10.000000 MHz = 5 dBm
26.500000000 GHz | ] 100.00 kHz
10.000000 MHz  |+] 20
26.500000000 GHz | 3]
Receiver
Frequency
Offset
) Enter
Option
Required:

e Source Start

080
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e Source Stop
o Receiver Start
e Receiver Stop
o Power Level
¢ |F Bandwidth

Number of Points

Learn more about FOM.

Creates an S11 measurement and enables Time Domain.

[T ]
Sweep
Start Time 0 fsec E Start Frequency  10.000000 MHz
Stop Time 7.55 nsec E Swp Frequency  22.085000000 GHz [=]
Transform Band Pass - Powar -5 dBrm
. .
IF Bandwidth 100,00 kHz
Mumber of Points 201
Time
Domain Calibrate this setup E Cancel Halp
Option
Required: ~ Enter:
010

e Start/Stop Time

e Transform Mode (Time Domain Settings dialog auto-select
the start frequency if a LPF transform mode is selected.)

e Start/Stop Frequency
e Power
e |F Bandwidth

e Number of Points

Learn more about Time Domain measurements.

If any one of the SMC Measurements is selected in Step 1, the Mixer

101



Mixer

Option
Required:

080

Quick Settings dialog will appear.

Mhicer : CQuuick Settings
Equation
Chutpast = bnpast - LO
& Outpast = Inpat + LO

Output = LO - Input

Fixed Fraquancy

Frxed Inpul:
& Fiveed LO

Fioeesd Oustpt

Input : Port 1

0%
\-g[:x

L : Port 3 Output : Port 2
Start 1 0LOD0000 MHz{s Fixed 0OHz 10.000000 MHz
Stop  JE.500000 GHz |5 26,50 |
Power  -15.00 dBm
Calibrate this setup OK Cancel Help
Enter:

e Equation: Output = Input - LO, Output = Input + LO, Output = LO -

Input.

¢ Input, LO, and Output Frequencies and configuration.

Learn more about SMC Measurements

Steps 3: Cal Wizard Dialog (Optional)

4/ If "Calibrate this setup" checkbox is enabled, the Cal Wizard Dialog will appear when Stimulus

Settings Dialog is dismissed with the "OK" button.

If "Calibrate this setup" checkbox is disabled, the Cal Wizard Dialog will NOT appear.
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Basic Measurement Sequence

The following process can be used to setup all analyzer measurements:

Step 1. Set Up Measurements
Reset the analyzer, create a measurement state, and adjust the display.

Step 2. Optimize Measurements
Improve measurement accuracy and throughput using techniques and functions.

Step 3. Perform a Measurement Calibration
Reduce the measurement errors by performing a calibration.

Step 4. Analyze Data
Analyze the measurement results using markers, math operations, and limit tests.

Step 5. Print, Save or Recall Data
Save or print the measurement data.
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Frequency Blanking

For security reasons, you can prevent frequency information from appearing on the screen and
printouts.

How to set Frequency Blanking
Using Hardkey/SoftTab/Softkey Using a mouse

1. Press System > Main > Security.... 1. Click Utility.
2. Select System.

3. Select Security....

Prugramming Commands=s }

Security Setting dialog box help

Sacurity Level High - Mo frequency information is displayed. Only
High Preset or recall of instrument state can re-enable
display of frequencias.
OK Cancel Help
Notes

e To learn how to erase memory before moving your analyzer out of a secure area, see
http://na.support.keysight.com/pna/security.html.

e An ECal Data Wipe Utility destroys all user data per US DoD 5220.22-M. Learn more at
http://na.support.keysight.com/pna/apps/applications.htm

e VNA 'Undo' is disabled with High and Extra security levels. Learn more.

Security Levels
None - All frequency information is displayed on the screen and printouts.

Low security level - Frequency information is blanked from the following:
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http://na.support.keysight.com/pna/security.html.
http://na.support.keysight.com/pna/apps/applications.htm

¢ Display annotation

e Calibration properties

o All tables

o All toolbars

o All printouts

e External sources - See Also: Preference to Deactivate External Devices on Preset. Note: Frequency
Blanking is fully supported ONLY on Keysight MXG sources with option 006. On MXG models without

option 006 and all PSG models, the window state is turned OFF. When the “local” button is clicked on
the source, then frequency is re-displayed.

High security level - Low security level settings PLUS:

e GPIB console is inactive

Extra security level - High security level settings PLUS:

o All ASCII data saving capability (.snp, .prn, .cti) is saved without frequency information. The X-axis
information is replaced with data point numbers. Before A.08.50, saving these file types was NOT
allowed.

o Mixer setup files (*.mxr) can NOT be saved.

For ALL security levels:

Frequency information is NOT blanked from the following:

e Service Adjustment Programs

e Your COM or SCPI programs.

Instrument State and Cal Sets

The security level is always saved and recalled with an instrument state. However, the instrument
state may contain a Cal Set or link to a Cal Set. Learn more. This may influence the security level
when the instrument state is recalled. Here is how.

¢ When a new Cal Set is created at the end of a calibration, the current system security level is stored with
it.
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e The only way to change an existing Cal Set’s security level is by writing a new calibration into the Cal Set.

o When later applied to a channel, if the Cal Set has a higher security level than the current system
security level, the system security level will become upgraded to that of the Cal Set.

¢ When saving an instrument state to either a *.csa or *.cst file, the security levels of the system and Cal
Set are saved separately. When recalled, the higher security level of the two is applied.

e To view the security level of a Cal Set, see Cal Set Properties.

Re-displaying frequency information

e When in Low security level, do any of the following:

e Reuvisit this dialog box and select None

e Perform an instrument preset

e Recall an Instrument State/Cal Set with security level of None.
o When in High or Extra security level, do any of the following:

e Perform an instrument preset

e Recall an Instrument State/Cal Set with security level of None.
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Networking and Connecting the VNA

The VNA as a PC

e VNA User Accounts and Passwords
e Drive Mapping

e Using VNC to Control the VNA User Interface

GPIB / COM Programming

e Configure for GPIB, SCPI, and SICL

Controlling External Devices

Configure an External Device

E5091 TestSet Control

Interface Control Feature

Handler 10 Connector
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Preferences

Preferences are settings that survive a Preset or Shutdown. Preferences are listed on this page with
links to locations that provide more information.

How to set Preferences
Using Hardkey/SoftTab/Softkey Using a mouse
1. Press System > System Setup > Preferences.... 1. Click Utility.

2. Select System.

w

Select System Setup.

4. Select Preferences.

Prugramming Commands=s }

Preferences dialog box help
Preferences survive a Preset and a Shutdown.

A checked box makes the following statements true unless stated otherwise.

Avg: On PRESET set two-point group delay aperture Group delay aperture is set to 11
points.

“ Avg: On PRESET set two-point group delay aperture Group delay aperture set to 2 points.
Learn more.

Cal: Always use Internal Trigger during cal - Only use Internal Trigger source

Cal: Always use Internal Trigger during cal (default) -use the other Trigger source

Cal: ECal Extrapolation for IMD

“ Cal: ECal Extrapolation for IMD Allows Swept IMD and IMDx channels to be calibrated

beyond the stop frequency of the ECal module by extrapolating the error terms. Learn more.
Cal: For Frequency Offset, use Primary Frequencies

“ Cal: For Frequency Offset, use Primary Frequencies Use when making mmWave
measurements without a test set. Learn more.

This setting only affects calibrations performed using SCPI. Cals performed from the User Interface
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ALWAYS offer a choice to save to a named Cal Set.

Cal: (SCPI only) Auto-generate a User Cal Set Completed calibrations are automatically
saved to Cal Registers; NOT to User Cal Sets.

“ Cal: (SCPI only) Auto-generate a User Cal Set Completed calibrations are automatically

saved to an auto-named User Cal Set. Caution: this can cause a lot of saved User Cal Sets. Learn
more.

The following message appears when both the Cal Set choices above and below are selected:
""Cal: Auto-save preferences conflict "

Cal: (SCPI) Auto-save to User Cal Set (above)- or - Cal: (SCPI) Auto-save to current Cal Set
(below)

Uncheck one of these.

This setting only affects calibrations performed using SCPI. Cals performed from the User Interface
ALWAYS offer a choice to save to a named Cal Set.

“ Cal: (SCPI) Auto-save to current Cal Set - Always automatically save a completed Cal to the
Cal Set that is currently selected on the specified channel, which could be the channel Cal Register.
If the channel does not yet have a selected Cal Set, the Cal will be saved to a new User Cal Set with
an automatically-generated name.

Cal: (SCPI) Auto-save to current Cal Set (default)- Do NOT automatically save a completed

Cal to the Cal Set that is currently selected on the specified channel.

Display: Selected trace changes width briefly. The selected trace does NOT change width
briefly in order to improve visibility.

“ Display: Selected trace changes width briefly.

Display: Selected Trace is wider. The selected trace is the narrow, default size.

“ Display: Selected Trace is wider. The active (selected) trace is always wider.

* Display: Touchscreen ON. Selections can be made by touching the screen.

Display: Touchscreen ON. Selections can NOT be made by touching the screen.

' Ext Device: De-activate on PRESET and recall. External devices are de-activated when the
VNA is Preset or when a Instrument State is recalled.

Ext Device: De-activate on PRESET and recall. External devices remain active when the
VNA is Preset or when a Instrument State is recalled.

Learn more about External Devices.
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“ Limit: Draw failed trace segments in red Failed segments are drawn in red. Learn more.

Limit: Draw failed trace segments in red Failed data points (dots) are drawn in red.

Limit: Draw Limit Lines in Red Limit lines are drawn in the same color as the trace.

“ Limit: Draw Limit Lines in Red All Limit limes are drawn in Red.

“ Limit: Test the nearest measurement point - When the stimulus of measurement point is not
the same as the limit test point, the nearest limit test point is used for pass/fail judgement.

Limit: Test the nearest measurement point - The pass/fail is judged at only the stimulus of

limit test point.
Markers: Coupling controls on|off state of markers - Turning a marker on or off will have no
effect on the markers on other traces.

* Markers: Coupling controls on|off state of markers - With Coupled Markers ON, when a
marker is turned on, the same-numbered marker on all coupled traces will also be turned on.

Likewise, turning off a marker will turn it off on all coupled traces.
Markers: On Preset, Coupled Markers is ON - Coupled Markers is OFF after Preset

“ Markers: On Preset, Coupled Markers is ON - Coupled Markers is ON after Preset

Markers: On Preset, Coupling Method is Channel - Marker Coupling Method is set to ALL
after Preset.

* Markers: On Preset, Coupling Method is Channel - Marker Coupling Method is set to
Channel after Preset.

“Marker: On Preset, set BW/Notch search reference to Peak - BW/Notch marker search
reference is set to current marker position after Preset.

Marker: On Preset, set BW/Notch search reference to Peak - BW/Notch marker search
reference is set to peak after Preset.

* Marker: Programming treats Mkr 10 as Reference A marker programming command that includes
10 as its marker number argument will operate on the Reference Marker (NOT the general-purpose
Marker 10). See Marker commands.

Marker: Programming treats Mkr 10 as Reference A marker programming command that includes
10 as its marker number argument will operate on the general-purpose Marker 10 (NOT the
Reference marker).

“ Marker: Use single marker for marker search (default) - Use one marker for marker search.
Sub Marker is displayed and used for Bandwidth, Notch searches.

Marker: Use single marker for marker search - Use multi marker for marker search.

“ Meas: Mathematical offset for receiver attenuation The reported test port receiver power is
mathematically offset by the amount of receiver attenuation. Default for all models.
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Meas: Mathematical offset for receiver attenuation The reported test port receiver power is
NOT mathematically offset by the amount of receiver attenuation.

Learn more.

* Meas: Mathematical offset for source attenuation The reported reference receiver power is
mathematically offset by the amount of source attenuation.

Meas: Mathematical offset for source attenuation The reported reference receiver power is
NOT mathematically offset by the amount of source attenuation.. Learn more.

Memory: Data Math 8510 Mode Standard data processing chain.

* Memory: Data Math 8510 Mode Simulate the Keysight 8510 data processing chain as it
pertains to Trace Math and Memory. Learn more.

Memory: Interpolate ON is default condition Set memory interpolation to OFF as the default.

* Memory: Interpolate ON is default condition Set memory interpolation to ON as the default.
Learn more.

“ Power: On Preset turn power on Instrument Preset always turns source power ON.

Power: On Preset turn power on When the current source power setting is OFF, source power
remains OFF after Preset. When the current power setting is ON, source power is turned ON after
Preset. Learn more.

For SCPI behavior only. Learn more.

“ Power: Report source unleveled events as errors Source unleveled events are reported as
errors.

Power: Report source unleveled events as errors Source unleveled events are NOT reported
as errors.

“ Power: Report when receiver is overloaded A warning message is displayed on the VNA
screen indicating that a receiver is overloaded or in compression. The displayed data is probably not
accurate. One error per sweep appears and is reported in the Error Log. (Always ON for ES080A/B)

Power: Report when receiver is overloaded Do NOT show overload warnings on the screen
or report these errors in the error log.

“ Power: Force RF power Off at end of sweep Turn RF power Off during a retrace of single-
band frequency or segment sweeps.

Power: Force RF power Off at end of sweep Leave RF power On during a retrace of single-

band frequency or segment sweeps. Learn more.

Power: Turn Source Power Off when receiver is overloaded. Power remains ON when a
receiver is overloaded.(Always ON for ESO80A/B)
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“' Power: Turn Source Power Off when receiver is overloaded. Turn OFF power to ALL ports
when a receiver is overloaded. A notification dialog appears. Click OK, then lower the power level,
then turn power ON. (Click Stimulus, then Power)

NOT implemented for ES080A/B models.

“ Power: Use Start Power during Power Sweep retrace At the end of a power sweep, while
waiting to trigger the next sweep, the VNA maintains source power at the start power level.

Power: Use Start Power during Power Sweep retrace Maintain source power at the STOP
power level. Learn more.

“ Preset: Confirm preset - When Preset hardkey button is pressed, VNA firmware immediately
presets (Hardkey is required only).

Preset: Confirm preset (defaul) - When Preset > Preset is pressed, VNA firmware
immediately presets (Hardkey and Softkey are required).

NOT implemented for M937xA/P937xA models.
Preset: On Preset enable TDR. Enable TDR on preset and power-up.

“ Preset: On Preset enable TDR. Do not enable TDR on preset and power-up.

“ Preset: On Preset show Quick Start dialog - Open Quick Start dialog on Preset.

Preset: On Preset show Quick Start dialog - Do not open Quick Start dialog on Preset.

“ Recall: Softkey order is most recently used - Recall softkey order which is most recently used.

Recall: Softkey order is most recently used (default) - Do NOT recall softkey order which is
most recently used.

“ Scale: On Preset Couple scale to Window - Scale coupling is set to Window when Preset.

Scale: On Preset Couple scale to Window (default) - Scale coupling is set to Off by default
when Preset.

* Sweep: On Preset set Sweep Mode to Stepped - Sweep Mode set to Stepped after Preset.
(Default: ESO80A)

Sweep: On Preset set Sweep Mode to Stepped - Sweep Mode set to Auto after Preset.
(Default: ES080B)

* Sweep: Use only ramp sweeps for Auto Sweep Mode - Auto Sweep Mode set to use
continuous ramp sweeps after Preset.

Sweep: Use only ramp sweeps for Auto Sweep Mode - Auto Sweep Mode set to not use ramp
sweeps after Preset.
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* System: Enable sound (default) - Instrument speaker turns ON.

System: Enable sound - Instrument speaker turns OFF.

“ System: On Power-on show Keys toolbar - Display softkey toolbar after power-on.

System: On Power-on show Keys toolbar - Hide softkey toolbar after power-on.

“ System: Use keyboard to navigate softkeys - Enable the keyboard to browse the softkeys.

System: Use keyboard to navigate softkeys (default) - Disable the keyboard to browse the
softkeys.

* System: Optimize memory for use with many channels - (M9485A only) The maximum
number of channels will be extended but measurement speed may be decreased. The maximum
number of channels depends on PC memory, NOP and traces.

System: Optimize memory for use with many channels (default) - (M9485A only) Standard
mode (No memory optimization)

Sets the scope of External Trigger Output signal properties. The VNA is Preset after changing this
setting.

Trigger: External Trigger OUT is Global Channels can have different External Trigger OUT
settings. Default for PNA-X and N522xA models. On the Trigger Setup dialog, Trigger Mode =
Point is ignored for external triggering.

“ Trigger: External Trigger OUT is Global All channels have same External Trigger OUT
settings. Default for VNA “C” and PNA-L models. Aux Trig OUT properties apply to all channels
except the Per Point setting. To set Per Point for specific channels: On the Trigger Setup dialog, set
Trigger Scope = Channel, under Channel Trigger State, select the channel, and set Trigger
Mode = Point.

See External Triggering dialog.
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The More buttons launch dialogs that contain predefined preferences:

Data Saves... -

Define Data Saves - While not explicitly called Preferences, all of these settings survive a
shutdown. Learn more.

Power Limit

Offsets and Limits - Sets Power Limits and Offsets. Learn more.

Transparency...

Dialog Transparency - Some dialogs can be viewed in various levels of transparency. Learn more.

Language...

Help - Sets the language of the built-in help (English or other localized language). Learn more.

User Preset...

User Preset - Specify the Instrument State file that the analyzer will use when Preset. Learn more.

Page Setup...
Page Setup - Standard printer settings (Paper, Orientation, and Size) do NOT survive a shutdown.

All other settings DO survive a shutdown. Learn more.

Colors...
Display Colors - Sets display items to custom colors. Learn more.

Print Colors - Sets print items to custom colors. Learn more.

Toolbars...

Show Toolbars/Other Bars - Select toolbars to display.

Defaults - Restore preferences to their default values.

Millimeter settings

Sets MM Wave configurations. Learn more.

Although they are called preferences, the following settings do NOT survive a shutdown.
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Calibration

UI Setting

Show or not, the first 'Method' Page of the Cal
Wizard.

Cal Preferences

Set and order default Cal Types

Cal Preferences

Perform orientation of the ECal module during
calibration?

ECal Wizard

Specify ECal port mapping when orientation is
OFF

ECal Wizard

Show or hide custom Cal Windows during Cal

Cal Window (remote commands only)
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LXI-1.1 and VXI-11.3 Compliance

PNA-X, N522x, and VNA-C models are LXI-1.1 and VXI-11.3 compliant.

LXI-1.1 Compliance

A VNA is LXI-1.1 compliant if the / logo appears on the dialog box shown below.

Learn more about LXI at http://www.Ixistandard.org/
VXI-11.3 Compliance

To be compliant with VXI-11.3, the VNA must have been either:

e Shipped from the factory with VNA version A.08.20 or higher, or

e Had the Hard Disk Drive (HDD) upgraded since about June 2008 when A.08.20 was released and using VNA
Rev. A.08.20 or higher.

Learn more about VXI at http://www.vxi.org/

LAN Status

When a LAN connection is used with the VNA, the LAN Status dialog allows you to see the IP address
and other LAN connection properties.

How to view LAN Status
Using Hardkey/SoftTab/Softkey Using Menus

1. System > System Setup > Lan Status.... 1. Click Utility.
2. Select System.
3. Select System Setup.

4. Select LAN Status.

Pru-gra.mming Commands ’

LAN Status dialog box help
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LAN Status =

LAN Status Indicator

IF Adddress
1P Link-Local Address

Computer Name (Host Mame)

MAC Address
Ls‘ll' LAN Reset
Close Help

Indicator Shows the current status of the LAN connection.
NORMAL - Indicates that the VNA LAN is ready for communication.

IDENTIFY - Indicates that a remote computer has invoked an LXI identification operation on the
VNA using the web-based interface or LXIDevicelDState COM property.

FAULT - Indicates that the VNA LAN interface is not connected to the Internet.
IP Address Shows the current IP address of the VNA.
IPv6 Link-Local Address Shows the current IPv6 address of the VNA.

Computer Name Shows the full computer name of the VNA. Learn how to change this. If you see
the IP address listed here, that means there is no DNS server specified in the network setup.

MAC Address Shows the unique address of the VNA computer. Also known as HostID.
LAN Reset Provides a LAN Configuration Initialize (LCI) mechanism. Press to return the
following settings to factory default conditions:

e IP Address Configuration (DHCP): Enabled

e ICMP Ping Responder: Enabled

¢ Web Password for configuration: Resets the password to 'keysight'.

Web Server Software
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If your VNA is LXI Class C compliant (see above), you can connect to the VNA using a web browser
over an internet connection.

To do this, when the above dialog indicates a NORMAL condition:
1. From a web browser, type http://<your_VNA_computer_name>.For example, to connect to the fictitious
VNA in the dialog above, type: http://lvna1-22
2. Type the log on User Name and Password

3. You will see the welcome screen with connection links.
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Dialog Transparency

Most VNA dialogs can be made to appear with various amounts of transparency. This allows you to
view the VNA traces through the dialog as you make dialog settings.

How to set Transparency Level
There are three ways to make the transparency level setting:

1. Right-click in any non-control area of a dialog that allows transparency to see the following
selections:

v Opaque
8% Transparent
25% Transparent

50% Transparent

2. In tabbed dialogs, cycle through the above transparency settings by pressing| £ multiple times.

Tl'wf

Sty Meas Trigoer  fam Trig 1 Aas Trig 2 | Pulsa Trigge

Tiigger Buress

@ Wrvaanal

3. Launch the Transparency dialog (below) from the Preferences dialog.

This setting is not programmable
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Duog Tamsparersy

Transparency

& Opaque
8% Transparent

25% Transparent

50% Transparent

| Double-click changes transparency

Lok ][ comont | [ bew |

Note: This single Transparency setting applies to ALL supported VNA dialogs.

Opaque (NOT Transparent) - Default setting

8% Transparency

25% Transparency

50% Transparency

Double-click changes transparency - When checked, cycle through the above transparency
settings by double-clicking in any non-control area of a dialog that allows transparency.

Notes

e The transparency setting is stored as a VNA Preference.
¢ The setting survives a VNA Shutdown and Preset.

e [tis NOT saved and recalled with instrument state.
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Keyboard Shortcuts

Function Shortcut
Instrument Keys
PREV PAGE UP

SHIFT + CONTROL + LEFT ARROW SHIFT + CONTROL + COMMA
NEXT PAGE DOWN

SHIFT + CONTROL + RIGHT ARROW

SHIFT + CONTROL + PERIOD
TRACE SHIFT + CONTROL +T
CHANNEL SHIFT + CONTROL + H
DISPLAY SHIFT + CONTROL +D
SETUP SHIFT + CONTROL +U
Response Keys
MEAS SHIFT + CONTROL + M
FORMAT SHIFT + CONTROL +F
SCALE SHIFT + CONTROL +S
MATH > Memory SHIFT + CONTROL + O
MATH > Analysis SHIFT + CONTROL +N
AVG BW SHIFT + CONTROL + A
CAL SHIFT + CONTROL +C
MARKER SHIFT + CONTROL +R
SEARCH SHIFT + CONTROL +E
Stimulus Keys
FREQ SHIFT + CONTROL +Q
POWER SHIFT + CONTROL +P
SWEEP SHIFT + CONTROL +W
TRIGGER SHIFT + CONTROL +1
Utility Keys
SAVE RECALL >Recall SHIFT + CONTROL +L
SAVE RECALL > Save SHIFT + CONTROL +Y
SYSTEM SHIFT + CONTROL +Y
MACRO SHIFT + CONTROL + G
SYSTEM > Help CONTROL +H
Undo CONTROL +Z
Redo CONTROL +Y
PRESET SHIFT + CONTROL + X

Other Features

Trace 1 SHIFT + CONTROL + 1

Trace 2 SHIFT + CONTROL +2

Trace 3 SHIFT + CONTROL + 3

Trace 4 SHIFT + CONTROL +4
Hardkeys Toolbar SHIFT + CONTROL + K
Minimize Application SHIFT + CONTROL +7Z
Mainframe Menu show/hide SHIFT + CONTROL +B
File Open dialog CONTROL +0O

Save file

CONTROL +8
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Save As dialog CONTROL + A
Print dialog CONTROL +P
Print to File dialog CONTROL +T
Focus on Mainframe Menu ALT

CONTROL +1, to CONTROL +8

Softkey 1 to 8
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Using Help

This topic discusses the following:

e Documentation

e Printing Help

e Copying Help to your PC
e Launching Help

e Searching Help

e GUI Reference

e Help Languages

e Documentation Warranty

See Also

Help, About Network Analyzer

Other Quick Start Topics

Help Documentation

Printing Help

Copying Help to your PC

With the Help system on your PC, you can read about the analyzer while away from it. You can also
Copy and Paste programming code from this Help system directly into your programming environment.

The Help file is located on your analyzer hard-drive at C:/Program Files (x86)/Keysight/Network
Analyzer/Help/<filename>.chm . If both the analyzer and PC are connected to LAN, you can map a
drive and copy the file directly.

Launching Help
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The Help system can be launched in the following ways:

1. From the Help drop-down menu.

2. From Dialog Box Help buttons.

Search Tab

TIP: To Search any topic for a keyword, press Ctrl and F .

The following rules apply for using full-text search:

e Searches are not case-sensitive.
e You can search for any combination of letters (a-z) and numbers (0-9).
e Punctuation marks (period, colon, semicolon, comma, and hyphen) are ignored during a search.

e You can group the words of your search using double quotes or parentheses. Examples: "response
calibration” or (response calibration). This requirement makes it impossible to search for quotation marks.

e Use Wildcard expressions:

e To search for one undefined character use a question mark (?). For example, searching for cal? will
find calc and calf.

e To search for more than one undefined character use an asterisk (*). Searching for Cal* will find
calibration and calculate.

e Use Boolean operators to define a relationship between two or more search words.
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Search for Example Results will show topics containing:

Two words in the same response Both the words "response" and "calibration".
topic AND
calibration
Either of two words in a response OR  Either the word "response" or the word "calibration"
topic calibration or both.
The first word without the  response The word "response" but not the word "calibration".
second word in a topic NOT
calibration
Both words in the same response The word "response" within eight words of the word
topic, close together. NEAR "callibration".
calibration
GUI Reference

The GUI Reference corresponds to the GUI Hardkeys to help find information quickly:
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Hardkeys | X
Instrument
E
E
Response
. M

The GUI Reference topics displayed in the table of contents are arranged in alphabetical order:
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L—‘_Il:['l] 5UI Reference
- [2] Awa BW
- 7] Cal
E Channel
E Dizplay
E Format
- | 2] Freq
E Macro
(2] Marker
- [2] Math
- 2] Meas
E Power
E Presst
E Save Recall
E Scale
2] Search
E Setup
- 2] Sweep
E System
- 2] TDR
E Trace
- 2] Trigger
- | 2] Undo

The following procedure is a typical example of how to find information using the GUI Reference. This
example shows how to search for the Avg BW Hardkey information with the Standard Measurement
class selected.

1. Under GUI Reference in the table of contents, select the Avg BW topic. The following is displayed:
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i VNA Help

o e = 6 &

Hide Back Forward Home Print

Conterts | Indesx I Search I Favortes I

- Quick Start

- 1. Set Up a Measurement
@ 2. Optimize & Measurement
@ 3. Calibrate a Measurement
- 4. Analyze Data

- 5 Output Data

=@ Programming

@ Applications

@ Low Frequency Extension (LFE)
@ Millimeter Wave Configuration
- Networking the VNA

- Product Support

@ IF Access

@ System Settings

- Tutorials

=l GUI Reference
..... kil
..... 2] cal

----- E Channel
..... 2] Display
..... E Format
..... E Freq

..... 2] Macro

----- E Marker
..... 2] Math

..... E Meas

..... E Power

..... 2] Preset

----- E Save Recall
----- 2] Scale

..... E Search
..... E Setup

..... 2] Sweep
----- E System
..... (2] TOR

----- E Trace

..... E Trigger
..... 2] Undo

----- @ Glossary

----- (7] Specifications

Avg BW

Standard

Active Hot Parameters
GCA

MF

Modulation Distartion

The links shown on this page correspond to Measurement Class names because some menus change with

Measurement Class.

2. Click on the Standard link. The following is displayed:
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E? VNA Help

Hide Back Forward Home Print

Contents | Index | Search | Favortes | Standard Avg BW
ndard Avg

...... E What's New

@ Administrative Tasks .
-8 Quick Start Main
@ 1. Set Up a Measurement
@ 2. Optimize a Measurement
@ 3. Calibrate a Measurement
- 4. Analyze Data

-4 5. Output Data

@ Programming

@ Applications

@ Low Frequency Extension (LFE)
@ Milimeter Wave Configuration
- Networking the VNA

@ Product Support Smoothing
-8 IF Access

@ System Settings _
- @ Tutorials ¢ Smoothing

=[] GUI Reference + Smooth Percent

----- 2] Avg BW _
%C;g » Smooth Paints

Averaging

Averaging Restart

Average Type
IF Bandwidth
LF Auto BW

----- E Channel
..... 91 Dizpl
..... % Fusni:: Delay Aperture

..... E Freq
..... % Macro ¢ Aperture Percent
----- 2] Marker
----- 2] Math
..... % Meas « Aperture Freg
----- ?] Power

----- E Presst

----- E Save Recall
----- E Scale

----- 2] Search

..... E Setup

..... E Sweep

..... E System

..... E TOR

----- E Trace

..... E Trigger

----- E Unda

----- Glossary

----- @ Specifications

¢ Aperture Points
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Avg BW

Averaging

1

Smoothing

Averaging Delay
Restart Aperture

Average Type

SWEEP point

IF Bandwidth

100 kHz

LF Auto BW

Main , Smoothing , and Delay Aperture correspond to the soft tab labels. The links correspond to the
softkey labels.

3. Click on a link for information.

Help Languages

130



This help file is offered in English ONLY.

Glossary

The Glossary holds definitions of words, in alphabetical order.

Click to Access
Terms that Start
With the Letter

e A (ETRE ]

g
i
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3
]
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Documentation Warranty

THE MATERIAL CONTAINED IN THIS DOCUMENT IS PROVIDED "AS IS," AND IS SUBJECT TO BEING
CHANGED, WITHOUT NOTICE, IN FUTURE EDITIONS. FURTHER, TO THE MAXIMUM EXTENT PERMITTED
BY APPLICABLE LAW, KEYSIGHT DISCLAIMS ALL WARRANTIES, EITHER EXPRESS OR IMPLIED WITH
REGARD TO THIS MANUAL AND ANY INFORMATION CONTAINED HEREIN, INCLUDING BUT NOT LIMITED
TO THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE.
KEYSIGHT SHALL NOT BE LIABLE FOR ERRORS OR FOR INCIDENTAL OR CONSEQUENTIAL DAMAGES IN
CONNECTION WITH THE FURNISHING, USE, OR PERFORMANCE OF THIS DOCUMENT OR ANY
INFORMATION CONTAINED HEREIN. SHOULD KEYSIGHT AND THE USER HAVE A SEPARATE WRITTEN
AGREEMENT WITH WARRANTY TERMS COVERING THE MATERIAL IN THIS DOCUMENT THAT CONFLICT
WITH THESE TERMS, THE WARRANTY TERMS IN THE SEPARATE AGREEMENT WILL CONTROL.
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Help - About Network Analyzer

Click System > Help > About NA... to learn the capabilities of your analyzer.
Emmm)
( About Network Analyzer ﬁ1

Keysight VNA Network Analyze
N5242A, 10 MHz to 26.5 GHz

@ Keysight Technologies 2000-2015

FEEWARNING: Development Releasa!®**
Serial Number: SM43017373

Options:

007 Automatic Fixture Remaoval -
008 Pulse measurements

010 Time domain capability

015 Dynamic Uncertainty for S-Parameters

028 Noise figure measurements using standard receivers
080 Frequency offset mode

082 Scalar calibrated converter measurements

N22? Vinctor 2. cealar calihratnd comenrtor moacoramnnte

m

Application Code Version: 7.11.65.78

Disk Drive Version: Mot available.

System CPU Version: 0.0 (Unknown CPU Version)
Computer Name: 3CG5170YM

DSP Version: 5.0 (FPGA: 0.0)

MATLAB. (c) 1984 - 2010 The MathWorks, Inc.

Host ID: 5D469438

KEYSIGHT

TECHNOLOGIES

e Model number

e Frequency range

e Serial number

¢ Options (Learn how to install software options)
e Application Code (firmware) Version

e Solid State Drive Version

132



e System CPU Version - Learn more
e DSP (Digital Signal Processor.) Version. Contact Keysight to upgrade the DSP.

e Computer Name - Learn more. This is also reported on the LAN Status / LXI Compliance dialog.
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Preset the Analyzer

When you Preset the analyzer, it is set to known, or preset conditions. You can use the factory default
preset conditions, or define your own User Preset conditions.

Note: Presetting the analyzer will not remove the calibration data in the Channel default CALREG

calset.

e Preset (Default) Conditions

e User Preset Conditions

See other 'Setup Measurements' topics

Preset Default Conditions

How to Preset the Analyzer

Using Hardkey/SoftTab/Softkey
1. Press Preset > Main > Preset.

When Confirm Preset is Off,

1. Press Preset.

Prcl-gra.mming Command= ’

User Preset Conditions

The analyzer can be preset to either factory default conditions or User Preset conditions.

How to set User Preset

Using Hardkey/SoftTab/Softkey

1. Press Preset > Main > User Preset.

Prugramming Commands=s }
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User Preset dialog box help

User Preset X

Usar Preset Status

[+] User Preset Enable

DMUserPreset.sta

Save current state as User Preset

Load existing file as User Preseat

Ok Cancel Help

With a User Preset saved and enabled, when the VNA is Preset, the User Preset settings are recalled

instead of the factory default settings. Calibration data is NOT recalled with a User Preset. Learn
more about instrument state settings.

User Preset Enable
Check - The VNA is preset to User Preset conditions when the Preset button is pressed.
Clear - The VNA is preset to Default conditions when the Preset button is pressed.

Save current state as User Preset Click to store the current instrument state as the User Preset
conditions. File is stored as D:\UserPreset.sta.

Load existing file as User Preset Click to retrieve an instrument state to be used as the User Preset
conditions.
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Measurement Classes

Measurement Classes are categories of measurements that can coexist on a channel.

o What are Measurement Classes
e How to assign a Measurement Class to a Channel

e Measurement Class Dialog Box Help

See other 'Setup Measurements' topics

What are Measurement Classes
Note: Measurement classes vary according to the VNA model and options installed.

The dialog below is an example showing the Measurement Classes currently available for a VNA.
Within each of these classes there are a number of measurements.

Measurement Classes are categories of measurements that can coexist on a channel. A measurement
from one class can NOT reside in a channel with a measurement from another class. For example, a
Noise Figure measurement can NOT reside in a channel that is currently hosting Scalar Mixer
Measurements.

The Measurement Class dialog is accessed in the following ways:

How to assign a Measurement Class to a Channel
Using Hardkey/SoftTab/Softkey Using a mouse
1. Press Meas > S-Param > Meas Class... 1. Click Instrument.

2. Select Meas Class....

Prugramming Commands= }

Measurement Class dialog box help
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Measurement Class : Channel 1 @
Determines the types of measurements available on a channel.
General Converters
@ Standard Gain Compression Converters
Gain Compression IM Spectrum Converters
IM Spectrum Swept IMD Converters
Swept IMD Noise Figure Converters
Noise Figure Cold Source Scalar Mixer!Converter + Phase
Spectrum Analyzer Vector Mixer/Converter
/| Show setup dialog
Confirm changes | New Channel | I OK l | Cancel ‘ ‘ Help |

Measurement class dialog box shows the supported classes for your unit. The supported classes
depends on the product and installed options. The above dialog box shows an example of PNA.

Measurements in a measurement class can NOT coexist in a channel with a measurement of a
different measurement class.

Select a measurement class for the active channel or new measurement channel.

e The Standard measurement class contains S-Parameters. Balanced parameters, and Receiver
measurements.

¢ All other measurement classes are commonly called "Applications".
Title Bar Indicates the active channel to which the measurement class will be assigned.

Show setup dialog

e Check to launch the selected Measurement Class dialog.

o Clear (default setting) to not launch the selected Measurement Class dialog. This setting survives a
Preset and VNA Shutdown.

Confirm changes

e Check (default setting) to launch the Confirm Measurement Class Change dialog.

o Clear to perform the 'OK' actions without confirmation. This setting survives a Preset and VNA Shutdown.

New Channel Click to create the measurement class in a new channel and new window. A default
measurement for that class is created in the channel.

To change the measurement, click Trace, then select a new measurement.
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Confirm Measurement Class Change

Continuing will delete existing measurements on Channel 2.

:y [ vwou wank ko conkinue?
Moy

Ik Cancel

Choose to do the following:

e OK - Delete the existing measurements in the active channel. Create the new measurement class, and
default measurement, in that channel.

e Cancel - Do not create the new measurement class. Leave the old measurements (and class) in that
channel and return to the Measurement Class dialog box.
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Measurement Parameters

This topic contains the following information:

S-Parameters (pre-selected ratios)

Ratioed (choose your own ratio)

Unratioed Power (absolute power)

How to Select a Measurement Parameter

e Auxiliary

Learn about Balanced Measurements

See other 'Setup Measurements' topics

S-Parameters

S-parameters (scattering parameters) are used to describe the way a device modifies a signal. For a 2-
port device, there are four S-Parameters. The syntax for each parameter is described by the
following:

S out - in

out = analyzer port number where the device signal output is measured (receiver)

in = analyzer port number where the signal is applied (incident) to the device (source)

Move the mouse over each S-parameter to see the signal flow:
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S

11 21
Reflection/ Incident
DUT
[ I
Port 1 Port 2
S'12 522

For two-port devices:

e When the source goes into port 1, the measurement is said to be in the forward direction.

e When the source goes into port 2, the measurement is said to be in the reverse direction.

The analyzer automatically switches the source and receiver to make a forward or reverse
measurement. Therefore, the analyzer can measure all four S-parameters for a two-port device with a
single connection.

See the block diagram (including receivers) of your VNA.

Common Measurements with S-Parameters

Reflection Measurements Transmission Measurements
(S11 and S22) (S21 and S12)

e Return loss e Insertion loss

¢ Standing wave ratio (SWR) e Transmission coefficient

¢ Reflection coefficient e Gain/Loss

e Impedance e Group delay

e S11,S2o e Deviation from linear phase

e Electrical delay

e S21,S12
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Receiver Measurements
All analyzer models have test port receivers and reference receivers.

For 4-port models...

¢ R1, R2, R3, and R4 are reference receivers. They measure the signal as it leaves the analyzer source.

e R1 measures the signal out of Port 1

e R4 measures the signal out of Port 4
e A, B, C, and D are test port receivers. They measure the signal out (or reflecting off ) of the DUT.
e A measures the signal into VNA Port 1
e B measures the signal into VNA Port 2
e C measures the signal into VNA Port 3
e D measures the signal into VNA Port 4
Models with more than 4 ports must specify receivers using Logical Receiver Notation. Learn more.
Ratioed Measurements

Ratioed measurements allow you to choose your own ratio of any two receivers that are available in
your analyzer. S-parameters are actually predefined ratio measurements. For example S11 is A/R1.

The following are common uses of ratioed measurements:

e Comparing the phase between two paths of a device. An example could be something simple like a power
splitter or more complicated like a dual-channel receiver.

¢ Measurements that require a higher dynamic range than the analyzer provides with S-parameters.
Unratioed (Absolute Power) Measurements

The unratioed power parameter measures the absolute power going into any of the receivers that are
available on your analyzer.

The reference receivers are internally configured to measure the source power for a specific analyzer
port.
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e Measuring phase using a single receiver yields meaningless data. Phase measurements must be a
comparison of two signals.

e Averaging for Unratioed parameters is computed differently from ratioed parameters. Learn more.
e To calibrate ratioed or unratioed receiver (power) parameters, the recommended method is the Guided

Power Calibration. The Unguided Response Calibration can also be used to calibrate a single unratioed or
ratioed parameter at a time.

New / Change Measurement dialog box help

Note: The only measurements that are available are those in the measurement class currently
assigned to the active channel. Other measurements are NOT compatible.

To create a measurement other than these, first assign the appropriate measurement class to a
new or existing channel. Learn how.

Click a tab to create or change measurements.

e When creating NEW measurements, you can choose more than one.

¢ When changing an EXISTING measurement, you can choose ONLY one.

Tabs

S-Parameter Select a predefined ratioed measurements. Learn more about S-parameters.

For Setup:<= 4-Port
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S-Parameter | Balanced \ Receivers‘ Waves ‘ Aux \ _:.\_

Esn fs12 Os13 [Is14
21 Flszz  [s23 s
831 Os3a2  [s3  [0s34
1541 Cls42  [Is43  [S44
Newtace  Channell  +| [Windowi =]
(SelectAll| | OK || Cancel | Apply || Hep |

Balanced Select a balanced measurement type.

Topology Click to invoke the Balanced DUT Topology / Logical Port mappings dialog box. Learn
more about Balanced Measurements.

For Setup:<= 4-Port

S-Parameter ‘ Balanced ‘Rm'r\rers I Waves I Aux | [—'_.\—]
[ sss11 [ssd12 [ ssc12
[] sds21 [ sdd22 Sdc22
O] Ses21 [ Sed22 0 Scc22
[ Imbal [ % %
Topology...
Newtace |[Channell  ~| |Window1  ~|
|selectAl| | Ok || concel || Apply || Help |

Select All Will only select the parameters shown and will not select the check box of the
Receiver selector at the bottom.
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Receivers Select receivers to make Ratioed and Unratioed (absolute power) measurements. Learn
more about receiver measurements.

S-Parameter I Balanced | Receivers I Waves I Au ] [1.\]
A1 | A2 ! A4
REX |B.2 1B.3 B.4
Oc,1 Fc2z Fca Fca4
FD.1 |D.2 1D.3 D4
FIR11 |R2,2 IR3,3 TIR44
O (A v = [1.0 v| |Source Port1
Mewtrace  [Channell  +| Window1 <
|selecta | | Ok | | Cancel || Appy || Help |

Ratioed Click on the check box to select the parameters and create measurement. Receiver
selector at the bottom allow you to define ratios. Select a receiver for the Numerator, select
another receiver for the Denominator, then select a source port for the measurement.

The Source portis ALWAYS interpreted as a logical port number.
For convenience, the table is populated with common choices.

Select All Will only select the parameters shown and will not select the check box of the
Receiver selector at the bottom.

. Learn more about Ratioed Measurements.

Unratioed Same as Ratioed, but select 1 as the Denominator.

. Learn More about Unratioed Measurements.

Waves Select receiver notation to make ratioed and unratioed measurements.
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S-Parameter | Balanced | Receivers Waves | Aux } -.:
al,l al,2 al3 al4d
b1,1 b1.2 b1.3 b1.4
b2,1 b2,2 b2,3 b2 4
b3.1 b3,2 b3,3 b3.4
b4,1 b4.2 b4.3 b4.4
|al v|f|10 *| |Source Port1 ~
New frace |Channel 1 v| Window 1 v|
| Select All | OK | Cancel Apply | Help |

Click on the check box to select the parameters and create measurement. Wave selector at the
bottom allow you to define ratio.

Select All Will only select the parameters shown and will not select the check box of the
Wave selector at the bottom.

Receiver Notation
Receivers can be also selected using logical receiver notation. This "8510-style" notation
makes it easy to refer to multi-port receivers.

¢ aN - Reference receiver for logical port N

o bN - Test port receiver for logical port N

For example:

e For Ratioed measurements: "b12/a1" refers to the logical test port 12 receiver / the logical port 1
reference receiver.

e For Unratioed measurements: "b10" refers to the logical test port 10 receiver.

The VNA-style notation (A, B, R1 and so forth) can still be used to refer to physical receivers
in less than 4 ports. Learn more.

However, ratioed measurements MUST use the same notation to refer to both receivers; either
the physical receiver notation (A, R1) or the logical receiver notation (aN, bN). For example,

145




the following mixed notation is NOT allowed: A/b3 and a5/R2.

Programming

When entering receiver letters using programming commands, neither logical or physical
receiver notation are case sensitive.

AUX Select input of Auxiliary on the rear panel to make DC measurement.

S-F'arameterl Balanced \Receiversl Waves | Aux ‘ -:.:-

Auxini,1 Auxin1 Range 10V A
Auxln2,1 Auxin2 Range 10V -

|Auxln1 A ‘ |Snurce Port 1 A ‘
New trace |Channe| 1 - | ‘Winduw 1 - ‘
| Select All | l OK l | Cancel ‘ ‘ Apply ‘ ‘ Help |

Click on the check box to select the input of auxiliary and create measurement. Auxiliary selector
at the bottom allow you to define auxiliary and other parameters such as PMAR and DVMs.

AuxIn range Click on the drop down selection to select the DC range. (ESO80A Only)

Select All Will only select the parameters shown and will not select the check box of the
Auxiliary selector at the bottom.

Channel / Window Selections

| Select Al | | Clear Al Create in Mew YWindow

| 1 * | Channel Mumber

These selections are NOT AVAILABLE when changing an EXISTING measurement.Learn how to
change a measurement.

Channel Number Select the channel for the new traces.
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Create in New Window

e Check to create new traces in a new window.

e Clear to create new traces in the active window. When the traces per window limitation has
been reached, no more traces are added.

About Measurement Parameters (top of page)

Balanced Source / Topology dialog box help

. Ealanced Source / Topolagy : Oha ﬁ

Logical Ports

Topology: |SE-SE-BAL -

Smle Er}.‘,l-:\:l Paowt 1

. DuT |
- —
Singke Ervled Pioet 2 -

Port 3 -

Port 1 -

Port 2 - Port 4 -

Create or edit DUT Topology and Logical Port Mapping.

A Logical Port is a term used to describe a physical analyzer test port that has been remapped to a
new port number. You can assign logical single-ended ports to logical balanced ports.

Note: These selections apply to ALL measurements in the channel. If the device topology is
changed, any existing measurements in the channel that are incompatible with the new topology
will be automatically changed to one that is compatible.

Topology: Describes your DUT as you would like it tested. The following device topologies can be
measured by a multiport analyzer.

e Balanced / Balanced
(2 logical ports - <4 actual ports>)

¢ Single-ended / Balanced
(2 logical ports - <3 actual ports>)

¢ Single-ended - Single-ended / Balanced
(3 logical ports - <4 actual ports>)
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These topologies can be used in the reverse (<==) direction to measure:

e Balanced / Single-ended topology

¢ Balanced / Single-ended - Single-ended topology

For example, to measure a Balanced / Single-ended topology, measure the S12 (reverse direction)
of a Single-ended / Balanced topology.

See Also

e |earn more about Balanced Measurements

e Balanced parameters can be saved to SNP files. Learn more.
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Frequency Range

Frequency range is the span of frequencies you specify for making a device measurement.

e How to Set Frequency Range
e Zoom
e CW Frequencies

e Frequency Resolution

See other 'Setup Measurements' topics

How to set Frequency Range
You can also make these settings and more from the Sweep Type dialog.

See the frequency ranges of all analyzer models.

Using Hardkey/SoftTab/Softkey Using a mouse
1. Press Freq> Main > Start, Stop, Center, 1. Right click on the X-axis label or stimulus range
or Span. area under grid line.

2. Enter desired frequency value. 2. Click on Start/Stop/Center....

'mrt. Center,

Start 10000000 MHz  [I]  Cener 4.505000000 GHz |3

Siop 9000000000 GHz [3|  Span 8990000000 GHz |5
Points 201 El swp DEImEmE [
o e

Either of the following pairs of settings determine the frequency range. The last value that you enter
determines the X-Axis labels. For example, if you enter the Start and Span values, the X-Axis will
show Center and Span labels.

Start /Stop - Specifies the beginning and end frequency of the swept measurement range.
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Note: The start frequency at preset is not the minimum value in full range. (E5080A: 100
kHz, ES080B 10 MHz)

Center /Span - Specifies the value at the center and frequency range.

Either of the following settings determine the number of evenly-spaced data points across the
frequency range.

Points - Specifies the number of evenly-spaced data points across the frequency range. Learn more
about Data Points.

Step - Available ONLY in Linear sweep type. Specifies the frequency step size between evenly-
spaced data points. Changes to this setting will cause the Points setting to adjust to the closest
integer. Any 'remainder' will adjust either the Stop value or Span value depending on which is
displayed on the X-Axis label.

Zoom

Zoom allows you to easily change the start and stop frequencies or start and stop power levels in a
power sweep.

Zoom operates on the Active Trace and all traces in the same channel as the active trace, regardless of
the window in which they appear.

How to Zoom in a measurement window

1. Left-click the mouse or use a finger, then drag across a portion of a trace.
2. Release the mouse or lift the finger and the following menu appears:

3. Select from the following:

e Zoom - changes the channel stimulus settings to the left and right border values of the Zoom
selection

e Zoom xy - changes the channel stimulus settings as above. In addition, the Y-axis scale of
the active trace changes to the approximate scale of the Zoom selection.

e Zoom Full Out - changes the channel stimulus settings to the full span of the current
calibration. If no calibration is ON, then the stimulus settings are changed to the full span of
the VNA model.

Notes
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e The stimulus settings are changed for ALL traces in the active channel, regardless of the window in
which they appear.

o If markers are in the selected area, they remain in place.

¢ If markers are in the unselected area, they are moved to the right or left edge of the new span. When
Zoom Full Out is selected, the markers are moved back to their original location.

Zoom is NOT available for the following:

e Smith Chart or Polar display formats

e CW Time and Segment sweep type

CW Frequencies

Measurements with a CW Time sweep or Power sweep are made at a single frequency rather than over a
range of frequencies.

How to set CW Frequency

Using Hardkey/SoftTab/Softkey Using a mouse
1. Set Sweep Type to CW Time or Power 1. Set Sweep Type to CW Time or Power Sweep.
Sweep.

2. Right click on the stimulus range area under grid
2. Press Freq > Main > CW. box.

3. Enter desired CW frequency.
3. Click on CW....

Prugramming Commands= }

CW Frequency dialog box help

x|
|' Frequency

0k, | Eancell Help

CW Type a value and the first letter of the suffix (k,m,or g) or use the up and down arrows to
select any value within the range of the VNA.
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Frequency Resolution

The resolution for setting frequency is 1 Hz.
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Power Level

Power level is the power of the source at the test ports.

How to make Power Settings

Power Dialog

Power and Attenuator Dialog

Power ON and OFF during Save / Recall and Preset

Power ON and OFF during Sweep and Retrace

See other 'Setup Measurements' topics

Power Settings
The test port output power is specified over frequency.

See the Power Range specifications for your analyzer.

How to make Power settings

Use one of the following methods to set port power.

Using Hardkey/SoftTab/Softkey Using a mouse
1. Press Power > Main > Power Level / Start Power / Stop Power to 1. Right click on the X-axis
enter desired power level. label or stimulus range

area under grid line.
2. Press Power > Main > RF Power to turn ON or OFF the RF power.
2. Click Power.... and then
3. Press Power > Leveling & Offsets > click left side Slope small Power: Channel N
button to turn ON or OFF the slope (Green color means the slope is dialog box appears.
turned ON; Grey color means the slope is turned OFF).

Programminq Commands= }

Power dialog box help
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[ Power: Channel 1 =)

¥ Power On (All Channels)
Fort 1

Paort Power: -5.00 dBm

Power Sweep
3 10.00 dBm

0,00 dEm

Power Slope
Slope: 0.000 dB/GHz |

o] i

This dialog provides basic control of source power for a specific port.
See Power and Attenuators dialog box.

Power On (All Channels) Check to enable source power for all channels. Only turns power ON if
channel power setting is ON or Auto.

Port 'n' Active source port for which power is being set.
Port Power Sets the power level for the specified port.
Power Sweep

Start / Stop Power Set the start and stop power values of a power sweep.

These settings are only available when Sweep Type is set to Power Sweep.

Uncoupled power sweep power can be set from the Advanced Power dialog.

You can Zoom to easily change the start and stop power levels in a power sweep. Learn how.

Learn more about Power Sweep.
Power Slope
Helps compensate for cable and test fixture power losses at increased frequency.

Slope Select to set the power slope. Clear to set power slope OFF. Learn more about power slope.

154




How to make Power settings

Use one of the following methods to set port power.
Using Hardkey/SoftTab/Softkey

1. Press Power > Main > Power and Attenuators and then the Power and Attenuators dialog box
appears.

Detailed settings for Power and Attenuators:

1. Press Power > Main > RF Power to turn ON or OFF the RF power.
2. Press Power > Port Power > Select Port x to active the selected port.

3. Press Power > Port Power > Power Level / Start Power / Stop Power to enter desired power level for
selected port.

4. Press Power > Port Power > Source State to choose the source state either Auto, On or Off.
5. Press Power > Port Power > Coupling to turn ON or OFF Power Coupling.

6. Press Power > Leveling & Offsets > click left side Slope small button to turn ON or OFF the slope
(Green color means the slope is turned ON; Grey color means the slope is turned OFF).

Pru-grannning Commands }

Power and Attenuators dialog box help

w3 Fowir and Attenuatars: Channel 1 @
[+ Power ON (All Channgls) 4| Port Powers Couplad
Name State  Port Power Start Power Stop Power Leveling Mode
Port 1 |Auto 0.00 dBm -10.00 dBm 0.00 dBm Internal

Paort 2 .F'LLIID . 0.00 dBm -10.00 dBm 0.00 dBm Internal

Channel Power Slope 0.0 dB/GHz r . Offsets and | Receiver |
Limits... Leveling...
oK Holp |

Defines and controls the source power and attenuation for the active channel.
External sources can be controlled from this dialog. Learn more.

Power On (All Channels) Check to enable source power for all channels (same function as RF
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Power). Only turns power ON if channel power setting is ON or Auto.

Port Powers Coupled

e Coupled (checked) The power levels are the same at each test port. Set power at any test
port and all test ports change to the same power level.

e Uncoupled (cleared) The power levels are set independently for each test port. Uncouple
power, for example, if you want to measure the gain and reverse-isolation of a high-gain
amplifier. The power required for the input port of the amplifier is much lower than the
power required for the output port. A power sweep can also be performed with uncoupled
power.

Name Lists the analyzer test ports.

State

e Auto Source power is turned ON at the specified test port when required by the measurement. This is
the most common (default) setting. See also Power ON and OFF during Save / Recall, User Preset, and
Preset.

e ON Source power is ALWAYS ON, regardless of measurements that are in process. Use this setting to
supply source power to a DUT port that always requires power, such as an LO port. This could turn OFF
power at another test port.

e OFF Source power is never ON, regardless of the measurement requirements. Use this setting to
prevent damage to a sensitive DUT test port.

Port Power Sets the power level at the output of the source.

e To accurately set the power level at any point after the test port, perform a Source Power Calibration.
o See specified power range of VNA model.

e See ECal Module Compression Level
Start / Stop Power Available ONLY when sweep type is set to Power Sweep. Set the start and
stop power values of a power sweep. Learn how to set Power Sweep.

e You can specify whether to maintain source power at either the start power or stop power

level at the end of a power sweep. Learn more.

e A power sweep can be performed with uncoupled power. Different power ranges can be swept
in the forward and reverse directions.
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Leveling Mode (ALC Hardware Softkey)- Refer to the following diagram:

e Receiver Rx - Receiver Leveling. Select a receiver to use for leveling the source. Learn more.

Channel Power Slope

Helps compensate for cable and test fixture power losses at increased frequency. With power
slope enabled, the port output power increases (enter positive value) or decreases (enter negative
value) as the sweep frequency increases.

Slope Select to set the power slope. Clear to set power slope OFF.
Power slope is computed and applied from 0 GHz — not from the measurement start frequency.

For example, with the following measurement settings:

e Start/ Stop Freq: 10 GHz to 20 GHz
e Power level: 0 dBm
e Slope: 1 dB/GHz
The power into the DUT from 10 GHz to 20 GHz is 10 dBm sloping to 20 dBm
Offset and Limits Launches the Power Offset and Limits dialog.
Receiver Leveling Launches the Receiver Leveling dialog.

Receiver Attenuator Launches the Receiver Attenuator dialog.

Source Unleveled

When the power level that is required at a test port is higher than can be supplied, a Source Unleveled
error message appears on the screen and the letters LVL appear on the status bar.

To resolve an unleveled condition, change either the Test Port Power or Attenuator setting.

Important Note: The available power range can also be adjusted AUTOMATICALLY by a Source
Power Calibration, Guided Power Cal, or Power Compensation. If you are NOT seeing the range that
you expect, or the correct power level at your DUT, view the Power Offset column in the Power Limits
and Offsets dialog.
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Receiver Attenuators dialog box help
This dialog box is not available in ENA.

Receiver Attenuation is used to protect the VNA test port receivers from damage or compression.

Note: A preference can be set to mathematically offset (or NOT) the reported power at the test
port receivers by the amount of receiver attenuation. By default, All VNA models offset the
display.

Learn how to set the preference.

CAUTION! You can damage the analyzer receivers if the power levels exceed the maximum
values.

e See Technical Specifications for the maximum input power to a receiver and receiver compression.

o See Receiver attenuation values for your VNA model.

Power ON and OFF during Save / Recall, User Preset, and Preset

To protect your DUT from being inadvertently powered ON, the following RF Power ON/OFF settings
occur:

Instrument State Save/Recall

If power is OFF when an instrument state is saved, then power will always be OFF after the instrument
state is recalled.

If power is ON when an instrument state is saved, and the current power setting is OFF, then power
will be OFF after the instrument state is recalled.

Preset
Instrument Preset sets power ON by default.

This can be changed with a Preference setting so that, if the current power setting is OFF, then power
will be OFF after Preset.

Power ON and OFF during Sweep and Retrace

158



Caution: Avoid expensive repairs to your analyzer. Read Electrostatic Discharge Protection.
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Receiver Leveling

Note: The M937xA/P937xA does not support this function.

Receiver Leveling adjusts the source power until the measured receiver power is equal to the Port
Power.

In this topic:

e Overview

e Receiver Leveling Process

e Features and Limitations

¢ How to make Receiver Leveling settings
e Receiver Leveling dialog box help

e Initial Power Selection

See other 'Setup Measurements' topics

Overview

Receiver Leveling uses receiver measurements to adjust the source power level across a frequency or
power sweep. Before each measurement sweep, a variable number of background sweeps are
performed to repeatedly measure power at the receiver for each stimulus point. Those power
measurements are then used to adjust the source power level and achieve greater source power level
accuracy.

This is similar to a Source Power Calibration which makes a single sweep to measure source power. The
source power correction values are applied for all subsequent measurement sweeps. Because Receiver
Leveling is performed for every measurement sweep, it provides more accurate source power levels,
but also takes longer to perform each measurement sweep.

Note: Enabling Safe Mode when using receiver leveling may be necessary to ensure stable results.

Receiver Leveling Process

Leveling sweeps are performed in the background (not visible) before every measurement sweep to
measure and apply source correction data.
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1. For each leveling sweep, source power is applied at each data point and measured by the specified receiver.
Learn how the initial power level is selected.

2. The deviation is calculated between the measured power and the port power.

3. The deviation is applied to the current source power, and the updated source power levels are applied on the
following leveling sweep.

4. This process continues until the receiver power at each data point has achieved the port power within the
specified tolerance value, or until the specified number of leveling sweeps (iterations) has been reached.

Features and Limitations

e Receiver Leveling can be used with most sweep types, including Segment sweep and Power sweep.

e Receiver Leveling is ALWAYS enabled for the controlled source when Phase Control (Opt S93088A/B) is
enabled.

e Receiver Leveling is available for standard S-parameter measurements and with FCA, GCA, and IMD
applications.

e Turn ON Receiver Leveling before or after doing a Calibration. When turned ON before calibrating, it is
turned OFF during the calibration, then back ON after calibration.

e Power Offset on the Offsets and Limits dialog can be used when there exists an additional attenuator or

booster amplifier in the source path. An offset should be set to improve the leveling speed. This power offset
is automatically used to set the port power.

Use Receiver Leveling for the following:

e Correcting for short term drift when using an external component, such as a booster amplifier. The booster
amplifier must be connected to the front-panel jumpers, in front of the reference receiver. See the Block
diagram for your VNA, located at the end of every Specifications document.

e Extending the accuracy of power leveling at very low powers where the internal detector may be too noisy.

e Providing controlled power during Pulsed measurements in an open loop mode.

e Controlling the power at the outputs of MM-Wave heads.

Note: Increase the sweep delay if output power is not accurate when Receiver Leveling is applied to two or more
ports.
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How to make Receiver Leveling settings

Start the Power and Attenuators dialog box as follows:

Using Hardkey/SofitTab/Softkey Using a mouse
1. Press Power > Main > Power and 1. Click Stimulus, Power, then Power and
Attenuators.... Attenuators.
2. On the Power and Attenuators dialog, click 2. On the Power and Attenuators dialog, click
Receiver Leveling button. Receiver Leveling button.

Prugramming Commands ’

| Receiver Leveling dialogboxhely |
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[

Receiver Leveling Setup: Channel 1 i |

Enable Receiver Leveling
Define Controlled Source Port 1 )

Leveling Receiver setup

Receiver type | VINA Receiver 1

Receiver name ;R'I ":

Level when this RF source is turned on Port 1

Receiver frequency is determined by ;Aul.u ';

Leveling loop tolerance 0.100 dB | .

Leveling loop max iterations 10 | -
Leveling uses IFBW 100.0 kHz |+

Controlled Source setup
Update source power calibration with leveling data

4 Enable source ALC hardware circuit

Enable Safe Mode while leveling

Max port output 30.0 dBm _
Min port output -30.0 dBm ||
Max source step size  1.00 dB [

Ok | Cancal Help

Learn about Receiver Leveling (scroll up).

I8

Enable - Checkbox enables/disables receiver leveling. The default is disabled
(unchecked).

Define Controlled Source (Port)

Each source port to be leveled is configured individually. Select a source to be configured for

receiver leveling. Choose from: Port 1, Port 2, Port 3, Port 4, or any active external source. Learn
more about External Devices.

Leveling Receiver Setup

Receiver Type Receiver type does an initial sort to make it easier to select a receiver. Choose
from: VNA Receiver or Ext. Device (PMAR).
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Receiver Select a receiver to be used to level the specified source.
For VNA Receiver type, choose from any VNA receiver using standard or receiver notation.

To level power at the source output or DUT input choose the reference receiver for the source
port. For example, to level the source power at port 1, then choose "R1". To level power at the
DUT output, choose the receiver that is used to measure the DUT output. If the DUT output is
connected to port 2, then select "B" or 'b2". Learn about Receiver Notation.

When Phase Control is enabled, the ratioed receivers used in Phase Control are selected and can
NOT be changed. However, the Reference Source CAN also be selected for Receiver Leveling.

For Ext Device type, choose a configured PMAR device.

Level when this RF source is turned ON: The Controlled Source is selected automatically and
can NOT be changed.

Receiver frequency is determined by: Available ONLY when the selected receiver is a VNA
Receiver or power meter. This setting determines which receiver frequencies are measured.
Choose from:

e Auto - always uses the frequency range that is assigned to the measurement receiver.

e  FOM Receiver - FOM Receiver frequency range. Learn more aboutFrequency Offset Mode.
e FOM Source - FOM Source frequency range.

e DUT Input - Mixer/Converter input frequency range.

e DUT Output - Mixer/Converter output frequency range.

Leveling Loop Tolerance The source is considered leveled when each stimulus data point has
achieved the power level +/- (plus or minus) this tolerance value.

Leveling Loop Max Iterations If every stimulus data point does NOT achieve the port power
after this number of leveling sweeps, the measurement sweep occurs using the correction values
obtained from the last leveling sweep. The message: Not settled, noisy trace appears when the
Max Iterations is reached. If you see this message, you can increase the Max Iterations, reduce the
IFBW, or increase the Tolerance setting.

Note: If the Max Iterations is set to zero, there will be no pre-sweep for the receiver leveling,
but the value of the receiver data will be used to correct the next sweep. In this way setting
the value to zero provides a post sweep correction and can be useful for correcting slow drift
in a system where a booster amplifier or open loop ALC is used, without adding pre-sweeps
to the sweep-acquisitions.
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Leveling IFBW Available only for VNA receivers. By default, the IFBW for the leveling sweeps
is set to 100 kHz. Learn more about IFBW.

e Increase this value to make faster, but noisier leveling sweeps.
e Decrease this value to maker slower, more repeatable leveling sweeps.
e Uncheck the box to use the same IFBW as the measurement sweeps.
Controlled Source Setup
Update source power calibration with leveling data Available only when using an RF Source

and VNA receiver.

e  When checked, the latest correction data is copied to the Source Power Cal correction array.
When Leveling Mode is switched back to Internal (on the Power and Attenuators dialog),
Source Power Cal is automatically turned ON using this correction data.

e  When cleared, Source Power Cal is NOT turned ON when Leveling Mode is switched back
to Internal.

Enable Source ALC hardware circuit (Not available on ES080B)
NOT available with External sources.

Leveling Revr.

DB

e
Open Loop -5,
Internal ALC Leveding

Recaiver Leveling

e Checked - Internal ALC leveling and Receiver Leveling (Recommended).
¢ Cleared - NO ALC leveling; Receiver Leveling ONLY.
Enable Safe Mode while leveling

To protect your DUT and ensure stable results, these settings control the extent to which the
source power will be changed to achieve the port power as measured at the reference receiver.
These settings could be necessary when using external components with a large variation in
frequency response (flatness).
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When checked:

e The Min source output is used as the initial power level for the leveling loop process.
e The controlled source is never stepped more than the Max source step size.

When cleared:

e The initial power for the leveling loop may be determined by the Min source output, the
Max source output, the last setting of the leveling loop, or the target value of the leveling
loop. See Initial Power below.

e The Max source step size is ignored.

Max source step size When Safe Mode is enabled, the change in source power at each data point
from one sweep to the next is limited to this value. For example, assume Safe Mode is enabled,
and Max Power Step is set to 1 dB. On the first leveling sweep, the first data point measures 3 dB
lower than the port power, then source power for data point 1 will be increased by 1 dB for the
next sweep, and likely for the following two sweeps.

Max port output Always limits the maximum power out of the source to this value. The
message: Power set to Max Power appears when this limit is reached.

If the maximum port power out of the VNA is reached at any time during the leveling sweeps, the
following message appears: Power set to user power limit.

Min port output Always limits the minimum power out of the source to this value. The
message: Power set to Min Power appears when this limit is reached. When Safe Mode is
enabled, this value is used as the initial power level for the leveling loop process.

Note: The MAX/MIN limit is always used regardless of the safe mode state. In addition, the
MAX/MIN limit is for port power and related to power offset. If the power offset is not set
correctly, the MAX/MIN limit is not correct and it may impact the leveling. Ensure that the power
offset in the channel is the same as power offset during calibration. If the exact power offset is not
known, choose a limit for source and then it will not be related to power offset.

Initial Power Selection

For each displayed data point, the leveling algorithm must select an initial power to begin the
iteration process. This value is chosen as follows:
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Iz Safe Mode on?

Yes No
Iz this the first sweep?
TEsl Nao
Iz a PNA source being
leveled with its own R I8 Prinat = Py, 3.
receivers
Yes l No Yes | No
El!tpnn SIE'tPnn Sﬂtpnn= Sﬂtpnn= SaetF"nn
= Puin = Prargst [Pain + Prss)i2 [Pan + Pusa)i2 = Pzinai

Where:
P1nit = the initial power for the iteration process.
PFinal = the final power setting from the previous leveled sweep.
PMin = the minimum controlled source output level as specified in the Receiver leveling setup.
PMax = the maximum controlled source output level as specified in the Receiver leveling setup.

PTarget = the target power level for the selected leveling receiver.
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Sweep Settings

A sweep is a series of consecutive data point measurements taken over a specified sequence of stimulus
values. You can make the following sweep settings:
o Number of Points (Separate topic)
e Sweep Type
e Linear/Log
e Power Sweep
e CW Time

e Segment Sweep

e Frequency Range: Start/Stop (Separate topic)
e Power Sweep

e Segment Sweep

e How to make segment sweep settings

e Segment Table dialog

e X-Axis Point Spacing - Segment Sweep ONLY
e Arbitrary Segment Sweep
e Sweep Time
e Sweep Setup
e FastSweep
e Auto vs Stepped
e Dwell and Delay

e Standard vs Point Sweep

See Triggering and other 'Setup Measurements' topics
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How to set Sweep Type
Using Hardkey/SoftTab/Softkey Using a mouse

1. Press Sweep > Main > Sweep Type. 1. Right click on the stimulus range area under grid box.
2. Click Sweep Setup....
3. Select Sweep Type tab and select type.

4. Click Apply to implement the setting changes.

amning Commands
r

W

Sweep Type | Timing

Sweep Type Sweep Properties
@ Linear Frequency Start 10000000 MHz F‘

© Log Frequency Stop 26500000000 GH: H

) Power Sweep Power -5.00 dBm |Z|
© CW Time Points 20 m
) Segment Sweep IF Bandwidih

) Phase Swaep

Note: Sweep Settings are not applied until either OK or Apply is pressed.

Channel The active channel when Sweep Type was selected. Sweep settings will be applied to this
channel.

Sweep Type

Linear Frequency Sets a linear frequency sweep that is displayed on a standard grid with ten equal
horizontal divisions.

e Start Sets the beginning value of the frequency sweep.
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Stop Sets the end value of the frequency sweep.

Points Sets the number of data points that the analyzer measures during a sweep. Range: 2 to
20001.(Default is 201).

Power - Sets the power level or the source. Learn more.

IF Bandwidth - Sets the IF (Receiver) bandwidth. Learn more.

Log Frequency The source is stepped in logarithmic increments and the data is displayed on a
logarithmic x-axis. This is usually slower than a continuous sweep with the same number of points.

e Start Sets the beginning value of the frequency sweep.

Stop Sets the end value of the frequency sweep.

Points Sets the number of data points that the analyzer measures during a sweep. Range: 2 to 20001.
(Default is 201).

Power - Sets the power level or the source. Learn more.

IF Bandwidth - Sets the IF (Receiver) bandwidth. Learn more.

Power Sweep Activates a power sweep at a single frequency that you specify. Learn about power
sweep

e Start Sets the beginning value of the power sweep.
e Stop Sets the end value of the power sweep.
o CW Frequency Sets the single frequency where the analyzer remains during the measurement sweep.

e Points Sets the number of data points that the analyzer measures during a sweep. Range: 2 to 20001.
(Default is 201).

¢ IF Bandwidth - Sets the IF (Receiver) bandwidth. Learn more.

CW Time Sets the analyzer to a single frequency, and the data is displayed versus time. Learn more.

e CW Frequency Sets the frequency where the analyzer remains during the measurement.
o Sweep Time Sets the duration of the measurement, which is displayed on the X-axis.

o Points Sets the number of data points that the analyzer measures during a sweep. Range: 2 to
20001.(Default is 201).
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¢ IF Bandwidth - Sets the IF (Receiver) bandwidth. Learn more.

Segment Sweep Sets the analyzer to sweep through user-defined sweep segments. Learn how to
make these settings.

OK Applies setting changes and closes the dialog box.
Apply Applies setting changes and leaves the dialog box open to make more setting changes.

Cancel Closes the dialog. Setting changes that have been made since the last Apply button click
are NOT applied.
Help - Display the Sweep Type dialog box help.

Power Sweep

A power sweep either increases or decreases source power in discrete steps. Power sweep is used to
characterize power-sensitive circuits, with measurements such as gain compression.

In the Sweep Type dialog, specify Start power, Stop power, and CW Frequency. Power can be swept
over any attainable range within the analyzer ALC range.

The remaining power settings apply in power sweep mode:

Test Port Power setting is not available.

Port Power can be coupled or uncoupled.

Attenuator Control is always Manual.

Power Slope (dB/GHz) is ignored (output frequency is CW).

e Press Sweep > Main > Number of Points to change the step size of the power sweep.

Notes:

e Using a preference setting, you can specify whether to maintain source power at either the start power or
stop power level at the end of a power sweep.

e Power Sweep is optimized for speed. For highest measurement accuracy during a power sweep, it may be
necessary to increase the Dwell Time to allow the source more time to settle.
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Segment Sweep

Segment Sweep activates a sweep which consists of frequency sub-sweeps, called segments. For each
segment you can define independent power levels, [F bandwidth, and sweep time.

Once a measurement calibration is performed on the entire sweep or across all segments, you can make
calibrated measurements for one or more segments.

In segment sweep type, the analyzer does the following:

e Sorts all the defined segments in order of increasing frequency
e Measures each point

e Displays a single trace that is a composite of all data taken

Restrictions for segment sweep:

e The frequency range of a segment is not allowed to overlap the frequency range of any other segment.
e The number of segments is limited only by the combined number of data points for all segments in a sweep.

e The combined number of data points for all segments in a sweep cannot exceed the max number of data
points per trace.

How to make segment sweep settings

Using Hardkey/SoftTab/Softkey Using a mouse
1. Press Sweep > Segment Table > 1. Right click on the X-axis label or stimulus display
Segment Table... area under grid line.

2. Click Sweep Setup... then select Segment Sweep
under sweep type.

3. Click Segment Table....

Pru-grannning Commands }

Segment Table dialog box help
Segment Table Softkeys

Add Segment - adds a sweep segment at last segment.

Insert Segment - adds a sweep segment before the selected segment. You can also click the "down"
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arrow on your keyboard to quickly add many segments.
Delete Segment - removes the selected segment.

Delete All Segments - removes all segments.

Note: At least ONE segment must be ON or Sweep Type is automatically set to Linear.

Segment Table dialog box
X-Axis Point Spacing - Check to scale the X-axis to include only the segments. Learn more.

Allow Arbitrary Segments - Check to allow arbitrary frequencies (overlapped or reverse sweep).
Learn more.

Display Center/Span Freq - Check to display the center/span frequency.

Independent Setting Per Segment

Power Level - Sets the Power level for the segment. Also, the test port power can UNCOUPLE. See
Power Coupling.

IF Bandwidth - Sets the IF Bandwidth for the segment.
IF Bandwidth Per Port - Sets the different bandwidth with different port for the segment.
Sweep Time - Sets the Sweep time for the segment.

Dwell Time - Specifies the time the source stays at each measurement point before the analyzer
takes the data.

Vector Averaging - Enables SA vector average for the segment.

Video Bandwidth - Enables SA video bandwidth for the segment.

Delay- Sets the time to wait just before acquisition begins for each segment.
Sweep Mode - Sets the sweep mode to auto or stepped.

Shift LO- Sets the state of Shift LO.

Receiver Atten Per Port - Enables receiver attenuation per port for the segment.

Reference Tone - Enables SA multitone reference for the segment.
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SA Data Threshold - Enables SA data threshold for the segment.

Save Table - Saves the setting changes in segment table.

Load Table - Apply the setting changes in segment table.

To Modify an Existing Segment

To make the following menu settings available, the segment table must be displayed first. (Press
Sweep > Segment Table).

State - Click the box on the segment to be modified. Then, use the up/down arrow to turn the
segment ON or OFF.

Start - Sets start frequency for the segment. Click the box and type a value and the first letter of a
suffix (KHz, Mhz, GHz). Or double-click the box to select a value.

Stop - Sets stop frequency for the segment. Click the box and type a value and the first letter of a
suffix (KHz, Mhz, GHz). Or double-click the box to select a value.

Note: The segment table truncates the frequency resolution. To verify the frequency resolution that
you input, create a marker at the start or stop frequency settings.

Points - Sets number of data points for this segment. Insert a value or double-click the box to select
a value.

To set Power Level, IF Bandwidth/IF Bandwidth Per Port, Sweep Time, Delay, Receiver
Attenuator Per Port, Sweep Mode and Shift LO independently for each segment:

1. Press Sweep > Main > Sweep Type > Segment Sweep.

2. Click on Segment Table > Segment Table....

3. Check the box corresponding to the segment setting to set then click OK.

4. Click in the box at the bottom of the display and use the up/down arrows to enter a value or double-click
the box and select a value with the numeric keypad.

Note: If the following are NOT set, the entire sweep uses the channel [IFBW, Power, and Time
settings.
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X-Axis Point Spacing - Segment Sweep ONLY

This feature affects how a segment trace is drawn on the screen.

How to select X-Axis Point Spacing

Using Hardkey/SoftTab/Softkey Using a mouse
1. Press Sweep > Segment Table. > 1. Right click on the X-axis label or stimulus display
Segment Table.... area under grid line.
2. Check X-Axis Point Spacing. 2. Click Sweep Setup... then select Segment

Sweep under sweep type.
3. Click Segment Table....

4. Check X-Axis Point Spacing.

Prugramming Commands= }

o Without X-axis point spacing, a multi-segment sweep trace can sometimes result in squeezing many
measurement points into a narrow portion of the x-axis.

¢ With X-axis point spacing, the x-axis position of each point is chosen so that all measurement points are
evenly spaced along the x-axis.

For example, given the following two segments:

STATE sTART | 5TOP | POINTS |
1 [on ~| 45000000MHz  50.000000 MHz 21
| oM | 170000000 MHz | 180.000000 MHz 21

H.E04dE

Without X-Axis Point Spacing

175



With X-Axis Point Spacing

Arbitrary Segment Sweep

This feature allows arbitrary frequencies to be entered into the segment sweep table. With this

capability, segments can have:

e overlapping frequencies.

¢ the stop frequency less than the start frequency (reverse sweep).

However, there are several limitation:

e Sweep mode: Stepped only.

e Sweep time: When reverse sweep is performed, the sweep time and the wait time before the

measurement point becomes longer.

How to enable Arbitrary Segment Sweep
Using Hardkey/SoftTab/Softkey

1. Press Sweep > Segment Table. >
Segment Table....

2. Check Allow Arbitrary Segments.

Using a mouse

1.

3.

4.

Right click on the X-axis label or stimulus display
area under grid line.

. Click Sweep Setup... then select Segment

Sweep under sweep type.
Click Segment Table....

Check Allow Arbitrary Segments.

Prugramming Commands=s ’

Notes:
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e Unusual results may occur when using arbitrary sweep segments with markers, display settings, limit lines,
formatting, and some calibration features.

o When Allow Arbitrary Segments is checked, X-axis point spacing is automatically turned ON.

o When the segment table has both forward and reverse frequency sweep, the correction interpolation may
not work properly. Use the same segment table setting for both correction and measurement. (Make a
measurement at the condition where "Cor" is displayed.)

¢ When the measurement data size of segment table exceeds its limitation, an error occurs. In this case,
reduce the measurement data size (i.e., NOP, number of channels).

Sweep Time

The analyzer automatically maintains the fastest sweep time possible with the selected measurement
settings. However, you can increase the sweep time to perform a slower sweep.

How to set Sweep Time

Using Hardkey/SoftTab/Softkey Using a mouse
1. Press Sweep > Sweep Timing > Sweep 1. Right click on the X-axis label or stimulus range area
Time. under grid line.
2. Input the desired sweep time. 2. Click on Sweep Setup....

3. Select Timing tab.
4. Deselect the Auto Sweep Time box.

5. Input the desired sweep time.

Time dialog box help { |pxogramming Commands| 3

Sweep Time Specifies the time the analyzer takes to acquire RF data for a sweep. The maximum

sweep time of the analyzer is 86400 seconds or 1 day. Learn about other settings that affect sweep
speed.

Note: When a channel has an Aux In or SMU trace, the measurement time for DC voltage/current
will be added.

Sweep Setup
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How to make Sweep Setup settings
Using Hardkey/SoftTab/Softkey = Using a mouse

1. Press Sweep > Sweep 1. Right click on the X-axis label or stimulus range area under grid
Timing. line.

2. Click on Sweep Setup....

3. Select Timing tab.

Sweep Setup dialog box help ‘}

Time
Sweep Time - same as Sweep Time Softtab Help.

Dwell Time - Specifies the time the source stays at each measurement point before the analyzer
takes the data. Only applies to stepped sweep. The maximum dwell time is 20 seconds. See also
Electrically Long Devices.

Sweep Delay - Specifies the time to wait just before acquisition begins for each sweep. This delay
is in addition to Dwell Time (per point) and External Trigger delay if enabled.

Auto Sweep time - Automatic adjust the sweep time and dwell time. When "Auto Sweep Time" is
checked, the sweep time and dwell time will disable to edit.

Fast Sweep Not available on ES080B. When checked, in Analog Sweep mode the analyzer source
settling times are shortened in both frequency and power-control (ALC) circuits. In Stepped Sweep
mode, the settling time at ALL data points are shortened. This nearly doubles the sweep speed at
preset conditions, but at the expense of frequency accuracy and a few dB of amplitude variation. For
ratioed measurements, such as S-Parameters, these errors substantially ratio out.

e By default, Fast Sweep is always OFF to provide maximum accuracy and stability.

e Fast Sweep is NOT allowed with Power Limit enabled.
e Note: Performance specifications do NOT apply in Fast Sweep.

Sweep Mode

Auto - Automatic adjusts the sweep time and dwell time. When "Auto Sweep Time" is checked,
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the sweep time and dwell time will disable to edit.

Stepped When checked (Stepped Sweep) the analyzer source is tuned, then waits the specified
Dwell time, then takes response data, then tunes the source to the next frequency point. This is
slower than Analog Sweep, but is more accurate when testing electrically-long devices.

When cleared (Analog Sweep) the analyzer takes response data AS the source is sweeping. The
sweep time is faster than Stepped, but could cause measurement errors when testing electrically-
long devices.

When the dialog check box is cleared, the analyzer could be in either Analog or Step mode. The
mode can change from sweep to sweep. There is NO way to determine whether the analyzer is in
Analog or Stepped Sweep. If you want to be sure what the current sweep mode is, then switch it to
Stepped.

Stepped sweep is automatically selected for a number of reasons. Here are some of the reasons:

e |F Bandwidth is at, or below, 5 kHz.
e When step mode is a faster way to take the data.

e For all FOM measurements.
Sweep Sequence
Note: This feature is not available on E5080.

Standard Sweep When checked, the analyzer sweeps all data points for each source port in turn.
For a 2-port analyzer, this means that all data points are swept in the forward direction, then all
data points are swept in the reverse direction. Even when NO reverse parameters are displayed
(S22 or S12), reverse measurements are necessary when a full 2-port calibration is correcting the
channel. This is the default behavior.

Point Sweep Available ONLY on standard S-parameter channels. When checked, the analyzer
measures all parameters at each frequency point before stepping to the next frequency. The
display trace is updated as each data point is measured.

e Point sweep usually results in slower sweeps and is useful only in rare circumstances.

e Point sweep is the same as stepped sweep mode on the 8510 and 8530.

e PMAR is not compatible with Point Sweep mode.
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Trigger

A trigger is a signal that causes the analyzer to make a measurement sweep. The analyzer offers great
flexibility in configuring the trigger function.

View the interactive Trigger Model animation to see how triggering works.

e How to Set Trigger
e Source

e Scope

e Channel Settings
e Restart

e External Triggering (separate topic)

See other 'Setup Measurements' topics

How to set Triggering
Using Hardkey/SoftTab/Softkey Using a mouse
1. Press Trigger > Main > Trigger.... 1. Right click on the Trig or Meas icons on the status bar.

2. Select Trigger....

Pru-grannning Commands }

Note: The Continuous, Single, and Hold settings apply ONLY to the active channel. These settings
are available from the Trigger menu, Active Entry keys, and softkeys

Trigger Setup dialog box help

View the interactive Trigger Model animation to see how triggering works.

Trigger Source

These settings determine where the trigger signals originate for all existing channels. A valid
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trigger signal can be generated only when the analyzer is not sweeping.

Internal Continuous trigger signals are sent by the analyzer as soon as the previous measurement
is complete.

Manual One trigger signal is sent when invoked by the Trigger button, the active tool bar, or a
programming command.

External Trigger signals received from the trigger source. The trigger source can be defined in
External and AUX Triggering.

Manual Trigger! - Manually sends one trigger signal to the analyzer. Available ONLY when
Manual trigger is selected.

Trigger Scope
These settings determine what is triggered.
Global All channels not in Hold receive the trigger signal [Default setting]

Channel Only the next channel that is not in Hold receives the trigger signal. This is not obvious
or useful unless Trigger Source is set to Manual. This setting enables Point Sweep mode.

Active Channel - Trigger are sent only to the active channel. The active channel does not change.
Channel Trigger State

These settings determine how many trigger signals the channel will accept.

Continuous The channel accepts an infinite number of trigger signals.

Groups The channel accepts only the number of trigger signals that is specified in the Number of
Groups text box, then goes into Hold. Before selecting groups you must first increment the
Number of Groups text box to greater than one.

Number of Groups Specify the number of triggers the channel accepts before going into Hold. If
in Point Sweep, an entire sweep is considered one group.

First increment to desired number, then select 'Groups'.
Single The channel accepts ONE trigger signal, then goes into Hold.

Another way to trigger a single measurement is to set Trigger Source to Manual, then send a
Manual trigger. However, ALL channels are single triggered.

Hold The channel accepts NO trigger signals.
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Trigger Mode

These settings determine what EACH signal will trigger.

Sweep and Point modes are available ONLY when both Trigger Source = MANUAL or
EXTERNAL AND Trigger Scope = CHANNEL.

e Channel Each trigger signal causes ALL traces in that channel to be swept in the order
specified below.

e Point Each Manual or External trigger signal causes one data point to be measured.
Subsequent triggers go to the same trace until it is complete, then other traces in the same
channel are swept in the order specified below. When in Groups or Single trigger, the count
is decremented by one after ALL data points on ALL traces in the channel are measured.

See Also, the (point) Sweep Indicator and SCPI Triggering example for use with External.

e Trace Available ONLY when Point Sweep is selected. Each trigger signal causes two
identical measurements to be triggered separately - one trigger signal is required for each
measurement. Other trigger mode settings cause two identical parameters to be measured
simultaneously. Trace triggering is NOT permitted when a channel is using a 2 port (or
more) S-Parameter calibration.

e Sweep Each Manual or External trigger signal causes ALL traces that share a source
port to be swept in the order specified below. When in Groups or Single trigger, the count
1s decremented by one after ALL traces in ALL directions are swept.

When multiport correction is ON, which requires sweeps in more than one direction, traces
on the screen will not update until all of the relevant directions have been swept. For
example, with all four 2-port S-Parameters displayed:

e When Full 2-port correction is ON, trigger 1 causes NO traces to update; trigger 2
causes ALL S-Parameters to update. Learn more about sweeps with correction ON.

e  When correction is OFF, trigger 1 causes S11 and S21 to update; trigger 2 causes S22
and S12 to update.
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Trace Sweep Order

For ALL Trigger Modes, trigger signals continue in the same channel until all traces in that
channel are complete. Triggering then continues to the next channel that is not in HOLD.

Traces within each channel are always swept in the following order:

e Traces are swept sequentially in source-port order. For example, in a channel with all
four 2-port S-parameters, first the source port 1 traces (S11 and S21) are swept
simultaneously. Then the source port 2 traces (S22 and S12) are swept simultaneously.

e In addition, when Alternate sweep is selected, traces are swept sequentially in source-port /
receiver-port order. In the above example, first the S11 trace is swept, then S21, then
S12, then S22.

Restart (Available only from the Trigger menu) Channels in Hold are set to single trigger (the
channel accepts a single trigger signal). All other settings are unaffected, including decrementing
trigger Groups.

See Also

e External Triggering

o Interactive Trigger Model animation
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External and Auxiliary Triggering

External and auxiliary triggering is used to synchronize the triggering of the analyzer with other
equipment.

e Overview

e How to make Trigger Settings:
e Auxiliary Triggering
e Meas Trig (IN) Dialog

e Pulse Triggering

See Also

Controlling a Handler

Synchronizing an External Source

Internal Triggering

Pulse Triggering (separate topic)

Overview
Ready Signals versus Trigger Signals

A 'Ready for Trigger' signal is different from a Trigger signal. The ready signal indicates that the
instrument sending the signal is ready for measurement. The instrument receiving the ready signal
would then send a trigger signal, indicating that the measurement will be, or has been, made. Usually
the slower instrument sends the trigger signal.

Learn more about each type of triggering signal:
e Meas Trig RDY and Meas Trig IN - This pair of signals is easy to use and limited in ability to configure.

e AUX TRIG OUT - These two pair of connectors and signals are highly configurable. Use them to synchronize
with any number of devices and equipment.
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Meas (External) Trigger dialog box help

Trigger ®
Setp  Meas Trigger A Trig 1 Pulse Trigger £ 3

Main Triggar Input

Gilobal Trigger Dalay

Dielay | 0 nsec = Giloh

Source Lenel'Edge
% Maas Trig In BN

[ Handler 110 Pin 18
3 Pulsad () Positiva Edge
{® Nagative Edge

Heady fer Trigger Indicabor
Meas Trig Heady

L Hamdler 10 Fin 21 Heady Low

o

Meas Trig RDY and Meas Trig IN
TheMEAS TRIG connectors are located on the VNA rear-panel.

These signals can be used when the VNA is communicating with a slow mechanical device. A
material handler is very mechanical and takes a relatively long time to load and discharge parts.
Here is how these signals work together to communicate:

1. The VNA sends a 'Ready' signal when it is ready to make a measurement.

2. The external device sends a trigger signal to the VNA when it is ready for a measurement.

3. Additional signals are available on the VNA Handler 1/O to indicate that the VNA sweep has ended, and
that the handler can setup for the next measurement. See Material Handler /O description.

See how to access the Trigger Dialog
Trigger Ready and Trigger IN

The Trigger connectors are located on the rear-panel.
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These signals can be used when the VNA is communicating with a slow mechanical device. A
material handler is very mechanical and takes a relatively long time to load and discharge parts.
Here is how these signals work together to communicate:

1. The VNA sends a 'Ready' signal when it is ready to make a measurement.

2. The external device sends a trigger signal to the VNA when it is ready for a measurement.

3. Additional signals are available on the VNA Handler 1/O to indicate that the VNA sweep has ended, and
that the handler can setup for the next measurement. See Material Handler I/O description.

Dialog Settings

To cause the VNA to respond to Meas Trig IN or Handler I/O signals, select External on the Trigger
Setup tab, Source setting.

Note: You must select External when you use any external triggers.

Also on the Trigger Setup tab, Scope setting, choose whether one external trigger signal will apply
to ALL channels (Global) or one trigger signal per Channel. The following settings apply
accordingly.

Main Trigger Input
Global / Channel Trigger Delay After an external trigger is received, the start of the sweep is
held off for this specified amount of time plus any inherent latency.
e When Trigger Scope = Channel, the delay value is applied to the specified channel.
e  When Trigger Scope = Global, the same delay value is applied to ALL channels.

Source The VNA accepts Trigger IN signals through the following connectors:

e Meas Trig IN BNC

. Handler 1/0

e Pulse3 (ES080B only): Trigger signals are routed internally without the need of a cable
connection between the pulse 3 output and the external trigger input.

Level / Edge

High Level The VNA is triggered when it is armed (ready for trigger) and the TTL signal at the
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select input is HIGH. (Not available on E5080B)

Low Level The VNA is triggered when it is armed (ready for trigger) and the TTL signal at the
select input is LOW. (Not available on E5080B)

Positive Edge After the VNA arms, it will trigger on the next positive edge. If Accept Trigger
Before Armed is set, the VINA will trigger as soon as it arms if a positive edge was received since
the last data was taken.

Negative Edge After the VNA arms, it will trigger on the next negative edge. If Accept Trigger
Before Armed is set, the VNA will trigger as soon as it arms if a negative edge was received since
the last data was taken.

Accept Trigger Before Armed When checked, as the VNA becomes armed (ready to be
triggered), the VNA will immediately trigger if any triggers were received since the last taking of
data. The VNA remembers only one trigger signal. All others are ignored. (ES080B does not
support this function.)
e  When this checkbox is cleared, any trigger signal received before VNA is armed is ignored.
e  This feature is only available when positive or negative EDGE triggering is selected.

e  Configure this setting remotely using CONTrol:SIGNal (SCPI).

Low latency mode (ES080A only): - When checked, variations in delay time between the reception
of a trigger and the start of a one-point measurement are decreased for point trigger measurement.
However, the /READY FOR TRIGGER does not output for each points at this mode.

e Point Trigger: ON, Low Latency: ON

188




1 sweep

'
- Lol
]

i PT2
e ==

CE T e Vain Vs Vs e
AINDEX / e \
TIRIGGER / ) \

e Point Trigger: ON, Low Latency: OFF
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Ready for Trigger Indicator (Trigger Ready)

On the VNA, when External is selected on the Trigger Setup tab, then both Meas Trig IN and
Meas Trig Ready are enabled.

Note: The Ready for trigger is available only when the trigger source is set at External.

Choose a connector to send the VNA Ready OUT signal:

e Handler I/O p21
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Choose Polarity of the 'Ready OUT' signal.

e Ready High - TTL High indicates the VNA is ready for trigger. (Not available on
E5080A/B)

e Ready Low - TTL Low indicates the VNA is ready for trigger (default setting).

See Also

e Learn how to External Trigger during Calibration

Satup | Meas Trigger  Aux Trig 1 -.-

External Device Handshake
| supports any triggar sourcs (INT, MAN, EXT) |

" Enable Crannet: |[HENE -
ALK TRIG OUT (To Devica)
Polarity Position
Positive Pulse Before Acquisition
@) Negativa Pulse (@) After Acquisition

Per Point Pulse Duration 1.000 usac H

See how to access the Trigger Dialog

AUX TRIG OUT

See the AUX TRIG (1&2) connectors on the VNA rear-panel. The ES080A/B supports only AUX
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TRIG 1.

These signals are highly configurable. They can be used with all types of external devices to receive
signals.

e The Aux Trig OUT signal can be configured to be sent either just BEFORE the measurement is made or
AFTER the measurement is complete. When communicating ONLY with an external source, the Aux Trig
OUT signal should be sent AFTER the measurement is complete to indicate that the external source can
setup for the next measurement.

Dialog Settings

The Aux Trig 1 and Aux Trig 2 tabs are identical. Two pair of connectors are available to allow two
external devices to be controlled simultaneously.

Enable Check to use the Aux1 or Aux2 connectors to output signals to an external device.

Channel: This setting is controlled by a VNA Preference setting.

e Global - ALL Aux Trig settings apply to ALL channels. The Per Point setting (see below) is made on the
Trigger Setup tab which also applies to ALL channels.

e Channel - ALL Aux Trig settings apply to the specified channel. Each channel can be configured
independently.

AUX TRIG OUT (To Device)

The following settings control the properties of the signals sent out the rear panel AUX TRIG OUT
(1&2) connectors:

Polarity
Positive Pulse Outgoing pulse is positive.
Negative Pulse Outgoing pulse is negative.
Position
Before Acquisition Pulse is sent immediately before data acquisition begins.
After Acquisition Pulse is sent immediately after data acquisition is complete.

Per Point Check to cause a trigger output to be sent for each data point. Clear to send a trigger
output for each sweep.
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When the Aux Trig - "Global" VNA Preference is selected, then the Point setting is made on the
Trigger Setup tab. It then applies to ALL channels. When more than one channel is present, the
channel setting that was made last is used.

Pulse Duration Specifies the duration of the positive or negative output trigger pulse.

See Also

e See how to use these connectors to synchronize with External Sources.

e Pulse Triggering

Note: Guided and Unguided Calibration CAN be performed in External Trigger mode. With this
optional behavior, while Trigger Source is set to External, trigger signals must be sent for
Calibration sweeps. This behavior does not apply to FCA calibrations.

You can set a Preference to calibrate using Internal trigger signals while Trigger Source is set to
External.

The following dialog box appears on the screen while waiting for an External trigger signal.

“Wfaiting for external tigger. .

Click Abort to cancel the wait for a trigger signal.
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Speedometer

D

® Continuous

Groups 5

Single
Hold

Point

Internal Trigger

e

® Continuous

Groups 5

Single
Hold

Point

About the trigger model

Trigger Source

o Internal

Manual !

Trigger Scope
o Global
Channel

® Continuous

Groups 5

Single
Hold

Point

Read Text description of triggering behaviors.

This model does not include Sweep trigger mode.
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Data Format

A data format is the way the analyzer presents measurement data graphically. Pick a data format
appropriate to the information you want to learn about the test device.

e How to set Format

e Rectangular (Cartesian) Display Formats

e Polar

e Smith Chart

See other 'Setup Measurements' topics

How to set the Display Format
Using Hardkey/SoftTab/Softkey Using a mouse
1. Press Format > Format 1 or Format 2. 1. Right-click on the trace status area above the grid box.
2. Click Format.

3. Select the desired format.

Prugramming Commands=s ’
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Format dialog box help

Click a link to learn about that format:

Log Mag Polar
Phase / Unwrapped Phase Linear Mag
Group Delay SWR
Smith / Inverse Smith Chart Real

Imaginary
Format Unit

Only the following Formats allow a Unit selections:

Log Mag - Choose from:

e dBm (Power)

e dBmV (dB milli Volts) - used for unratioed receiver measurements.
e dBmA (dB milli Amps) - used for unratioed receiver measurements.

Lin Mag - Choose from:

o W (Watts), V, (volts), A (amps)

Rectangular Display Formats

Seven of the nine available data formats use a rectangular display to present measurement data. This
display is also known as Cartesian, X/Y, or rectilinear. The rectangular display is especially useful for
clearly displaying frequency response information of your test device.

e Stimulus data (frequency, power, or time) appears on the X-axis, scaled linearly

e Measured data appears on the Y-Axis.

Log Mag (Logarithmic Magnitude) Format

e Displays Magnitude (no phase)
e Y-axis: dB

o Typical measurements:
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o Return Loss
o Insertion Loss or Gain

Phase Format

Measures the phase of a signal relative to the calibration reference plane with a range of +/- 180
degrees.

e Displays Phase (no magnitude)

e Y-axis: Phase (degrees)

e The trace 'wraps' every 180 degrees for easier scaling.
e Typical Measurements:

o Deviation from Linear Phase

Unwrapped Phase

e Same as Phase, but without 180 degree wrapping.

Note: Phase is unwrapped by comparing the phase from one data point to the next. If the phase
difference between two points is greater than 180 degrees, or if the phase of the first data point is
greater than 180 degrees from DC, than the phase measurement is probably NOT accurate.

Positive Phase
Displays the phase wrapped between 0 to +360 degrees.

Group Delay Format

¢ Displays signal transmission (propagation) time through a device
e Y-axis: Time (seconds)
e Typical Measurements:
o Group Delay
See Also:

Group Delay (Measurement)

196



Comparing the analyzer Delay Functions.

Phase Measurement Accuracy

Linear Magnitude Format

e Displays positive values only

e Y-axis: Unitless (U) for ratioed measurements
Watts (W) for unratioed measurements.

e Typical Measurements:
o reflection and transmission coefficients (magnitude)
o time domain transfer

SWR Format

Displays reflection measurement data calculated from the formula (1+p)/ (1-p) where p is reflection
coefficient.

Valid only for reflection measurements.

Y axis: Unitless

Typical Measurements:

o SWR

Real Format

Displays only the real (resistive) portion of the measured complex data.

Can show both positive and negative values.

Y axis: Unitless

Typical Measurements:
o time domain
o auxiliary input voltage signal for service purposes

Imaginary Format
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o Displays only the imaginary (reactive) portion of the measured data.
e Y - axis: Unitless

e Typical Measurements:

o impedance for designing matching network

Polar Format

Polar format is used to view the magnitude and phase of the reflection coefficient (I') from your S11 or
S22 measurement.

You can use Markers to display the following:

e Linear magnitude (in units) or log magnitude (in dB)

e Phase (in degrees)

Reflection
Coefficiert
{/. Magrtud e
Phase Angle of -~ +4 0
Reflected Signa " P - 180
. 001

e The dashed circles represent reflection coefficient. The outermost circle represents a reflection coefficient (T7)
of 1, or total reflected signal. The center of the circle represents a reflection coefficient (I") of 0, or no
reflected signal.

e The radial lines show the phase angle of reflected signal. The right-most position corresponds to zero phase
angle, (that is, the reflected signal is at the same phase as the incident signal). Phase differences of 90°,
+180°, and -90° correspond to the top, left-most, and bottom positions on the polar display, respectively.

Smith Chart Format

The Smith chart is a tool that maps the complex reflection coefficient (I') to the test device's
impedance.
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In a Smith chart, the rectilinear impedance plane is reshaped to form a circular grid, from which the
series resistance and reactance can be read (R + jX).

You can use Markers to display the following:

e Resistance (in units of ohms)

e Reactance as an equivalent capacitance (in units of farads) or inductance (in units of henrys)

Rectilinear Impedanc e Plane
+i

i +Ro —

Inverse Smith Chart (also known as Admittance)

Same as standard Smith Chart , except:

e The plot graticule is reversed right-to-left.

e Admittance (in units of siemens) instead of resistance.

Interpreting the Smith Chart
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e Every point on the Smith Chart represents a complex impedance made up of a real resistance (r) and an
imaginary reactance (r+-jX)

e The horizontal axis (the solid line) is the real portion of the impedance - the resistance. The center of the
horizontal axis always represents the system impedance. To the far right, the value is infinite ohms (open).
To the far left, the value is zero ohms (short)

e The dashed circles that intersect the horizontal axis represent constant resistance.

e The dashed arcs that are tangent to the horizontal axis represent constant reactance.

e The upper half of the Smith chart is the area where the reactive component is positive and therefore
inductive.

e The lower half is the area where the reactive component is negative and therefore capacitive.
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Scale

The Scale, Reference Level and Reference Position settings (along with Format) determine how the data
trace appears on the VNA screen.

e Scale, Reference Level and Position

Scale Coupling

Magnify Mode and Zoom Preference

Electrical Delay (Separate topic)

Magnitude Offset & Magnitude Slope

Phase Offset (Separate topic)

See other 'Setup Measurements' topics

Scale, Reference Level and Position

The Scale, Reference Level and Reference Position settings (along with format) determine how the data
trace appears on the VNA screen.

How to set Scale, Reference Level, and Position

Using Hardkey/SoftTab/Softkey Using a mouse
1. Press Scale > Main > Scale / Reference Level / 1. Right-click on Y-axis annotation or the trace
Reference Position. status label above the grid box.
2. Input the desired value. 2. Select Scale....

Prugramming Commands=s ’

Scale dialog box help
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[ sesle e |

Scale
Per Division 10.000 dB
Autoscale | Autoscale All
Reference
Level 0.000 dB
Paosition 5.00 Div
OK Cancel Help

e, A

Note: The scale settings are set to couple with other traces in each window. The following settings
assume that Scale Coupling is set to OFF. Learn more about Scale Coupling.

Scale

Per Division Sets the value of the vertical divisions of a rectangular display format. In Polar and
Smith Chart formats, scale sets the value of the outer circumference. Range: 0.001dB/div to 500
dB/div.

Tip: Click on the Y-axis labels, then use a mouse scroll wheel to change scale in preset
increments. Or Right-click on Y-axis annotation to change Scale.

Autoscale - Automatically sets value of the vertical divisions and reference value to fit the
ACTIVE data trace within the grid area of the screen. The stimulus values and reference position
are not affected.

The analyzer determines the smallest possible scale factor that will allow all the displayed data to
fit onto 80 percent of the vertical grid.

The reference value is chosen to center the trace on the screen.
Tip: Double click on the Y-axis labels to autoscale the active trace.

Autoscale All Automatically scales ALL data traces in the ACTIVE WINDOW to fit vertically
within the grid area of the screen.

Reference

Level In rectangular formats, sets the value of the reference line, denoted by _ on the
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screen. Range: -500 dB to 500 dB.
In Polar and Smith chart formats, reference level is not applicable.

Tip: Click on the Y-axis labels, then drag up or down to change the reference level in preset
increments.

Position In rectangular formats, sets the position of the reference line. Zero is the bottom line of
the screen and ten is the top line. Default position is five (middle).

In Polar and Smith chart formats, reference position is not applicable.

Tip: Click on the triangle _, then drag up or down to change the reference position in
preset increments.

Scale Coupling

With Scale Coupling enabled, traces that have the same format will have the same Scale, Reference
Level, and Reference Position. You can choose to couple the scale of traces that are in the same
window, couple the scale of all traces in all windows, or to have NO coupling.

How to set Scale Coupling

Using Hardkey/SoftTab/Softkey Using a mouse

1. Press Scale > Main > Scale Coupling.... 1. Right-click on Y-axis annotation.

2. Select Scale Coupling....

Prugramming Commands= }

Scale Coupling dialog box help

203



[ ™,

Scale Coupling X |
Coupling Method

a Off
Window

All : couple between all selected windows

Selected Windows

"
o

OK Cancel Help

L o

Allows traces that share the same format to have the same Scale, Reference Level and Reference
Position.

Coupling Method
Off - No coupling. Traces are scaled individually. Default setting.
Window - All traces with the same format in each selected window share the same scale settings.

All - All traces in ALL selected windows with the same format share the same scale settings.

o When Window or All coupling is enabled, the scale settings for the active trace are assumed by other
coupled traces with the same format.

¢ When there are traces with a different format present, all traces with that format assume the trace
settings of the lowest-numbered trace of that format.

¢ Once enabled, scale settings for all coupled traces with the same format can be changed with any
coupled trace being active.

Selected Windows

Available when either the Window or All method is selected. Selected windows will participate
in scale coupling. All windows are selected by default. Clear a checkbox to 'Opt-out' of scale
coupling for that window.
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About Autoscale and Scale Coupling

Autoscale (not Autoscale All) affects the active trace in the active window. All traces that are
coupled to this trace assume the new scale settings of the active trace. This could cause some
traces to NOT show on the screen.

Autoscale All with Coupling Method...

e Off - All traces in the active window are autoscaled independently.

e Window - All traces in each selected window are autoscaled to fit within a common set
of scaling factors.

e All - All traces in all selected windows are autoscaled to fit within a common set of
scaling factors.

Magnify Mode and Zoom Preference

The magnify feature allows to magnify all traces in the active window. It allows to zoom into a portion
of the display to see the response in detail.

How to magnify the trace

Using Hardkey/SoftTab/Softkey Using a mouse

None
1. Left-click and select the area you want to
magnify

2. Select Magnify from the pop-up menu.

Pru-grannning Commands }

Other methods to set the magnify mode includes:

e When the Zoom Preference is set to Magnify, a 2-finger spread gesture will turn ON the Magnify
mode

e Click on the Magnify icon at the top of the screen
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e Enable the zoom box select mode and drag the zoom box to select an area, and then choose the
Magnify option in the popup menu.

When the Magnify Mode is turned on:

2-finger pinch on the display changes the x and y magnification. If magnification is pinched down to
1:1 scaling, the magnify mode will be turned off.

1-finger drag across display changes the reference of the magnified x and y.

Zoom Preference Dialog Box Help

Zoom Preference allows you to decide the default operation of the 2-finger pinch gesture, from these
4 choices:

2-finger pinch automatically turns on magnify mode so that x and y-axis can be magnified/ This is
the default setting.

2-finger pinch changes y-axis scale.
2-finger pinch changes y-axis scale and x-axis stimulus.

2-finger pinch does nothing.

Magnitude Offset

Magnitude Offset allows you to offset the magnitude (not phase) data by a fixed and / or sloped value
in dB. If the display format is Linear Magnitude or Real (unitless), the conversion from dB is
performed and the correct amount of offset is implemented.

How to set Magnitude Offset

Using Hardkey/SoftTab/Softkey

1. Press Scale > Constants > Mag Offset / Mag Slope.

Pru-grannning Commands }
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Magnitude Offset dialog box help

Magnitude Offset allows you to offset the magnitude (not phase) data by a fixed and / or sloped
value in dB. If the display format is Linear Magnitude or Real (unitless), the conversion from dB is
performed and the correct amount of offset is implemented.

The Magnitude offset setting affects only the active trace.
Mag Offset Offsets the entire data trace by the specified value.

Mag Slope Offsets the data trace by a value that changes with frequency. The offset slope begins at
0 Hz.

For your convenience, the offset value at the start frequency is calculated and displayed.
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Receiver Gain

MO938xA/P50xxA and E5080B can fix the receiver gain. When the receiver gain is lower than
expected, for example due to an unexpected spurious signal, this function allows you to fix the gain
level to improve the dynamic range. The measurement speed is almost the same even if the range is
fixed.

How to make Receiver Gain settings

Use one of the following methods to set port power. The softkey is available on standard
measurement class only.

Using Hardkey/SoftTab/Softkey Using a mouse
1. Press Setup > Internal Hardware > 1. Click Instrument > Setup > Internal Hardware>
Receiver Gain.... Internal Hardware > Receiver Gain...

Prugramming Commands= }

The M938xA/P50xxA and ES080B have the independent error terms for high and low receiver settings.

In Auto, the analyzer measures the error terms for both high and low settings automatically SeeCal Set
Viewer.

Receiver Gain dialog box help

ﬁ' Receiver Gain: Channel [

Source Port | Receiver Port

Port1 Port 2
I Port 1 Auto Auto
Port 2 Auto Auto

Set All Gains "1 { Ok ‘ Cancel

This dialog provides basic control receiver for a specific port.

This table consists of source port rows and receiver port columns. Each cell is corresponded to
measurements in the active channel. (e.g. ‘Receiver port 1 — Source port 3 is corresponded to S13,
al,3 and bl,3.)
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The each cell sets the setting by the following drop down list.
e Auto - (Default) Receiver gain is controlled automatically for each measurement points
according to the input signal level.
e High - Fix the gain setting at high
e Low - Fix the gain setting at low

Set All Gains - Sets all cells at one time.

Receiver Gain for Segment Sweep dialog box help

Tl

8 | Receiver Gain: Channel 1

|Segment 1: 9 KHz - 1 MHz

Source Port | Receiver Port
Port 1 Port 2

Port 1 ?ﬂutn Auto
Port 2 Auto Auto

Set All Gains | Help

| (0].4 ‘ Cancel

This dialog provides basic control receiver gain of the specified segment for a specific port in the
segment sweep. The receiver gain in Segment Table dialog box should be turned on, then click Edit
under Rev Gain column in the Segment Table,

Select your required segment to define the setup in the selection at the top of dialog box.

This table consists of source port rows and receiver port columns. Each cell is corresponded to
measurements in the active channel. (e.g. ‘Receiver port 1 — Source port 3’ is corresponded to S13,
al,3 and bl,3.)

The each cell sets the setting by the following drop down list.

e Auto - (Default) Receiver gain is controlled automatically for each measurement points
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according to the input signal level.
High - Fix the gain setting at high

Low - Fix the gain setting at low

Set All Gains - Sets all cells at one time.
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Customize the Analyzer Screen

You can customize your analyzer screen by showing or hiding the following display elements. All of
these selections are made from the Response > Display menu.

¢ Windows (Separate topic)

Display Labels
o Trace Status
e Y-axis Labels

o X-axis Labels

Marker Display (Separate topic)

Tables

Toolbars

e Softkey

e Hardkey

e Port Extension

e Transform

o Marker

e Cal Set Viewer

e Title Bars

o Active Entry

e Status bars

e System Date and Time
e Display Colors (Separate topic)
e Grid: SOLID | Dotted

e Grid Lines
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e Y-axis Divisions
e Show Table

e Tools

e Colors

e Window Title

e Trace Title

e Frequency/Stimulus

Minimize Application
See Also

Traces, Channels, and Windows

See other 'Setup Measurements' topics

Labels

You can display different labels for traces status, Y-axis and X-axis labels.

How to display labels

Using Hardkey /SoftTab /Softkey Using a mouse
1. Press Display > Display Setup > Customize Display... . 1. Right click on any window area.
2. Select Labels tab. 2. Click Customize Display... .
OR 3. Select Labels tab.

1. Press Marker > Marker Setup > Marker Display... .

2. Select Labels tab.

Pru-gra.mming Commands ’

Labels tab Dialog Box Help
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-

Customize Display ﬁ

Labels | Markers | Grid Toolbars ‘ Tools

Colors ==

Show Labels
¥ Trace Stalus
+ Y-aoas Labels

¥ X-axis Labels

0K | Cancel Apply fl Help

o

Show Labels

Trace Status

Tr 1 511 Logh 10.00dB/ 0.00dB 512 Logh 10.00dB/ 0.00dB

Trace status is annotated at the top of each window.
The highlighted trace number indicates Active Trace .
Click the title to select a trace.

Trace Status shows the following:

e Trace number (Tr x). This is the trace number of the channel; NOT the window trace number which is
used in many programming commands.

o Measurement parameter. This can be replaced with a custom Trace Title .

e Format

e Scaling factor
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e Reference level

How to show/hide Trace Status.

Y-axis Labels

" Y-axis Labels " - allows user to show or hide the y-axis labels.

How to show/hide Y-axis Labels.

X-axis Labels

>Ch1: Start 100.000 kHz — Stop 9.00000 GHz

"X-axis Freq Resolution " - allows user to choose the resolution of the frequency display. The pull
down selects: 6-digit, GHz, MHz, kHz, Hz. It shows 1Hz resolution, but only shows significant
digits.
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How to show/hide X-axis Labels.

Grid
How to set VNA Grid and display tables.

Each window can display only one table at a time.

Using Hardkey /SoftTab /Softkey Using a mouse
1. Press Display > Display Setup > Customize 1. Right click on any window area.
Display...

2. Click Customize Display... .
2. Select Grid tab.
3. Select Grid tab.

OR
1. Press Marker > Marker Setup > Marker
Display... .

2. Select Grid tab.

Prugramming Commands }
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Labels | Markers | Grid Toolbars | Tools | Colors -w-
Grid Lines [sm ..]
Y-ais Divisions |10 -

Show Table |None

Grid Lines: Solid | Dotted - Set whether to display ALL open window grid lines in solid or dotted
lines. The selected setting is shown in CAPS. Once set, new windows are created using this setting.
Grid lines return to SOLID when the VNA is Preset.

Set the color of the grid using Display Colors.

How to display grid settings

Y-axis Divisions - Set the desired rows of Y-axis, it can shows 2 to 30.

Show Table

None - Turn OFF the table.
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Marker Table

You can display a table of marker settings. These settings include the:

Marker number

Marker reference (for delta measurements)

Frequency

Time and Distance (for Time Domain measurements)

e Response

Learn more about Markers

Limit Line Table

You can display, set up, and modify a table of limit test settings. These include:

e Type (MIN, MAX, or OFF)
e Beginning and ending stimulus values

e Beginning and ending response values

Learn more about Limit Lines .

Ripple Table

You can display, set up, and modify a table of maximum ripple limit over frequency range
settings. These include:

e Type (ON or OFF)
e Beginning stimulus value
e Ending stimulus value

e Maximum ripple

Learn more about Ripple limits .
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Segment Sweep Table

You can display, set up, and modify a table of segment sweep settings. These include:

e State (On/Off)

e Start and Stop frequencies

e Number of Points

e |F Bandwidth (if independent levels)
e Power Level (if independent levels)

e Sweep Time (if independent levels)

Learn more about Segment Sweep .

Distortion Table

You can display,set up, and modify a table of modulation distortion measurement
parameters. Each row represents a measurement band. Each column represents a
measurement parameter.

Learn more about the Distortion Table.

Toolbars

You can display different toolbars to allow you to easily set up and modify measurements.
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How to display Toolbars

Using Hardkey /SoftTab /Softkey Using a mouse

1. Press Display > Display Setup > Customize
Display...

2. Select Toolbars tab.

OR

1. Press Marker > Marker Setup > Marker
Display... .

2. Select Toolbars tab.

Labels | Markers i Toolbars | Tools

1. Right click on any window area.
2. Click Customize Display... .

3. Select Toolbars tab.

Show Toolbars Other Bars
7] Softkey Main Title Bar
Hardkey Menu Bar

Port Extensions [¥] Active Entry Toolbar
Transform V| Status Bar
Marker 2 Bars
Cal Set Viewer VI Clock
Display Sheet Tabs
@ Top

) Bottom

Show Toolbar
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Note: There is also a Cal Set toolbar available for Monitoring Error Terms

Softkey

Display

Softkey is a combination of softkeys and SoftTabs. Softkeys are automatically turned ON when one
of the 'function' hardkeys is pressed. This setting allows you to turn the softkeys OFF to show more
measurement space on the screen. The softkeys will reappear when another function hardkey is

pressed.

Hardkey
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Hardkeys | X
Insbrument
E
E
Response

These keys also known as Front Keys, perform interface operations that are equivalent to those of
keys in the INSTRUMENT keys, RESPONSE keys, STIMULUS keys and UTILITY keys on the
front panel of VNA. Learn more.

Port Extensions Toolbar
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|| Port Extension  Dist  0.000000 jm El’r Loss1 DudB :. @Freql 1000 GHz ﬂ Usal Auto Port Ext..
[Poti ] Time 0000000ps  [/T] Loss2 OpcB [2] eFreqz 10mar: 2] juse 2] |ix

The Port Extension toolbar allows you to set Port Extensions while viewing the measurement trace.
Learn more about Port Extensions .

Transform (Time Domain) Toolbar

Transigm ] Gaang lTransfqrmSHrﬂSmp vJ -10.000000 nzec ? 10000000 nzec m .h,k_-.rem . T . _'-‘.l

The Time Domain toolbar allows you to do the following:

Turn Transform and Gating ON/OFF.

Change the Start/Stop times for both Transform and Gating.

More... - Launches the Time Domain Transform dialog box.

? - Display the help file.

X - Closes the toolbar.

Markers Toolbar

Marker L | Won Sm +Sﬂﬂﬂsummel-ﬂ |Deltn | b | Min | | start |[ Stop |.Ember- ﬂ

The markers toolbar allows you to set up and modify markers. It shows:

e Marker number
¢ Stimulation value
e Marker functions:
o Delta
o Max/Min
o Start/Stop

o Center/Span
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Tip: To use the Front Panel Knob to change marker position, first click the Stimulus field of the
marker toolbar and then turn the knob.

Learn more about Markers

Cal Set Viewer Toolbar

Cal Sets Display: '@ Errar Terms Standards

[caiset 1 v| [crossTanin,2) = Ensble | x |

Learn more about Cal Set Viewer .
All Off (NOT on softkeys)

This allows you to hide all toolbars with a single selection. NOT available on sofkeys.

Other Bars

Main Title

r
8 Network Analyzer = &1

The Main Title shows the title of VNA window and Minimize / Maximize icons.

e ¥ Checked - Title bars for all VNA window are shown.

e [ Cleared - Title bars for all VNA window are hidden. This allows more room to display measurement
results.

Active Entry Toolbar
e v B

When used with softkeys, this area allows numeric values to be entered for settings. From the
keyboard, enter G for Giga, M for Mega or milli, K for kilo and so forth.

Status Bar

2 Bars
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Trl | Ch1 || IniTrig | Meas | BW=100k | Mo Cor
RFOn | UpdateOn | IntRed  no messages LCL | 2atanin-1n

When enabled, the status bar is displayed along the bottom of the VNA screen. The primary status
bar shows the following:

Tip: Right-click on many of these items in the status bar for quick access to settings.

e Active trace

e Active channel

e Trigger source

e Channel Trigger State (Hold, Single, Continuous)

¢ |F Bandwidth

o Error correction for the active trace to the Basic cal, Smart cal and Calibrate All Channels.
e F: Full Port Calibration, R: Response Calibration, -: Nothing

e Reference (Internal/ External )

e Source Power Calibration

e Service

e RF power

e Display Update

e Error messages

e GPIB status : Local (LCL), Remote Talker Listener (RMT), or System Controller (CTL).

e System Date and Time - Can be set ON or OFF. How to show/hide the VNA clock.

Note: A second level status bar appears when using External Test Set Control or Interface control.

The status bar state (ON or OFF) will not change when the VNA is Preset.

Clock (System Date and Time)

The VNA system date and time can be shown in the far right corner of the status bar.
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The format is: year-month-day hr:min and can NOT be changed.
To hide the clock, right click the mouse on the clock and then click Hide Clock .

Learn how to set the VNA time settings.

Display Sheet Tabs
Top - Display sheet tabs above display.

Bottom - Display sheet tabs below display.

Tools

How to set Tools settings

Using Hardkey /SoftTab /Softkey Using a mouse
1. Press Display > Display Setup > Customize 1. Right click on any window area.
Display...

2. Click Customize Display... .
2. Select Tools tab.
3. Select Tools tab.

OR

1. Press Marker > Marker Setup > Marker
Display... .

2. Select Tools tab.

Prugramming Commands= }

Tools Dialog Box Help
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Sl )

Labels | Markers | Grid | Toolbars | Toels | Colors ‘-
Tool Active Entry

- ] unde |

Mew Window Redo

Mew Channel Screenshot

Mew Trace - Window E] Mew Trace
Mew Sheeat Mew Channel + Window

New Trace + Sheet Dalete

New Channel + Sheet
Home

Help

Preference

Tile Windows Sofkey _

Manage Files Eih-:r-.-.- Task Bar

Minimize Application Favornte

Magnify 3>

About Metwork Anahyzer

e |

—

Tools function to create a shortcut icon to display on Active Entry or Softkey Toolbar. The
maximum icons can display on Active Entry is 9, while Softkey Toolbar is 12.

New Window - Create a new window.

New Channel - Create a new channel on active window.

New Channel + Window - Create a new trace and channel to a new window.
o

New Trace - Create a new trace on active window.
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New Trace + Window - Create a new trace to a new window, but the channel is remain.

E

New Sheet - Create a new sheet.

+!

-

New Trace + Sheet - Create a new trace to a new sheet, but the channel is remain.

®

New Channel + Sheet - Create a new trace and channel to a new sheet.

B

Home - Display VNA Home softkeys.

Ty
™

Favorite - Set favorite application. To Add a Favorite, press and hold any softkey for three seconds
and select the desired Favorite number (Favorite 1 to 3).

*

Help - Shows Help file.

o

Show Task Bar - Shows Window bar.

L

Preference - Display preference dialog box.
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Tile Windows

—

Manages Files - Use to manage the saved files in the "D:\" drive folder. Learn more.

Minimize Application - Restore VNA screen. Learn more.

I

About Network Analyzer - Display About Network Analyzer dialog box.

o

Undo - Recover to previous version. Learn more.

9

Redo - Set to latest version. Learn more.

A

Screenshot - Save screen figure to "D:\" drive (D:\).

Delete - Delete the active window.

=
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Colors

How to set colors

Using Hardkey /SoftTab /Softkey Using a mouse
1. Press Display > Display Setup > Customize 1. Right click on any window area.
Display...

2. Click Customize Display... .

2. Select Colors tab.

3. Select Colors tab.

Labels | Markers | Grid Toolbars | Tools | Colors .‘.’.
Menu Color Theme [Dﬂad‘t -
| Display Colors... ]
| PrntColors.. |
ok || cancel Apply | [ Help

Menu Color Theme - Select color theme
Display Colors... - See Display Colors

Print Colors... - See Print Preview
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Window Title

You can create and display a title for each window.

e The limit is set by the number of windows that are displayed.

e The title (My Window) is annotated in the upper-left of the window as follows:

$11 LogM 10.00dB/ 0.00dB

Window 1

How to enter a Window Title

Using Hardkey /SoftTab /Softkey Using a mouse
1. Press Display > Window Setup > Window 1. Move a cursor in the grid and then right click.
Title... .
2. Select Title... .

Prugramming Commands=s ’

Window Title Dialog Box Help

e

I Window Title

Title: Window 1 Keyboard

[ OK J Cancel | Help |

1. Click Enable , then type the window title. Click Keyboard to type with a mouse.

2. To remove the window title, clear the Enable checkbox or delete the text from the dialog entry.

Trace Title

A Trace Title overwrites the Measurement Parameter in the Trace Status area, the Status Bar and
hardcopy prints .

e This title has priority over Equation Editor titles.
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e The practical limit is about 70 characters if there is only one trace.
e Spaces are accepted but not displayed; use underscores.

e The title is annotated as follows:

AN Trace AlegM 10.00dB/ 0.00dB

How to enter a Trace Title
Using Hardkey /SoftTab /Softkey Using a mouse

1. Press Trace > Trace Setup > Trace Title... . 1. Move a cursor in the grid and then right click.

2. Select Trace Title... .
Prugramming Commands=s }

Trace Title Dialog Box Help
¥| Enable

Titlg: Trace A Keyboard

[ oK ~ Cancel | Help |

1. Click Enable , then type the window title. Click Keyboard to type with a mouse.

2. Toremove the window title, clear the Enable checkbox or delete the text from the dialog entry.

Frequency/Stimulus

=Ch1: Start 100.000 kHz — Stop 9.00000 GH=z

Frequency/stimulus information is displayed at the bottom of each window on the screen. It shows:

e Channel number
e Start value

e Stop value
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How to show/hide Frequency/Stimulus information

Minimize Application

The Network Analyzer application can be minimized to show the desktop and Windows taskbar.

1. Click System > Main > Minimize Application .

To restore the VNA application, double-click the VNA application on the desktop.
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Copy Channels

Copy channels allows you to make a duplicate channel with the same stimulus conditions as an existing
channel.

e Why Copy Channels

e How to Copy Channels

e List of Channel Settings

Other Setup Measurements Topics

Why Copy Channels
Copy channel settings if you need to create several channels that have slightly different settings.

For example, if you have an amplifier that you want to characterize over a frequency span with several
different input power levels.

Follow these steps:

1. Create one measurement with your optimized channel settings.
2. Copy that channel to new channels.

3. Change the power level on the new channels.

The alternative to using Copy Channels is to create new default measurements on new channels. Then
change every channel setting to your new requirement. This is very time consuming and thus shows the
benefit of the Copy Channels feature.

How to Copy Channels
Using Hardkey/SoftTab/Softkey
1. Press Channel > Channel Setup > Copy Channel.

2. Click Copy to Active Window/Copy to New Window/Copy Channel....

Pru-grannning Commands }
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Copy Channel dialog box help

" Copy Channel e

Copy channel: | 4 'r| Te: | -
3 =
@ Channal Stimulus 4
7
Channal State [ L
OK Cancel Help

Copies an existing channel's settings to another channel. Measurement traces from the source
channel are NOT copied.

Copy channel (also known as 'Source' channel): Select a channel to copy.

to (also known as 'Destination’ channel): Scroll to select a channel to copy settings to. Compatible
channel numbers that are currently being used are highlighted. They can be selected and
overwritten.

The following are compatible destination channels:

¢ A channel that does not yet exist. The new channel is created with the channel's default measurement.

e A channel that contains no measurements. Again, the destination channel is created with the channel's
default measurement.

Notes:

e You can copy channel settings to ONLY one new or existing channel. Repeat this operation to copy to
more than one channel.

e The source channel is ALWAYS copied to the Active window. If you want the destination channel in a
separate window, first create a compatible new measurement in a new window. Then make sure it is the

Active window before you copy the channel into it.

e The measurement in the destination channel becomes the active measurement.

For example:

1. Source channel 1: Standard S21 measurement
2. Destination NEW channel 2

3. Result: Source channel 1, S21 Measurement AND channel 2, S11 measurement. Both with same
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stimulus settings and in the same window. Channel 2, S11 measurement is the active measurement.

For more information see Traces, Channels, and Windows

List of Channel Settings

e Frequency Span
e Power

e Cal Set usage

e |F Bandwidth

¢ Number of Points
e Sweep Settings
e Average

e Trigger (some settings)
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DC Source Control

Note: The ES080A does not support this function.

When a DC Source (power supply) is configured as an external device, the new DC source can be
controlled from the VNA using this dialog. Internal DC Sources are also controlled from this dialog.

e How to start the DC Source Control dialog
e The DC Source Control dialog box
e The DC Limits dialog box

See Also

Configure the DC Source as an External Device

Internal DC Sources - ADC Measurements

Other Setup Measurements Topics

How to start the DC Source Control dialog
Using Hardkey/SoftTab/Softkey Using a mouse
1. Press Sweep > Source Control > DC Source.... 1. Click Stimulus.
2. Select Sweep.
3. Select Source Control.

4. Select DC Source.

Prugramming Commands= }
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DC Source Control dialog box help

*  DC Source En

+ Enable DG Cutputs (A8l Channelds )

Name  |State |start DC Stop DC |
AuxOutl jOFF 0500V 1000 W
AuxOut2 | OFF 0,500 v 1,000 W

Limits_..

QK Hulg

Name Lists the names of the configured DC Sources. In the above image:

e AuxOut1 and AuxOut2 are internal VNA DC sources that are available

e Analog Out 1 and 2 in rear panel

o MyDCSupply is the name of an external DC Source. Learn how to setup and configure an External DC
Source and DC Meter.

State Set the state of the DC source.

e ON DC Source is always ON.

e OFF DC source is always OFF.

o Per Port The Name selection for that DC source expands to allow an Port <n>/ N/A setting for each
VNA port. When the RF source for that port <n> is ON, then the DC source for port <n> is also ON.
Select 'N/A' to turn the DC Source OFF for that port.

Start / Stop DC Set the start and stop voltages of the DC source. The VNA will step the voltage
of the DC source from Start to Stop in increments = (Stop - Start)/Number of data points.

Buttons
Limits Click to start the DC Limits dialog.

Receiver Leveling For future use.
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D Limit
Marse state | Min M
ADL o 10000 10000 ¥
ADZ o =D W N0 i Y
DC Sparce  OH 000 ¥ 10 0
oo | ca |

Select the Minimum and Maximum voltages to which the specified DC sources can be set by the
VNA. When the DC source level exceeds the limit, DC source is turned off and the measurement
sweep stops.

See the Interface Control.
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ADC Measurements

New Trace (ADC) dialog box help

On the New Trace dialog, click the Receivers tab.
Activate - check any empty line to create a trace.

Numerator - select from the following:

e Alx -Input x: xis Input No.
Denominator - NOT available (ONLY unratioed measurements)

Source Port - The ADC receiver is measured when the specified source port is sweeping. Select
None to always measure the ADC receiver.

Analog IN Range

Analog In Range can be set at Meas > Auxiliary. > AuxInN Range. (ESO80A only)

ADC receiver traces are labeled as shown in the following images:

A 10.00dB/ 0.00dB

e The ADC1 input is being measured, with 2 as the source port.
e TheY axis is U (unitless).

e The default trace format is Real (linear).

ADC Traces and other useful VNA functions
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Although most VNA functions work with ADC traces, the following may be especially useful.

e Equation Editor can be used with the trace data. Although the VNA ADC is measuring voltage , by using a
trace formula, this voltage can represent other types of measurement parameters (such as current,
temperature, or a scaled voltage). See PAE example.

e Trace averaging and Trace Smoothing can be used to remove trace noise.

e Dwell time can be used to allow for settling.

VNA Functions Not Supported

e Calibration for ADC receivers is NOT supported.

e Not supported in Noise Figure application
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Undo/Redo Settings

If you make an incorrect setting, you can quickly recover by selecting Undo. If you then incorrectly
Undo a setting, you can Redo the undone setting.

e Undo and Redo applies ONLY to selected settings.

e The Undo stack remembers 16 levels of Undo-able settings.

How to Undo or Redo a setting

Tips:

e Click or touch the Undo and Redo Icons:

Undo Redo

e With a mouse, right-click on the Softkeys or on the Entry toolbar.

e With a keyboard:

e Undo....Ctrl+Z

e Redo....Ctrl+Y
Using Hardkey/SoftTablSoftkey =~ Using a mouse

1. Press Undo > Main. 1. Click Undo and Redo Icons on Active Entry or Softkey Toolbar.

2. Click Undo or Redo.
SCPI and COM programming and Undo/Redo:

e There are NO Programming commands to invoke Undo/Redo
e Programing commands are NOT Undo-able.

e The Undo stack is cleared when programming commands are sent to the VNA.

Return To Task
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To return to the previous task, press Undo > Main > Return To Task.

Clear Undo History

To clear the Undo stack, press Undo > Main > Clear Undo History.

Undo and Security

e Undo/Redo is disabled with High and Extra security levels. Learn more.

o State files that are saved for Undo/Redo purposes (for example: Preset) are deleted when any of the
following occur:

e The Security level is changed

e The Network Analyzer App is started or closed.

Selected Undo-able settings

You can Undo or Redo the following settings:

Note: There are several settings that are NOT Undo-able. Because of this, when you attempt to Undo a
long sequence of operations, it is unlikely that the original state can be recreated exactly.

Preset

e File Recall

e Frequency Settings

e Turn off Marker and Marker All OFF

e Number of Points

e Power Level - most applications and S-parameters
e Turn OFF Channel

e Close Window

e New Channel , new Window, and new Trace.

o Delete Trace

e Window Tile

e Change Layout (1x, 2x, 3x, 4x)
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Move Trace, Drag Trace

Zoom XY, Zoom Out Full

Autoscale All, Autoscale

Scale, Reference Level, Reference Position

Scale Coupling dialog

Electrical Delay

Phase Offset

Measurement Setups dialog

Format

Sweep Type

Data->Memory

Single Marker Searches (Max, Min, Target, Peak...)
Multi-marker Searches (Bandwidth, Power Saturation, Normal Operating Pt)
Change a Marker’s stimulus value: softkeys, dialog or drag
Change cell in Segment Table

Mechanical Settings dialog
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Optimize Measurements

A measurement has many interdependent settings. You can modify the settings to achieve the goals of
your measurement application: faster throughput or greater measurement accuracy.

Increase Measurement Throughput

e Achieve Fastest Sweep
e Switch Between Multiple Measurements
e Data Transfer Speed

e Using Macros

Improve Measurement Accuracy

¢ Increase Dynamic Range
e Reduce Noise

e Averaging

e IFBW

e Smoothing

e Group Delay (Separate Topic)

e |mprove Phase Measurement Accuracy

e Improve Accuracy for Electrically Long Devices

e Improve Reflection Accuracy on Low-Loss 2-Port Devices
e Increase Measurement Stability

e Decrease Receiver Crosstalk

e Reduce the Effects of Test Accessories

e Reduce the unnecessary image response (Shift LO)

Caution: Avoid expensive repairs to your analyzer. Read Electrostatic Discharge Protection.
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Dynamic Range

Dynamic range is the difference between the analyzer receiver's maximum input power and the
minimum measurable power (noise floor). For a measurement to be valid, input signals must be within
these boundaries.

Increasing dynamic range is important if you need to measure very large variations in signal amplitude,
such as filter bandpass and rejection. The dynamic range is shown below for an example measurement.

-

Input signals must beowithin these
boundaries for a vald
measurenment

Chnamic
Fange

To help reduce measurement uncertainty, the analyzer dynamic range should be greater than the
response that the DUT exhibits. For example, measurement accuracy is increased when the DUT
response is at least 10 dB above the noise floor. The following methods can help you increase the
dynamic range.

e |ncrease the Device Input Power

e Reduce the Receiver Noise Floor

Other topics about Optimizing Measurements

Increase Device Input Power

Increase the DUT input power so that the analyzer can more accurately detect and measure the DUT
output power. However, use caution - too much power can damage the analyzer receiver or cause
compression distortion.

Caution! Receiver input damage level: +15 dBm.
See how to increase input power to the device

Tip: You can further increase dynamic range by using an external booster amplifier to increase the input
power to the DUT. See High Power Amplifier Measurements.
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Reduce the Receiver Noise Floor

You can use the following techniques to lower the noise floor and increase the analyzer's dynamic range.

e Reduce crosstalk between the VNA receivers when measuring signals close to the noise floor. See Receiver
Crosstalk.)

e Use Sweep Averaging - learn more about Sweep Average
e Reduce the IF Bandwidth - learn more about IF Bandwidth.

e In Segment sweep mode each segment can have its own IF bandwidth. For example, when measuring a
filter:

¢ In the passband, the IF bandwidth can be set wider for a fast sweep rate, as long as high-level trace
noise is kept sufficiently small.

¢ In the reject band, where noise floor contributes significantly to measurement error, the IF bandwidth
can be set low enough to achieve the desired reduction in average noise level.
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Number of Points

A data point is a sample of data representing a measurement at a single stimulus value. You can specify
the number of data points that the analyzer measures across a sweep. (A "sweep" is a series of
consecutive data point measurements, taken over a sequence of stimulus values.)

The analyzer sweep time changes proportionally with the number of points. However, the overall
measurement cycle time does not. See Technical Specifications for more information on how the number
of points, and other settings, affect the sweep time.

How to change the number of data points

Select a number or click Custom to invoke a dialog box
Using Hardkey/SoftTablSoftkey

1. Press Sweep > Main > Number of Points.

Prugramming Commands= }

Number of Points dialog box help

Specifies the number of data points that the analyzer gathers during a measurement sweep. You can
specify any number from 1 to 100,003. The default value is 201.

Two data points are required for Time Domain.

Tips:

To achieve the greatest trace resolution, use the maximum number of data points.

e For faster throughput use the smallest number of data points that will give you acceptable resolution.

¢ To find an optimized number of points, look for a value where there is not a significant difference in the
measurement when you increase the number of points.

e To ensure an accurate measurement calibration, perform the calibration with the same number of points
that will be used for the measurement.

The number of points is the number of data items collected in one sweep. It can be set for each
channel independently.

¢ To obtain a higher trace resolution against the stimulus value, choose a larger value for number of points.
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e To obtain higher throughput, keep the number of points to a smaller value within an allowable trace
resolution.

¢ To obtain higher measurement accuracy after calibration, perform calibration using the same number of
points as in actual measurements.
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Phase Measurement Accuracy

You can increase the accuracy of phase measurements by using the following features

e Electrical Delay

e Phase Offset

e Spacing Between Frequency Points (Aliasing)
See Also

Port Extensions

Comparing the Delay Functions

Learn more about Phase measurements

Electrical Delay
Electrical delay is a mathematical function that simulates a variable length of lossless transmission line.

Use the electrical delay feature to compensate for the linear phase shift through a device. This feature allows you to look at
only the deviation from linear phase of the device.

You can set the electrical delay independently for each measurement trace.

How to set Electrical Delay

Using Hardkey/SoftTablSoftkey

1. Press Scale > Electrical Delay.

Prcl-gra.mming Command= ’
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Electrical Delay dialog box help

Electrical Delay Specifies the value of delay added or removed, in Time or Distance. This compensates
for the linear phase shift through a device. You can set the electrical delay independently for each measurement trace.

Velocity Factor Specifies the velocity factor that applies to the medium of the device that was
inserted after the measurement calibration. The value for a polyethylene dielectric cable is 0.66 and
0.7 for PTFE dielectric. 1.0 corresponds to the speed of light in a vacuum.

Velocity factor can also be set from the Port Extensions dialog and Time Domain Distance Marker
Settings.

Softkey Display Allows you to enter delay in either Time or Distance using the softkeys and Active
Entry toolbar.

Delay Distance Changes the value when the Delay Time or Delay Distance values are changed.

Distance Units Select from Meters, Inches, or Feet. The step size will not change automatically
when this value is changed.

Media
Coax Select if the added length is coax. Also specify the velocity factor of the coax.

Waveguide Select if the added length is waveguide. Also specify the low frequency cutoff of the
waveguide.

Cutoff Freq Low frequency cutoff of the waveguide.

Learn about Electrical Delay (scroll up)

Phase Offset

Phase offset mathematically adjusts the phase measurement by a specified amount, up to 360°. Use this
feature in the following ways:

e Improve the display of a phase measurement. This is similar to the way you would change the reference
level in an amplitude measurement. Change the phase response to center or align the response on the
screen.

e Emulate a projected phase shift in your measurement. For example, if you know that you need to add a

cable and that the length of that cable will add a certain phase shift to your measurement, you can use phase
offset to add that amount and simulate the complete device measurement.
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How to set Phase Offset

Using Hardkey/SoftTablSoftkey

1. Press Scale > Constants > Phase Offset.

Prugramming Commands= }

Phase Offset dialog box help
Phase Offset Type a value or use the up and down arrows to select any value up to 360 degrees.

Learn about Phase Offset (scroll up)

Spacing Between Frequency Points (Aliasing)

The analyzer samples data at discrete frequency points, then connects the points, creating a trace on the
screen.

If the phase shift through a device is >180° between adjacent frequency points, the display can look like
the phase slope is reversed. This is because the data is undersampled and aliasing is occurring.

If you are measuring group delay and the slope of the phase is reversed, then the group delay will
change sign. For example, the following graphic shows a measurement of a SAW bandpass filter.

e The left measurement has 51 points and indicates the group delay is negative, which is a physical
impossibility. That is, the response is below 0 seconds reference line.

e The right measurement shows an increase to 201 points which indicates the group delay is positive. That is,
the response is above the 0 seconds reference line.

51 Point Trace Ref= | | 201 Point Trace |
DSE?DMB i Delay
Delay \ / m_. 5
\ Appears | | !
‘v\ Megative g:;‘h nd.r"'_
I TV TRV 1F
T A A e |

RV TV YA T |
NIA L AL A LU R |
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Tip: To check if aliasing might be occurring in a measurement, either increase the number of points or
reduce the frequency span.
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Electrically-Long Device Measurements

A signal coming out of a device under test may not be exactly the same frequency as the signal going in
to a device at a given instant in time. This can sometimes lead to inaccurate measurement results. You
can choose between two techniques to eliminate this situation and increase measurement accuracy.

e Why Device Delay May Create Inaccurate Results

e Solutions to Increase Measurement Accuracy

e Slow the Sweep Speed

Other topics about Optimizing Measurements

Why Device Delay May Create Inaccurate Results
The following graphic shows an example of this situation:
¢ In the network analyzer, the source and receiver are locked together and sweep simultaneously
through a span of frequencies.
e The signal flow through the Device Under Test (DUT) is shown as different colors for different frequencies.

e You can see as a stimulus frequency travels through the DUT, the analyzer tunes to a new frequency just
before the signal arrives at the receiver. This causes inaccurate measurement results.

il f
SOURCE RECEIVER

s

NN DUT Hmmm

If the analyzer is measuring a long cable, the signal frequency at the end of the cable will lag behind the network analyzer
source frequency. If the frequency shift is appreciable compared to the network analyzer's IF bandwidth (typically a
few kHz), then the measured result will be in error by the rolloff of the IF filter.

Note: There is no fixed electrical length of a device where this becomes an issue. This is because there
are many variables that lead to measurement speed. When high measurement accuracy is critical, lower
the sweep speed until measurement results no longer change.
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Solutions to Increase Measurement Accuracy
Choose from the following methods to compensate for the time delay of an electrically long device.
Slow the Sweep Speed

The following methods will slow the sweep speed.

Increase the Sweep Time

Increase the Number of Points

Use Stepped Sweep

Set Dwell Time
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Reflection Accuracy on Low-Loss 2-Port Devices

To make accurate reflection measurements that have a 1-port calibration, you should terminate the
unmeasured port.

o Why Terminate the Unmeasured Port

e How to Terminate the Unmeasured Port

e Resulting Measurement Uncertainty

Other topics about Optimizing Measurements

Why Terminate the Unmeasured Port

A 2-port calibration corrects for all 12 twelve error terms. A 1-port calibration corrects for directivity,
source match and frequency response, but not load match. Therefore, for highest accuracy, you must
make the load match error as small as possible. This especially applies for low-loss, bi-directional
devices such as filter passbands and cables. You do not need to be concerned with load match when
you are measuring a device with high reverse isolation, such as an amplifier.

How to Terminate the Unmeasured Port

Use one of the following methods:

e Connect a high-quality termination load (from a calibration kit, for example) to the unmeasured port of your
device. This technique yields measurement accuracy close to that of a Full SOLT 2-port calibration.

e Connect the unmeasured port of your device directly to the analyzer, inserting a 10 dB precision attenuator

between the device output and the analyzer. This improves the effective load match of the analyzer by
approximately twice the value of the attenuator, or 20 dB.
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Resulting Measurement Uncertainty

The following graph illustrates the measurement uncertainty that results from terminating with and
without a precision 10 dB attenuator on the output of the test device.

0

----------------------------- -11.4 dB

-141 dB
-16 dB

-18 5 d@

----------------------------- -26.4 dB

Filter Reflection
............. Uncertainty with attenuator

................ Uncertainty without attenuator

The calculations below show how adding a high-quality 10 dB attenuator improves the load match of
the analyzer.

Note: The corresponding linear value is shown in parentheses.
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Network Analyzer:

Filter:

Attenuator:

Calculations:

PNA

pAttenuator

Worst Case

Error =

(EwQ)

Uncertainty
Adds

Uncertainty
Subtracts

Load match (NAL M) = 18 dB (.126)
Directivity (NAD) =40 db (.010)

Insertion loss (Fq1,) = 1dB (.891)
Return loss (FR[,) =16 dB (.158)

Insertion loss (Ajr,)) =10 dB (.316)
SWR (ASwWR) = 1.05 (.024)

Without Attenuator

= (FIL)*(NALM)*(FIL)
= (.891)*(.126)*(.891)
=.100

NA

=PNA

= -20log(FRL)HEwWC)+(NAD)
= -20log(.158)+(.100)+(.010)
=11.4 dB

= -20log(FRL)-(Ew(C)-(NAD)
=-20log(.158)-(.100)-(.010)
=26.4 dB

32.26 dB Return Loss

With Attenuator

= (FL)*(AL)*(NALM)*(AIL)*(FIL)
= (.891)*(.316)*(.126)*(.316)*(.891)
=.010

= (FIL)*(ASWR)*(FIL)
(.891)*(.024)*(.891)

=.019

= PNA + pAttn.
=.01+.019

=.029

= -20log(FRL)HEwWC)+(NAD)
-20log(.158)+(.029)+(.010)
=14.1dB

-20log(FRL)-(EwC)-(NAD)
-20log(.158)-(.029)-(.010)
=18.5dB
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Measurement Stability

There are several situations that can cause unstable measurements. To ensure that you are making
repeatable measurements, you can use various methods to create a stable measurement environment.

e Frequency Dirift
e Temperature Drift

e |naccurate Measurement Calibrations

e Device Connections

Other topics about Optimizing Measurements

Frequency Drift

The analyzer frequency accuracy is based on an internal 10 MHz frequency oscillator. SeeTechnical
Specifications for stability and aging specifications.

If your measurement application requires better frequency accuracy and stability, you can override the
internal frequency standard and provide your own high-stability external frequency source through the
10 MHz Reference Input connector on the rear panel.

Temperature Drift

Thermal expansion and contraction changes the electrical characteristics of the following components:

Devices within the analyzer

Calibration kit standards

Test devices

Cables

e Adapters

To reduce the effects of temperature drift on your measurements, do the following.

¢ Switch on the analyzer 1/2 hour before performing a measurement calibration or making a device
measurement.
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¢ One hour before you perform a measurement calibration, open the case of the calibration kit and take the
standards out of the protective foam.

e Use a temperature-controlled environment. All specifications and characteristics apply over a 25 °C 5 °C
range (unless otherwise stated).

e Ensure the temperature stability of the calibration kit devices.
¢ Avoid handling the calibration kit devices unnecessarily during the calibration procedure.

e Ensure the ambient temperature is £1°C of the measurement calibration temperature.

Inaccurate Measurement Calibrations

If a measurement calibration is inaccurate, you will not measure the true response of a device under test. To ensure that your
calibration is accurate, you should consider the following practices:

e Perform a measurement calibration at the points where you connect the device under test, that is, the
reference plane.

e If you insert any additional accessory (cable, adapter, attenuator) to the test setup after you have performed
a measurement calibration, use the port extensions function to compensate for the added electrical length
and delay.

e Use calibration standards that match the definitions used in the calibration process.

¢ Inspect, clean, and gage connectors. See Connector Care.

See Accurate Measurement Calibrations for more detailed information.

Device Connections
Good connections are necessary for repeatable measurements. To help make good connections, do the
following:

¢ Inspect and clean the connectors for all of the components in the measurement setup.

e Use proper connection techniques.

e Avoid moving the cables during a measurement.
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Noise Reduction Techniques

Random electrical noise which shows up in the analyzer receiver chain can reduce measurement
accuracy. The following features help reduce trace noise and the noise floor which can lead to better
dynamic range and more accurate measurements.

e Averaging

IF Bandwidth

LF Auto BW

Trace Smoothing

See Also
Group Delay

Increase Dynamic Range

Other topics about Optimizing Measurements

Averaging

Averaging is a feature that reduces the effects of random noise on a measurement. There are two types of averaging: Point or
Sweep.

The Point averaging type computes averaging on each data point before stepping to the next data point. You determine the
number of measurements by setting the averaging factor (enabled by clicking the Averaging button). The higher the averaging

factor, the greater the amount of noise reduction.

The Sweep averaging type computes averaging on subsequent sweeps until the required number of averaging sweeps are
performed.

Effects of Sweep Average

Without Lyverage With Average

REEE
£ULC SRSE SEsRE

Both Averaging and IF Bandwidth can be used for the same benefit of general noise reduction. For minimizing very low
noise, Averaging is more effective than reducing IF bandwidth. Generally, Averaging takes slightly longer than IF bandwidth

261



reduction to lower noise, especially if many averages are required. Also, changing the IF bandwidth after calibration results in
uncertain accuracy.

How to Set Averaging

Using Hardkey/SoftTablSoftkey Using a mouse
1. Press Avg BW > Main > Averaging. 1. Click Response.
2. Enter the Averaging number. 2. Select Avg BW.

3. Select Averaging....

Average dialog box help { |Programming Commands| 3
Fwerage ﬁ 1

Average ON Restan Average

Average Factor 1
Average Type
@ Sweep

Paint

OK Cancel Help

Average ON Check to enable Averaging.

Average Factor Specifies the number of measurements that are averaged. Range of 1 to 65536
(2™16).

Average Type

Sweep Each data point is based on the average of the same data point measured over consecutive sweeps. When the
number of sweeps = Average Factor, the averaging continues following the Sweep Averaging formula.

(Sweep) Restart Begins a new set of measurements that are used for the average. Applies only
to Sweep averaging - NOT Point.

Point Each data point is measured the number of times specified by the Average Factor, and then
averaged, before going to the next data point.

e On subsequent sweeps, averaging is automatically restarted by measuring each data point
again the number of times specified by the Average Factor.

e Because measurements occur quickly in the background, the Average Counter is NOT updated.
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e  Point averaging is NOT available in Gain Compression, or Noise Figure Apps.

Notes

e An Average Counter appears on the screen when Sweep averaging is selected, displaying the number of
sweeps that has been averaged. The effect on the signal trace can be viewed as the Average Factor
increases. This can assist in the selection of the optimum number of sweep averages. The Average Counter
is NOT updated for Point averaging.

e Channel-wide scope- Averaging is enabled and the factor is set for all measurements in a channel. The
Average counter is displayed for each channel.

e Calibration - Because averaging is a mathematical process that occurs after the raw measurement is made,
averaging can be turned ON before or after calibration without invalidating the error correction terms. If
averaging is ON before calibration, the measurement of calibration standards are averaged measurements.
More time is needed to perform the calibration, but there will be less noise in the resulting error correction
terms. Subsequent corrected measurements will also have less noise error. In addition, noise is further
reduced by turning Averaging ON after calibration.

e Triggering is implemented separately from Averaging. For example, setting averaging factor to 4 has NO
effect on the number of triggers that are required to achieve 4 sweeps or 4 data points.

¢ Unratioed measurements - Although averaging unratioed (single receiver) measurements is allowed, you
may see unexpected results.

¢ The noise floor does not drop when averaging unratioed measurements as on ratioed measurements.

e Phase results may tend toward 0. This is because phase measurements are relative by nature.
Measuring absolute phase with a single receiver appears random. Averaging random positive and
negative numbers will tend toward O.

Sweep Averaging Formula

NewAvg = (NewData/n) + [0ldAvg*(n-1/n)] 'where n = average factor

From the formula, you can see that data from the first n sweeps continues to be included in the
results of subsequent sweeps. Its effect is increasingly smaller but never diminishes to zero. For
example, with n = 5, the average of the 5 sweeps is displayed. On the 6th sweep, you see 4/5 the
average of the first 5 sweeps plus 1/5 the new sweep.

The effects of older data can be eliminated by clicking Restart.

Learn more about Averaging (scroll up)

IF Bandwidth

The received signal is converted from its source frequency to a lower intermediate frequency (IF). The bandwidth of the IF
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bandpass filter is adjustable down to a minimum of 1 Hz. The maximum IF varies depending on the VNA model.

Reducing the IF receiver bandwidth reduces the effect of random noise on a measurement. Each tenfold reduction in IF
bandwidth lowers the noise floor by 10 dB. However, narrower IF bandwidths cause longer sweep times.

e Channel - IF bandwidth can be set independently for each channel
¢ Segment sweep - IF bandwidth can be set independently for each segment of segment sweep.

e Calibration - Changing the IF bandwidth after calibration will cause a 'C-delta’ correction level, which means
that calibration accuracy is uncertain.

Effect of Reducing IF Bandwidth

10 Hz IF B Jod0Hz IF By
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How to set IF Bandwidth
Using Hardkey/SoftTablSoftkey Using a mouse
1. Press Avg BW > Main > IF Bandwidth. 1. Right click on the BW icons on the status bar.

2. Enter the IF Bandwidth value. 2. Select an IF Bandwidth....

IF Bandwidth dialog box help { |Programming Commands| 3

Right click on the BW icons on the status bar then select IF Bandwidth... to display the IF
Bandwidth dialog:

Learn about IF Bandwidth (scroll up)

LF Auto BW

When LF Auto BW is ON (default), the VNA uses a smaller IF Bandwidth than the selected value at
low frequencies. . Learn about IF Bandwidth (scroll up).
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How to enable/disable LF Auto BW
Using Hardkey/SoftTablSoftkey

1. Press Avg BW > Main > LF Auto BW.

2. ON enables and OFF disables LF Auto BW.

Trace Smoothing

Trace smoothing averages a number of adjacent data points to smooth the displayed trace. The number
of adjacent data points that get averaged together is also known as the smoothing aperture. You can
specify aperture as either the number of data points or the percentage of the x-axis span.

Trace Smoothing reduces the peak-to-peak noise values on broadband measured data. It smooths trace
noise and does not increase measurement time significantly.

Because Trace Smoothing follows Format in the data processing map, the formatted data is smoothed.
Smoothing is automatically turned off if the format is Polar or Smith Chart.

Learn more about Data Format Types.

See the data processing map.
Tips:
e Start with a high number of display points and reduce until you are confident that the trace is not giving
misleading results.

¢ Do not use smoothing for high-resonance devices, or devices with wide trace variations. It may introduce
misleading information.

e Smoothing is set independently for each trace.

Effects of Smoothing on a Trace

iMithout =moothing WNith S moat hire

— -

bl i
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How to set Trace Smoothing
Using Hardkey/SoftTablSoftkey

1. Press Avg BW > Smoothing > Smoothing ON|OFF.

Pru-gra.mming Commands ’

Smoothing ON When checked, applies smoothing to the displayed trace.

Percent of Span Specify percent of the swept stimulus span to smooth. For example, for a trace that
contains 100 data points, and specify a percent of span = 11%, then the number of data points that are
averaged is 11.

Points Specify the number of adjacent data points to average.

Learn about Trace Smoothing (scroll up)
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Crosstalk

Crosstalk is energy leakage between analyzer signal paths. This can be a problem with high-loss
transmission measurements. Although the crosstalk specification of the analyzer is exceptional, you can
reduce the effects of crosstalk by doing the following:

e Set the Sweep to Alternate

e Perform an Isolation Calibration

Other topics about Optimizing Measurements

Set the Sweep to Alternate
This selection is no longer available from the user interface. Learn more.
Perform an Isolation Calibration

For transmission measurements, a response and isolation measurement calibration helps reduce
crosstalk because the analyzer measures and then subtracts the leakage signal during the measurement
calibration. The calibration improves isolation so that it is limited only by the noise floor.

Note: Isolation is never performed on a Smart (Guided) Calibration. Learn more.

Generally, the isolation error falls below the noise floor. So when you are performing an isolation
calibration you should use a noise reduction technique such as sweep averages or reducing the IF
bandwidth.
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Effects of Accessories

Accessories in a configuration may affect the results of a device measurement. You can choose
between these analyzer features that reduce ore remove the effects of accessories

e Power Slope to Compensate for Cable Loss

e Gating to Selectively Remove Responses

e De-embedding a 2-port device (separate topic)

Other topics about Optimizing Measurements

Power Slope to Compensate for Cable Loss

If you have a long cable or other accessory in a measurement configuration where a power loss occurs
over frequency, apply the power slope function. This function increases the analyzer source power by a
rate that you define (dB/GHz).

1. Press Power > Leveling & Offsets.

2. If the slope function is not already switched on, click the button beside Slope.

3. In the Slope box, enter the rate that you want the source power to increase over the frequency sweep.

Gating to Selectively Remove Responses

Gating is a feature in the time domain (option S93010A/B) that allows the analyzer to mathematically
remove responses. You can set the gate for either a reflection or transmission response, but you will see
different results.

e Gating a reflection response isolates a desired response (such as a filter's return loss), from unwanted
responses (such as adapter reflections or connector mismatches).

e Gating a transmission response isolates a specific path in a multipath device that has long electrical
lengths.

See Time Domain Gating for more information.
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Achieve Fastest Sweep

You can achieve the fastest measurement sweep by adjusting the following:

Sweep Settings

Noise Reduction Settings

Measurement Calibration Choice

Unnecessary Functions

Other topics about Optimizing Measurements

Sweep Settings

Consider changing each of the following settings as suggested.

e Frequency Span - Measure only the frequencies that are necessary for your device.

e Segment Sweep - Use segments to focus test data only where you need it.

e Switch Off Stepped Sweep - Use linear swept mode to minimize sweep time when possible.
e Auto Sweep Time - Use this default to sweep as quickly as possible for the current settings.

e Number of Points - Use the minimum number of points required for the measurement.

For more information on how number of points and other settings affect sweep cycle time, see Technical
Specifications.

Noise Reduction Settings

Using a combination of these settings, you can decrease the sweep time while still achieving an
acceptable measurement.

e |F Bandwidth. Use the widest IF bandwidth that will produce acceptable trace noise and dynamic range.

e Average. Reduce the average factor, or switch Average off.
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Measurement Calibration Choice
Choose the appropriate type of calibration for the required level of accuracy.

When full 2-port error correction is applied, the analyzer takes both forward and reverse sweeps to
gather all 12 error correction terms. This occurs even with a single S11 measurement displayed. All
displayed measurements are updated as the second sweep is performed. Both sweeps are performed
using the specified sweep time.

When calibrating greater than 2 ports, the following formula is used to determine the number of sweeps

required:

e N * (N-1) where N = the number of ports.

When full 3-port calibration is applied, 6 sweeps are required; forward and reverse for each port pair.
With full 4-port correction, 12 sweeps are required, and so forth.

To limit the measurement time, perform ONLY the level of calibration that your measurements require.
For example, if making only an S11 measurement, perform a 1-port calibration on that port.

Sweep speed is about the same for uncorrected measurements and measurements done using a response
calibration, or one-port calibration. For more information see Select a Calibration.

Unnecessary Functions
The analyzer must update information for all active functions. To achieve an additional increase in
sweep speed, switch off all of the analyzer functions that are not necessary for your measurement
application.

e Delete Unwanted Traces

o Switch Off Unwanted Markers

e Switch Off Smoothing

e Switch Off Limit Testing

e Switch Off Math Functions

Analyzer sweep speed is dependent on various measurement settings. Experiment with the settings to
get the fastest sweep and the measurement results that you need.
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Switch Between Multiple Measurements

If you need to make multiple measurements to characterize a device, you can use various methods to
increase throughput. Experiment with these methods to find what is best for your measurement
application needs.

e Set Up Measurements for Increased Throughput

e Arrange Measurements in Sets
e Use Segment Sweep

e Trigger Measurements Selectively

e Automate Changes Between Measurements

e Recall Measurements Quickly

Other topics about Optimizing Measurements

Set Up Measurements for Increased Throughput

To achieve optimum throughput of devices that require multiple measurements, it is helpful to know
the operation of the analyzer. This knowledge allows you to set up the measurement scenarios that are
best for your applications.

Learn more about Traces, Channels, and Windows

Arrange Measurements in Sets

If you arrange measurements to keep the complete set of device measurements in one instrument state,
you can save them so that you can later recall a number of measurements with one recall function.

See Pre-configured Measurement Setups for more information.

Use Segment Sweep

Segment sweep is helpful if you need to change the following settings to characterize a device under
test.
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e Frequency Range
o Power Level

¢ |F Bandwidth

e Number of Points
e Delay

o Sweep Mode

LO Offset

The segment sweep allows you to define a set of frequency ranges that have independent attributes.
This allows you to use one measurement sweep to measure a device that has varying characteristics.

See Segment Sweep for more information.

Trigger Measurements Selectively

You can use the measurement trigger to make measurements as follows:

e Continuously update only the measurements that have rapidly changing data.

e Occasionally update measurements that have infrequently changing data.

For example, if you had four channels set up as follows:

e Two channels measuring the data that is used to tune a filter

e Two channels measuring the data for the out-of-band responses of the filter

You would want to constantly monitor only the measurement data that you use for tuning the filter. If
you continuously update all of the channels, this could slow the response of the analyzer so that you
would not be able to tune the filter as effectively.

Note: You must either trigger the infrequent measurement manually or with remote interface
commands.

To trigger measurements selectively:
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This procedure shows you how to set up two different measurements with the following behavior:

e Channel 1 measurement will continuously update the data.

e Channel 2 measurement will occasionally update the data.

1. Press Setup > Quick Start.
2. At the Quick Start dialog box, click Create in new channel.

3. Frequency Sweep dialog box shows. Enter the preferred sweep setting.

Set Up a Measurement Trigger for Continuous Updates

1. Press Trigger > Trigger Source and select Internal.
2. Press Trigger > Trigger....

3. Atthe Trigger dialog box under Channel Trigger State, select Channel 1, and click Continuous.

Set Up a Measurement Trigger for Occasional Updates

1. At the Trigger dialog box under Channel Trigger State, select Channel 2, and click Single, OK.

2. Press Trigger > Restart.

Update the Measurement

1. Click on the lower window to make Channel 2 the

2. On the active entry toolbar, click the type of trigger you set up.

o Click Single if you set up the analyzer for a single sweep per trigger.

o Click Groups if you set up the multiple sweeps per trigger.
Note: A trace must be active for you to initiate a trigger for that measurement.
Automate Changes Between Measurements

If there are slight differences between the various measurements that you need to characterize a device,
you may find that it is faster to change the measurement settings using programming.
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Recall Measurements Quickly

The most efficient way to recall measurements is to recall them as a set of measurements (instrument
state).

e It only takes a short time longer to recall an instrument state that includes multiple measurements, than it
does to recall an instrument state with only one measurement.

e Each recall function has time associated with it. You can eliminate that time by setting up the measurements
as a set so you can recall them as a set.

See Save and Recall Files for more information.
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Data Transfer Speed

When testing devices remotely using SCPI, the following techniques can be used to transfer data
quickly between the analyzer and remote computer, helping you achieve the best measurement
throughput.

e Use single sweep (trigger) mode to ensure that a measurement is complete before starting a data transfer.

¢ Transfer the minimum amount of data needed. For example, a trace with a few points, using segment
sweep rather than a full trace with many linearly spaced points. Also, use markers instead of trace transfers.

e Choose the REAL data format to provide the fastest transfer speed when using SCPI programs for
automated applications.

e Use SCPI over LAN for applications that are automated with SCPI programs.

Other topics about Optimizing Measurements
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Setting Shift LO (Reducing Unnecessary Image Response)

e Overview

e Turning ON Shift LO Mode

Other topics about Optimizing Measurements

Overview

The Shift LO mode is used to set the local signal (LO).Generally, the VNA sets the local signal (LO) as
RF+IF. However, this causes image response at certain frequencies. To reduce the unnecessary image
response, the LO mode allows you to select the local signal (LO). This function is available on the
ES5080A, M980xA, PS0xxA and M9485A.

Shift LO mode should be turned ON for frequencies below the center frequency of the bandpass filter
and turned OFF for frequencies above the centre frequency of the bandpass filter.
e Shift LO mode ON: LO = RF-IF

o Shift LO mode OFF: LO = RF+IF

Note: This function is not available for frequencies below 150 MHz (ES080A), 400 MHz (M9485A),
322.375 MHz (M980xA, P50xxA).

How to turn on Shift LO mode
Using Hardkey/SoftTablSoftkey

1. Press Sweep > Source Control > Shift LO.
2. Input the maximum frequency.

3. Click the switch of the softkey to turn on the Shift LO function.

Prugramming Commands=s }
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Note: System calibration (adjustment) is not taken into account when Shift LO mode is ON.
Calibration should be performed before your measurement. If this function is turned ON after a
calibration, “C” is changed to "CA" on the status bar.

Note: When List Shift LO in Segment Sweep is OFF, the setting of global setting (Sweep > Source
Control > Shift LO) is used.

Max Frequency

Sets the maximum frequency for the measurement sweep. By default, the maximum frequency is set to
the maximum frequency of the unit.

Note: This setting is only valid when the Shift LO mode is turned ON.
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Using Macros

Macros are executable programs that you write, load into the analyzer, and then run from the analyzer.
You can have up to 25 macros set up to run on the analyzer.

e How to Setup Macros

e How to Run Macros

e Macro Example

How to Setup Macros

Using Hardkey/SoftTablSoftkey

1. Press Macro > Key Setup > Macro Setup....
In the Macro Setup dialog box:

1. Create an executable program and save it on the VNA hard drive. See SCPI example programs in VBscript.

2. Use a mouse or the front-panel 'down-arrow' to select a blank line below the last entry. (There may be NO
entry.)

3. Click Edit to start the Edit Macro Setup dialog.

4. Inthe Macro Title box, type a descriptive title for your macro.

5. Click Browse.

6. Change Files of Type.

7. Find and select your executable file. Change Files of Type if necessary.
8. Click OK on the Edit Macro Setup dialog.

9. Click OK on the Macro Setup dialog.

10. Press MACRO to run. It may be necessary to first Preset the VNA to see your macro in the menu.

278



Macro Setup dialog box help
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Macro setup allows you to create up to 25 macros that can be launched from the VNA application.

An external keyboard is required to enter the Macro Title and the Run string parameters.

To add a Macro, use a mouse or the front-panel 'down arrow' (NOT the 'Down' key) to select a
blank line. Then click Edit.

Macro Title Shows the titles that appear in the softkeys and menu when you press the Macro key.
These titles are associated with the executable files and should be descriptive so you can easily
identify them.

Macro Executable Lists the complete path to the executable file. To follow the example of
launching the Keysight VNA Series Home Page, the path to the executable could be "C:/Program
Files/Internet Explorer/iexplore.exe.

Macro Runstring Parameters Lists the parameters that get passed to the program that is
referenced in the executable file. Again following the example of launching the VNA Series Home
Page, you could assign the runstring parameters "http://www.Keysight.com/find/pna".

Edit Invokes the Macro Edit dialog box.
Delete Deletes the selected macro.

Up Allows you to reorder the macros, moving the selected macro up one line. This order
determines how they appear in the VNA Menu and in the softkeys and when you press the Macro
front-panel key.

Down Moves the selection down one line in the list of macros.
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Macro Edit dialog box help
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Macro Title Add a title that appears in the softkeys and menu.

Macro Executable Set the complete path to the macro executable file. Click Browse to navigate to
the macro executable file and establish the complete path to the file.

Macro run string parameters Optionally add parameters that are passed to the program
referenced in the executable file.

See Macro Setup dialog box

How to Run Macros

Using Hardkey/SoftTablSoftkey

1. Press Macro > Macro<#>.

Macro Example

The following is an example Visual Basic Scripting (vbs) program that you can copy, install, and run
on your VNA.

Note: Print these instructions if viewing in the analyzer. This topic will be covered by the Macro Setup
dialog box.

1. Copy the following code into a Notepad file.
2. Save the file on the analyzer hard drive in the C:/Documents folder. Name the file FilterTest.vbs

3. Close Notepad
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4. Setup the macro in the VNA
5. Run the macro
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Select a Calibration Type

The following calibration types are available in the VNA.

Cal Type Interface | Accuracy Thru Methods allowed
TRL Family Both Very High All except Unknown Thru
SOLT Both High All

Enhanced Response SmartCal High Defined Thru or Flush Thru
QSOLT (Quick SOLT) SmartCal Medium Defined Thru or Flush Thru
1-Port Reflection Both High Not Applicable
Open/Short Response Unguided Low Not Applicable

Thru Response Unguided Low Known Thru or Flush Thru

Learn how to select a default Cal Type.

Other Cal Types (Separate Topic)

e Source and Receiver Power Cals

See other Calibration Topics

TRL Family

Application: Used to accurately calibrate any pair of ports when calibration standards are not readily available.

Note: A Delta Match Cal may be required.

» Learn more about TRL family cal
« For more information on modifying standards, see Calibration Standards.

Calibration Method: SmartCal, Unguided Calibration

General Accuracy: Very High

Standards Required: THRU, REFLECT, LINE or similar combination

Systematic Errors Corrected:

+ Directivity

» Source match

* Isolation (see exceptions)

» Load match

* Frequency response transmission tracking
» Frequency response reflection tracking
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SOLT

Application: Used to accurately calibrate any number of ports.

General Accuracy: High

Calibration Method: SmartCal, Unguided Calibration, ECal

Standards Required: (SHORT, OPEN, LOAD, THRU) or ECal module

Systematic Errors Corrected (on all ports):

+ Directivity

» Source match

* Isolation (see exceptions)

» Load match

* Frequency response transmission tracking
» Frequency response reflection tracking

Enhanced Response

Application: Used to calibrate two ports when only measurements in one direction (forward OR reverse) are
required. Measurements are faster because a second sweep is NOT required.

» Reflection Standards (OPEN, SHORT, LOAD) are connected to the source port to be calibrated.
» Defined THRU or Flush THRU standard is connected between port pairs.

* Much quicker than SOLT when using a mechanical cal kit. ECal can also be used.
To select Enhanced Response:
For a standard S-parameter Cal, select Cal > Main > Basic Cal....

Then, In the Basic Cal dialog box:

1. Under 'Cal Type', select Enh Response 1-> 2 Enh or Response 2-> 1.

General Accuracy: High

Calibration Method: SmartCal, ECal

Standards Required: (SHORT, OPEN, LOAD, Defined THRU or Flush THRU)

Systematic Errors Corrected:

+ Directivity (source port)

+ Source match (source port)

* Isolation (see exceptions)

* Load match (receiver port) - used only to produce transmission tracking term.
* Frequency response transmission tracking (receiver port).

» Frequency response reflection tracking (source port).
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QSOLT (Quick SOLT)

Application: Used to quickly calibrate any number of ports. Developed specifically for use with external
multiport test sets.

Note: A Delta Match Cal is required to cal test ports that do not have a dedicated reference receiver.

+ Reflection Standards (OPEN, SHORT, LOAD) are connected to only ONE of the ports to be calibrated. The
lower port number of the ports to be calibrated is selected by default. This can be changed through the Modify
Cal / Cal Type setting.

* Defined THRU or Flush THRU standards are connected from the reflection standard port to the remaining ports to be
calibrated.

* Much quicker than SOLT when using a mechanical cal kit.

* Based on TRL math.

General Accuracy: Not as high as SOLT

Calibration Method: SmartCal, ECal

Standards Required: (SHORT, OPEN, LOAD, Defined THRU or Flush THRU)

Systematic Errors Corrected:

+ Directivity

» Source match

* Isolation (see exceptions)

+ Load match

* Frequency response transmission tracking
» Frequency response reflection tracking

1-Port (Reflection)

Application: Used to accurately calibrate any single test port for reflection measurements only.

Calibration Method: SmartCal, Unguided Calibration, ECal

General Accuracy: High

Standards Required: (SHORT, OPEN, LOAD) or ECal module

Systematic Errors Corrected:

+ Directivity

» Source match

* Frequency response reflection tracking
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Open / Short Response

Application: Used to quickly calibrate any single test port for reflection measurements only.

Calibration Method: Unguided Calibration

General Accuracy: Low

Standards Required: OPEN or SHORT

Systematic Errors Corrected:
Frequency response reflection tracking

Thru / Transmission Response (Isolation Optional)

Application: Used to quickly calibrate any pair of test ports for transmission measurements only.
Isolation is not usually recommended. Learn more about Isolation

Calibration Method: Unguided Calibration and Guided Cal from the 'Select DUT Connectors page', check
Modify Cal, then click Next.

General Accuracy: Low

Standards Required: THRU

Isolation: One LOAD for each VNA test port.

Systematic Errors Corrected:
* Frequency response transmission tracking
* Isolation
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Calibration Thru Methods

e What is a Non-Insertable Device

e Choosing a Thru Method

e Flush Thru

e Adapter Removal

e Swap Adapters and Offset Delay (separate topic)
e Defined Thru

e Unknown Thru

ECal Thru Method Choices

Other Cal Topics

What is a Non-Insertable Device

To understand the Thru method choices, you must first understand what is meant by "Non-Insertable
device". These definitions also apply to ECal modules. Substitute "ECal module" for "device". Then
see ECal Thru Method Choices.

A non-insertable device is one whose connectors could NOT mate together. They either do not have
the same type of connector or they have the same gender. This also means that the test port cables
would not mate together, as in the following diagram.
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An insertable device is one whose connectors could mate together. They have the same type of
connector and opposite,or no, gender. This also means that the test port cables would mate together, as
in the following diagram.

Analyzer
Part 1 Port 2

Choosing a Thru Method of Calibration

The Thru method is selected from the Cal Wizard. Select the Modify checkbox in the Select DUT
Connectors and Cal Kits dialog box.

Notes:

For ECal, the following choices have different meanings. See THRU methods for ECal.

For 4-port calibration, see How can we measure only 3 THRU connections?

Choice for Insertable Devices: FLUSH Thru (also known as Zero-length Thru)

When calibrating for an insertable device, the test ports at your measurement reference plane connect
directly together. This is called a zero-length THRU, or Flush THRU meaning that the THRU standard
has zero-length: no delay, no loss, no capacitance, and no inductance. Your calibration kit may not
have a physical THRU standard because it is assumed you have an insertable device and will be using a
zero-length THRU.

Choices for Non-Insertable Devices

The following methods calibrate for a non-insertable device:

e Adapter Removal Accurate, but least convenient.
e Defined Thru

e Unknown Thru Cal Preferred method.
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Adapter Removal Calibration

The accuracy of the Adapter Removal calibration is very similar to the accuracy of the Unknown Thru
calibration. However, the Unknown Thru calibration has fewer connections and therefore has the
potential of being more accurate than the Adapter Removal calibration.

Two full 2-port calibrations are performed: one with the adapter connected at port 1, and the other with
the adapter connected to port 2. The result of the two calibrations is a single full 2-port calibration that
includes accurate characterization and removal of the mismatch caused by the adapter.

Performing an Adapter Removal Cal requires:

e a THRU adapter with connectors that match those on the DUT.

e calibration standards for both DUT connectors.

To select Adapter Removal during a SmartCal, select the Modify checkbox in the Select DUT
Connectors and Cal Kits dialog box. The Cal Wizard will guide you through the steps.

Learn how to perform an Adapter Removal Cal using ECal.
Defined Thru (also known as Known Thru, Cal Kit Thru, ECal Thru, Characterized Thru)

Defined Thru uses the THRU definition that is stored in the Cal Kit file or ECal module. The THRU
standard may have worn over time, making it not as accurate as when it was new. Defined Thru is
usually more accurate than Adapter Removal, but not as accurate as Unknown Thru method.

Notes

¢ If performing an ECal, this is the THRU standard in the ECal Module.

¢ If Defined Thru appears as a potential THRU method in the SmartCal Wizard, this means that there is a
defined THRU standard in the selected Cal Kit. This could be a Zero-length Thru. The SmartCal Wizard
will prompt you to connect the required standard when appropriate.

To define a THRU standard in a Cal Kit (not ECal module):

1. Click Cal > Cal Sets & Cal Kits.
2. Click Cal Kit....
3. Select the Cal Kit from the list.

4. Click Edit....
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8.

Select the Standards tab.
Click Add....
Select THRU.

Complete the dialog box.

The next time you perform a Guided Cal, this Defined THRU standard will be available if the DUT
connector types match the THRU standard.

Unknown Thru Cal

Unknown Thru Cal is the preferred THRU method of calibrating the analyzer to measure a non-
insertable device.

The Unknown Thru calibration is also known as Short-Open-Load-Reciprocal Thru (SOLR)
calibration.

Very easy to perform.
Better accuracy than Defined Thru and usually better than Adapter Removal.
Does not rely on existing standard definitions that may no longer be accurate.

Causes minimal cable movement if the THRU standard has the same footprint as the DUT. In fact, the DUT
can often BE the THRU standard.

NOT recommended when there is 40 dB or more of combined loss in the Unknown Thru and calibration path.
This would NOT allow enough signal to accurately measure at the receiver.

About the Unknown Thru Process

SmartCal guides you through the process. Although the following process describes ports 1 and 2,
Unknown Thru can be performed on any two ports when using a multiport analyzer.

1.

Perform 1-port cal on port 1.

Perform 1-port cal on port 2.

Connect Unknown Thru between ports 1 and 2.
Measure Unknown Thru.

Confirm Estimated Delay. This estimate may be wrong if there are too few frequency points over the given
frequency span. You can measure the delay value independently and enter that value in the dialog box.
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The Unknown Thru Standard

e Can have up to 40 dB of combined loss in the Unknown Thru and calibration path.

Must be reciprocal: S21=S12.

Must know the phase response to within 1/4 wavelength (see step 5 above).

Can be the DUT if it meets these conditions.

Unknown Thru Limitations

e Unknown Thru is NOT supported during a TRL calibration from the GUI.

e Cable movement introduces measurement errors.

ECal Thru Method Choices

When the ECal module connectors exactly match the DUT connectors, choose from the following
THRU methods:

ECal Thru as Unknown Thru Learn more about Unknown Thru.

¢ Measures the THRU state of the ECal module as an Unknown Thru.
e The default method when the ECal module connectors match the DUT.

e Very accurate and easy.

Flush Thru (zero-length Thru) Learn more about Flush Thru

e Requires an insertable ECal module / DUT.
e Remove the ECal module and connect the two reference planes directly together for a zero-length thru.

e Accurate, but not as easy as 'ECal Thru as Unknown Thru'.

ECal (Defined Thru)

e Measures the THRU state of the ECal module.

e Very easy, but not as accurate as 'ECal Thru as Unknown Thru'
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Unknown Thru

¢ Remove the ECal module.

e Then connect a Thru adapter to be measured as Unknown Thru.

When the ECal module connectors do NOT exactly match the DUT connectors, choose from the
following two methods:

Adapter Removal

e Can be used with ECal when your DUT is NON-insertable. However, the ECal module MUST be insertable,
and the adapter connectors must exactly match the connectors of the DUT as in the following diagram.

e Adapter removal performs 2-port measurements on both sides of the adapter.

PNA

e
DLT

ECAL

M adule *

ECal User Characterization

In cases when adapter removal cannot be performed, ECal User Characterization is ALWAY'S possible if
you have the right adapters. A User Characterization is performed once and stored in the ECal module.
However, accuracy is compromised every time you remove, then reconnect, the adapter with the ECal

module.
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Calibration Wizard

The Calibration Wizard allows you to choose a Calibration method and then perform the calibration.

e How to Start Calibration Wizard

SmartCal (Guided Calibration)

Basic Calibration

Unguided Calibration

Saving a Calibration

Other Cal Topics

How to start Calibration Wizard
Using Hardkey/SoftTablSoftkey

1. Press Cal > Other Cals > Smart Cal....

Pru-grannning Commands }

The Calibration Window / Channel

During a Guided Calibration, a 'Cal Window' is created for you to view the connection of
calibration standards before standards are measured. This Cal Window uses a new Cal channel that
is created and duplicates the settings in the channel being calibrated. Correction is ALWAYS OFF for
the displayed calibration channel. At the completion of the calibration, the calibration channel and
window are deleted.

The measurement of calibration standards can be performed while viewing any VNA window
configuration you choose. The Cal Window is appended to your Custom Cal Window setting, and
all windows are visible and sweeping below the Cal Wizard before the Measure (cal standard)
button is pressed. The windows to be viewed and channels to be swept during the cal process are
specified using Remote commands. See an example.

SmartCal (Guided Calibration)
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A Guided Calibration automatically determines the calibration type and suggests a calibration kit that
matches your DUT connectors.

Guided Calibration can perform the following Cal Types:

e ALL Cals EXCEPT Open, Short, and Thru Response Cals.
e ECal on one or more ports.

e TRL - Learn how to do TRL cals

Prugramming Commands ’

Note: SmartCal DOES allow you to measure calibration standards in any order. However, you must
click Next and Back without measuring standards until you get to the standard you want to measure.

The following dialog boxes appear when performing a Guided calibration on standard channels.

Select Ports for Guided Calibration dialog box help

Allows you to select ports to calibrate.
Cal Type Selection Select the number of ports to calibrate.
N Port Cal Configuration If not calibrating all ports, specify which ports to calibrate.

Show Advanced Settings (Orientation & Thru Cal Section) Available only for ECal.

Back Return to Cal Wizard Begin dialog.

Select DUT Connectors and Cal Kits dialog box help

|
Correcion Cal Kits
DUT Port 1 (IR ~| [iS05E E
DUT Port 21| APC 35 male =l ||mosze = Cal Methodt 4PORT, SOLT
DUT Pest 3 [APT 35 make =||||esmzm =|
DUT Port 4 [P 35 frmale ]| |[e=szm = |
7 Modly Cal

Moty Cof] EMABLED . Prass [Mast] v seady

« Back el 2 Carced I Help |

Allows you to select the connector type and Cal Kit for each DUT port to be calibrated.

Connectors To change selection, click the connector field for each DUT port.

If your DUT connectors are not listed, you can create your own connector type and calibration kit
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file. The VNA includes the following example cal kits that can be used as a template. See
Calibration kits for more information.
¢ If using a gendered (male and female) connector type, select Type A as the connector type.

e If using a connectorless device such as on-wafer probes., select Type B as the connector type.

Cal Kits Select the Cal Kit to be used to calibrate each test port. The list for each DUT Port
displays kits having the same connector type as the DUT.

Identical ECal models connected? ECal modules can be distinguished by serial number. This can
have implications on your remote SCP| programs.

Cal Kit Notes
85056 K

The 85056K definitions in the analyzer are for 2.92mm standards (2.4mm plus 2.92 adapters).
To calibrate 2.4 mm connectors using the 85056K cal kit, select 85056A as the cal kit when you
need the sliding load. Otherwise, select 85056D as the cal kit. Both the 85056A and the 85056D
kits contains exactly the same standards as the 85056K cal kit WITHOUT the adapters.

TRL

e To perform a TRL Cal, assign a TRL Cal Kit to the lowest port number of each port pair.

Modify Cal Check, then click Next, to Modify Cal (Standards AND Thru Method).
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Error dialog box help
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The current cal kit does not cover the current frequency range of the measurement. Do one of the

following to correct the problem:

Cal Kit Class Category Choose from SOLT and TRL.
Edit to modify the appropriate class assignments.

Not available with ECal modules. Click

Frequency Change the frequency range of the active channel.

Edit Modify the class assignments so that a different standard is selected.

Back Select a different Cal Kit that covers the required

Cancel Exit the Cal Wizard

frequency range.

Modify Cal dialog box help

[ 16t Post | 2nd Post]  Theu Cal Mefhod | -]
Thutiz 1 =+ =][UnircomTios =] Cal TipalStds
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¢ Back Hest > Cancel |

et |

Thru #n

Lists the proposed Thru connections to be made during the calibration process. You can change

these Thru connections to better suit your test setup.

e The proposed Thru connections are listed automatically.

¢ Additional Thru connections can be selected for higher accuracy. Learn more.
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Add Thru

Click to add a Thru connection. Learn more

Remove Thru

Select a Thru by clicking the "Thru #N" field or the "1st Port / 2nd Port" field. Then click "Remove
Thru". This selection is NOT available if the selected Thru is required for the calibration.

1st Port / 2nd Port

Click to select the two ports to be included in the Thru connection. The order of the port numbers is
not critical.

Thru Cal Method

Lists the available Thru Cal methods for the specified port pairs.
Learn about the Thru Cal Method choices.

Cal Type/ Stds

Click to invoke the View / Modify Properties of Cal dialog box

Do orientation - Appears ONLY if an ECal module is selected for use.

When this box is checked (default) the analyzer automatically senses the model and direction in
which an ECal module port is connected to the test ports. If power to the ECal module is too low, it
will appear as if there is no ECal module connected. If you use low power and are having this
problem, clear this check box to provide the orientation manually.

Orientation occurs first at the middle of the frequency range that you are calibrating. If a signal is
not detected, it tries again at the lowest frequency in the range.

View/Detect ECal Characterizations - Appears ONLY if an ECal module is selected for use.

Click to invoke the View ECal Modules and Characterizations dialog box. Displays a list of connected
ECal modules.
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View/Modify Properties of Cal for Ports... dialog box help
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Select calibration type
Another chance to change the Thru method.
Learn about the Thru Cal Method choices.
Advanced

Select the cal method for each connector of the Thru pair.

e TRL - Available ONLY when a TRL cal kit was selected for the lowest port number of the
port pair.

e QSOLT Available ONLY when "Defined Thru" or "Flush Thru" is selected. "QSOLT 2 <=
1" refers to the receive port 2 and source port 1(where reflection standards are connected).

e Enhanced Response Available ONLY when "Defined Thru" or "Flush Thru" is
selected.""EnhResp 2 <= 1" refers to the receive port 2 and source port 1.

e  Transmission Response Available ONLY when "Defined Thru" or "Flush Thru" is selected,
when Mechanical Cal is selected, and when 2 ports are being calibrated. "TransResp 2 <=
1" refers to the receive port 2 and source port 1.

View Modify Click to invoke the Preview and Modify Calibration Selections dialog box.

Note: Changes made to the Cal Kit through this dialog are temporary that last only for this
calibration. To make permanent changes to the Cal Kit, perform Advanced Modify Cal Kits.
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Calibration Steps dialog box help
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Note: Calibration can be performed with External triggers. Learn more.

As each new cal step prompt appears, the traces are setup for the next standard measurement. Also,
sweeps are triggered continuously until the Measure button is pressed. This way you can view the
integrity of the standard connection.

Prompts for standards to be measured.
Measure Click to measure the standard.

Done Click after a standard is re-measured and all measurements for the calibration are
complete.

Next Click to continue to the next calibration step. Does NOT measure the standard.

If a standard i1s NOT measured, a warning appears and Done will not be available after the last Cal
step.

Note: Smart (Guided) Cal allows you to measure calibration standards in any order. However, you
must click Next and Back without measuring standards until you get to the standard you want to
measure.

Sliding Load Measurement dialog box help
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Set slide position 1 of at least 5 [t

Fosition the shde then select Measue

Allows you to measure the sliding load standard.
To Measure a Sliding Load:

1. Connect the sliding load to the measurement port following the procedure described in the
Calibration Kit User’s and Service Guide.

Note: Do NOT set the center conductor to be an interference fit with the center conductor of
the testport.

2. Position the sliding element, then click Measure. Do not move the sliding element until
measurement is complete.

Note: The direction in which the slide moves is NOT important. You can start with the slide
at the front and move it backward or start at the back and move it forward. To minimize
stability errors it is important to start at one end and move it in the same direction for each of
the measurement steps.

3. Measure the sliding load for at least five positions for best accuracy.

Note: The positions of the sliding element should cover the full length of the slide, but be
unequally spaced to reduce the possibility of overlapping data points. Most sliding loads have
marks for each slide position.

4. Click Done after the final measurement.

5. Disengage sliding load lock (if available), and remove sliding load from the measurement
port.

6. Measure the remaining standards.
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How to Verify Sliding Load Calibration Measurements

Once the calibration is completed, the sliding load can be measured again. The magnitude of the
return loss should remain nearly constant as the slide is moved. If the slide spacing was not
adequate due to slide position selections, there will be frequency ranges where the magnitude will
not remain nearly constant.

Specify delay dialog box help

Spedify dedey for APC 3.5 malke bo APC 3.5 male adapter Betwesn ports 1 and 2
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> | Cancl Hadpz

This dialog appears ONLY when Adapter Removal or Unknown Thru calibrations are performed.

The following values were estimated from the measurement. Most of the time, they are adequate.
However, for CW sweep or frequency sweep with large step sizes, the accuracy of the values may
be improved.

Adapter delay To improve this value, measure and record the delay of the adapter with a dense
step size. Enter that value here. The required precision value is the accuracy that is required to
characterize the delay value.

Nominal phase offset (Waveguide ONLY). To improve this value, measure and record the phase
offset of the Waveguide adapter with dense step size. Enter that value here.

When one connector is coax and the other connector is waveguide, the phase offset has an
ambiguity of 180 degrees. For consistency, the estimate provided here is always between 0 and 180
degrees. You can change this estimate to any value between -180 degrees and +180 degrees.

The Calibration Complete dialog box appears after all standards are measured.

Basic Calibration
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Basic Calibration

Using Hardkey/SoftTab/Softkey

1. Press Cal > Main > Basic Cal....

Prugramming Commands=s }

It provides basic calibration. The limitations of basic calibration are:

e oOne connector type
e one cal kit
 one cal type

e 1o isolation cal

e no power calibration

Py = | el

Connector Type Allows user to select single connector type.

Cal Kit Allows users to select single Cal Kit. The displayed selection options are according to the
selected connector type.

Port Allows users to select the port gender. No Connect indicates that no port is connected to the
VNA.

Cal Type Allows users to select calibration type. The displayed selection options are according to
the selected cal kit, connector type and gender.
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Save As Calset... Its grayed out when calibration is incomplete. Once the calibration is completed,
press this button to save the calibration.

Unguided Calibration

Unguided Calibration

Using Hardkey/SoftTab/Softkey

1. Press Cal > Main > Other Cals > Response Cal....

Prugramming Commands=s ’

The following dialog boxes appear when performing an Unguided calibration:

Sobect Cabbaastion Type lor Mechsnical 5tendands
- Call Type Selsction .+ TRL Configustion

?EP:EEII:T Sedect ports: I'I-I - Selecied CalFit 950584
2. mm with shding lnad
Resporus Cherpcteizafiorr. o lppes
View/Select Cal it |

Unguided calibration does NOT support cals greater than 2 ports or ECal calibrations.

Calibration Type Selection

e 2-Port SOLT
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e 1-Port SOL

e TRL - Learn more about TRL

¢ Response - Reflection and Thru (if the active measurement is transmission)
Cal Configuration If not calibrating all test ports, specify which ports to calibrate.
Back Return to Cal Wizard Begin dialog.

View/Select Cal Kit Click to invoke the Select Cal Kit dialog box.
Note: When selecting a Cal Kit with an impedance other than 50 ohms (Waveguide = 1 ohm), it is
NO LONGER NECESSARY to change the System Impedance setting before performing a

calibration. The impedance for the calibration is now derived from the Cal Kit impedance.

Next Click to continue to Measure Mechanical Standards dialog box.

x|
TAL Rederencs Flars TRL lmpadancs
1% THRU Standand (% LINE Standad
" REFLECT Storced £ SYSTEM Impadarcn

cBock | Hwas | coce | [CHee

This dialog box appears ONLY when the selected Cal Type is TRL in the previous dialog box.

TRL Reference Plane Select which standard to use to establish the position of the measurement
reference plane.

THRU Standard Select if the THRU standard is zero-length or very short.

REFLECT Standard Select if the THRU standard is not appropriate AND the delay of the
REFLECT standard is well defined.

TRL Impedance

LINE Standard Specifies that the characteristic impedance of the LINE standard should be used
as the system impedance. This ignores any difference between Offset Z0, Offset Loss, and
System Z0.

SYSTEM Impedance Transforms the LINE standard impedance and loss to that of the system
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impedance for use with the calibration error terms. The TRL calibration will first compute the
error terms assuming the LINE standard impedance is the system's characteristic impedance (same
as previous LINE selection), then modify the error terms to include the impedance transformation.
This should only be used with coax since the skin effect model used is a coaxial model.

Learn how to change System Z0.

To learn to substitute other calibration kits, see Advanced Modify Cal Kits

Select Cal Kit dialog box help

[ 10 | kit Mame | Description =|
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Displays the calibration kit files available for Unguided calibration. Select the desired calibration kit
file and click OK.

Choose class type

Edit Class Assignments Allows modification of the selected Cal Kit class assignments.

o To learn to substitute other calibration kits, see Advanced Modify Cal Kits

¢ Unguided Cal can access only mechanical cal kits #1 through #95, although more cal kits can imported.
Learn how.

Note: When selecting a Cal Kit with an impedance other than 50 ohms (Waveguide = 1 ohm), it is
NO LONGER NECESSARY to change the System Impedance setting before performing a
calibration. The impedance for the calibration is now derived from the Cal Kit impedance.
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Measure Mechanical Standards dialog box help
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Note: Calibration can be performed with External triggers. Learn more.

Displays the calibration kit file and standards required for the calibration.

¢ Standards may be connected and measured in any order.

o Connect the standard to the measurement port and click its associated green button. A check mark
indicates the standard has been measured.

¢ If a standard type contains multiple standards, the Multiple Standards dialog box opens to display the
multiple standards included in the calibration kit file.

¢ If a sliding load is included in the calibration kit file, the Sliding Load dialog box opens to perform the
measurement with the standard.

¢ Reflection Response Select EITHER Open or Short standard, then click Next.

¢ Isolation Requires one load for each test port. Learn more about Isolation. Use when your
measurement requires maximum dynamic range (> 90 dB). See also Isolation Portion of 2-Port
Calibration.

¢ Normalize Available when performing a response cal for any measurement. After Normalize is pressed
and the Cal is complete, the data trace is flat when the same physical connections are present on the
port. This is similar to Data/Memory, except that the response cal is saved with Cal data and can be
applied to other like measurements. Data/Memory is still available after using Normalize. You would
usually connect a THRU standard when calibrating a transmission measurement, and a SHORT standard
when calibrating a reflection measurement.

Show Prompts Check to provide a reminder for the required connection when you click on the
standard.
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Multiple Standards dialog box help
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Sliding

Select the standards to be measured.

Note: You may see both male and female standards. The Unguided cal has no knowledge of the
gender of your connector types. Choose the gender of your DUT connector; NOT the test port.

Then click OK.

To modify this calibration class to show only one standard, on the Calibration menu, click
Advanced Modify Cal Kits. Select the Cal kit and click Edit Kit. In Class Assignment, click
Edit. Learn more about Modify Calibration Class Assignments.

e Connect the standard to the measurement port and click its associated button. A check mark in the
Acquired box indicates the standard has been measured.

e To cover the entire frequency range, you may need to measure more than one standard. The order in
which the standards are measured is important. The last standard that is measured will override the
others in respect to the frequency range of the standard definition. Example: In the case of measuring
both a broadband load and a sliding load, you would measure the sliding load last. This is because the
frequency range of the sliding load is a subset of the broadband load.

Saving a Calibration

SmartCal, ECal, and Unguided Calibrations end with the following dialog box:
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Finish Save to the channel's calibration register.

Save As User Cal Set Invokes the Save as User Cal Set dialog box AND save to the channel's
calibration register.

Cancel Calibration is NOT applied or saved.

Learn about Calibration Registers.

Learn about User Cal Sets

CopyCalSetdialogboxhelp |

Copy CHI1 CALREG
to

Optional: Copy to existing Cal Set I
CalSet_1
CalSet_2
CalSet_4

Existing Cal Sets - Lists the previously-saved Cal Set names.

to Specify a name for the new Cal Set. Either accept the suggested new name, type a new name, or
select a name from the list to overwrite an existing name.

OK Saves the Cal Set to the new Cal Set name and exit the dialog message.
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Learn about User Cal Sets

308



Guided Power Calibration

Source and Receiver Power Calibration can be performed during a standard S-parameter Guided
Calibration. This power cal provides the following enhancements over the standard source and receiver
power calibration:

e A source and receiver power cal can be performed for all PNA ports with a single power sensor connection.

e Multiple power sensors can be used to cover wide frequency ranges.

e The receivers are corrected automatically.

e Optionally compensates for an adapter that may be used to connect the power sensor.

e Provides optional match-corrected power measurements.

e Source and Receiver power correction is stored to the Cal Set along with S-parameter correction.
Note: A Guided Power Calibration is not accurate when Frequency Offset Mode is enabled.
Learn more about the standard Source and Receiver Power Cals.

How to perform a Guided Power Cal

1. In a Standard (S-parameter) channel, setup your measurements (sweep type, frequency range, IFBW,
and so forth). A special version of this feature is available on mmWave SMC measurements. Learn
more.

2. Connect the Power Meter / Sensor the same as a standard Source Power Cal. Learn more.

e See Supported Power Meters

e See Important first-time USB connection note.

3. Start the Cal Wizard, then select Guided (Smart) Cal. Learn how.

Prcl-gra.mming Command= ’

On the following Select Ports dialog, check Calibrate source and receiver power, then click Next.
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Two Cal Wizard pages later, complete the following dialog.

Power Cal Settings dialog box help
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Note: A Use Power Table checkbox (not shown) is available when a mmWave SMC measurement
is active. Learn more.

Power Cal at: Select the source port for which a Power Calibration will be performed. The source
and receiver correction will be transferred to all other sources and receivers involved in the S-
parameter measurements.

Use Multiple Sensors NOT available with SMC measurements.

Check this box to use one or more power sensors that are configured as PMAR devices. This dialog is
replaced with the Multiple Sensors dialog. See following image.

When "Use Multiple Sensors" is cleared (default setting), click Power Meter Settings to configure
the power meter.

De-embed (power sensor) adapter When the power sensor connector is NOT the same type and
gender as the DUT connector for the specified port, then for optimum accuracy, extra cal steps are
required to measure and correct for the adapter that is used to connect the power sensor to the
reference plane.
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Clear this box to NOT compensate for the added adapter.
Check this box to perform extra calibration steps to measure and correct for the adapter.

Then select the Power Sensor Connector type and gender of the power sensor. "Ignored" does
NOT compensate for the added adapter, just as if the checkbox were cleared.

When this connector matches the DUT connector for the same port, then the PNA assumes that
there is no adapter. Extra cal steps are NOT required and the Cal Kit selection is not available.

Otherwise, select the Cal Kit to be used to calibrate at the adapter.

See Accuracy Settings below.

Power Cal Settings - Use Multiple Sensors dialog box help
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Notes

"Multiple sensors" are allowed ONLY on standard channels and during a Cal All calibration.

The power sensors that are used as "multiple sensors" MUST be configured PMAR devices.

Power Cal at: Select the source port for which a Power Calibration will be performed. The source
and receiver correction will be transferred to all other sources and receivers involved in the S-
parameter measurements.

Sensor Settings Click to start the Sensor Settings dialog, used to ADD / Configure an External Device.
Sensor Grid
Sensor Select the power sensor and the associated Start and Stop frequency range.

Adapter When the power sensor connector is NOT the same type and gender as the DUT
connector for the specified port, then for optimum accuracy, extra cal steps are required to
measure and correct for the adapter that is used to connect the power sensor to the reference
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plane.
Clear this box to NOT compensate for the added adapter.

Check this box to perform extra calibration steps to measure and correct for the adapter. Then
specify the Power Sensor Connector type and gender of the power sensor. When this
connector matches the DUT connector for the same port, then extra cal steps are NOT
required, and the Cal Kit selection is not available. Otherwise, select the Cal Kit to be used to
calibrate at the adapter.

Remove Click to remove the power sensor from the list.

Add Sensor Click to add a new line, then click the down-arrow to select a sensor. If a power
sensor does NOT appear in the list, click the Sensor Settings button to configure a power sensor.

Accuracy

Tolerance When consecutive power sensor readings are within this value of each other, then the
reading is considered settled.

Max Readings Sets the maximum number of readings the power sensor will take to achieve
settling. Each power reading is "settled" when either:

e Two consecutive readings are within this Tolerance value or

¢ When the Max Number of Readings has been met.
The readings that were taken are averaged together to become the "settled" reading.

Set Power For Best Accuracy Select to use the power level associated with the best
uncertainty for a specific power meter.

‘ Frogramming Commands }
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Power Sensor Connection step dialog box help
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Power Level Set the power level at which the Source Power Cal is to be performed.

It is usually best to perform the Source Power Cal at 0 dBm because the power sensor is calibrated
at that level. If 0 dBm is not achievable for your measurement, then set to the power level with the
lowest level of measurement noise.

Turn OFF Match Correction

During a Guided Power Cal, the match between the power sensor and the VNA source port is
measured. The source power correction array is compensated to account for the measured mismatch. In

addition, the reference receiver measurement is also compensated to account for the mismatch of the
DUT.

How to turn OFF match correction:

Click cal > Main > Correction Methods.....

Correction Methods dialog box help

Correction Methods: Channel 1

Power Wave Correction Type [I".l'l.atch Corrected >
Actual Waves

Enable port subset correcti

Define port subset: Response Corrected Exclude all ports |

1 2 3 4

OK ' Cancel Help

Power Wave Correction Type

Match Corrected - Guided Power Cal applies match correction on all receivers used on this
channel. However, you may not want match correction in the following cases:

¢ When making non-traditional measurements, such as high-power or multiport configurations. Because of
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added components or reconfigurations, the mismatch measurement may not be valid.
¢ When you have a remote program that already accounts for the match effects of the sensor.

Actual Waves - These are the full error corrected actual waves at device reference planes.
Response Corrected - These are response corrected waves.
Port subset correction

Refer to Port Subset Correction (Devolve Calibration).
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Calibrate All Channels

"Cal All" allows you to calibrate multiple channels in a single calibration session. This not only
reduces the number of connections that need to be made, but also the number of cal standard
measurements that must be performed.

Note: Beginning with the A.12.80 release, Cal All has been extended in order to deal with the new Low
Frequency Extension option. If a user has a mixture of LFE and non-LFE channels and they would like
to use Calibrate All to calibrate them at the same time, two calibration channels are created to account
for the hardware differences between the two situations. When using the GUI or COM to set calibration
and stimulus conditions, the settings are applied to both calibration channels. With SCPI, the user can
query the primary guided calibration channel using SYST:CAL:ALL:GUID:CHAN:VAL?. This will
return the primary calibration channel. When subsequent Guided Cal commands are used, settings will
be transferred to the second calibration channel. If there is a desire to set these settings separately, the
user should query for all Cal All Calibration channels with SYST:CAL:ALL:GUID:CHAN:LIST?

. The user should set values for the primary calibration first, and then secondary calibrations. When
initializing the calibration and acquiring steps, use the primary cal all channel number.

In this topic:

e Features
e Limitations

e How to perform a Cal All Channels Calibration

e Select Channels dialog

¢ Measurement Class Cal Properties dialog

e Setting Up an Independent Power Calibration
e Calibration Attenuator Settings dialog

e Select DUT Connectors and Cal Kits dialog

e Power Cal Settings dialog

e Cal Steps dialog

e Finish

Other Cal Topics
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Features
Cal All offers a single, optimized calibration procedure for all channels (with some limitations, see
below). The optimizations include:

e Minimizing the number of physical connection of standards.

e Minimizing the number of power meter calibration sweeps.

e User-settable power levels for S-Parameter as well as power calibration steps.

e Accounting for different switch and attenuator settings among different channels. This reduces the number of
measurements required to characterize different switch/attenuator settings (channel setup differences).

e Cal All will produce the same number and format of Cal Sets (error terms) that would be realized had the
calibrations been performed one at a time.

e Calibrate External Sources that are connected to the analyzer using Configure an External Source .

Limitations

e Cal All is performed at one IFBW.
e All channels that are calibrated are forced into stepped sweep mode .

e All channels to be calibrated MUST have the same cal reference plane . In other words, Cal All cannot
compensate for any path changes that occur external to the analyzer.

How to perform a Cal All Channels Calibration
Using Hardkey / SoftTab | Softkey

1. Press Cal > Other Cals > Cal All... .

Prugramming Commands= }
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1. Check the channels to be calibrated.

2. Check the ports to be calibrated. Click on the Apply to all channels button to apply the port selections to
all channels.

3. Click Next>

<Back T s cocel | mep |

Confirm or change the following unique cal properties for each channel to be calibrated. Click a
link to learn about these properties.

The properties with (NOT available in Cal All) are NOT available in a Cal All calibration as they
are in a stand-alone calibration.

SMC
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Mixer Delay "Mixer Delay" Real number indicating delay
value.
Receiver Characterization "Calset" String of Cal Set Name
Cal Set
Characterized mixer (s2p
file)
(NOT available in Cal All)
Standard Channel
Programming
UI Setting Property Value

Include Power Calibration

"Include Power Calibration"
"Enable Extra Power Cals"

"Port 1 Src2 Cal Power"

"true" or "false"

"Port 1", "Port 2", "Port 3",
"Port 4", and/or "Port 1 Src2"

Integer indicating valid
calibration power. For
example, "-20" indicates a
power level of -20 dBm. Only
valid if an independent port
calibration on Port 1 Src2 is
selected.

The power cal is optional only if none of the selected channels require a power cal.

Setting Up an Independent Power Calibration

Independent Power Calibration

Several applications control internal and external sources in a mode that is often decoupled from the
span over which the receivers are swept. This includes, for instance, Differential 1Q, and Spectrum
Analyzer. Cal All can add a power calibration for any port (including external sources) over an
arbitrary frequency span defined by the user.

For all ports selected for an independent power calibration (except for Port 1 Src 2, see below), a
power sensor calibration measurement is performed. The resulting source match correction terms
are added to the calsets for ALL channels selected for the Cal All calibration. The power
calibrations used in Cal All have all the same features as typical power calibrations. These include
the ability to specify power offsets, the power at which the calibration is completed, and the ability
to use multiple power sensors (note that using multiple power sensors is a feature only available on
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regular PNA ports — that is, not external sources or auxiliary ports).

Port 1 Src2 Calibration

The Port 1 Src2 calibration is a special case: In this case, a calibration is requested for situations
where the Port 1 Bypass Switch is in “Combiner Path” mode and either the “Port 3 Bypass Switch”
(4-port PNA-X) or the “Source 2 out 1 Bypass Switch” (2-port 2-source PNA-X) is also in
“Combiner Path”. Therefore, if a user requests a calibration of this port:

1.

Port 1 will also be calibrated at the same frequencies in the combiner path (*note: The user can still
elect to add more Port 1 independent cal ranges, but this will be done in “Bypass” mode, not “Combiner
mode.”

The calibrations for both Port 1 and Port 1 Src2 will be done with both sources on, but offset by 10MHz
(to more accurately characterize the behavior during use).

These calibrations will ONLY be applied to user channels in which both the Port 1 Bypass Switch and
either the Port 3 or Source 2 Out 1 Bypass Switches are set to “Combiner Path.”

Important Notes:

¢ If a user selects an independent power calibration on a port also used for the typical S-parameter

calibration, then the frequencies calibrated will be in addition to those frequencies used via the typical
calibration (a separate measurement will be completed at the time).

Previously a user could select a similar calibration of “LO” ports for application channels (for instance, in
a GCX measurement with Port 3 used for LO1, a user can select (via GUI or remote) to do an “LO1”
calibration. This will do a power sensor calibration of LO1 (port 3) at the frequencies specified by the
channel. This is still available, but if the user selects to do an Independent Power Calibration instead,
this will override the selection by the channel.

If the user has a mixture of LFE (Low Frequency Extension) and non-LFE channels the calibration will be
done by default in the NON-LFE configuration (this is because most applications do not support LFE and
external sources and sources like Src2 Out 1 do not have LFE paths). Instead, if it's desired to do
these calibrations in LFE mode, the user must select only LFE channels over which to do the cal all
calibration.

Independent Power Calibration for Cal All Setup

1.
2.

Start the Cal All Wizard .
In the Measurement Class Cal Properties dialog, enable Independent Power Calibration by selecting
the port(s) to cal then clicking OK .
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Messzrement Class Cal Propertier

B Mimcollsnoous

Enable Exira Powar Cols Port 1 Port 3 =
B Power Cal Parts List — v
Include Pownr Calibration Trua o
4| Port 1
Port 2
7 Port 3
Port 4
Port 1 Snc2
OK Cancel

If Port 1 Scr2 is a selected port, the Port 1 Src2 Cal Power level is displayed allowing a calibration
power level to be entered.

rMeasuwntoass Cal Properties

B Miscollansous
Enable Exira Power Cals Port 3 Port 1 Src2
Port 1 Sre2 Cal Power -
B Power Cal Ports List —_—
nclude: Power Calibration True =
Port 1
Port 2
4] Port 3
Port 4
41 Port 1 Sre2
Back e Cancal i
Ln Window 1 e
Tr 1 511 LogM 10.00
OK Cancel

To enter the Port 1 Src2 Cal Power level, click in the field then enter a valid calibration power level.

hescurement Class Cal Properbes

B Miscellnnecus
Enable Extra Power Cals Port 3, Port 1 Sre2
Par 1 Src2 Cal Power 20000000 dBm
B Power Cal
Include Power Calbration True

In the Power Cal Settings for Port<n> dialog, select the port from the Power cal at dropdown.
To add a new Cal range, click the New button.

Specify a frequency range for each Range Name by clicking in the corresponding Settings field then
clicking on the Edit button that appears.
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8. Enter the Start and Stop frequency and the number of Points then click OK .
9. Continue the Cal All process by clicking on the Next button.

Calibration Attenuator Settings dialog box help

Calibration Attenater e NN B N

S g mrraten ol o -
L At [T = Sri— _J FoipLrend fBans i
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S 038 = 1500d8m

Fécrien Flgubat e W bvw il Dt

This dialog shows the Power, Attenuator, and IFBW settings for the Cal All calibration. The default
values for the Cal All session are the preset values of a standard S-parameter channel. These values
are not necessarily the same as those of the channels that are selected for calibration. When there are
differences in measurement path (switch) settings between the Cal All channel and the selected
channels, these differences are detected by Cal All and additional measurements are made for each
path condition. These additional measurements allow Cal All to produce error terms appropriate for
each of the selected channels. In general, the Cal All session should be performed at a power level
that is high enough to prevent noise in the error terms. However, an increase in power could cause
compression or damage to the analyzer receivers. The following settings allow you to increase the
power level ONLY during the Cal All session.

Power Limit (Disable)

Cal All shows you when power limits are enabled. This setting provides you a convenient way to
TEMPORARILY disable these limits in order to take advantage of the power settings available in
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Cal All. If power limits are on, your DUT is probably a high-gain device and the attenuator
settings in your channels are high resulting in lower power at the cal reference plane. This lower
signal can result in noisier measurements during the acquisition of cal. This situation is precisely
what Cal All is intended to improve. Cal All allows you to configure the calibration conditions
for better signal-to-noise performance during the cal while leaving your DUT conditions alone.
You can elect to clear the “Disable Power Limits during cal” checkbox when you prefer to
calibrate at a higher power level than is allowed by your limit. The limit is restored after the Cal
All session.

Source / Receiver Attenuator

By default, the Cal All calibration is performed with Source and Receiver attenuators set to 0.
Change the Source or Receiver attenuator settings when external hardware (such as a booster
amplifier) would cause the analyzer receivers to be compressed or damaged.

You may also want to change the attenuator or path configuration settings to force the cal channel
to match settings of the selected channels. If all of the selected channels are set to identical
hardware settings, it may be better to apply these settings to the cal channel. For example, if your
channels all use a 5 or 10 dB attenuator step at port 1, you might elect to change the Cal All
channel to use the same low attenuator settings. This will result in the cal measurements being
made under the same path conditions as the channel and it will eliminate the need to
mathematically compensate for the difference. However, if large attenuator values are used, the
default Cal All settings will likely improve your results.

S-Parameter Cal Port Power
Set the power level at which the S-Parameter cal is performed.
Power Offsets

Power Offsets are channel-scoped. Consequently, offsets that you already set are NOT
automatically copied to the Cal All session. This setting allows you to also apply a Power Offset
during the Cal All session. Learn about Power Offsets .

Noise Reduction

This button accesses the following dialog for settings that help reduce trace noise and the noise
floor which can lead to better dynamic range and more accurate measurements. Learn more.
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IF Bandwidth

Set the IFBW used to perform the Cal All calibration. The default IFBW setting of 1 kHz
1s a good nominal setting for most measurements. Lowering the IFBW removes noise from
the calibration measurement, but also causes slower sweeps.

Always ON

Check to enable averaging.
Average Factor

Specifies the number of measurements that are averaged. Range of 1 to 65536 (2"16).
Average Type

Sweep Each data point is based on the average of the same data point measured over
consecutive sweeps.

(Sweep) Restart Begins a new set of measurements that are used for the average.
Applies only to Sweep averaging - NOT Point.

Point Each data point is measured the number of times specified by the Average Factor,
and then averaged, before going to the next data point.

Reduce IF BW at Low Frequencies

When this box is checked, the VNA uses a smaller IF Bandwidth than the selected value.
Learn more .
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Select DUT Connectors and Cal Kits dialog box help

DUT Post 2 [6PC 35 mae M EE | CalMethod: 4PORAT, SOLT
DUT Post 3 [2PC 35 make || |[msE =
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7 Modiy Cal
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For each DUT port:

e Select the connector at the calibration reference plane (where the cal standards will be connected).

e Select the cal kit to be used.

Check Modify Cal to change the Thru method. An Unknown Thru cal is performed by default.
Learn about THRU methods .

Learn more about this dialog .

Power Cal Settings dialog box help
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A guided power cal is performed on the source ports for the Cal All calibration.
This dialog is displayed for each source port to receive a power cal.
To perform an LO power cal for a mixer channel, set the LO port to a VNA or external source in the
Mixer Setup dialog . Then select that port in the Selected Channels dialog .
¢ To use the same power sensor for all power cals, do NOT check Use Multiple Sensors.

e To use different power sensors, check Use Multiple Sensors . The sensor must be configured as a
PMAR device. Learn how .
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This page is a summary of the Cal All settings. Confirm the settings, then click Next > or < Back to
change settings.
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Follow the prompts to connect each standard. Then click Measure .
Click Re-measure if necessary.

Then click Next >
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| Finish Cal dialogboxhelp |

Calibration results will be saved in each channel's Cal Register when you exit the wizard.
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Click Finish to save the Cal All session results to Cal Registers.

Or click Save As User CalSet , then enter a prefix title. The Meas Class and channel number are
appended to this prefix to save to a User Cal Set for each calibrated channel.

Learn more about this dialog.
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Using Calibration Sets

What are Cal Sets

Cal Registers and User Cal Sets

How to Manage and Apply Cal Sets
e Cal Set Selection dialog box help
e Cal Set Properties dialog box help

e Select Cal Set -- Choose Stimulus Settings dialog box help

Examples of Cal Set Usage

e Archiving Cal Sets using .cal files

See Also

Save and Recall: Instrument States and Cal Set Data

See other Calibration Topics

What are Cal Sets

At the completion of a calibration, all calibration data is stored to a Cal Set. The Cal Set can be applied
later to any channel that has the same stimulus settings as the Cal Set, thereby saving the time it takes
to perform another calibration. The following data is saved to a Cal Set:
e Name
e Cal Set Description
e Cal Set Attributes - stimulus settings, cal type, port association
e Standards data - The “Standards data” container in the Cal Set is intended for internal use only. External
access is provided for use in diagnosing calibration problems. Users should not form any expectations as to
the presence of the data or the naming conventions used.

e Error term data

e GUID (Globally Unique IDentifier)
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Cal Registers and User Cal Sets

There are two types of Cal Sets:

e Cal Registers (channel specific)

e User Cal Sets

Calibration data is automatically saved to a Cal Register at the end of every calibration. You can also
choose to save the cal data to a User Cal Set.

Calibration Registers

Calibration Registers are designed to simplify calibrations for most users. When a calibration is
complete, the data is automatically saved to the channel's Cal Register, overwriting (or appended to) the
previous cal data stored in that register. This concept is similar to 'legacy' Vector Network Analyzers.

e Every channel has ONE dedicated Cal Register. They are named CHn_CALREG, where n is the channel
number. The name cannot be changed.

e Cal Registers are more volatile because they are overwritten (or appended) each time a calibration is
performed on that channel. The Cal data is always saved, but only temporarily.

e Cal Registers can be applied to other measurements, but ONLY on the same channel as the Cal Register.

User Cal Sets

At the end of a calibration, you can choose to also save cal data to an existing or new User Cal Set.

e User Cal Sets can be applied to any number of channels simultaneously.
e User Cal Sets are named by you for easy identification.
e You can have an unlimited number of User Cal Sets.

e At any time, you can copy Cal Register data to create a User Cal Set. See Cal Set Properties.

Appending Data in a Cal Set

At the end of a calibration, data is saved to the channel's Cal Register and, if you choose, to a User Cal
Set. When you choose to save to an existing User Cal Set, the analyzer attempts to append the new
error terms to the existing User Cal Set. The existing Cal Set data is completely overwritten UNLESS
the new data can coexist with the existing data according to the following two rules:

328



e The stimulus settings of the new data must exactly match the existing data.

e The new cal must involve different ports from the existing cal.

For example:

Case 1 - An existing Cal Set contains a full 2-port cal between ports 1 and 2. Using the same stimulus
settings, you perform a 1-port cal on port 3. At the end of the cal, you click Save As User Cal Set and
select the existing full 2-port User Cal Set.

Result: The 1-port cal is appended to the 2-port User Cal Set. There is NO overlap between them.
Case 2 - Same situation as Case 1, except the 1-port cal is performed on port 1.

Result: The Cal Set will contain a 1 port cal on portl and a 1 port cal on port 2. The overlapping
tracking terms are removed rendering the original full 2 port cal invalid.

How to Manage and Apply Cal Sets and Cal Types

The analyzer attempts to apply a Cal Set and turn error correction ON for ALL of the measurements on
the active channel. This may not always be possible. For example, suppose a channel contains both S11
(reflection) and S21 (transmission) measurements. If a Cal Set that contains only an S11 Cal Type is
applied to that channel, the Cal Set does not contain the error terms to correct the S21 measurement.
Error correction is turned ON for the S11 measurement and NOT turned on for the S21 measurement.

There are two ways to apply an existing Cal Set (Cal Register or User Cal Set) to a measurement:

1. Recalling an Instrument State with Cal data (.cst file) - A .cst file contains an Instrument State with all
measurement attributes AND a 'pointer' to the Cal Set that was used to calibrate the measurement. Before
saving a .cst file, be sure that a User Cal Set (NOT a Cal Register) is being used for the measurement.
Because Cal Registers are automatically overwritten when a new calibration is performed, it is likely that the
Cal Register data will change before the .cst file is recalled.

2. Create a new measurement and select a Cal Set to apply to the active channel.

Note: NEVER copy or modify Cal Sets from Windows Explorer or other applications. Cal Sets should
only be accessed through the VNA Application.
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How to select and apply a Cal Set to the active channel

Using Hardkey/SoftTablSoftkey

1. Press Cal > Cal Sets & Cal Kits > Cal Set....

Programminq Commands= }

Cal Set Selection dialog box help

[Lcose s S DT [
. [l
Cal Set Name Class Active Channels Cal Type/Ports Date :
| CalSet_1 STD 2P/1-2 2017/08/21-13:12
| || CH1_CALREG 8TD 2P/1-2, 4P/3-4-5-6 2017/08/21-13:12
f
h
i
i
Channel 1 - Select Cal Set ‘ | File - OK Cancel Help
Properties... = =

Copy-.
Delete

Delete Al

This dialog allows you to manage and apply Cal Sets

Since the number of Cal Sets you can have is limited by the amount of analyzer memory,
old Cal Sets (with 'stale' data) should be deleted or overwritten.

e Learn about Cal Registers.

e Learn how to View the Error Terms of a Cal Set.

To apply a Cal Set to the active channel, click a row to select that Cal Set, then click OK.
The Cal Set used by the currently active channel is indicated with dotted outline. Currently

selected Cal Set is indicated with blue highlight.

Note: A Cal Set must have been generated from the same measurement class as the active channel in

order for it to Applied.

Columns click a heading to sort by that column
Cal Set Name Name to identify the Cal Set.

Class Indicates the type of channel that created the calset.
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Active Channels Channel numbers that are currently using this Cal Set. A blank entry means it
is not currently in use.

CalType / Ports Type of Cal contained in the Cal Set. Learn about applying appropriate Cal Types.
Cal Type Abbreviations:
1P, 2P, 3P, 4P... - Port list indicating which ports were calibrated.

+ - Indicates source and receiver Power Correction is included for the ports that are listed. So
2P+(2,3) means that the test and reference receivers on ports 2 and 3 are power calibrated.

R - Response (parameter).

ER/x-y Enhanced Response, where X is the receive port; y is the source port. ER/2-3,
therefore, corrects S23.

ER+/x-y Enhanced response plus power. Also contains tracking terms for bx and ay.
Date Date and time the Cal Set was last modified.
Buttons

Select Cal Set Applies the selected Cal Set to the active channel. If the stimulus
settings of the Cal Set and channel are different, a choice must be made. This button is
greyed-out if the highlighted Cal Set is not compatible with the active channel.

Unselect Cal Set Available ONLY if the selected Cal Set is being used by the active
channel. Click 'Unselect Cal Set', then click OK to exit with the Cal Set un-applied.

OK Always APPLIES THE SELECTED CAL SET to the active channel, then closes the dialog
box. If the currently highlighted Cal Set is not compatible with the active channel and click OK, a
message dialog will be displayed and indicate the selected Cal Set is not compatible with the
active channel. Click OK to dismiss the message dialog.

Cancel Exit the dialog box. Performs no further action.
Drop-Down Selector

Channel To choose the active channel.

File This includes Properties, Copy, Delete and Delete All.

Properties Starts the Cal Set Properties dialog box. This allows you to view all of the Cal Set
properties.

Copy Invokes the Copy Cal Set dialog box. Type a name for the copy of the selected Cal Set
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data.
Delete Permanently deletes the Cal Set after you choose OK to a warning prompt.

Delete All Permanently deletes ALL listed Cal Sets and Cal Registers after you choose OK
to a warning prompt.

Cal Set Properties dialog box help

Calset Properties e o |

l Cal Set Name CalSet_5
Description CalSet_d

| Date Modified 2017/08/22-11:38:52
----- Calibration |
Measurement Class Standard
Cal Type 2PMn-2
——- System
GUID {1440CFA2-BBB3-4081-9B92-73250E0E3C8A} |
Firmware Revision 7.13.01.22 l
VNA Model Number M9485A |
VNA Serial Number SH23535387

v o . I pe— | I Ho

Cal Set Name... —

Description...

Allows you to view all of the Cal Set properties.
Drop-Down Selector
Edit This includes Cal Set Name and Description.

Cal Set Name Edit name of the User Cal Set. You CANNOT change the name of a Cal
Register.

Description Descriptive text to further identify the Cal Set.
Buttons

OK Applies the changes on Cal Set name or description if any and then closes the dialog box.
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Cancel Discard changes made to the Cal Set name or description.

Learn how to View the Error Terms of a Cal Set.

Note: Only temperature compensated calibrations show the temperature in the Calset Properties
dialog.

Correction Properties dialog box help

Tabs
Summary
%5
Summary | Cal Set
Cal Set Name CH1_CALREG
Cal Set Date 2017/08/25-10:53:36
-——- Correction
Measurement Class Standard
Fixtures Off
Paort Extensions Off
Interpolation On
I Channel 1 - OK l | Cancel Help

Allow you to view summary of correction properties including Correction, Receiver Power,
Source Power and Correction Level.

Channel Selector Select the channel that you want to view the summary of correction
properties.

Cal Set
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e T
=

| Summary | Cal Set
Cal Set Name CH1_CALREG
Description CH1_CALREG
Date Modified 2017/08/25-10:53:36
—— Calibration
Measurement Class Standard
Cal Type 2PN-2
—— System
GUID {00000001-0000-0000-0000-000000000000}
Firmware Revision 7.12.59.00
VNA Model Number M9485A
VNA Serial Number SH23535387

Channel 1 . oK |[ Gancel H Help

Allow you to view the Cal Set properties. Shows the same data as shown in the Cal Set Properties
dialog accessed from the Cal Set Selection dialog.

Channel Selector Select the channel that you want to view the Cal Set properties.

Stimulus Setting Different between Cal Set and Measurement

| Select Cal Set ~ Choose Stimulus Settings dialogboxhelp |
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Select Cal Set -- Choose Stimulus Setting x|

The Cal Set that you have zelected has different stimulus [%ttings
than the active channel.

Fleaze zelect one of the following actions:

— Actions

f* Do not change the active channel's stimulus settings.
If hecezzary, interpolation will be turned on autoratically.

™ Change the active channel's stimuluz settings to match thoze of
the zelected Cal Set.

[k, | Cancel | Help |

The Cal Set contains the channel stimulus settings that were in place when the Cal Set was saved.
This dialog appears when the Cal Set channel settings are different than those of the channel to
which the Cal Set is being applied. Choose between the following options.. (See above image).

¢ A. Keep the Active Channel Stimulus settings. Interpolate if possible.

e If the Cal Set frequency range is greater the active channel, then Interpolation will be turned ON.
Learn more about Interpolation Accuracy

¢ If the Cal Set frequency range is less than the active channel, then this option is not available.
o B. Keep the Cal Set Stimulus settings. The Active Channel stimulus setting are changed.
OK Make the change.

Cancel Cal Set will NOT be applied.

Examples of Cal Set Usage

The following examples show how Cal Sets increase flexibility and speed in making analyzer
measurements.

e Using one User Cal Set with many Channels

e Using one Measurement with many Cal Sets

335



Using one User Cal Set with many Channels

It is possible to do one calibration, then apply it to several channels.

An example:

During a manufacturing process, you may have many calibrated channels. You may wish to
continuously cycle through the measurements and examine them individually. Occasionally,
you may wish to refresh the calibration without having to recreate all the measurement state
files.

Here is how: Examine the stimulus settings for each channel. Then make the User Cal Set
stimulus range a super-set of the whole group. Each channel can then use the same User
Cal Set. Some calibrations will be interpolated. Note: Make sure that interpolation is turned on.

Notice in the following image, Cal Set 78 is used on more than one channel, in this case
Channel 5 and 16 .

Channel Cal Set

AWM=

NMlajlWiMK|] =

[ \—p
4
=

98
15 o
16 p— 100

Using one Measurement with many Cal Sets

The drawback with having one very large User Cal Set associated with many instrument
states could be a loss of accuracy due to interpolation. In such cases, consider using one
User Cal Set for each stimulus setting.. The stimulus conditions can then be changed for a
channel by applying different User Cal Sets. Other settings (window setups, measurement
definitions, scaling, limits, markers) will not change. This may result in faster state changes
than if you saved and recalled *.cst files for each set of stimulus conditions.
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Example #1: An amplifier needs to be measured at several input power levels. Calibrate at
several power levels and save each calibration in a separate User Cal Set. Then, apply the
User Cal Sets to the single measurement consecutively.

Example #2: Making an S21 Measurement, you need to measure both wide span and
narrow span characteristics of the device. One Cal Set covers the wide span setup; another
the narrow span setup.

Archiving Cal Sets using .cal or .csa files

Because User Cal Sets can easily be deleted, provide extra backup by also saving your
calibration as a .cal or .csa file (see saving a .cal file).

Example:

One person performs a calibration, names and saves it as a User Cal Set. This Cal Set is
available for any other person to use. A second user could accidentally delete or modify the
User Cal Set requiring the originator to repeat the calibration.

Security can be provided for calibration data by saving the Cal Set to a .cal file or .csa file. At
a later time, the file could be recalled and the original calibration restored.
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Error Correction and Interpolation

Error Correction and Interpolation settings work together to provide you with the highest level of
calibration accuracy possible.

How to set Error Correction

Error Correction

Viewing Correction Levels

How to set Interpolation

Interpolation Accuracy

See other Calibration Topics

How to set Error Correction
Using Hardkey/SoftTablSoftkey

1. Press Cal > Main > Correction > Channel Correction On|Channel Correction Off.

Pru-gra.mming Commands ’

Error Correction

The Error Correction ON setting means that the calibration error terms are applied to the measurement.
Error Correction is automatically turned ON when a calibration is performed or if a Cal Set is applied
to a measurement. The VNA attempts to turn error correction ON for ALL of the measurements on the
active channel. This may not always be possible when applying Cal Sets. For more information, see
Applying Cal Sets.

When full 2-port error correction is ON, both forward and reverse sweeps are required to gather all 12
error terms, even if only one reflection measurement is displayed. This may result in a higher
measurement speed than expected. Learn more.

You can always turn Error Correction OFF for the active measurement by clicking Correction OFF.
The VNA will turn Error Correction OFF automatically when making stimulus changes under some
conditions. To turn correction back ON, click Correction ON. Then:
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o [f Interpolation can NOT be performed, a dialog box will ask if you would like to change the stimulus settings
to those of the applied calibration. Click OK or Cancel.

o If Interpolation can be performed, the stimulus setting will change and correction turned ON.

How to set Factory Error Correction
Using Hardkey/SoftTablSoftkey

1. Press Cal > Main > Factory Cal On | Off

Prugramming Commands ’

Factory Calibration

The factory calibration is a calibration which is done at the factory shipment or service centers for
periodical calibration.

Viewing Correction Level

The correction level provides information about the accuracy of the active measurement. Correction
level notation is displayed on the status bar for different calibration types like response, full 2-port,
TRL, or power calibration.

To View Correction Levels:

Right-click in the display, select Customize Display, select Toolbars tab, then select Status Bar. The
status bar appears and displays the following items:

Tr2 | Ch1 | IntTrig Meas | BW=100k | No Cor
RFOn UpdateOn IntRef

Correction Level Accuracy

C N-Port  Full N Port Highest
C Enh Resp Enhanced Response

CResp Response

Factory  Factory calibration at test port

No Cor No Correction Lowest
C*  Interpolated Uncertain
CA  Changed Uncertain
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C N-Port
Full N Port correction, where NV is the number of fully calibrated ports.
This correction is applied to SParameters.

If the calibration was performed with a receiver power cal, this correction can be applied to receiver
measurements. (eg: al, bl, A, R1, bl/al). (See Correction Methods for the ability to control the level of
calibration applied to receiver measurements).

C Enh Resp
Enhanced response cal is an aggregate of a 1 Port calibration and a transmission response cal.

This correction is applied to reflection and transmission parameters in either the forward direction
(S11, S21) or the reverse direction (S12, S22) depending on how the calibration was performed.

For reflection measurements, Enhanced Response correction is equivalent to C 1-Port correction. For
transmission measurements, the correction is equivalent to a match-corrected transmission response
cal.

C Resp

Response calibrations are one term calibrations that correct for the frequency response of the
measurement. It does not correct for impedance mismatches.

No Corr No Correction

The following will cause the VNA to turn Error Correction OFF for the channel:

e Decrease the start frequency
¢ Increase the stop frequency
e Change start frequency, stop frequency, or number of points with Interpolation OFF.

e Change sweep type

The correction pop up pane, accessed by right-clicking on the Correction item in the status bar,
indicates port by port correction methods for a VNA with 12 or less test ports. This table is updated
when the port subset correction is turned on to reflect the correction methods being applied. In the image
below, the pane indicates a full 4-port calibration. On the right, the table indicates the methods after
the correction was devolved to ports 1, 2, and 3.
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S
123 4
1 F+F+F+F+
2 F+F+F+F+
3 F+FFF+
4 F+ F+ F+ F+

Basic Cal...
Smart Cal...
Cal All Channels...

Cal Properties...
Correction off

Cal || SrcCal |

5
1 2 3 4
1 F+ F+F+e+
2 F+F+F+e+
3 F+F+F+e+
4 etetetF+

Basic Cal...

Smart Cal...

Cal All Channels...
Cal Properties...

Correction off

The F+ indicates that the port had the full error correction applied. The e+ indicates that the enhanced
response correction method was applied to the port.

C* Interpolated Correction

"C star" appears in the status bar when a measurement is being interpolated. See Interpolation (above)

and Interpolation Accuracy.

CA Changed Settings

"C-delta" appears in the status bar when one or more of the following stimulus settings change. The
resulting measurement accuracy depends on which parameter has changed and how much it has
changed. For optimum accuracy, recalibrate using the new settings.

Sweep time

IF Bandwidth

e Port power

Stepped sweep enabled/disabled
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How to set Interpolation
Using Hardkey/SoftTablSoftkey

1. Press Cal > Main > Interpolation ON|OFF.

Pru-gra.mming Commands ’

Interpolation

Calibration interpolation adjusts calibration error terms to match changes to the following settings that
you make AFTER a calibration is performed or a Cal Set applied.

The Interpolation ON setting means that interpolation is enabled for the active measurement. This does
not necessarily mean that the measurement is interpolated. When enabled (ON), if interpolation
becomes necessary because you change any of the following stimulus settings, then interpolation will
be applied. When stimulus settings change while interpolation is OFF, interpolation is NOT applied but
instead, error correction is turned OFF.

Interpolation occurs (if enabled) when you change any of the following settings:

e Start frequency increased
e Stop frequency decreased

e Number of points

Note: Decreasing the start frequency, or increasing the stop frequency will always turn correction OFF.
(Exception: Power Calibration DOES extrapolate to the start and stop frequencies.)

Interpolation Accuracy

When a measurement is interpolated, the accuracy of the measurements cannot be predicted. It may be
affected significantly or not at all. Identifying measurement errors in these cases must be determined on
a case-by-case basis. In general, the magnitude and phase stimulus from the VNA and the response
from the DUT need to be smooth and continuous for measurement interpolation to give accurate
results.

Significant measurement inaccuracy WILL occur when the phase shift response between measurement
points increases changes more than 180 degrees. The VNA will incorrectly interpolate the new phase
data. For more information, see phase accuracy.

In general, the chances of significant inaccuracy increases when interpolating measurements under the
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following conditions:

e when frequency span between measurement points becomes much greater.
¢ when measurement frequencies are above 10 GHz where phase changes happen more rapidly.

e when interpolating across frequency band crossings. Learn more about band crossings.

Note: When the interpolation algorithm encounters an abrupt or large change in the response
magnitude or phase, such as can occur at band crossings, large interpolation errors can be included in
the displayed data. These errors can be seen as steps or spikes. If this occurs, consider turning off
interpolation, changing the measurement parameters, or creating sweep segments that skip over the band
crossings.
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Using ECal

This topic discusses all aspects of performing an ECal:

e ECal Overview

e Connect ECal Module to the Analyzer

e How to Perform a Calibration Using ECal
See Also:
ECal User-Characterization

Perform a 4-Port Cal with ONE 2-Port ECal Module

Restore ECal Module Memory

See other Calibration Topics

ECal Overview

ECal is a complete solid-state calibration solution. Every ECal module contains electronic standards
that are automatically switched into position during a measurement calibration. These electronic
standards have been measured at the factory and the data stored within the memory of the ECal
module. The analyzer uses this stored data, along with the measured data, to calculate the error terms
for a measurement calibration.

ECal modules are available in 2-port and 4-port models and a variety of connector types, covering
many frequency ranges. See Analyzer Accessories for more about available ECal modules and ordering
information.

You can perform the following calibrations with ECal:

e 1-Port Reflection calibration
e Full 2-Port calibration
e Full 3-Port calibration

e And so forth...

Verify the validity of a mechanical or ECal calibration with ECal confidence check.
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Care and Handling of ECal Modules

You can improve accuracy, repeatability, and avoid costly repair of equipment in the following ways.

e  Practice proper connector care. See Connector Care.

e  Protect equipment against ESD damage. Read Electrostatic Discharge Protection.

Power Level into an ECal module

e NEVER exceed the following Damage levels to the ECal module.

e For highest accuracy, do not exceed the following ECal Compression levels when calibrating:

Model Compression level Damage level
N469x series -5dBm +10 dBm
N4432A series -7 dBm +20 dBm
N4433A series

N4431x series +7 dBm +20 dBm
N755xA series -5dBm +10 dBm
8509x series +9 dBm +20 dBm

The power level can be increased after calibration with minimal impact on measurement accuracy.

Connect ECal Module to the Analyzer

ECal modules are controlled and powered through a USB connection. When you connect the module,
the type of module, frequency range, and connector type are automatically recognized.

Important Note: DO NOT connect/disconnect USB devices during ECal calibrations. Doing so may
cause problems with the calibration.

Notes:

e Unused ECal modules that have completed a calibration may remain connected to the USB port.

e You can connect and disconnect the ECal module while the analyzer is operating. However, DO NOT
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connect or disconnect the module while data transfer is in progress. This can result in damage or at least
corrupted data.

How to Perform a Calibration Using ECal

Select an ECal module that has connectors of the same type and gender as the DUT. If such an
ECal module is not available, a module with connectors different from the DUT can be used by
using Advanced Settings or User Characterization. See Also: Perform a 4-Port Cal with ONE 2-Port ECal
Module

Connect the ECal module ports to the analyzer ports. During the calibration process the analyzer
can either automatically detect how the ECal module is connected, or the orientation can be
performed manually.

1. Connect the ECal module USB cable to the analyzer USB. See Connect ECal Module to USB.

2. Allow the module to warm up until it indicates READY.

3. Enter the analyzer settings. See Set Up Measurements.

4. Do one of the following to start the Calibration Wizard

Using Hardkey/SoftTablSoftkey

1. Press Cal > Main > Other Cals > Ecal....

Prugramming Commands }

2. In the Guided Calibration Wizard dialog box (step 2), select ECal option from the Cal Kits combo box.
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Select Calibration Ports and ECal Module dialog box help

Select Calibration Ports and ECal Modu b

Cal Ty Sbirctns 4 PoAEC Db Shivs

i | - SeecedCalke  BSHROEDNT

2Pt ECal = Baral Mo 00778

FotECal — Chammaniolsh  Famosy
=1 Vsl eiemECH Mot

[ Shemwr tdbvareid Salireyd (Draedaten & Thro Cal Sosben)

£ Dmci Hgud Cancsl Hedp

Allows you to select calibration type and settings.

Cal Type Selection / Configuration Select the number of ports to calibrate. Then select the port
number configuration.

4 Port ECal
3 Port ECal
2 Port ECal
1 Port ECal- (Reflection) Advanced Settings are not available.

View/Select ECal Module Click to Select the ECal module if more than one ECal module is
connected to the USB. Also, Select the User Characterization within the module. Learn more about
User Characterization.

Show Advanced Settings Check to display the Advanced Settings when Next is clicked.

Back Return to Cal Wizard Begin dialog.

Note: ECal isolation is not performed. The inherent isolation of the analyzer is better than that
attained with correction using an ECal module.

Note: Terminate any unused ECal ports with a 50 ohm load. Refer to Determining Effects of Not
Terminating Unused ECal Ports.

Note: Do not connect any USB memory during ECal calibration.
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Enmor; An ECal module wae rot found. Please be sue the ECH module i corrected
ooy, ['ou may ressd o disoonrect and ie-conrect the LIS cable]

_Fu |

e | o | o | [

When this dialog appears, the ECal module is not connected or has not been recognized by the
network analyzer.

Retry Check the USB connections and click to continue.

Notes:

¢ If your ECal module is not detected, try to unplug, then reconnect to the USB.

e When the ECal module is connected to the network analyzer for the first time, it may take approximately 30
seconds for the analyzer to recognize the module and make it available for calibration.

e For best accuracy, allow the ECal module to warm-up until it indicates READY.

e See Connect ECal Module to USB.

| Select Module and Characterization dialogboxhelp |
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‘Select Calibration Ports and ECal Madule

Cal Type Selachon 2 Poat ECal Conliguraton
4Fof ECa Soloct 151 Pont 1 - Saloctod Cal Kit N4E91-60004
JPoECal Earial M D001
2 Pot ECal Solect 2nd Poet | 2 bd e
1 Po ECal Chesacheriraions  Faciory
WirwSeled ECal Moduls
o = S |
" Ehectronic Calibration: Select Module and Characterization E
ECal Module, | Modked; N4G91-60004, S0 011 = Dot Connecind ECak

dvvilable Charachir 2atons: (@ ECal Module Memory Irsstrumint Disk Memory

0 Port & Correc... PortB Connec.. Min Freguency M Freqguency  Murber of P Port A Exferaion

Factory APC 15 femals  APC 315 mals 200 ez 265 GHE b e ] Pt Sppie ki

Ihar 1 APC3Sfomale AFC 3% forale 300 ME G a1 Mo adagder

Lgar 2 APC 1S fernale  APC 1S male 000 iz B G 1601 iy Sl

User 3 APC 395 formale  APC 35 male 10 MHE k-4 il P SClapieT

4 ¥
e 4 Cancel P

Note: User Characterizations listed in the dialog below that have no temperature shown
cannot be temperature-compensated during calibrations. Also, this is true of CalPod as
ECal characterizations that were performed prior to this temperature capability in the VNA
firmware, because temperature was not measured-and-recorded. However, the firmware
will still recognize those and allow them to be used for cals.

.Selecl.' Calibration Ports and ECal Module

Call Type Selackon 4 Por ECal Conbguraiion
4 Fan ECal - Silached Cal Kn CalPod MyCharacterization
Far ECal
A = Saviol Mo 02297
1 Fon ECal Charscignrabon
i = Wiray Sokec ECal Mogule
s - — &1
... Electronic Calibration: Select Module and Characterization =5
wHHOR
B Mok | (Mol CatPod Myl | B4 (0290 = Dt Corracied ECal
At Chor aes 2 ators | B Modkls Maory (00 It Ditk Mafory
ﬂ Port & Extinion Pt B Extérkion Duirtar Chiractiningd. . etk dnsiynir Temeesatuts (¢
4 L3
Carced | el

ECal Module Select one of the ECal modules that are connected to the analyzer.
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Detect Connected ECals Click to rescan the USB for ECal modules.
Available Characterizations

ECal Module Memory - Displays the factory and user characterizations that are stored in the ECal
module.

Instrument Disk Memory - Displays the user characterizations that are stored in Disk Memory.
Learn more User Characterizations in Disk Memory.

Temperature - Displays the temperature reading at the time a characterization was performed.

The information in the Calset Properties dialog confirms which of those characterizations
were temperature-compensated during calibration. The (compensated) notation for a CalPod
indicates that the CalPod’s characterization was temperature-compensated when that cal’s
error terms were computed (it also implies the factory thermal data for that CalPod must be
present on the VNA). Whereas the (uncompensated) notation indicates that temperature-
compensation could not be done for that characterization during the cal, which could mean
either that one is an older characterization that didn’t record its temperature, or else factory
thermal data for that CalPod serial # was not installed on the VNA.

Select the characterization data to use for the calibration. Once selected, that characterization
becomes the default selection until the analyzer is turned OFF and restarted. When restarted,
Factory again becomes the default selection.

Error: Frequency Range dialog box help

Gl Kt Claas Comagony F

P R0 ECd 01 200 Sl K Evvor: Tha 5114 dass sienderds n nod dedesd oot e oumend irpquansoy sefegs
Thir psidebarmal tharadordd moedid rmon! ke (AP 3 5 S ala] cosrscsn

T rcechilly bpqueprasy 1pSingy prave Frequesray F-ua—.mr\-'-yl

BEZN|

When this dialog appears, the current cal standards (or ECAL module) does not cover the current
frequency range of the measurement. Do one of the following to correct the problem:

Cal Kit Class Category Not available with ECal modules.
Frequency Change the frequency range of the active channel.

Edit Not available with ECal modules.
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Back Select a different characterization that covers the required frequency range.

Cancel Re-characterize the module with an increased frequency range.

Cal Kbz

Cioaver lore
ouT ot | T 7] [0 L o0 7]
DLT Pt 2| [4FC 26 female ¥] | |[2B0CCE0010 Lser 200 #]

Cal bedhodt 4-POAT, SOLT

BUT Fon 2| [4FC 2.5 make i | T e |
LUT P'aH-lI.'.'.FE 35 mae K ||aﬁrra:z-a:-:-1|:| I za;l|
¢ Back et > I

If the ECal module or selected User Characterization has more than one connector type, then the
following dialog box is presented which allows you to describe the DUT connector type. Otherwise,
click next to proceed to Advanced Settings (if checked) or ECal Steps.

Connectors

The available connectors are listed for each DUT port.

Elecironic Lahbeatson Advamrced Setlirga

1 st Pioet | 2nd T hwu ICall M sthod
Thull 1 =|[3 =||ECal Theu s Lk =] | Col TopesSads...

Thutiz 1 =][t =][ECa Theu e Urkne =] Cal TrpesSids..
Thutd 7 =[5 =][ECa Theuhs Urkons =] ColTppessde |  [CE3ETRGL]

Thutd 1 =][2 =|[ECaiDefred Thol =] CalTopasSade.|  Foomove Thu
Do crsntation |mao menaing of pod connectiont] IT Choome delta match

cgok [ Hews | coe | v |

Thru #n
Lists the proposed Thru connections to be made during the calibration process. You can change
these Thru connections to better suit your test setup.

e The proposed Thru connections are listed automatically.

¢ Additional Thru connections can be selected for higher accuracy. Learn more.
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e For Balanced measurements, learn which Thru paths to select.

Add Thru
Click to add a Thru connection. Learn more

Remove Thru

Select a Thru by clicking the "Thru #N" field or the "1st Port / 2nd Port" field. Then click "Remove
Thru". This selection is NOT available if the selected Thru is required for the calibration.

1st Port / 2nd Port

Click to change the two ports to be included in the Thru connection. The order of the port numbers
(1st or 2nd) is not critical.

Thru Cal Method

Lists the available Thru Cal methods for the specified port pairs.
Learn about ECal Thru Methods

Cal Type/ Stds

Click to invoke the View / Modify Properties of Cal dialog box

Do orientation

When this box is checked (the default setting) the VNA automatically senses the model and
direction in which an ECal module port is connected to the VNA ports. If power to the ECal module
is too low, it will appear as if there is no ECal module connected. If you use low power and are
having this problem, clear this check box to provide the orientation manually.

Orientation occurs first at the middle of the frequency range that you are calibrating. If a signal is
not detected, it tries again at the lowest frequency in the range.

Choose delta match

Available only when a Delta Match Cal is required.

e Check, then click Next to invoke the Select Cal Set for Delta Match dialog box.

e Clear - The Cal Wizard uses the Global Delta Match Cal if available.
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This dialog box appears when the Do orientation checkbox in the previous dialog box is cleared.

Click the ECal Port that is connected to each VNA port.
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Note: Beginning in VNA Rev. 6.0, ECal can be performed with External triggers. Learn more.

Displays the instructions for each measurement required for calibration.
Measure Measures the ECal standards.

Done Click when last standard has been measured.

Saving an ECal Calibration

When complete, you can save the new calibration. Learn how.
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ECal User Characterization

Overview

How to Perform a User Characterization

Manage Disk Memory

Restore ECal Module Memory

See Also
Using ECal

Perform a 4-Port Cal with a 2-Port ECal Module

Other Calibration Topics

Overview

A user-characterized ECal module allows you to add adapters to the ECal module, re-measure the
standards in the ECal module, INCLUDING the adapters, then add that data to ECal memory or save it
to disk memory. This extends the reference plane from the module test ports to the adapters.

Compared to legacy ECal modules, the new N755xA ECal modules have greater flash memory.

Important Note: DO NOT connect/disconnect USB devices during ECal calibrations. Doing so may
cause problems with the calibration.

Why perform a User Characterization?

¢ If you need to use adapters with your ECal module, you could characterize your ECal module with the
adapters attached and perform subsequent ECals in a single step.

¢ If you have a 4-port ECal module, you could configure the module with adapters of different connector types,
then perform a User Characterization of the module. When you need to test a DUT with a pair of the
connector types on your module, calibrate the analyzer with a 1-step ECal using the same two connectors on
the User-characterized module.
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o If you test devices in a fixture, you could embed the characterization of the fixture in the characterization of
the module. To do this, during the mechanical calibration portion of the User Characterization, calibrate at the
reference plane of the device as you would normally calibrate. Then remove the fixturing to be embedded
and insert the ECal module to be characterized. When measuring the ECal module, the analyzer removes
the effects of the fixturing and stores the measurement results in the user characterized ECal module.
Subsequent calibrations with that user-characterized module will also remove the fixture effects.

Notes:

e Both 2-port and 4-port ECal modules support User Characterization.

e User Characterization does not delete the factory characterization data. The factory data is saved in the ECal
module in addition to the User Characterization data.

e The ECal Data Wipe Utility is the only way that data can be deleted from the module. Learn more at
http://na.support.keysight.com/pna/apps/applications.htm.

e A User Characterization can be performed beyond the frequency range of the ECal module. Although this
practice is allowed, calibration accuracy with the extended User Characterization is likely to be degraded. To
determine the level of degradation, compare measurements of a variety of devices with a mechanical cal kit
calibration versus an ECal extended User Characterization calibration.

e You can save up to 12 User Characterizations in a single ECal module. Previous releases allowed up to 5.
There are memory limitations. The analyzer will determine if the contents of a User Characterization will fit

inside the module before it is performed.

e A User Characterization can be performed remotely. See programming commands.

User Characterizations can be saved to Disk Memory. Learn how.
This feature provides the following benefits:
¢ A User Characterization using connectors that are NOT included in the supported connector table can
NOT be stored to the ECal module. But when stored to disk memory, ANY connector type is allowed by
firmware using a description of any length for the User Characterization.
e There is NO limit to the number of data points allowed in a User Characterization stored to disk memory.
When stored in the ECal module, the number of data points is limited to a maximum of 65535 per

characterization, or less as dictated by the remaining free memory in the module.

e The number of User Characterizations that can be stored to disk memory is limited only by available disk
space.

e User Characterizations stored to disk memory can be freely shared between analyzers.

Learn how to Manage User Characterization in Disk Memory.
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How to Perform a User Characterization

SUMMARY (A detailed procedure follows.)

r Adapters -1

1. Select adapters for the module to match the connector configuration of the
DUT.

PNA
Port 1 Port 2
LE*‘—|“:|:“|—

short Bll --5 Thru --- ] short

2. Either calibrate the analyzer using mechanical standards or recall an existing
Cal Set.

Open H'“: :“'H Open
1 1
Load [l --- ===l 10ad
PMA
Port 1 Port 2

3. Measure the ECal module, including adapters, as though it were a DUT.

PNA

Port 1 Port 2

4. The measurement results are the characterization data that then gets stored inside
the module or to disk.
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Note

A 2-port analyzer can be used to perform a User Characterization on a 4-port ECal module.
However, a 4-port ECal module has SIX different port pairs. The analyzer must be recalibrated for
each port pair that uses unique connecter types or gender.

e If all 4 ECal module ports have the same connector type and gender, then only one calibration is required to
measure all six port pairs.

o If all 4 ECal module ports have different connector types or gender, then 6 calibrations are required.

When more than one calibration is required during a User Characterization, then ALL calibrations
must be performed using the standard Cal Wizard, saved to Cal Sets, and then recalled from Cal Sets
DURING the User Characterization.

Detailed steps to Perform a User Characterization

1. Connect the ECal module to the network analyzer with the USB cable. See Connect ECal Module USB
to the analyzer USB.

2. Allow the module to warm up until it indicates READY.
3. Preset the analyzer.
4. Set up the measurement. For best accuracy, the IF bandwidth should be set to 1 kHz or less.

5. Start and complete the Characterize ECal Module Wizard:
Using Hardkey/SoftTablSoftkey

1. Press Cal > Cal Sets & Cal Kits > ECal > Characterize ECal....

Prcl-gra.mming Command= ’
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Select Module and Location dialog box help

ki (1w b e ECal Modli: Sedact rocdule and location lor new dharasdberization

Locson
 ECalbiosbs Wpssey
5 PMADRE sty Chaeachmigpson Mame [H4,00T] Kirpteooard

I b b I Crnenl | B |

ECal Module Select one of the ECal modules that are connected to the analyzer.
Detect Connected ECals Click to rescan the USB for ECal modules.

Location

e ECal Module Memory Click Next to see the following dialog.

e Disk Memory Enter a Characterization Name. This name appears when selecting a User
Characterization to be used with subsequent calibrations.

e Learn how to manage characterizations that are stored to disk memory.

e See the benefits of storing the User Characterization to disk Memory.

Keyboard Launches a keypad that can be used to type a characterization name from the analyzer
front panel.

Next Click to continue to the Select Connectors for the Characterization dialog box.

See note regarding extended frequency use.
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Select User Number for new characterization dialog box help
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Scroll to view all of the parameters of the stored characterizations. Select an empty location or
select to overwrite an existing characterization.

Next Click to continue to the Select Connectors for the Characterization dialog box.

See note regarding extended frequency use.

Select Connectors for the Characterization dialog box help

Uzes Charactesize ECal Module: Select Connecto 51 the Characterization il

FORT B {£5T 25 famasle -

Connector Notes

the "Type A" variations from the list of connectors for each port.

A User Characterization using connectors that are NOT included in the supported connector table
can NOT be stored to the ECal module. But when stored to disk memory, ANY connector type
is allowed. Learn more about storing to Disk Memory.

When performing an ECal User Characterization, do NOT use a custom connector name that you
added to this list. If you need to use a custom-defined connector type, select "Type B", or one of

Select the adapters for the ECal module test ports. Select No adapter if no adapter is used on a port.

PORT A Lists the connector types available for Port A.

PORT B Lists the connector types available for Port B.
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PORT C Lists the connector types available for Port C (available with a 4-port ECal module).
PORT D Lists the connector types available for Port D (available with a 4-port ECal module).

Next Click to continue to the Calibrations to perform or recall dialog box.

Calibrations to perform or recall dialog box help

Uses Charsctesize ECal Module: Calibrations to pesfoam on recall e x|
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The analyzer must be calibrated before measuring the ECal module and necessary adapters. This
dialog box displays the number and types of mechanical calibrations required for the
characterization.

Guide me through this cal now Click to perform a Guided calibration. A calibration kit is
required for each connector type.

If more than one calibration is required, the following selection is not available. See Note.

Let me recall this cal from a cal set Click to select an existing Cal Set. You cannot select a Cal

Set that is currently in use. Learn more about Using Cal Sets.

Next Click to continue to either the Select Cal Kits or the Select Cal Set dialog box.
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Provides a list of calibration kits to perform the calibration. Select the Cal Kit you will use for each
port.

Enable Unknown Thru for characterizing the module Check to enable. This reduces the
number of steps required to characterize the THRU standard.

Next Click to continue to the Select Cal Set dialog box.

User Charactenize ECal Module: Select Cal Set
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The calibration that you perform will be written to a Cal Set. This dialog box allows you to select a
Cal Set to overwrite, or to write to a new Cal Set. The current choice is visible below the Select Cal
Set button.

Select Cal Set Click to open the Select A Cal Set dialog box.

Create new Cal Set Check to create a new Cal Set to store the calibration. Clear to select and
overwrite a stored Cal Set.

Next Click to continue to the Guided Calibration Steps dialog box.

Note: Remember the Cal Set name for future reference.
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Guided Calibration Steps dialog box help

User Characterze ECal Module: Guided Calibistion Step 1 of 7
PR 1 s
o
L]} @ o J[1]
3
m Meaxre I

Connact 25 MM MALE OFEN Iopoet 1

cBack | Mews | coanca |

Instructs you to connect each calibration standard to the measurement port.
Measure Click to measure the standard.
Back Click to repeat one or more calibration steps.

Done Click after a standard is re-measured and all measurements for the calibration are
complete.

Next Click to continue to the next calibration step. (Does not measure the standard.)
Cancel Exits Calibration Wizard.

The Specify nominal delay or Guided Calibration completed dialog box appears when the steps
are completed.

Speclfy nominal delay dialog box help

This dialog ONLY appears when Adapter Removal or Unknown Thru calibrations are performed.

The following values were estimated from the measurement. Most of the time, they are adequate.
However, for CW sweep or frequency sweep with large step sizes, the accuracy of the values may
be improved.

Nominal adapter delay To improve this value, measure and record the delay of the adapter with a
dense step size. Enter that value here.

362




Nominal phase offset (Waveguide ONLY). To improve this value, measure and record the phase
offset of the Waveguide adapter with dense step size. Enter that value here.

When one connector is coax and the other connector is waveguide, the phase offset has an
ambiguity of 180 degrees. For consistency, the estimate provided here is always between 0 and 180
degrees. You can change this estimate to any value between -180 degrees and +180 degrees.

Guided Calibration completed dialog box help

Uzer Charactismze ECal Moduls: Guided Calibrafion compledsd [x]

SmariCal Tha calbeahion o Ports AR has completed succasbul
The calbrsion = savsd nlo pour calsst
CaltSel: CalSet_213

v ookt vl b 2anem an insttrment slale Thal points bo tas cal er?
¥ Mo Finih reee. T Mex

© Back | Mt » |

Allows you to finish the calibration and continue to the next characterization steps.
No. Finish now Select to save Cal Set data.
Yes Allows selection of Save options.

Next Click to continue to the Exit to Inspect Quality of Calibration dialog box.

Exit to Inspect Quality of Calibration dialog box help

Uges Characieize ECal Module: Exil bo Inspect Qualkty of Calibsslion?

Click M est' ba bzgin measning de module, or click Tancel’ b exx thiz swizand F pou kave lests pou would e o
peshanm on Lk calshor

If you checse o et now, pou can launch this wizand 2gain later and select (o load e coibeation
I 'z ol gal

¢ Back Cancel J ]

Allows you to exit User Characterization to validate the calibration before proceeding with the
characterization.

Back Allows you to repeat calibration.

Next Click to continue to the Characterization Steps dialog box.
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Cancel Exits the Calibration.

To return to the current step:

1. Start User Characterization.
2. Inthe Select user number for new characterization dialog box, click Next.

3. In the Select Connectors for Characterization dialog box, click Next. (Previous entry is stored in
memory.)

4. In the Calibrations to perform or recall dialog box, recall the Cal Set that you just performed.

Characterization Steps dialog box help

User Charsctesize ECal Module: Charactenzation Step 1 of 1
FORL 1 o

Measue

Cennect ECal Modul: Pois & |with pour APC 25 male adapter] and B fsith pour APC
3.5 lemals sdeplei) lo Ports 1 and 2

Heo |

Describes the instructions for each measurement required for characterization.
Measure Measures the ECal module.

Next Click to continue to the Information for the New Characterization dialog box when
measurements are complete.

Information for the New Characterization dialog box help

User Characteize ECal Module: Information for the New Charackerization

Wou name of Company name:
Dheceenphion ol the neleo, Srakeer (1o be storsd r module] ECa i thee
Dhezoription of Port & esercion [adapter, cable, fshue, o | s ol B e el
Click, Help' lor suggestions: on
Dhascniphion of Port B sberiion [adapher, cable, s, sic | sbbevastons lor connechor
deseriptions:

Allows you to describe the properties of the User Characterization.
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Suggestions for connector abbreviations

To minimize the number of characters, we suggest using the following 3-character codes to describe
the connectors listed.

A User Characterization using connectors that are NOT included on this list can NOT be stored to
the ECal module. But when stored to disk memory, ANY connector type is allowed. Learn more
about storing to Disk Memory.

Connector Type | 3-Character Code
1.0 mm female | 10F
1.0 mm male | 10M
1.85 mm female | 18F
1.85 mm male | 18M
2.4 mm female | 24F
2.4 mm male | 24M
2.92 mm female | 29F
2.92 mm male | 29M
3.5 mm female | 35F
3.5 mm male | 35M
7-16 female | 16F
7-16 male | 16M
Type F female | F7F
Type F male | F7M
N50 female | NSF
N50 male | N5SM
N75 female | N7F
N75 male | N7M
APC7 | TMM
K-band waveguide | KBW
P-band waveguide | PBW
Q-band waveguide | QBW

R-band waveguide | RBW

U-band waveguide | UBW

V-band waveguide | VBW

W-band waveguide | WBW

X-band waveguide | XBW
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| Next Click to continue to the Write Characterized Data to the ECal module dialog box. |

Hll:-:l:l Characlenine ECal Module: Wiite Charactensed Dala by ECal maidile msmod 5‘

Hete: Thiswl bz & fee minates

cBack | ded: | Comcdl | He |

User Characterization and factory characterization data is written to either the disk memory or the
ECal module memory.

Write Click to write data.

The Summary of new User Characterization dialog box opens after data is saved to module.

e Existing data will be overwritten is you selected a User Characterization number that already has data.
Learn more

e For more information, see Restore ECal module memory.

e The ECal Data Wipe Utility is the only way that data can be deleted from the module. Learn more at
http://na.support.keysight.com/pna/apps/applications.htm.

| Summary of new User Characterization dialogboxhelp |

User Characterize ECal Module: Surmmany of new uzer characterzation

Madel Humber: CalPod Senal Mumber S0270198

Characlenzalion Name: reahy?, Tempersture [Celaus) 3225

Characlenzed By in. Frequency 100 kHz
Drabe; Jan03 2018 Maw Frequency: 135 GHz
Habaoek Analyzes: Mumbers of Pointz: 201

Pait RF1 Ir sku Pait RF1

Fon RF2 AP 35 male Pait RF2

ctack | Fish | | Cancel | | Hep |

Verify the status of the ECal User Characterization.
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e ECal module model number
e summary from User Characterization

Cancel Click to exit (characterization complete).

Finish Click to exit (characterization complete).

Manage ECal User Characterizations in Disk Memory

Normally, User Characterizations that are stored in disk memory can be used indefinitely without
needing them to be managed. However, this dialog allows you to backup the characterizations in case
they are accidentally erased, or to save them to a file that can be moved to another analyzer.

How to Manage ECal User Characterizations in Disk Memory
Using Hardkey/SoftTablSoftkey

1. Press Cal > Cal Sets & Cal Kits > ECal > Manage ECal Disk Memory....

Pru-grannning Commands }

Manage ECal User Characterizations in Disk Memory dialog box help

Manege ECal User Characterizations in Dusk Memony @
ECal Modulie: | Moded: N8691-60004, S/ 00011 =
—_—
Avalable Characherizations: M Sve AS... Dbt
o8] Port A Conrmector Port B Connector Min, Frequency Mg, Froguency Musrkeer of Poinds  Port
foa APC 2.4 lemale APC 2.4 male 100 MHz 201GH: Furl|
O Cancel Help

367




Manage ECal User Charackenzations in Disk Memory
ECal Module: |Model: CalPod, 5N 50270196 = |
Available Characterizations: | Impart... | | Save hs.. | | Delste |
Part RF2 Extension Diabe Characterized By Maobwork fnalyzer Used  Temperature (Celsius)
Dec 29 2017 33
Jan 03 2018 32.25
| m b | [}
L
ok || caneel | Hep |

This dialog allows you to do either of the following:

e Save an existing User Characterization in disk memory to an *.euc file.
e Load a previously saved *.euc file for use on the analyzer with the specified ECal module.
Learn more about User Characterizations stored to Disk Memory.

ECal Module Select an ECal Module from the list for which User Characterizations are currently
stored in disk memory.

Save As Saves a User Characterization that is currently in disk memory to a *.euc file. This file can
be used as a backup in case the archive file is accidentally deleted, or allows you to move the file to
another analyzer to be used with the selected ECal Module.

Import Loads a previously saved *.euc file for use on the analyzer with the specified ECal module.

Delete Removes a User Characterization from disk memory.

Note: If a temperature is shown in the Temperature column, then the temperature during
characterization was measured and recorded. For VNA ports on which a CalPodAsECal user
characterization is used during a calibration, the cal error terms for those ports in the CalSet will
have been computed with compensation for temperature at the time of calibration if the following
two conditions are true: 1) The user characterization must show a temperature value in the
Temperature column in this dialog box, and 2) the CalPod must be a Thermal or TVAC CalPod
whose factory temperature data has been installed on the VNA by the installer package that was
provided with the CalPod.

Restore ECal Module Memory

When user-characterized data is written to the ECal module, the entire contents of ECal memory is also
written to the disk memory, including the factory ECal data. In the unlikely event that your ECal
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module memory is lost, you can restore all ECal data to ECal memory.

Caution: If a new factory cal was performed after the ECal memory was written to disk memory, the
new factory cal data will also be overwritten.

Note: An ECal Data Wipe Utility destroys all user data per US DoD 5220.22-M. Learn more at
http://na.support.keysight.com/pna/apps/applications.htm

How to Restore ECal Module Memory
Using Hardkey/SoftTablSoftkey

1. Press Cal > Cal Sets & Cal Kits > ECal > Restore ECal Memory....

No Programming commands are available for this feature.

Module to be restored dialog box help

ECal Hodule Memory Restorahon: Module s be resdtosed - x|

= Modul ldentifed
Fadel Wb Pt DONOT !
Serial Number (0ER]

Rote: Thic lsstues i onls Lo resiwg chesacteizaion dets lo sn E0 modude which sppears o be congpisd dus o
sorormal termination of an ECal Urer Chamcheizalion oisoece.

Bt

Verity the serial number of the module to be restored. If two modules are connected, choose the one
to have data restored.

Next Click to write data to the module.
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Perform a 4-Port Cal with One 2-Port ECal Module

You can perform a 4-port calibration with a 2-Port ECal Module. When all four DUT connectors are
the same type and gender, the calibration can occur with only four connections, the same number of
connections you would make with a 4-port ECal module.
e The ECal module must span the frequency range of the measurement.
e The ECal module must have connectors that match the DUT connectors. Because we are using a 2-port
ECal module, this means that the DUT must have only TWO unique connector types and gender. When the

DUT has more than two connector types/genders, you can select a different cal kit for each port using
SmartCal.

Important Note: DO NOT connect/disconnect USB devices during ECal calibrations. Doing so may
cause problems with the calibration.

Procedure
1. Connect the 2-port ECal module to a VNA USB port.

2. Press Cal > Main > Other Cals > Smart Cal....

3. Select 4 Port Cal, then click Next to see the following dialog:

Gulded Calibration: Select DUT Connectors and Cal Eits
DT Confeecions Call Kt

Poal |[Type MShtemale [ || |[65050-60007 ECal D354 =

Pon2 |[Type stemale  w || |[BS0-50007 ECal 0354 ]

For3 || Typs M50 lamale Ll BS052-60007 ECal 00354 Ll

Podd |[Type ME0temale = || |[ES052-60007 ECal 00354 =]

[+ Modiy Cal Changa Cal Moo, shandands

4. Select the DUT Connectors for each port. In this example, all four DUT connectors are Type N, female.
5. Select the attached ECal module. We are using a 85092-60007 ECal module.

6. Select Modify Cal (Show Advanced Settings for ECal)then click Next to see the following dialog:

ol TypaSids.
Cal Topa/Sads
Call Typo/Sads AdTh |

]
|

[+ D aruprbaisan { e binviing of pod Sonrician]

7. For the fewest number of physical connections, select the default port assignments.
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o The 1st Port selection for each port pair is 1.

e For single-ended (standard) measurements, THREE is the minimum number of Thru connections. For
Balanced measurements, FOUR Thru connections should be made. Learn more.

e For higher accuracy, select Add Thru. The Cal Wizard will add another port pair which results in more
physical connections.

8. Select ECal Thru as Unknown. This is the most accurate and easiest Thru Cal Method. Learn more.

9. You may need to clear Do Orientation when calibrating at low power levels. Learn more. This will add
additional connection steps.

10. Follow the prompts to complete the calibration:

1. Connect ECal to ports 1 and 2. Click Measure.
2. Connect ECal to ports 1 and 3. Click Measure.

3. Connect ECal to ports 1 and 4. Click Measure.

11. At the Specify Delay dialogs, click OK. This is the measured delay for each of the Thru connections in the
ECal module. Learn more.

12. Click either Save As User Cal Set, or Finish.
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TRL Calibration

TRL (Thru, Reflect, Line) represents a family of calibration techniques that measure two transmission
standards and one reflection standard to determine the 2-port 12-term error coefficients. For example,
TRM (Thru, Reflect, Match), LRL (Line, Reflect, Line), LRM (Line, Reflect, Match) are all included
in this family.

The traditional SOLT calibration measures one transmission standard (T) and three reflection standards
(SOL) to determine the same error coefficients.

e Why Perform a TRL Cal?

e The TRL Calibration Process

e TRL Cal Kits

e Cal Standards Used in TRL

e TRL with an External Test Set

See other Calibration Topics

Why Perform a TRL Cal?

TRL calibration is extremely accurate, in most cases more accurate than an SOLT cal. However, very
few calibration kits contain TRL standards. TRL Cal is most often performed when you require a high
level of accuracy and do not have calibration standards in the same connector type as your DUT. This is
usually the case when using test fixtures, or making on-wafer measurements with probes. Therefore, in
some cases you must construct and characterize standards in the same media type as your DUT
configuration. It is easier to manufacture and characterize three TRL standards than the four SOLT
standards.

Another advantage of TRL calibration is that the TRL standards need not be defined as completely and
accurately as the SOLT standards. While SOLT standards are completely characterized and stored as
the standard definition, TRL standards are modeled, and not completely characterized. However, TRL
cal accuracy is directly proportional to the quality and repeatability of the TRL standards. Physical
discontinuities, such as bends in the transmission lines and beads in coaxial structures, will degrade the
TRL calibration. The connectors must be clean and allow repeatable connections.

To learn more about Cal Standard requirements, see Cal Standards Used in TRL.
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Note: Virtual Device describes a non-physical (connect the two test port reference planes together)
type of connection description during the calibration. So, in a cal kit definition, you should not define
more than one Thru standard with the same connector/gender pairing to each Virtual Device. This
could cause those Thru standards to all be treated as the same physical connection step during a
calibration, which would especially be a problem for TRL calibrations if a Thru standard and Line
standard were measured as the same connection step.

The TRL Cal Process

Although TRL can be performed using the Cal Wizard Unguided Cal selection, the following process
uses the easier SmartCal selection. Both selections require that you already have TRL calibration
standards defined and included in a VNA cal kit.

1. Preset the VNA

2. Set up a measurement and the desired stimulus settings.

3. Press Cal > Main > Other Cals > Smart Cal....

4. Select the DUT connectors and Cal Kit for each port. The LOWEST port number of each port pair MUST
include TRL standards. TRL appears as the Cal Method.

5. Check Modify Cal, Next, then View/Modify to change default TRL options if necessary.
6. Follow the prompts to complete the calibration.

7. Check the accuracy of the calibration

TRL Cal Kits

Keysight Technologies offers two cal kits that include the required standards to perform a TRL
calibration: 85050C (APC 7mm) and 85052C (3.5mm). Both kits include the traditional Short, Open,
and Load standards. (The Thru standard, not actually supplied, assumes a zero-length Thru). In addition,
the kits include an airline which is used as the LINE standard. To use the airline, the kits include an
airline body, center conductor, and insertion / extraction tools. The APC 7 kit includes an adapter to
connect the airline to the APC connector.

Cal Standards Used in TRL
These standards must be defined in your TRL cal kit:

THRU
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Note: All THRU calibration methods are supported in a TRL Cal EXCEPT Unknown Thru.

The THRU standard can be either a zero-length or non-zero length. However, a zero-length THRU is more
accurate because it has zero loss and no reflections, by definition.

The THRU standard cannot be the same electrical length as the LINE standard.

If the insertion phase and electrical length are well-defined, the THRU standard may be used to set the
reference plane.

Characteristic impedance of the THRU and LINE standards defines the reference impedance of the
calibration.

If a THRU standard with the correct connectors is NOT available, an adapter removal cal can be performed.

REFLECT

LINE

The REFLECT standard can be anything with a high reflection, as long as it is the same when connected to
both VNA ports.

The actual magnitude of the reflection need not be known.
The phase of the reflection standard must be known within 1/4 wavelength.

If the magnitude and phase of the reflection standard are well-defined, the standard may be used to set the
reference plane.

The LINE and THRU standards establish the reference impedance for the measurement after the
calibration is completed. TRL calibration is limited by the following restrictions of the LINE standard:

Must be of the same impedance and propagation constant as the THRU standard.
The electrical length need only be specified within 1/4 wavelength.
Cannot be the same length as the THRU standard.

A TRL cal with broad frequency coverage requires multiple LINE standards. For example, a span from 2 GHz
to 26 GHz requires two line standards.

Must be an appropriate electrical length for the frequency range: at each frequency, the phase difference
between the THRU and the LINE should be greater than 20 degrees and less than 160 degrees. This means
in practice that a single LINE standard is only usable over an 8:1 frequency range (Frequency Span / Start
Frequency). Therefore, for broad frequency coverage, multiple lines are required.

At low frequencies, the LINE standard can become too long for practical use. The optimal length of the LINE
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standard is 1/4 wavelength at the geometric mean of the frequency span (square root of f1 x f2).

Note: The TRL LINE standard must have a delay that is greater than 0 (zero) ps. Otherwise,
calibration correction calculations will contain unpredictable results.

MATCH

If the LINE standard of appropriate length or loss cannot be fabricated, a MATCH standard may be
used instead of the LINE.

The MATCH standard is a low-reflection termination connected to both Port 1 and Port 2.

e The MATCH standard may be defined as an infinite length transmission line OR as a 1-port low reflect
termination, such as a load.

¢ When defined as an infinite length transmission line, both test ports must be terminated by a MATCH
standard at the same time. When defined as a 1-port load standard, the loads are measured separately. The
loads are assumed to have the same characteristics.

e The impedance of the MATCH standard becomes the reference impedance for the measurement. For best

results, use the same load on both ports. The load may be defined using the data-based definition, the
arbitrary impedance definition, or the fixed load definition.

See Also

e See Modify Calibration Kits for detailed information about creating and modifying Calibration kit definitions.
e For more information, read Specifying Calibration Standards and Kits for Keysight Vector Network Analyzers
(Application Note 1287-11)
TRL with an External Test Set

Beginning with the VNA code revision 5.25, TRL CAN be performed with an External Test Set enabled.
Previously, a TRL calibration required a VNA with a reference receiver for each test port. With the
new TRL method, a Delta Match Calibration is first performed and applied.

Note: See Delta Match Calibration to learn which models require this.

The accuracy of this TRL cal greatly depends on the accuracy of the Delta Match Calibration. With an
accurate Delta Match Calibration, the difference in accuracy between a traditional TRL cal and this
TRL cal is negligible.

How to Perform a TRL Cal in these cases
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1. Press Cal > Main > Other Cals > Smart Cal....
2. Select a TRL cal kit for the ports to be calibrated.

3. During the calibration, the Cal Wizard prompts you for a valid Delta Match Cal.
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CalPod

Note: The E5080B does not support this function.

CalPod is a system that simplifies the process of recalibrating the VNA without requiring the removal
of the DUT or the physical connection of standards. This allows recalibration from a remote location
such as when the DUT is in a temperature chamber.

Note: This feature is available to GCA, NF and standard (S-Parameter) channels.

In this topic:

Overview

How to start the CalPod dialog

CalPod dialog

CalPod Setup dialog

CalPod Operational Check

See Also

CalPod as ECal

Other Calibration topics

Process Overview

Note: The following overview assumes the CalPod system has been installed and configured. See the
CalPod User's Guide for installation instructions
at: http://na.support.keysight.com/pna/calpod/calpod _ug 85523-90005.pdf.

The following process assumes a 2-port DUT connected to the VNA ports 1 and 2 through CalPod
modules as follows:
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VNA

I Port 1 Port 2

_Optional Adapters
& ™~
RF1 Rn-’ +RE R 1 p—
Calpod | . | calpod
I_ i N —
:Cal Reference Planes:

CALPOD Controller ‘

The Blue boxes represent CalPod modules with internal Thru, Short, Open, and Load states.
1. After configuring and assigning CalPod modules to VNA ports 1 and 2, connect the CalPod modules to the
VNA, directly or using short cables. Learn how to configure CalPod.

2. Setup measurements on a channel. An IFBW of 1 kHz or lower with eight averages is
recommended. CalPod does not support measurements below 100 MHz.

3. Perform a full 2-port calibration for the channel with the CalPod outputs as the reference plane.
4. Click Initialize Channel to automatically perform the following steps:
a. The OPEN, SHORT, AND LOAD states of both Calpod modules are switched in and $S11/S22 are
measured.
b. The resulting measurements are stored in the channel's Cal Set as additional standard measurements.

These measurements are used to characterize the Calpod states - they are NOT used at this time to
change the error correction.

Notes:

e Because the OPEN, SHORT, AND LOAD states in the CalPods are measured, it is not
important what is connected to the CalPod when Initialize is pressed. Therefore, for highest
accuracy, click Initialize IMMEDIATELY and ONLY ONCE after performing the calibration -
before causing ANY cable movement.

e If an adapter is required to connect the DUT to a CalPod, use a high-quality adapter. Any
temperature drift due to the adapter is NOT recorrected.

¢ Always connect the DUT as close as possible to the CalPod modules.
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5. Connect the DUT to the CalPod outputs.

6. Click Recorrect Channel or Recorrect All Channels whenever necessary. Any of the following actions will
cause the current calibration to become invalid and require recorrection:

a. Moving the CalPod modules to the ends of long cables.
b. Changing the cables.
c. Extreme temperature variations.

d. Measurement drift over long time periods.

7. The following steps occur automatically during recorrection for the active channel:
a. The OPEN, SHORT, AND LOAD states of both CalPod modules are switched in and S11/S22 are
measured.

b. Additional (de-embedded) error terms are computed to compensate for changed conditions from the
Initialize measurements.

c. Another Cal Set is created using the original name with the CalPod number appended. The modified

error terms are saved to that Cal Set and applied to the channel. The measurements are now fully
corrected.

How to start the CalPod dialog
Using Hardkey/SoftTablSoftkey

1. Press Cal > Cal Sets & Cal Kits > Cal Pod....

Prugramming Commands=s ’

CalPod dialog box help

Learn all about the CalPod process.(Scroll up)
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CalPod =

Inltuallze Initialize All Recorrect Recorrect All o (T [FEET
Channel Channels Channel Channels 1 0OSL Averages
Assignment of CalFods 1o ViNA Ports
Fort 1 Faort 2 Fart 3 Fart 4 ~

sn000071622 » | |sn00010484 - Unassigned w | |Unassigned -

-

CalFaod Delete All
Setup.. | | CalPod Calsets

Help ‘ Cloze ‘

Initialize Channel Calibrated measurements of the CalPod states are performed as initial reference
data points for the active channel.

Initialize All Channels Calibrated measurements of the CalPod states are performed as initial
reference data points for all current channels. This command is not recommended, it is generally
preferable to initialize each channel immediately following calibration.

Recorrect Channel Recorrects the active channel Cal Set to match the initial reference.
Recorrect All Channels Recorrects the Cal Sets on ALL channels that were initialized.
Correct Power

This checkbox causes power to be recorrected ONLY when source power correction data is stored
as error terms in the CalSet. This occurs only when a Guided Power Cal is performed and when an
app channel is calibrated such as a FCA, GCA, IMD, and Noise Figure channel. This checkbox
has NO effect when a S-parameter Cal or a standard Source Power Cal has been performed,
because source power correction data is not stored in the CalSet.

When any of the above power cals have been performed, and when this box is checked, the power
output at the VNA port is adjusted to compensate for any change in path loss when Recorrect is
performed. For example, if the path loss between the VNA port and the CalPod was increased by
two dB following initialization, then the VNA output power will be increased by two dB upon
recorrection. Do this when you add a significant amount of loss in the calibration path, or when
the power level at the DUT is important.

When a significant amount of loss is introduced in the calibration path, it may not be possible to
increase the source power enough to overcome the loss. In this case, an Unleveled source
message may appear on the VNA screen.

When the checkbox is cleared, the source power level is not corrected.
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OSL Averages Controls the number of sweeps worth of raw measurements to be measured and
averaged together for the recorrection computations for each state of each CalPod.

Assignment of CalPods to VNA Ports

For each VNA port, select a CalPod module.

Note: A CalPod can be assigned up to 16 test ports in each measurement channel in multiport PNA
mode.

CalPod Setup Starts the CalPod Setup dialog

Delete All CalPod Cal Sets Deletes all recorrection Cal Sets and reinstates the Initialization Cal
Set.

CcalPod Setwp @

CalPod Senal Murmber
Add CalPad ‘ Utilities. . ‘ Help
Seriald CalPod Tupes Test
en00001 522 STAMDARD
zn0001 0484 THERMAL IP Setup...
=nB0270196 STAMDARD
Cielet
snB0270198 STANDARD eeE
About
Controller Addreszes IP Address
Add Close
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To start this dialog, click CalPod Setup in the CalPod dialog box.

CalPod Serial Number Type the CalPod module (without 'sn'), then click Add CalPod. The
new module is added to the list of available CalPod modules.

Serial # and CalPod Types

Shows the list of available CalPod modules. A CalPod module type may be STANDARD or
THERMAL (include temperature correction). A CalPod module will be listed as a STANDARD
type unless the thermal characterization data was previously loaded into the PNA from the USB
flash drive that came with the CalPod. Once thermal characterization data has been loaded into
the PNA, the CalPod is automatically listed in the CalPod Setup dialog.

Note: Loading thermal characterization data from the USB flash drive is the only method of
setting up a THERMAL CalPod. Simply entering the serial number in the CalPod Setup dialog
will set the CalPod Type to be STANDARD.

STANDARD and THERMAL data files are stored in C:\e-trak\adapters.
Buttons

Utilities Launches the VNA CalPod Utilities used to configure the CalPod Controller and VNA
over LAN.

Note: Before using a CalPod Controller, the LAN MUST be set up using the CalPod Utilities or
an error message will be displayed indicating that the VNA is unable to communicate with the
CalPod Controller.

Test Click to test the connection between the controller and the selected CalPod module. The
message box displays the connection status and temperature for both Ambient and Thermal
modules. Only the Thermal module will apply test temperature for recorrection.

IP Setup Starts the IPSetup dialog box to confirm the CalPod controller settings.
Delete Removes the selected STANDARD CalPod module from the list.

To delete a THERMAL CalPod from the list;

1.  Navigate to the c:/e-trak/adapters/itm directory.
2. Delete the .xml file associated with the CalPod serial number.
3. Exit all CalPod dialog boxes and restart the CalPod dialog.

4.  The CalPod may now be removed using the Delete button.
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About Shows the CalPod software version information.
Controller Addresses

Each controller can support 4 modules directly, and up to 48 modules using external splitters.
Additional controllers may be required if more than 48 CalPod modules are needed.

IP Address Enter the [P Address of the Controller, then click Add. The IP address is configured
using the IPSetup Utility. The default [P=192.168.0.100, but different static network settings can
be configured if required.

Delete Select the Controller Address, then click Delete to remove the address from the list.

For more CalPod Setup information, see the CalPod web site:
http://na.support.keysight.com/pna/calpod. Click CalPod Controller Configuration.

CalPod Operator's Check

This program is provided as a convenience to help determine the operational status of each 855xxA
Series CalPod and its associated CalPod Controller. While this check is not intended to be a complete
test, it does check each unit enough to provide greater than 95% confidence that the CalPod is
functioning properly.

¢ When the max frequency of the CalPod is higher than the max frequency of the VNA, the full frequency
range of the CalPod is not tested.

e Up to four CalPod modules may be checked at once. All four devices must be of the same frequency range.

e The software revision for the Operator’'s Check code is displayed in the upper left-hand corner of the window
Before running Op Check
The CalPod system must be installed and configured on the VNA.

See the CalPod User's Guide for instructions at:
http://na.support.keysight.com/pna/calpod/calpod_ug_85523-90005.pdf

Required equipment:

¢ An appropriate ECal or mechanical Cal Kit.

e A high-quality cable.
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o A female-female adapter of the calibration connector type.

o A fixed attenuator up to 10 dB (3 dB preferred) or other frequency insensitive device with similar loss.

How to perform CalPod Operators Check

Click Utility, then System, then Service, then Verification, then Operator's Check.

E Operator's Check

PMA CalPod Operator's Check Foarwulita
=y & o)
Mot M2 A, Sanek MY EMEIA) P Z00T58 LaH Coaeolm
Conbgare FouststuFod 01 #2 01 M
Conmoller's 197 168.0.180 Pousson | [ o
P Addruns I ey # UsaECal Madule/Teng ] E [ [
. ™ wch ¥
e SOFS0104
a '  Lsa P Load March ] 2 [ [
I Honn 2 Caddditar
=l Hon , Entar CaiFod i 35mem Ihuloss ] B E G
— sl Frarhts ™ 292 e
FI W 4 e o e ||| zama S @ E E
[Emtisf thir adial humbiors o s 4o 4 CalPods Recorecion ] [ [ [
Aok B b st 1 His 50N il you wast o Seet Siat parsculas CalPod
Conaiet o Fomal-Famals adapios dinksohy 1 Poa 2 ol b PRA This
incdnptes will b considesnd Be spstem’s Por 2
[Click "Qatap lalo® i naedid,  Salect Bagis® whis piady Ext

Click Setup Info to learn more about this dialog.
Also, click Cal Method or Connector for additional explanation for these areas.

Configure

1. Enter information in the “Configure” area.

2. Each time a 2-port cal is performed, the results are saved in a file. The “Use Prior” selection uses the saved
calibration.

3. When the calibration connector type does not mate with the CalPod connectors, perform the calibration and
then use adapters to connect to the CalPod module.

4. Click Begin to start the Op Check.

5. Follow the prompts in the gray box.

Op Check Results

e The Results area shows Op Check progress.
¢ Click a test label for test information.

e When the check has finished, the results are saved to a text file. The default path and filename is:
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C:/Program Files/Keysight/Network Analyzer/Service/calpodopchklog.txt. To save multiple results, rename
the file or save it to a different location.

e For assistance in troubleshooting CalPod Operator's Check failures or for additional information, see the
appropriate FAQ at the CalPod web site: http://na.support.keysight.com/pna/calpod
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CalPod as ECal

A CalPod module can be used as 1-port ECal module to calibrate channels for all measurement classes.
In addition, the CalPod module can be left in place during measurements in order to refresh
calibrations.

In this topic:

e Overview

e Characterizing the CalPod module
e Summary
e Detailed Steps

e (Calibrating with CalPod

More Calibration topics

Overview

To use a CalPod module as a calibration device:

1. The CalPod module must be configured using the CalPod software. Learn how.

2. Unlike an ECal module, a CalPod module has no internal memory and therefore, no internal characterization
data. Before a CalPod can be used as an ECal module, its internal standards must first be characterized
using the ECal User Characterization wizard. In addition, the characterization data can ONLY be stored in
VNA disk memory.

3. After these steps have been performed, connect the CalPod modules to the controller to perform a VNA
calibration. The CalPod modules will appear in Cal Wizard dialogs just like an ECal module.
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This image shows TWO CalPod modules after both have been characterized. An additional thru
connection is required to complete a 2-port calibration. Subsequent ‘refresh’ calibrations can occur
without making additional connections.

Characterizing the CalPod module - Summary

When performing a User Characterization for a CalPod module, you can establish the Calibration
reference plane at the input connector, or at the output connector, depending on how you plan to use
CalPod.

1. Initially calibrate the VNA.
2. After the calibration, the internal CalPod OPEN, SHORT, and LOAD standards are measured.

3. The measurements are saved to VNA disk memory. They are used when performing calibrations using the
CalPod module.
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Detailed steps to Perform a User Characterization

Note: If you have more than one CalPod module, each module must be characterized separately.

1. Perform a one-time CalPod configuration. Learn how.

2. Connect the CalPod module to the CalPod controller.

3. Preset the analyzer.

4. Set up the measurement. For best accuracy, the IF bandwidth should be set to 1 kHz or less.

5. Start the User Characterization Wizard as follows:

Using Hardkey/SoftTablSoftkey

1. Press Cal > Cal Sets & Cal Kits > ECal > Characterize ECal....

Programminq Commands=s }

Select Module and Location dialog box help

ey Charac bertee FOA Mochle: Select madule aned o ation for new dhers Tarbnation

B Module: [Mocet Casfo S 1548 = Cwtect Comracied ECal

& Cheraciaraasen Mama: o1 Fryltoend

| Husd I Eariond | Halp |

ECal Module Select a CalPod from list of connected modules and registered CalPods.

Detect Connected ECals Click to rescan CalPod/ECal modules.

Location

e ECal Module Memory NOT available for CalPod modules.

e VNA Disk Memory Enter a Characterization Name. This name appears when selecting a User
Characterization to be used with subsequent calibrations.

e Learn how to manage characterizations that are stored to VNA disk memory.

e See the benefits of storing the User Characterization to VNA Disk Memory.
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Keyboard Launches a keypad that can be used to type a characterization name from the VNA front
panel.

Next Click to continue to the Select Connectors for the Characterization dialog box.

See note regarding extended frequency use.

Select Connectors for the Characterization dialog box help

Loy Clhuaracievicne ECA Modise: Select Coawws bors Tor Hhe Clharad terization
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In situ characterization
When Checked:
e This initial calibration, and all DUT measurements are performed WITH the CalPod module THRU path in
place (In Situ).

¢ Only the port with the switchable states is characterized (open, short, load, and offset short). The THRU
state is not characterized.

e Select the RF2 (output) connector type and Cal Kit.

e The Cal Kit standards are connected to the RF2 Output connector, making it the reference plane. This
calibration removes everything in front of the output connector from subsequent measurements.

e The User Char description will show "In Situ".

e The CalPod’s states physically switch in at its RF1 port, but for an in-situ characterization the calibration
used for measuring the characterized data for those states has its reference plane at-or-beyond the
CalPod’s RF2 port. So, for all calibrations subsequently performed using the in-situ CalPodAsECal user
characterization, those calibrations also establish the reference plane at that same connector interface
at-or-beyond that CalPod’s RF2 output port.

When Cleared:

e This initial calibration, and all DUT measurements are performed WITHOUT the CalPod module in place.
This is similar to an ECal calibration.

e Select the RF1 (input) connector type and Cal Kit. The Cal Kit standards are connected at this location,
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making it the reference plane.

Next Click to continue to the Calibrations to perform or recall dialog box.

Calibrations to perform or recall dialog box help

Ly Chuarac ferlee ECA Module: Callbeations §o perform of recal

Thedh Ao USRS FubinTH W) Bl [ACTTYbd 0 1080
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™ Ll e el Wi £ et & il

o B [ Pt & I o Haip:

Perform or load a 1-port cal.

Guide me through this cal now Click to perform a Guided calibration. A calibration kit is
required for each connector type.

Note: Some PNA-L models cannot perform TRL calibration during the calibration portion of a
User Characterization. However, this type of Cal can be performed using the Cal Wizard, saved to
a Cal Set, then recalled at this point in the User Characterization.

Let me recall this cal from a cal set Click to select an existing Cal Set. You cannot select a Cal
Set that is currently in use. Learn more about Using Cal Sets.

Next Click to continue to either the Select Cal Kits (Perform Cal) or Select Cal Set (Recall Calset).
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Select Cal Kits dialog box help
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When 'In situ' is selected, a cal kit is selected for port "RF2", as this will be the calibration reference
plane (where standards are connected).

Provides a list of calibration kits to perform the calibration. Select the Cal Kit you will use for the
port.

Next Click to continue to the Select Cal Set dialog box.

Select Cal Set dialog box help
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The calibration that you perform will be written to a Cal Set. This dialog box allows you to select a
Cal Set to overwrite, or to write to a new Cal Set. The current choice is visible below the Select Cal
Set button.

Select Cal Set Click to open the Select A Cal Set dialog box.

Create new Cal Set Check to create a new Cal Set to store the calibration. Clear to select and
overwrite a stored Cal Set.

Next Click to continue to the Guided Calibration Steps dialog box.

Note: Remember the Cal Set name for future reference.
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Guided Calibration Steps dialog box help

e Chearaferire ECal Module: Gusded Collbeabion Siep 1 of 1
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The first Measure page.

Connect each calibration standard to the location in the prompt.
Measure Click to measure the standard.
Back Click to repeat one or more calibration steps.

Done Click after a standard is re-measured and all measurements for the calibration are
complete.

Next Click to continue to the next calibration step. (Does not measure the standard.)

Cancel Exits Calibration Wizard.

Guided Calibration completed dialog box help
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Allows you to finish the calibration and continue to the next characterization steps.
No. Finish now Select to save Cal Set data.
Yes Allows selection of Save options.

Next Click to continue to the Exit to Inspect Quality of Calibration dialog box.
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Exit to Inspect Quality of Calibration dialog box help
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Allows you to exit User Characterization to validate the calibration before proceeding with the
characterization.

Back Allows you to repeat calibration.
Next Click to continue to the Characterization Steps dialog box.
Cancel Exits the Calibration.

To return to the current step:

1. Start User Characterization.

2. In the Select Connectors for Characterization dialog box, click Next. (Previous entry is stored in
memory.)

3. In the Calibrations to perform or recall dialog box, recall the Cal Set that you just performed.

Characterization Steps dialog box help
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After the initial VNA calibration, the CalPod internal states are measured.
Connect the CalPod if not already connected.

Measure Measures the CalPod module.
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Next Click to continue to the Information for the New Characterization dialog box when
measurements are complete.
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Enter descriptive information that will be stored in the characterization file. This description will be
viewable in the several VNA dialogs when the CalPod is selected.

Next Click to continue to the Write Characterized Data dialog box.

Mode: This il babom & fes mictes

cBack | b | Camed | Hep |

The VNA writes User Characterization data to the VNA disk memory.

Write Click to write data.

394



Summary of new User Characterization dialog box help

User Characterize ECal Module: Surmmany of new uzer characterization @
adel Mumbier: CalPad Sierial Number SOZ70196
Chaiaclenzalion Mame: rrahu?, Temperstue [Celbust 3225
Chaiacleized By Min, Frequency: 100 MHz
Drate; Jan 03 2018 Mas Frequency: 135 GHz
Hahuoek Analyzes: Mumber of Pointz: 201
Part RF1 [GET Poit RF1
Fan RF2 AFC 35 male Poit FiF2
Back || Finsh | [ Canca Help

Summary page of characterization wizard after characterization is complete.

Cancel Click to exit (characterization complete).

Finish Click to exit (characterization complete).

Calibrating with CalPod
The CalPod module is now characterized and ready to be used in a VNA calibration.

When CalPod modules are selected for ALL ports of an N-port cal, Unknown Thru is the only
selectable Thru method for all paths. Learn more about Unknown Thru.
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The above image is the Connectors and Cal Kits page as seen during a SmartCal on a standard
channel. A similar version of this page is shown in the Calibration Wizard for all Application channels
(FCA, GCA, NFA and so forth).
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Calibration Preferences

Cal type preferences are set from this dialog.

How to change Cal Preferences

Programming commands are NOT available for the preference settings discussed in this topic,
although there are other Cal Preferences that can be set remotely.
Using a mouse

1. Click Response
2. Select Cal
3. Select Cal Sets & Cal Kits

4. Select Cal Preferences...

Cal Type Preferences dialog box help

— -
C#l Type Prefesences for SemanCal p—

Machanical cal kits
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THL
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Ok Canoal Help
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This dialog is used to set which Cal Types are available, and the order in which they are selected as
the default choice, during a SmartCal with Mechanical Standards. This setting is also used to set the
default Cal Type for Guided calibrations using SCPI or COM.

Note: Your Cal Type settings are saved only until the NA application is closed. When re-opened,
the factory default settings are restored.

The specified Cal Type order should allow you to make fewer changes to the Cal Type during a
SmartCal with Mechanical Standards.

For example, in the above image, the first Cal Type on the list is TRL. When doing a SmartCal with
Mechanical Standards:

396




e If a TRL Cal Kit is available for the specified DUT connectors, then TRL becomes the default Cal Type.

o Ifa TRL Cal Kitis NOT available, then the second Cal Type on the list (SOLT) is evaluated for
compatibility with the available Cal Kits, and so forth with the Cal Types that remain on the list.

¢ If TRL is removed from the list, that Cal Type is NOT available for selection during a SmartCal with
Mechanical Standards.

Learn more about Cal Types.

See where you choose Cal Type during a SmartCal

Prioritized list of choices for default Cal Type Shows the current list of Cal Types and the order
in which they will be selected for Mechanical calibrations.

Change Click to invoke the Modify list of default Cal Types dialog.

Restore factory defaults Returns the list to the original selections and order. The factory defaults
are in order of accuracy from highest (TRL) to lowest (QSOLT).

Cancel Closes the dialog without making changes.

Modify list of default Cal Types dialog box help

Modify list of default Cal Types for mechanical cal kits

Unsebected Cal Types Selected Cal Types (in
pricritized order)
QSOLT

TRL

SCOLT

Remone

sz [|1E
E
v

<« Remove Al

| Move Up || Hove Down |

ok | camen | mep |

Use this dialog to Add, Remove, and re-order the available Cal Types. There must be at least ONE
selected Cal Type to perform a SmartCal with Mechanical Standards.

Unselected Cal Types Cal Types in this list will not be presented as a choice during a Calibration.
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Selected Cal Types Cal Types in this list will be presented, in order, as the default choice during a
Calibration. Click a Cal Type to select it, then click the following buttons to perform that operation.

Add / Remove buttons Click to Add and Remove the selected Cal Types from the Selected Cal
Types list.

Move Up / Down Click to re-order the Selected Cal Types list.
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Cal Plane Manager (CPM)

Adapters, fixtures, and probes are often used for DUTs that have non-coaxial interfaces. This could
make it difficult to calibrate with traditional cal standards. Cal Plane Manager (CPM) allows you to
mathematically remove (de-embed), a characterized adapter, test fixture, or probe head from
measurements.

In this topic:

e Features

¢ Using Cal Plan Manager

e Cal Plane Manager
o Characterize Adapter/Fixture and Apply
o Calset Selection
e Port Selection
e Phase Pivot
e Select Files
e Apply De-embedding
e Select Channels to De-embed
e Select Calsets to De-embed
o Other Actions
¢ Reverse Port Order
e Create a Transmission Only S2P File
e Cascade Two S2P Files

e Cascade an ENR file with an S2P file

Other Cal Topics

Features
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e Characterizes adapters and fixtures in SnP files.

e Applies the characterizations to existing Cal Sets and channels.

o Writes to VNA power loss table using the S2P files of fixtures/adapters.
¢ Reverses the port order of an existing S2P file.

o Creates a forward-only S2P file from an existing S2P file.

e Cascades two S2P files.

Important Notes

o Adapter/fixture definition: Any physical 2-port device or component that is to be mathematically removed
from channel measurements or Cal Sets.

e The adapter/fixture to be characterized MUST be reciprocal (S21 = S12).

e Two Tier-1 cals must be performed and saved to Cal Sets BEFORE performing the CPM characterization.

Using Cal Plan Manager

How to start Cal Plane Manager

Using Hardkey / SoftTab | Softkey Using a mouse
1. Press Cal > Fixtures > Cal Plane Manager... . 1. Click Response
2. Select Cal

3. Select Fixtures

4. Select Cal Plane Manager
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Cal Plane Manager dialog box help ‘}

Choose from the following, then click Next > :

e Characterize Adapter/Fixture and Apply - Given that you have already performed calibrations both
before and after the adapter/fixture, SNP files are generated which characterize the adapter/fixture.
These files are then used to de-embed the fixture from the channel and a new calset. Learn how.

¢ Apply Adapter/Fixture - The *.SNP files are already saved. Use these files to de-embed the fixture from
the channel and a new Cal Set.

e Other Actions

Characterize Adapter/Fixture and Apply dialog box help
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Requirements

¢ You must have already performed a Tier 1 calibration at the input of the fixture/adapter(s) AND a Tier 2
calibration at the output of the fixture/adapter(s) as in the above image.

¢ In addition, the calibrations must have been saved to Cal Sets on the analyzer.

Note: The mechanical switch / attenuator settings of the Tier 1 and Tier 2 cals for CPM MUST be the
same settings. Also, when the span or number of points are different between the two cal tiers, there
must be sufficient data points to ensure that phase wrapping does NOT occur. This is accomplished
when the delta frequency for either calset is less than 12/combined length of the test port cables in

meters.

Applications

The following images show the calibration planes of the Tier 1 and Tier 2 calibrations:
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Procedure

Configuration Select the number of adapter/fixtures to be characterized and de-embedded.

e Choose One fixture when you have a single fixture/adapter on either the input or output of the DUT.
e Choose Two fixtures when you have a fixture/adapter on BOTH the input AND output of the DUT.
Browse - Starts the following Calset Selection dialog.

DC Phase - Starts the Phase Pivot dialog .

Click Next >

e
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Calgat Selection =]

Tier 1 Calset
Mame D Caltype Date Modified
1 10 1PA 1/16/2014 220:09 AM =
1hz 1k 1PA1 171672014 2:22:15 AM
CalSet_1 Ce 1P1 171672014 1:35:44 AM
| CalSet 2 Ce 1P/1 1/16/2014 1:36:21 AM
[ Filter Calsets... ] Start: 10000000, 000000 S1op: 26500000000.000000 Peants: 201
Tier 2 Calsat
Name D Caltype Date Modified
1hz . 1k 1F/1 171672014 222115 AM
CalSet_1 Ca 1P/ 171672004 13544 AM
CalSet_2 Ca 1F/1 1/16/2014 1:36:21 AM ”
Filter Calsets... Start: 10000000.000000 Stop: 26500000000.000000 Poants: 201
OK Cancel Help

Choose from the listed Cal Sets on the analyzer to use for the Tier 1 and Tier 2 calibrations.

e The Tier-1 calset MUST be from a calibration that was performed at the input to the adapter/fixture.

e The Tier-2 calset MUST be from a calibration that was performed at the DUT reference plane.

Click Filter Calsets to start the following dialog.

Calset Filters (=}
] Enable Filter
Filter Options
Measurement Class: StandardPHA "

Cal Type: 1P
Calset Name [ncludes:
Calget Description Inchudes:

Cal Ports: Ex 123

Active Cals - Channel List: B 123

Last Modified Between: [1,19/2014 E-IIUH;';IDH E

OK Cancel

Check Enable Filter , then provide advanced filter requirements to narrow the search for
appropriate Cal Sets.
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Filter Options
Measurement Class - The classes listed are those that are enabled on the analyzer.
Cal Type - Filter for 1P (one-port) or 2P (two-port) Cal Sets.
Calset Name Includes - Filter to include any text that appears in the calset name.
Calset Description Includes - Filter to include any text that appears in the calset description.
Cal Ports - Filter to include only the analyzer ports to be de-embedded.
Active Cals - Filter to include only the Cal Sets that are currently in use on the analyzer.

Last Modified Between - Filter to include only the Cal Sets that were last modified between the
two specified dates.

Port Selection dialog box help

Port Selection =]

Port of Fixture A 1 -

QK Cangel

In the previous dialog, when a multiport calset is selected for a characterization that involves fewer
ports, then select the port in the calset that is used to characterize the fixture/adapter.
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Phase Pivot dialog box help

Phase Prvat ]

Fiochure A Phvot: O Degree(s)

0K Cancel

For most devices, the projected phase of S21 at DC crosses the X-axis between 0° and -180°.

The phase pivot point specifies the center of the phase window. It is normally 1 Pi wide. The default
value of 0° should be adequate for the majority of adapters.

However, when characterizing electrically long cables, cables with significant mismatch, or high
noise in the measurements, it is possible that the projection of phase goes above 0°. This results in a
180° phase difference between the results computed by CPM versus the results you might get by
measuring the same adapter with a 2-port calibration.

In these cases, you may have to change the default value to capture the projected phase of S21 at
DC.

Select Files dialog box help

Sedect file o s fidure characterization
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Save < Back Lol
For each Fixture (A and B):

¢ Click Browse , then navigate to the folder to where the S2P files are to be saved.

e Enter a filename, then click S2P Format , then choose the format in which the data is to be saved:
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e Log Magnitude & Angle (default)
e Lin Magnitude & Angle
¢ Real & Imaginary
Click Apply to continue to de-embed the fixture.

Click Finish to end with the characterization and close the dialog.

Apply De-embedding dialog box help
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Given one S2P file for each fixture/adapter, this dialog will remove the effects of the fixture/adapter

from either:

e one or more Calsets

e or one or more channels.

For each Fixture (A and B)

1. Check to enable fixturing.

2. Select the VNA port the fixture is connected to.

3. Click Browse , then navigate to the S2P file that represents the fixture/adapter.

4. Reverse Ports - S2P files that are created using CPM ALWAYS reference port 1 of the fixture/adapter
on the side closest to the analyzer and port 2 of the fixture/adapter ALWAYS on the DUT side of the
device as in the following image. The application of the S2P file (this dialog) assumes this same
orientation. If your S2P files were created using a different (external) application, check the orientation

and check Reverse Port Order if necessary.
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Analyzer

Fixture B

CAL1

5. Choose one of the following De-embed Options

e De-embed from Calsets - Starts the Select Calsets to De-embed dialog box.

¢ De-embed from Channels - Starts the following Select Channels to De-embed dialog.

| Select Channels to De-embed didlogboshelp |

De-Ernbsed from Channels

Select Channels
| Channets Meas Class Cal State Fiaetuaring State
i Standard off Off

De-embedding is performed and applied to specified channels on the analyzer.

Select one more channels currently displayed on the analyzer from which to de-embed the
adapter/fixture.

| Select Calsets to De-embed dialogboxhelp |
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Calibraticn Flane Masager L

De-Ernbed from Calset(s)

Select Calsets

| Calset Mame Channeds

1G_4G_101_FlAtten Properties._.

1G_ 45 6401 _FlAtten Properties_
7] 220084_2500M_11_P1Atten Proporiies.. -
Properties

Flter Calsets
& Over-write Sebected Calsets

Create Mew Caliets

« Back Cancel

This dialog appears when De-embed from Calsets is selected in the previous dialog.

De-embedding is performed and applied to specified Cal Sets. This allows you to easily apply de-
embedding in the future by simply applying the de-embedded calset to any channel.

Select Calsets : Select the Cal Sets to which de-embedding will be applied.
Properties View information about the corresponding calset.

Properties

e Overwrite Selected Calsets - The selected Cal Sets are overwritten with the adapter/fixture de-
embedded.

¢ Create New Calsets - Select the Cal Sets from which new Cal Sets will be created.

Click Options to start the following dialog.

MNew Calset Options =
Calset Mame

@ Auto Name
New Mame = [ CPM |_[Old Calset Name] CPM

Ack me for each name

#| Preserve Active Cal and Channel associations

Note - Channel Cal Registers will always be re-saved as User Calsets. The
names of new calsets will be added with a suffix composed of a underline
and a number automatically if calsets with the names already exist.

QK Cancel

Calset Name
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Auto Name - By default, a new calset will be created using the old calset name with the specified
text ("CPM" by default) appended to the beginning of the name. You can change the specified text.

Ask me for each name - Starts the following dialog when OK is pressed.

Preserve Active Cal and Channel associations - When checked (default) the new de-embedded
Cal Sets will be used to correct the same displayed channels as the current Cal Sets.

Input Calset Name el
Input a new name for each deembeded Cal Set

Existing Calsets Mew Calsets

CalSet_1 Deembed CalSet 1

CalSet_2 Deembed_CalSet_2

Cal5et_3 Deembed_Cal5Set_3

CH1_CALREG Deembed CH1_CALREG

Keyboard.. (9] 4 Cancel

The Existing Calsets that you selected for de-embedding appear in the left column.
The proposed New Calset names appear in the right column.
To change the new Calset name, select, then edit the name.

When finished, click OK .
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Other Actions dialog box help

Calibration Flane Manager =

Sedect one of the actions:

@ 'Write to VNA Power Sensor Loss Table Emable Power Sensor Loss Takle
& Compube Fodure Trom Calsets
Usze an 52P File

Reverse the Port Order of an 527 File
Create a Transmigsion Only 52P File
Cascade Two S2P Files
Cascade an EME fila with an S2P file
< Back | Plat = Cancel Help

Select one of the actions:

e Reverse the Port Order of an S2P File .
e Create a Transmission Only S2P File.
e Cascade two S2P files .

e Cascade an ENR file with an S2P file

Write to VNA power sensor loss table . Loads the S2P Frequency / Loss pairs into the VNA
Power Loss Compensation table to compensate for losses that occur when using the device to
connect a power sensor to the measurement port during a Source Power Cal.

e Enable Power Sensor Loss Table

e Then choose from the following:

o Compute fixture from Calsets . Computes the transmission loss of the fixture based on the
selected Cal Sets. This choice is NOT available until two valid Cal Sets are selected.

e Use an S2P file . Uses the S21 data in an existing S2P file to build the VNA’s power loss table.
Select, then click Browse , then navigate to the S2P file, then click Next > .

Note: In the VNA Power Loss Compensation table, loss is expressed as a positive
number. CPM assumes that any negative S21 value in the S2P file is a loss and
therefore multiplies the S21 values in the file by -1 to express that value as a positive
number. This ensures proper handling of the offset during a source power cal.
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Reverse Port Order dialog box help

Calinention Plane Mo

Reverse SAP file port ordes

Select S2P Files
Original Becwsi
Reversed Booearse...
The procedure will exchange 511 values for 522 values after ‘Finish® button is clicked

< Back Cancsl

S2P files that are created using CPM ALWAYS reference port 1 of the fixture/adapter on the side
closest to the analyzer and port 2 of the fixture/adapter ALWAYS on the DUT side of the device as
in the following image.

Analyzer

Fixture B

This action causes ports to be reversed on an existing S2P file.

e The data for S11 becomes the data for S22 and vice versa.

e The data for S21 becomes the data for S12 and vice versa.

The resulting file is written in the standard S2P file format.

1. Original - Navigate to the S2P file to be reversed.

2. Reversed - Navigate to the folder where the new reversed S2P file will be saved. Enter a filename. By
default, the file is saved to the same folder using the filename: <old filename>_Reversed.s2p

3. Click Finish. The Reversed file is saved to the specified location.
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Create a Transmission Only S2P File dialog box help

Calibration Flane Manoager

Convert file into & Transmission' S2P file
Sedact S2P Files

Original |
Modfied |

Hi

Madifications
% Set 511 to Zero
 Set S22 to Zero
 Set Both 511 and 522 to Zero

From an existing S2P file, this feature allows you to zero the S11, S22, or both data columns. The
original S21 and S12 data are preserved. This is useful for Enhanced Response calibration / de-
embedding.

Original - Click Browse , then navigate to the file to be modified.

Modified - Click Browse , then navigate to the folder and enter or change the filename of the
resulting S2P file. The file select dialog allows you to change the format of the data. Click Format ,
then choose from the following:

e Log Magnitude & Angle (default)

e Lin Magnitude & Angle

¢ Real & Imaginary

Modifications
Choose to Zero the S11, S22, or both data columns.

Click Finish. The transmission only file is saved to the specified location.
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Cascade Two S2P Files dialog box help

Calibraticn Plane Manager E

Cascade Two 52P Files
Sedict S2P Filed

S2F #] Brgrvsa.

S2P w2 Brovise

Cazcaded 52P Browse
FOAT L 1

< Back Casrecel

This dialog combines the losses and phase shift of two S2P files into a single S2P file.

The stimulus settings of the two input S2P files need not be identical. The frequency range of the
cascaded S2P file will be the frequency range that is common between the two input files. In
addition, the cascaded S2P file will use the data points of the input file with the denser data points.

For example:

S2P #1: Frequency range = 1 GHz to 5 GHz; 201 pts.

S2P #2: Frequency range = 2 GHz to 6 GHz; 1001 pts.

Cascaded S2P: Frequency range =2 GHz to 5 GHz using the data points of S2P #2.
S2P #1 - Click Browse , then navigate to one of the S2P files to be cascaded.
S2P #2 - Click Browse , then navigate to the other S2P file to be cascaded.

Cascaded S2P - Click Browse , then navigate to a folder and enter the filename of the resulting
S2P file.

Click Finish . The cascaded file is saved to the specified location.
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Colbration Prane Manager @

Cascade an EWR file with an 52# file

Select Files
Input 529 l Browse.. ]

Output ENR Browse |

Fowt ) PEA R
|'\|.1'|hr|. sz R Serce Timoed

o]
— e e

This dialog generates a new ENR file by embedding an adapter to an existing ENR file.
Input ENR - Click Browse , then navigate to ENR files to be cascaded.
Input S2P - Click Browse , then navigate to the S2P file to be cascaded.

Output ENR - Click Browse , then navigate to a folder and enter the filename of the resulting ENR
file.

Click Finish . The cascaded file is saved to the specified location.
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Port Subset Correction (Devolve Calibration)

It is often convenient to calibrate all the ports of the instrument so that corrected data is available at
every port. However, applying the resulting calset results in every port being swept. This level of
correction is appropriate if every port is connected to the DUT. However, sweeping ports that are
disconnected unnecessarily slows down measurement throughput. To remedy this situation, the user
can tell the instrument to exclude selected ports from the correction process. This is called "port sub-
setting" or "devolve calibration". This process does not modify the calset in any way. There are two
settings associated with port sub-setting: an on/off state, and the list of ports that should be included in
the correction for the channel.

Port sub-setting values are independent of calset selection. They are essentially a mask that is applied
to the calset.

Restricting correction to Enabled Ports

For example, on a 4 port instrument, the user is measuring two DUTs. Device #1 is connected to ports
1 and 2. Device #2 is connected to ports 3 and 4. The two devices are not interconnected in any way.
Channel 1 is used to measure device #1. Channel 2 is used to measure device #2. If you apply a 4 port
calset to each of these channels, both channels will sweep all 4 ports. Port sub-setting can be used to
reduce the level of the correction for each channel.

Channel (Port subset values Measurements Correction applied
Channel 1 [ON, ports 1 and 2 enabled S11,S21,S12,S22  |Full 2 Port (1,2)
Channel 2 [ON, ports 3 and 4 enabled S33, S43, S34, S44  |Full 2 Port (3,4)

In this condition, when the user performs a 4 port calibration and applies the same user calset to both
channels. Channel 1 sweeps ports 1 and 2. Channel 2 sweeps ports 3 and 4.

Best Effort on Disabled Ports

If measurements are added to the channel that utilize ports that are disabled in port sub-setting, those
measurements will be corrected on a "best effort" basis: some correction may be applied depending on
the contents of the calset. The level of correction is limited to enhanced response calibration or simple
response calibration.
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Channel |Port subset values Measurements Correction applied

S11,S21,S12,S22  [Full 2 Port (1,2
Channel 1 |ON, ports 1 and 2 enabled ’ ’ ’ u ort (1,2)

S43 Enhanced Response(4,3)
4 4,S44 |Full 2P(3.4
Channel 2 |ON, ports 3 and 4 enabled 533,543,534, 8 u G4
S11 1 Port (1)

This "best effort" correction cannot be turned off using the dialog. But there are SCPI commands for
disabling this feature.

See SENS:CORR:METH:PORT:SUBS:FULL:VAL and SENS:CORR:METH:PORT:SUBS:RESP:VAL.

Click Cal > Main > Correction Methods.....

Correction Methods dialog box help

Corection Methods: Channel 1 IE]

# Enable match correction on power measurements

Enable port subset correction

Define port subset: | Exclude all ports |

3 4

OK Gancal ‘ Help

Enabling match correction on power measurement Apply match correction on all receivers used
on this channel. See Matching

Enable port subset correction Enabling port subset correction to reduce the number of corrected
ports.

Define port subset Selects which ports should be included in a full N-port correction. Un-selected
ports will be corrected on a “best effort” basis: In other words, these ports will be corrected with an
enhanced response calibration if the error terms are available in the calset.

Exclude all ports Excludes all ports from correction. The button will change to Select all ports to
include all ports for correction.

The correction pop up pane, accessed from the status bar, indicates port by port correction methods for
VNA with 12 or less test ports. This table is updated when the port subset correction is turned on to
reflect the correction methods being applied. In the image below, the pane indicates a full 4 Port
calibration. On the right, the table indicates the methods after the correction was devolved to ports
1,2,3.
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Power Calibration

Note: It is recommended that SmartCal be used instead of the following Power Calibration procedures.
The procedures in this topic are for those who cannot change their existing test program/procedure with
their installed-base PNAs.

Note: Source and Receiver Power Calibrations are NOT available in M937xA/P937xA PXI.

Source and Receiver Power Calibrations work together to provide very accurate power levels from the
source, and very accurate power measurements from the VNA receivers.

Source Power Calibration Overview

e Supported Power Meters and Sensors
e How to perform Source Power Calibration
e Setup

e Source Power Cal dialog

e Source Power Calibration Options dialog
o Power Meter Settings dialog
e Power Loss Compensation dialog
e Power Sensor Settings dialog (Zero / Calibrate)
e Copy a Source Power Calibration to other Channels
e Saving a Source Power Calibration
e Reducing Time to Complete a Source Power Calibration
e Receiver Power Calibration

e Saving Receiver Cals

Other Source Power Cal choices

¢ Guided Power Cal can be performed during an S-parameter Guided Calibration. Learn more.

e Receiver Leveling can be used to provide 'real-time' source power cal. Learn more.
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e See Also: Configure an Power Meter As a Receiver (PMAR)

See other Calibration Topics

Source Power Calibration Overview
Note: Source and Receiver Power Calibrations are NOT available in M937xA PXI.

Perform Source Power Calibration when you need accurate power levels at some point in the
measurement path between the VNA test ports. For example, you need to characterize the gain of an
amplifier across a frequency range at a specified input power. You would perform a source power cal at
the input of the amplifier to ensure the exact power level into the amplifier across the frequency range.

Using a Source Power Cal, you can expect the power at the point of calibration to be within the range
of the uncertainty of the power meter and sensor that is used.

Source Power Calibration...

¢ Is independent of measurement type. It corrects the VNA source regardless of which receivers are being
used in a measurement. Therefore, it can be used with both ratio or non-ratio measurements.

e Applies ONLY to those measurements on the selected channel that use the test port that was specified as
the Source for the calibration. For example, if you specify Channel 1 and Port 1 as the source to be
calibrated, only those measurements on channel 1 that use port 1 as the source will be corrected.

e Can be used in conjunction with other measurement calibrations, such as a full 2-port calibration. For highest
accuracy, perform the measurement calibration AFTER the source calibration.

e Can be used with Power Sweep type. Source Power Cal will correct the power at all power levels across the
power sweep.

e Can be used with Port Power Uncoupled.
e Forces sweep mode to Stepped on measurements with source power correction turned ON.

e Beginning with VNA Rev. 7.50, an external source can be calibrated using Source Power Cal.
Overview of How it works:

See Important First-time USB connection note.

Click to see the detailed procedure

1. Specify the measurement settings (frequency range, IFBW and so forth).
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2. Start Source Power Calibration.

Note: When using an Keysight 848X power sensor (sensors that do NOT have built-in
calibration factors), enter the Cal Factors using the Power Sensor Settings dialog, because the
VNA instructs the power meter to NOT use the Cal Factor tables internal to the power meter.

3. Connect a power meter sensor to the point at which you want a known power level. This may be at the input
or output of your device, or some other point between the test ports.

4. The VNA source is stepped through the specified frequency range, and power is measured with the power
meter. At each data point, the source power is adjusted until the measured power is within your specified

accuracy level.

5. When complete, the power meter is preset. The source power calibration can be saved as part of the
instrument state.

6. The power meter is removed and the measurement path reconnected.

7. The calibration is automatically applied to the channel. All measurements on that channel using that source
port benefit from the source power cal.

8. Perform an S-parameter calibration AFTER a Source Power Cal. The S-parameter cal is performed using the
corrected stimulus power levels for the relevant ports.

Verify the source power calibration using the following procedure.

1. Connect the power meter as it was during the source power calibration.
2. Set the VNA to Point Trigger mode.
3. Trigger the VNA across the trace. Read about the behavior of the sweep indicator.

4. At each data point, the power meter should read the corrected power level within the specified tolerance.

Supported Power Meters and Sensors

See Keysight's Power Meters and Sensors Webpage.

USB Power Sensors

e UB848x Series USB Thermocouple Power Sensors (A.09.90.08 and later).

e These include the following models: U8481A, U8485A, U8487A, U8488A, U8489A

e External Calibration (connecting the sensor to the 1 mW ref port) is NOT supported.
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¢ IMPORTANT: See http://na.support.keysight.com/pna/pseriesmeter.html
U202x X-Series USB Peak and Average Power Sensors.
e The VNA does NOT support peak mode in these sensors, but measures average power.

U2000 Series USB Power Sensors.
U204x X-Series USB and LAN Power Sensors.

U205xXA/U206xXA Series USB Power Sensors.

USB Notes:

From a standard power cal (this topic), only one USB power sensor can be used to cover the
entire frequency span. To use multiple power sensors, perform a Guided Power Cal. Learn how.

To select a USB power sensor for a standard power cal:

1. Connect the sensor directly to one of the VNA USB ports.
2. From the Source Power Cal dialog, click Power Meter Config.

3. On the Power Meter Settings dialog, select USB.

See Important First-time USB connection note.
See note about Zeroing USB Power Sensors.

See also: Power Meters as Receivers (PMAR)

LAN Notes:

LAN power sensors can only be controlled via LAN.

Typical LAN ports found on a PC or Keysight instrument are used for data transfer and
communication only and will not power up a U2049XA LAN Power Sensor.

LAN power sensors must connect to a PoE port (Power over Ethernet), which will supply DC
power required to power up the sensor and to transfer data.

421


http://na.support.keysight.com/pna/pseriesmeter.html

To select a LAN power sensor for a standard power cal:
1. Connect the sensor to a PoOE/LAN connection.

2. From the Source Power Cal dialog, click Power Meter Config.

3. On the Power Meter Settings dialog, select LAN and enter the host name of the power sensor.

Power Meters

P Series power meters (N1911A and N1912A) and all supported sensors.
EPM Series power meters (N1913A and N1914A) and all supported sensors.
EPM-P Series power meters (E4416A and E4417A) and all supported sensors.

E Series power meters (E4418 and E4419) and all supported sensors.

Power Meter Notes:

N1911A, 12A, 13A, and 14A power meters have a device-side USB connector and are controlled by
the VNA exactly like a USB sensor. See USB Power Sensors (above). Although these meters may also have
a front-panel USB port, USB power sensors must be connected directly to one of the VNA USB ports.

Source Power Calibration operates slowly with the Keysight E930x and E932x power sensors.

Some Keysight power meters have a mode that emulates the command set of the 437B or 438A power
meter. The VNA does NOT support this emulation mode.

The 82357A USB/GPIB Interface can be used to control power meters.

Create a Custom Power Meter Driver for use with other power meters.

Non-Keysight Power Sensors

Rohde and Schwarz NRP-Z power sensors (limited support). Learn how to install the drivers.

VDI PM5 power meter (limited support). Learn how to install the driver and set up the power meter.

How to perform Source Power Calibration

Note: Guided Power Cal can be performed during an S-parameter Guided Calibration. Learn more.
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1. Setup your measurement (sweep type, frequency range, IFBW, and so forth). By default, a Source
Power Cal is performed on the source port of the active measurement.

2. Connect coax cable, GPIB cable, and power sensors to the VNA as shown in graphic below.

This image does NOT apply to USB power sensors, which are connected directly to a VNA USB port.

See Important First-time USB connection note.

N ETW OR K ANALY ZER

FCwER METER

FOWER SENSOR

3. Apply power to the power meter and allow 30 minutes warm-up time before beginning calibration.

4. Select Source Power Cal as follows:
Using Hardkey/SoftTablSoftkey

1. Press Cal > Main > Other Cals > Source Power Cal....

Prugramming Commands=s }

5. Complete the Source Power Cal dialog box (below), including Options, Loss Compensation and Power
Sensor Settings, as needed.

Note: When using an Keysight 848X power sensor (sensors that do NOT have built-in
calibration factors), enter the Cal Factors using the Power Sensor Settings dialog, because the
VNA instructs the power meter to NOT use the Cal Factor tables internal to the power meter.

6. When complete, click Take a Cal Sweep in the Source Power Cal dialog box.
7. Follow the prompts to connect the sensors as required.
8. At this time you can change the Source Port setting and perform a Source Power Cal on a different port.

9. When calibration is finished, click OK. Correction is then applied and turned ON for the relevant ports on
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the active channel.
10. Remove sensor.

11. SrcPwrCal is displayed in the status bar when Source Power Correction is applied to the Active
Measurement.

12. Perform a S-parameter calibration, which would use the corrected stimulus power levels for the relevant
ports.

To turn Source Power Correction OFF:

e On the Calibration menu, point to Power Calibration, then click Source Power Correction on/OFF.

e ONLY correction for the source port of the ACTIVE MEASUREMENT is turned OFF (regardless of port
power coupling setting.)

Interpolation or Extrapolation

If the original stimulus settings are changed, Interpolation or EXTRAPOLATION is applied and
SrcPwrCal* is displayed in the status bar. This is different from measurement calibration interpolation. For
example, if the frequency span is increased, the VNA will extrapolate new correction values rather than
turn correction off. This is to protect your test device from being overpowered by the source. If the
original settings are restored, then source power calibration returns to full correction.

Source Power Cal dialog box help
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Note: Be sure that the frequency range of your power sensor covers the frequency range of your
measurement. This does NOT occur automatically.

Power

Cal Power The calculated power (in dBm) at the calibration point. This value is the
specified VNA source power plus the Power Offset value.

Power Offset Allows you to specify a gain or loss (in dB) to account for components you
connect between the source and the reference plane of your measurement. These
components will remain during a measurement. For example, specify 10 dB to account for a
10 dB amplifier in the path to your DUT. Following the calibration, the VNA power
readouts are adjusted to this value.

To account for components that will be removed when the calibration is complete, use the Loss
Compensation table.

Channel and Port Selection

Channel Specifies the channel on which to perform the calibration. This setting defaults to the
active channel.

Source Port Specifies the source port to be corrected. This setting defaults to the source port for
the active measurement.

Note: External sources can be calibrated using his dialog. Learn more.

Accuracy
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At each data point, power is measured using the specified Power Meter Settling Tolerance, then
adjusted until the reading is within this Accuracy Tolerance or the Max Number of Readings has
been met. The last power reading is plotted on the screen against the Tolerance limit lines.

Tolerance Sets the maximum desired deviation from the specified Cal Power level in 0.005 dB
increments from 0 to 5 dB.

Max Number of Readings Sets the maximum number of readings to take at each data point for
iterating the source power. Enter a value between 1 and 1000.

Calibration Status

Allows you to turn Source Power Cal ON | OFF and view Cal data for each port, regardless of the
active measurement. This feature allows the Internal Second Source to be calibrated and turned
ON | OFF, even when being used as an incidental source in a measurement, such as an LO.

Calibration ON Check to turn Source Power Calibration ON for the specified source port.
The displayed text indicates when interpolation is applied for the calibration.
Buttons

Options Invokes the Source Power Cal Options dialog. Label to the left of the button displays the
current 'Options' setting.

Power Meter Config Invokes the Power Meter Settings dialog box
Take Cal Sweep Begins source power calibration measurement.
OK Applies calibration. This button is disabled until the Take Cal Sweep has been pressed.

Cancel Ifasweep is in progress, cancels the sweep. Press again to close the dialog.

Attention please: the power meter is operating in 200 r/s mode.

During a measurement, some Keysight power meters may display this message on the screen: It
means that the meter is operating in 200 readings/sec which is the fastest speed setting for this
meter. This is normal operation.

Pass / Fail Limits

Limit lines are drawn on the Source Power Cal measurement graticule area. These lines are at the
Cal Power +/- the current setting of Accuracy Tolerance. A FAIL during the Source Power Cal
sweep means that the VNA was unable to measure power to within the Accuracy Tolerance. Tight
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tolerances are more difficult to achieve at lower Cal Power levels. When a FAIL indication appears,
increase the Max Number of Readings. If this does not cause a PASS condition, then decrease the
Accuracy Tolerance value.

See Also

e Learn more about Source Power Cal

e Learn about External Testsets and Source Power Cal.

Source Power Calibration Options dialog box help

f Faurie Poswer Callirtaon Optiarg EI

Calibration Refarence
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Use this receiver. A

Usiz & power table and the anabyzer refeancs recaiver.

Calibrate the sourcs at muliple poesar leesls.

Calibrade the analyzar reference recabhar,

QK Careal Halp

Provides options for measurement of the source power.

Note: At low power levels (less than -30 dBm) most power meters are not as accurate as a
VNA receiver.

Calibration Reference Choose power meter/VNA receiver to use to measure power.

e Use a power meter. Traditional source power calibration using only a power meter to measure the
source power at each data point. Most accurate (at higher power levels) and slowest method.

Note: Because the following two settings use VNA receivers to make power measurements,
they do NOT work correctly when aFrequency Offset value is being used.

¢ Use a power meter once, to calibrate receiver, then use receiver. When checked, the first reading at
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each data point uses a power meter to calibrate the reference receiver. Subsequent readings, if
necessary to meet your accuracy requirement, are measured using the reference receiver. This
technique is much faster than using the power meter, and more accurate when measuring low power
levels.

Note: Do NOT use this setting if there is a component before the power sensor that exhibits
non-linear behavior, such as a power amplifier in compression. Use a power meter and
Calibrate the source at multiple power levels.

o Use this receiver. Select a VNA Receiver or a PMAR (Power Meter as Receiver).

VNA receiver - For highest accuracy, first calibrate the receiver by performing a
source power cal using a power meter, then a receiver cal. That receiver can then be
used to quickly calibrate other VNA source ports, or used on another channel with
different stimulus settings. This would be useful, for example, if the power level of
the measurement was below the sensitivity of the power sensor. Calibrate the VNA
receiver using a source power cal that is within the sensitivity of the sensor. Then,
use the calibrated receiver to perform a second source power cal at the reduced
power level.

e The VNA receiver is specified using either standard receiver notation or logical receiver notation.

o ltis best to use the reference receiver for the source port to be calibrated. For example, if
calibrating source port 2, specify "R2" or "a2" which is the same port 2 reference receiver using
logical receiver notation.

e To ensure an accurate source power cal, the frequency range over which the receiver was
calibrated must be the same or larger than the "receiver only" source power calibration.

e All accuracy and settling tolerance and number of reading settings apply just as they do with a
power meter reading.

PMAR Device - The power meter/sensor must first be configured. Learn how to Configure a
PMAR device.

o Use a power table and the analyzer reference receiver Used to provide power leveling with mmWave
test set and modules. Learn more.

Calibrate the source at multiple power levels Used primarily with mmWave measurements.

This feature can also be used with standard VNA measurements when a component is used in the
source path such as a booster amp which does NOT have linear gain or loss over frequency. If this
is not true for your setup but want to improve your source power accuracy, consider using the
Receiver Leveling feature.
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When checked, source power is measured using the specified 'Cal Reference' device (power
meter/sensor or VNA receiver) and iterated on a sweep-to-sweep basis to construct a 2-dimensional
power table: Power IN, Power OUT, over all frequencies.

¢ Click Power Levels to launch the Source Cal Power Levels dialog box to set the power levels at which
source power is to be measured.

e The source power cal is saved, but the power table is NOT accessible.

Calibrate the analyzer reference receiver Check to calibrate the appropriate reference receiver
to the power level that is measured at the calibration plane. Do this to make very accurate
measurements using the calibrated reference receiver. This cal is done in addition to the standard
source power cal using the any of the methods listed above. At the end of the source power cal
measurement sweep, you can optionally save the reference receiver cal to a Cal Set to be recalled at
a later time. The Cal is saved when the OK button is clicked to close the Source Power Cal dialog.

Source Cal Power Levels dialog box help

Source Calibration Power Levels m

Max Power | 10,000 dBm [
Min Power [ 30000 dBm[Z]
Power Step Size [1.000 dBm 2]

ok | cace | Hep |

This dialog appears when you click Power Levels on the Source Power Cal Options dialog.

Specify the power levels at which the Source Power will be calibrated. These values should be set
to a few dB more or less than the measurement power levels.

Max Power - The highest power level at which to calibrate. This value should be a few dB
higher than the highest power level of your measurement.

Note: Setting the Max Power will override power settings entered manually in a Power Table

(InputPower). Therefore, when using a power table, set the Max Power value to the same
value shown in the Power Table (InputPower).
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Min Power - The lowest power level at which to calibrate. This value should be a few dB lower
than the lowest power level of your measurement.

Power Step - Calibrate at every incremental power level, between the Max and Min Power
settings.

Power Meter Settings dialog box help

Power Meter Settings

Interface

 GPIB Address [13 [
cuse | =
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Tolerance Ima

Max Mumber of Readings I‘i_a

Sensor Loss Compensation

™ Use Loss Table Edit Table |

OK Cancel | Help |

This dialog appears when you click the Power Meter Config button on many dialog boxes.

Communication

e GPIB/ Address Select GPIB power meter. Then select the address for the power meter. Default is 13.
The VNA will search VISA interfaces that are configured in the Keysight IO Libraries on the VNA. Note:
Use this selection when using a 82357A USB/GPIB Interface,

e USB VNA scans for USB power sensors or N191x device-side USB power meters. Select a power
sensor from the list. Only ONE USB power sensor can be configured to cover the entire frequency range
of the calibration. To use multiple power sensors, perform a Guided Power Cal.

e LAN Specify the Hostname or IP address of the Power Meter.
e Any This can be used if you wish to spell out the exact VISA resource string/alias for your power
meter’s 1/0O connection, for GPIB, USB, LAN or any other I/O protocol supported by VISA. For example,

you must use this to use a VDI PM5 power meter, and the VISA resource string/alias in that case must
be ASRL3::INSTR.
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Note: The VDI PMS5 driver software must be installed to use VDI power sensors. Refer to
Install VDI PM5 Driver.

Sensors Invokes the power sensor settings dialog box.
Settling
These Settling settings do not apply when a VNA receiver is the power measurement device. Each
power meter reading is "settled" when either:
¢ two consecutive meter readings are within this Tolerance value or

¢ when the Max Number of Readings has been met.

The readings that were taken are averaged together to become the "settled" reading. The settled
reading is then compared to the Accuracy Tolerance requirements (tolerance and max readings)
specified on the Source Power Cal dialog box.

Tolerance When consecutive power meter readings are within this value of each other, then the
reading is considered settled.

Max Number of Readings Sets the maximum number of readings the power meter will take to
achieve settling.

Sensor Loss Compensation

Use Loss Table Select this checkbox to apply loss data to Source Power calibration correction
(such as for an adapter on the power sensor).

Edit Table Invokes the Power Loss Compensation dialog box.

Power Loss Compensation dialog box help

Power Loss Compeaensation

FRECQLENCY LOSS
1.000000 GHz 0.50 @B
2 2.000000 GHz 1.00 @B

Delete Table Segment | 1 E Drelebe All

[0 4 Cancel | Help |
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To Add a Row to the table, click on a row in the table and press the down arrow on either the VNA
front panel or keyboard.

To Edit a value, double-click in the cell to be edited.

Compensates for losses that occur when using an adapter or coupler to connect the power sensor to
the measurement port. These components will be removed when the calibration is complete. To
account for components that will remain during the measurement, use the Power Offset setting.

The Frequency / Loss pairs define the amount of loss for the entire frequency range. For example,
using the entries in the above dialog image:

e 0.5 dB is used to compensate power sensor measurements up to 1 GHz.

Each data point between 1 GHz to 2 GHz is linearly interpolated between 0.5 dB and 1 dB.

1 dB is used above 2 GHz.

A single frequency/loss segment is applied to the entire frequency range.

Beginning with A.09.80, enter up to 9999 segments to achieve greater accuracy. Previously the
limit was 100.

Note: Large segment counts with one or more power sensors can result in long load and close
times for the VNA Application.

Frequency Enter a frequency in Hz.

Loss Enter a loss as a POSITIVE value in dB. To compensate for gain, use NEGATIVE values.
Delete Table Segment Deletes row indicated in the field.

Delete All Deletes all data in the table.

The Power Loss Compensation table survives VNA Preset and Power OFF. To NOT use Loss
compensation, clear the Use Loss table checkbox on the Power Meter Settings dialog.

Power Sensor Settings dialog box help
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This dialog appears when you click the Sensors button on the Power Meter Settings dialog.

Note: Be sure that the frequency range of your power sensor covers the frequency range of your
measurement. This does NOT occur automatically.

Sensor A (B) Displays one of the following messages depending on type of sensor.

e Not connected The VNA is not detecting a power sensor.

o Cal factors are contained within this sensor This message is displayed when the Internal Reference
Cal Factor and Cal Factor data are contained in the sensor and automatically accessed.

e Sensor Data Allows the following entries for power sensor data:

e Reference Cal Factor Specifies the sensor's Reference Cal Factor.

Cal Factor Table Specifies the frequency and corresponding Cal Factor for the sensor.

e Delete Cal Factor Deletes the indicated row in the table.
e Delete All Deletes all data in the table.
e To Add a Row to the table, click on a row in the table and press the down arrow on either the VNA

front panel or keyboard. A row is added to the bottom of the table. The table is automatically sorted
by frequency when OK is pressed.

Load Cal Factors Click to load cal factors from a *.csv file that you create from the cal factors
that appear on the sensor. The first line of the file MUST have the reference Cal Factor (typically
100), followed by Freq / Cal Factor pairs as show in the following image:
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Save Cal Factors Click to save the cal factor table to a *csv file.

Use this sensor only Check this box to use this sensor over the entire frequency span of the
measurement, even if two sensors are connected to power meter.

Clear this box to allow entry of minimum and maximum frequencies for the sensor. Only ONE of
the two sensors can have this box checked. You will be prompted to connect the appropriate
sensor during the power calibration.

Minimum Frequency Specifies the minimum frequency range for the sensor when using dual
Sensors.

Maximum Frequency Specifies the maximum frequency range for the sensor when using dual
Sensors.

Zero and Calibrate the Power Sensor

For highest accuracy, Zero AND Calibrate the power sensor before measuring data. Follow prompts
that may appear.

Zero - If the following settings are 'greyed’, Internal or External zeroing is selected
automatically based on the power meter/sensor model. Otherwise, select the appropriate type
of zeroing to perform, then press Zero.

¢ Internal Zero - A switch inside the power sensor removes the sensor from the incident power.

e External Zero - Requires that you physically remove the sensor from incident power.
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Note: For the U2000 Series USB power sensors

Calibration is NOT available. Select External Zero ONLY when the power to be measured is
below the specified level. Otherwise, the U2000 series performs internal zeroing automatically
when needed. See your power sensor documentation for more details.

e U200xA - below -30 dBm
e U200xH - below -20 dBm
e U200xB - below 0 dBm

If your U2000 power sensor 'hangs' when external zeroing, upgrade the power sensor firmware
to Rev. A.01.02.00 or higher to fix this problem.

Note: For the U2020 X-Series USB power sensors

The U2020 X-Series support only internal zeroing. But like the U2000 series, they default to
performing zeroing automatically when needed.

Calibrate - Available when the selected sensor has calibration capability. Calibration involves
measuring an internal 1 mW source.

o Keysight P-Series sensors and U2020 X-Series USB sensors have an internal reference so you can
calibrate them without connecting to a meter’s reference port.

¢ Keysight U2000 USB power sensors do not require calibrating.

o For other sensors, refer to the documentation to determine if it has calibration capability.

Press Calibrate, then follow the prompts.

Copy a Source Power Calibration to other Channels

A macro application is now available that copies a Source Power Calibration to other channels. Once
downloaded and installed on a VNA, the macro is automatically configured up. To learn more, click
Help on the application main dialog. Get the application from
http://na.support.keysight.com/pna/apps/applications.htm.
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Saving a Source Power Calibration

Because Source Power Cal calibrates source hardware, the calibration data is saved as part of the
Instrument State, in either a .sta file or a .cst file. This correction is applied to all measurements on
the channel that uses the calibrated source. See Save Instrument State.

Reducing Time to Complete a Source Power Calibration

The time required to perform a Source Power Calibration depends on source power, number of points,
and number of readings taken. You can reduce this measurement time with the following methods:

¢ Reduce number of points before calibration. You can reduce the number of points before the
measurement, then return the number of points to its original value after calibration is complete and
correction is ON. The analyzer will perform a linear interpolation, although with some loss in accuracy.

¢ Use an Keysight E-Series sensor. You can obtain 40+ readings per second over GPIB with this type of
sensor on the VNA.

¢ Increase power to the sensor. Lower power may have longer settling time with some sensors.

Check Use Reference Receiver for Iteration.

Receiver Power Calibration

Note: Source and Receiver Power Calibrations are NOT available in M937xA PXI.

Note: A Guided Power Cal can be performed during an S-parameter Guided Calibration. Learn more.

Receiver power calibration mathematically removes frequency response errors in the specified VNA
receiver, and adjusts readings to the same, or a value offset from, the source power calibration level. It
is the same as doing a Response Cal or Data / Memory, (Normalization) but with the data shifted to
the Cal Power value.

Use Receiver Power Calibration to make very accurate absolute power (amplitude) measurements.

Receiver Power Calibration:

Is ONLY allowed when making absolute power (unratioed) measurements.

Is most accurate when a source power calibration was performed first.

Applies to all unratioed measurements in the active channel using that receiver.

Can be saved in a Cal Set and later reapplied to a like measurement.
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Interpolation

Like other calibration types, if the original stimulus settings are narrowed, interpolation is applied and
C* Revr Pwr is displayed in the status bar. If the original stimulus settings are made wider, the VNA
will turn Receiver Power Correction OFF.

If the original settings are restored, then receiver power calibration returns to full correction.

How to perform a Receiver Power Calibration

1. Perform a Source Power Calibration.
2. Set the active measurement to unratioed. Learn How.
3. Connect a THRU line from the source port to the receiver port.
e When performing a receiver power cal on a reference receiver (source 1 and receiver R1), no
connection is necessary as the receiver is internally connected to the source.
e When the source port and receiver port are the same (receiver A, source port 1), then connect an open

or short to get maximum power to the receiver. This practice is not recommended. It is best to use
different ports for the source and receiver.

4. Ensure correction for Source Power Calibration is ON as indicated by Src Pwr Cal or Src Pwr Cal* in
the status bar.

5. Start the Calibration Wizard
Using Hardkey/SoftTablSoftkey

1. Set the active measurement to unratioed. Learn How.

2. Press Cal > Main > Other Cals > Receiver Power Cal....

Prugramming Commands= }
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Select Calibration Type for Unratioed Measurement dialog box help
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Cal Type Selection Select Receiver Power
Receiver Power Configuration

Cal Power Specifies the power level to be displayed on the measurement when complete. (Source
Port Power + Power Offset).

Source Port Power Test port Power set for the measurement. Learn how to change Test Port
Power

Power Offset Allows you to specify a gain or loss (in dB) to account for components you connect
between the source and the reference plane of your measurement AFTER a source power cal has
been performed. Following the calibration, the VNA power readouts are adjusted to the Cal Power
value.

Next Click to continue the Calibration Wizard.

Notes:

¢ When Receiver Power Cal is finished, 'Response’ is displayed in the status bar and correction data is
applied to subsequent sweeps. This is done because Receiver Power Cals are essentially Response
Cals once they are stored and applied. See Saving a Receiver Power Cal below.

e To turn correction OFF, click Cal > Main > Correction > Channel Correction OFF.

Learn more about Receiver Power Cal (scroll up).

Saving a Receiver Power Calibration

Beginning with VNA Revision 5.0, Receiver Power Cal is saved to a Cal Register and optionally to a
User Cal Set. It can be applied to measurements in the same way as other Cal Types. Previously,
Receiver Power Cal data was saved as part of an Instrument State and was only applied to the
measurement on which it was performed.

Learn more about Saving VNA files types.
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Fixture Simulator

The following features allow you to mathematically add (embed) or remove (de-embed) circuits to, or
from, your measurements. The mathematical models are applied to specific ports for all measurements
on the channel.

Notes

o The following features are available in GCA, Noise Figure Apps:

Port Extensions (Not available in Swept IMD, IMDX, Noise Figure, NFX, or Diff 1Q)

2 Port De-embedding

Port Matching

Port Z Conversion

e Power Compensation

o All other Fixturing features are available ONLY in a standard channel.

See Also

e Procedures: To Embed or De-embed?

e "De-embedding and Embedding S-Parameter Networks Using a Vector Network Analyzer" App note. for more
conceptual information on Fixture Simulation.

e See an example of how these functions can be used to de-embed unwanted effects of a test fixture, and then
mathematically embed the DUT in the circuit in which it is used.

Order of Fixture Operations
Click to learn more about each operation.

First, the following Single-ended measurement functions are processed in this order:

1. Port Extensions

2. 2-Port De-embedding
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3. Ground loop de-embedding / embedding
4. Port Matching Circuit Embedding
5. Port Z (Impedance) Conversion

6. 4-Port Network (single-ended) Embed/De-embed

Note: The operation for ground loop embedding and ground loop de-embedding will always
occur as the 3 step. It cannot be moved. By default, this is after the 2-Port DeEmbedding
operation.

Then, Balanced measurement functions are processed in this order:

7. Balanced Conversion
8. Differential / Common Mode Port Z Conversion

9. Differential Port Matching

e Source power compensation is then optionally applied to compensate for the aggregate loss through all
enabled fixturing operations.

Notes

The fixturing operations are applied to the measurement results.

e The order of operations 1 through 5 can be changed using the SCPI command: CALC:FSIM:SEND:OORD.
Learn how to send this command from the GPIB Command Processor Console.

e The order of the operations 6 through 9 can NOT be changed.

¢ In the Data processing chain, the Fixture Simulator functions occur at the same time as the Apply Error
Terms block.

e When fixturing is enabled, all of the enabled fixturing features are applied when snp files are saved.
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How to select Fixturing Simulator
About Fixturing ON/off
BOTH of the following must occur to turn a fixturing selection ON.

EITHER ONE will turn a fixturing selection OFF.

1. Turn Apply Fixtures ON/off
Port Extensions is NOT affected by Fixturing ON/off.

2. Check Enable on the individual fixturing selection dialog box.

Using Hardkey/SoftTablSoftkey

1. Press Cal > Fixtures > Apply Fixtures.

Programming Commands=s }

Port Matching dialog box help
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Note: This feature is available in the following measurement classes: GCA, Noise Figure, ,and standard
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(S-Parameter) channels.

This function specifies a circuit to embed (add) to the measurement results. See Order of Fixture
Operations.

| VNA |

{-:nL Ref Plané

¢ Embed *
| VNA |

Matching
Network B B

CAL Ref Plana

Enable Port Matching Check to apply the settings to the measurement results. Must also enable
Fixturing ON/off.

Port - Select Port in which to apply simulation.

Circuit Model for Matching - Choose one of the following that best emulates your fixture at the

selected VNA port:
L N
E i TT DUT
Series L - Shunt C Gi 1 i
VNA ‘,T
Shunt C - Series L ':i I
VNA ;-I DUT
| |—*:~.*~
Shunt L - Series C EL :
i R
=
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VNA o DUT

I
Series C - Shunt L G f'-
;@ R
VNA L J J DUT
= I_ - & —
Shunt L - Shunt C [ G lb
iR
v v
User Defined (S2P File) Load a file that is specified with
User S2P File button.

None Use no circuit model.

User S2P File Click to specify an S2P file of the circuit model to embed at the selected port. If the
normalized impedance value in a recalled User .S2P file is different from the port reference
impedance setting of the VNA, the VNA setting is used.

Circuit Values

Capacitance (C), Inductance(L), Resistance(R), Conductance(G) Values for the specific
components of the circuit type that models your fixture.

Reset Restores the default values.

2 Port De-embedding dialog box help
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Note: This feature is available in the following measurement classes: GCA, Noise Figure, ,and standard
(S-Parameter) channels.

444




De-Embed when you have performed a calibration and then added a fixture (an adapter, an
attenuator, a longer cable, etc.) that connects between the Cal reference plane and your DUT. This
function removes the effects of a component or test fixture from the measurement results.

Note: De-embedding a component with more than 20 dB of loss becomes impractical because of an
inability to accurately measure the match of the DUT through such a device.

CAL Rel Plane

* De-Embed *

CAL Ref Plane

The de-embedding operation recalls an .s2p file (Touchstone format) which includes the electrical
characteristics of a 2-port fixture or device. The file can be in any standard format (real-imaginary,
magnitude-angle, dB-angle).

Enable De-embedding Check to apply the settings to the measurement results. Must also enable
Fixturing ON/off.

Enable Extrapolation Check to apply a simple extrapolation when the S2P file has a narrower
frequency range than the channel. The values for the first and last data points are extended in either
direction to cover the frequency range of the measurement. The frequency ranges of both the
channel and the S2P file are displayed at the bottom of the dialog.

When extrapolation is necessary and enabled, a message is displayed showing the frequency range
to be extrapolated. When extrapolation is necessary and disabled, a message is displayed offering to
enable extrapolation.

This setting also causes 4-port Extrapolation to be enabled and disabled.

Port The VNA port to which the recalled de-embedding file is applied.
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From the drop-down menu, select User Defined (S2P File).

Reverse Adaptor Ports Check to cause the Fixture/Adapter to be configured with Port 2
connected to the VNA and Port 1 to be connected to the DUT. The image in the dialog reflects that
change.

User S2P File Click to specify an existing .S2P file. If the normalized impedance value in a
recalled User .S2P file is different from the port reference impedance setting of the VNA, the VNA
setting is used.

Port Z (Impedance) Conversion dialog box help

Port F Comwersion
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Note: This feature is available in the following measurement classes: GCA, Noise Figure, ,and standard
(S-Parameter) channels.

This function corrects the measurement and displays the results as if the measurement had been
made into the specified impedance value. However, the physical port termination is still
approximately 50 ohms.

The specified impedance value is applied to all of the measurements on ONLY the active channel.

See Order of Fixture Operations.

Enable Port Z Conversion Check to apply the settings to the measurement results. Must also
enable Fixturing ON/off.

R Real part of the impedance value.
jX Imaginary part of the impedance value.

Close Applies the entries and closes the dialog box
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Note: Port Z (Impedance) conversion uses values in the following prioritized order:

1. Balanced (Differential or Common Mode) - if enabled, these values are always used.
2. Single Port Impedance - if enabled, this value is used if Balanced is not enabled.

3. System Impedance - if neither balanced or single port is enabled, this value is used.

4/6/8-Port Embed/De-embed dialog box help
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This function specifies a single-ended 4-port circuit (*.S4P file) to embed (add) or de-embed

(remove) from the measurement results. Computation takes place BEFORE Balanced conversion.
See Order of Fixture Operations.

There is a single normalized impedance value for each port in the *.S4P file. This impedance value
must match the impedance of the previous Port Z setting, or the VNA port impedance.

The VNA will interpolate if the number of data points that are read is different from the current
VNA setting.

Enable 4-Port Embed/De-embed Check to apply the settings to the measurement results. Must
also enable Fixturing ON/off.

Enable Extrapolation Check to apply a simple extrapolation when the S4P file has a narrower
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frequency range than the channel. The values for the first and last data points are extended in either
direction to cover the frequency range of the measurement. The frequency ranges of both the
channel and the S4P file are displayed at the bottom of the dialog.

When extrapolation is necessary and enabled, a message is displayed showing the frequency range
to be extrapolated. When extrapolation is necessary and disabled, a message is displayed offering to
enable extrapolation.

This setting also causes 2-port Extrapolation to be enabled and disabled.

Topology

Select a DUT topology. Refer to the images on the 4-port embed/De-embed dialog box.

e A - Network 1
¢ B - Network 1/3
o C - Network 1/2/4
NA Ports - Select the VNA Port that is connected to each circuit port.

Network Ports Select the network ports that represent the configuration of the S4P file. By default,
ports 1 and 2 are connected to the VNA and ports 3 and 4 are connected to the DUT.

None, Embed, De-embed For Networkl and Network?2, select:

¢ None - The same as disabling.
¢ Embed - Add the specified network circuit to the measurement results. See 2-port Embed image.

¢ De-embed - Remove the specified network circuit from the measurement results. See 2-port De-embed
image.

Browse For both Networkl and Network2, navigate to find the .*S4P file to embed or de-embed.
OK Applies the changes and closes the dialog box.

Cancel Does NOT apply the changes and closes the dialog box.
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Differential Impedance Conversion dialog box help
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This function sets the Differential impedance value for each balanced port.

The default value for R: is the SUM of the impedance values for both ports that make the logical
port. If Port Z Conversion is not enabled, then System Z0 values for both ports are summed.

See Order of Fixture Operations.

Enable Differential Z Conversion Check to apply the settings to the measurement results. Must
also enable Fixturing ON/off.

Logical Port Select the logical (balanced) port to receive impedance value. To see logical port
numbers, see the measurement topology.

R Real part of the impedance value.
jX Imaginary part of the impedance value.

Close Closes the dialog box.

See note about Port Impedance priority.

Common Mode Impedance Conversion dialog box help
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This function sets Common Mode Impedance value for each balanced port.
The default value for R: is calculated as follows.

(Z1 *Z2)/(Z1 + Z2)

Where ports 1 and 2 comprise the logical port:

Z1 = the Port Impedance values for port 1
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72 = the Port Impedance values for port 2

If Port Z Conversion is not enabled, then System Z0 values for port 1 and 2 are used in the
calculation.

See Order of Fixture Operations.

Enable Common Mode Z Conversion Check to apply the settings to the measurement results.
Must also enable Fixturing ON/off.

Logical Port Select the logical (balanced) port to receive impedance value. To see logical port
numbers, see the measurement topology.

R Real part of the impedance value.
jX Imaginary part of the impedance value.

Close Closes the dialog box.

See note about Port Impedance priority.

Differential Port Matching dialog box help
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This function allows the embedding of a differential matching circuit at a balanced port.

See Order of Fixture Operations.

Enable Differential Port Matching Check to embed the selected matching circuit to the
measurement results. Must also enable Fixturing ON/off.

450




Logical Port Choose Logical DUT port to receive the selected matching circuit. To see logical port
numbers, see the measurement topology.

Select Circuit Select a matching circuit. Choose from:

e Shunt L - Shunt C Predefined circuit.

L= 0

Tesl port R DUT pot

Circuit Values Choose from:

C Capacitance value

G Conductance value

L Inductance value

R Resistance value

o User defined Select an *.S2P file that represents the matching circuit. Then click Browse to navigate to
the *.S2P file.

Note: For the *.S2P file:
Port 1 of the circuit is assumed to be connected to the VNA
Port 2 of the circuit is assumed to be connected to the DUT.

e None No embedded circuit on selected port.

Close Closes the dialog box.

Power Compensation dialog help
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Fixburing: Power Compensation m

Compensated Ports

Port 2
Port 3
Port 4

m|m||mm|

Note: This feature is available in ALL measurement classes.

This function adjusts the source power at the specified port to compensate for the combined amount
of gain or loss through specific fixturing operations. Use this function to set the power level at the
DUT input.

Power Compensation adjusts the source power for the gain/loss through 2-port de-embedded fixture
components.

¢ |t does not compensate for any port matching networks.

o To work around this limitation, compute the anti-network of the matching circuit and use that data to
generate an S2P file. Change the fixture type from port matching to De-embed. This should result
in the same measurement data but will also enable the port power compensation feature.

¢ [t does not compensate for any fixture networks with more than 2 ports.

o There is no work around for this limitation. There is a coarse adjustment for port power using
Power Offsets. Calculate the loss through the fixture, use that number to set the power offset, and
then set the desired power level at the port.

For example:

¢ Your DUT requires a fixture on the input port which is connected to VNA port 1.

o The fixture description (such as an S2P file at the 2-port De-embed function) indicates the fixture has
approximately 2 dB of loss across the frequency span.

e You set source power to 0 dBm. But you want 0 dBm at the DUT input (the fixture output).

o Check Power Compensation on Port 1 and enable Fixturing.
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e Power Compensation causes the source power to be increased by approximately 2 dB so that the power
at the fixture output plane will remain at 0 dBm.

Power Compensation affects all measurements in the channel.
Enable Fixturing to use Power Compensation.

Note: Use caution when applying power compensation. Always test your setup without a DUT in a
place. If you are using S2P files, Recall your S2P file into the VNA so you can verify that the device
your S2P file describes is what you intended it to be. It is too easy to misalign data in S2P files if
they are constructed by hand.

Ground Loop De-embedding / Embedding

Ground loop de-embedding removes the effect of a non-ideal ground connection between the DUT’s ground and
the analyzer's ground reference. Typically, the non-ideal component is the parasitic inductance of the ground
contacts.

Ground loop embedding adds the effect of a non-ideal component on the ground contacts.

The Ground Loop De-embedding / Embedding can be specified by circuit model type or touchstone file.

S1P Shunt | Shunt ¢
— DUT |— —1 DUT |— — DUT [—
DUT ref, DUT ref DUT ref,
1-post i .
data r ! -
R [, |
Analyzer ref. Analyzer ref.

Ground loop de-embedding / embedding is only available from SCPI remote interface.

Fixture Simulator Example

The following example shows a DUT and the matching circuit with which the DUT will be used in its
intended application. When the DUT is tested in a high-volume manufacturing environment, multiple
test fixtures are often required. The most accurate way to test the DUT and ensure measurement
consistency between the different test fixtures is to use a simple, repeatable, test fixture without the
actual matching elements.

To get the desired performance data, the parasitic effects of the fixture must first be removed (de-
embedded) from the measured data. Then a perfect "virtual" matching circuit must be simulated and

453



added mathematically (embedded) to the corrected, measured data. The result is an accurate display of
the DUT as though it was actually tested with a physical matching circuit, but without the uncertainties
of using real components.

Test Device and the circuit in which it will be used.
Ti ouT o
o—” o
2

Rs ]
L SRR
& L

M T

Rs = 50 ';.-E'
RL= 200 &
Circuit Simulation
Fort 7 Fort Extensions! Balanced
Comversion De-embed Conversion
. —— Y SR -
1 I [| E !
i i C1 1 '
i ; ] i
e e DUt A
i z;¢ §L1é T )
v v cz ||
i i i ] ! QEC
i . A il A l + :
[
Fort Matching Diff Port Match
[ de-embed test fidure Balanced
[ embed circuit 7 Conversion

This diagram does NOT refer to the order in which operations are performed.

See Order of Fixture Operations.

1. Create a balanced measurement using single-ended to balanced (SE-Bal) topology. Include all relevant
measurement settings (IFBW, number of points, and so forth). Once the measurement is created and
calibrated, the measurement parameter can be easily changed. For example, Sdd22 to Sds21.

2. Calibrate the measurement at the point where the simple test fixture is connected to the VNA. Use accurate
calibration standards and definitions.

3. Remove the effects of the three uncalibrated transmission lines of the simple test fixture. This can be done in
several different methods. The easiest is to use manual or automatic Port Extensions to move the calibration
reference plane to the DUT. This removes the electrical length and loss of the fixture’s transmission lines, but
does not account for fixture mismatch. Another method is to de-embed previously-created *.S2p files of the 3
transmission lines. The files can be created using external ADS modeling software. Another alternative is to
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10.

create the *.S2P files by independently measuring all 3 ports of the test fixture and saving the results of each
to an S2P file.

With the test fixture connected to the VNA and a DUT inserted, the measurement results now appear as
though calibration was performed at the connections to the DUT, and the device was measured in a 50-ohm
single-ended test environment. The following steps will cause the results to reflect the performance of the
device as though the device is embedded in the circuit in which it will be used.

Port 1 of the device is a single-ended port and sees a source impedance the same as the VNA system
impedance, so no change is required. However, if Rs were a value other than 50 ohms, Port 1 Impedance
Conversion would be used to simulate the different impedance.

Port Matching is used to simulate L1 inductance. Select any of the Shunt L circuits to embed (add) to the
measurement results. Enter the value of L and R. The C and G values can be entered as 0 (zero).

Port Matching is used to simulate C1 and C2 capacitance. For both port 2 and port 3, select any of the
Series C circuits to embed (add) to the measurement results. Enter the value of C and G. The L and R
values can be entered as 0 (zero).

Balanced Conversion mathematically simulates the measurement in balanced mode.

Differential Port Matching is used to simulate L2 inductance. Select Shunt L- Shunt C and enter the
inductance / resistance value. The C and G values can be entered as 0 (zero).

Finally, Differential Z Conversion is used to simulate a circuit termination of 200 ohms. If you are making
Common Mode measurements, specify Common Mode Z Conversion.
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Automatic Fixture Removal (AFR)

Note: This feature requires Option S9x007A or 007.

In this topic:

e Overview
e Requirements

e Automatic Fixture Removal Wizard

Overview

Fixtures are often used for DUTs that have non-coaxial interfaces. This feature allows you to
mathematically remove, or de-embed, a characterized test fixture from displayed measurement results
of the test fixture and DUT.

Before starting the AFR process, Perform a calibration at the connectors of the test fixture (red lines
in images below).

The AFR Wizard will guide you through these steps:

1. Press Cal > Fixtures > Auto Fixture Removal....

2. Describe your fixturing situation.

3. Specify How the Thru fixture characterization will occur.

4. Do characterization.

5. Remove the effects of the test fixture. Leaves ONLY the displayed results of the DUT.

6. Touchstone files are saved that characterize the two halves of the test fixture.

Requirements

e Test fixture and either a complete Thru OR Left and Right Thru halves, all shown below.

¢ Both the Test fixture and Thru are made of the exact same medium; preferably fabricated ON the same piece
of medium.

Single-ended Fixtures
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Test
fixture

Thru
standard

OR

Left and
Right
halves of
Thru
standard

Supports both 1-port (not shown) and 2-port single-
ended DUT configurations.

When used with a 4-port DUT configuration, the trace
coupling is not removed.

Differential (Balanced) Fixtures

Test
fixture

Thru
standard

OR
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Left and
Right
halves of
Thru
standard

Supports 4-port DUT configuration ONLY which
includes removing the effects of coupling between the
differential traces.

How to start the Automatic Fixture Removal Wizard
With a calibrated measurement of the DUT in the test fixture present:

Click Response, then Cal, then Fixtures, then Automatic Fixture Removal

Note: The dialogs below show images for a Single ended DUT, but Differential works exactly the
same, only with Differential S4P files.

Automatic Fixture Removal Wizard ‘ Programming Commands }

For best results, follow the AFR Wizard tabs from steps 1 through 5 by either clicking Next > or
clicking the tabs.

In this section:

1. Describe Fixture

2. Specify Standards
3. Measure Standards
4. Remove Fixture

5. Save Fixture

1. Describe Fixture
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The choices that you make in the dialog are reflected in the diagram and text (red box in following
image).

1. Dersgribe Fecturg | 2 Spacdy Standards | 3 Messure Standards | 4 Remove Fisture | 5. Save Fohane A

Mty fodbure inputs are
& Single Endied

Dhffesentaal
Moty meacunement is: Currant Ficture and DUT Assumpbicns
1 Post Feehare Madch: A w B
Fachare Lengtic A= B
@ 7 Peaty =

DUT 20 will be comverbed ta 50 Ohms

MRt
~ | Adwanced Seltangl
Aftes fchure removal st Calibration Reference I0 to
“Syitem IO
& 0 Chims
S St “Syitem IO to Calbraton Reference 20
o I'want to correct for Focune Match A = B
# wiand b Soivedt fof Fosfe Length A « B

¥ My feetare i barsd lennediuse Bandpass v domn mode)

My fixture inputs are:

¢ Single Ended - The fixture and DUT have single-ended inputs and outputs.

o Differential - The fixture and DUT have differential inputs and outputs.

My measurement is:

e 1-port - such as S11.(single-ended only)
e 2-port - such as S21 (single-ended) or SDD11 (differential)
e 4-ports - such as SDD21 (differential only)

e Multiport - available when using a testset with more than 4 ports.

Advanced Settings (click * to show and hide)

After fixture removal set Calibration Reference Z0 to: (Choose one of these settings)

e System Z0 - Sets impedance to the System Impedance setting. Learn how to set System Z0.

o Measured Fixture Z0 - Sets impedance to the value that is measured during the AFR process. Not
allowed when 'band limited' is selected below.

e <nn> ohms - Sets impedance to an arbitrary value.
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e Set 'System Z0" to Calibration Reference Z0 - When the impedance is measured or set to an arbitrary
value, check to also set the System Z0 to the same value.

Select all that apply:

o Check if this is true: | want to correct for when the match (Return Loss) of Fixture A is NOT equal to
the match of Fixture B.

e Check if this is true: | want to correct for when the electrical length of Fixture A is NOT equal to the
electrical length of Fixture B.

e Check if this is true: My fixture is band limited. Bandpass mode will be used during the Time Domain
measurement. If NOT checked, then Lowpass mode is used. Because Lowpass mode includes
impedance in the calculation, it renders the best accuracy. Learn more about these settings.

Note

When using Lowpass mode and an error message appears ("' Measurement settings are not
adequate..."), change the start frequency and the number of points so that the frequency span
between data points equals the start frequency. This can be done by selecting values using the
following logic:

Start freq = 10 MHz
then either:

Stop freq = 20 GHz
Number of points = 2000
or

Stop freq = 50 GHz

Number of points = 5000

In either case, the frequency span between data points equals 10 MHz, the start frequency.

2. Specify Standards
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1. Describe Fowe 2 Specdy Standards | 3. Measure Standards | 4. Remove Fixture | 5. Seve Fidure

Far oy cablrabaon standands | hanve:

[

& Krcram: theu kength i ns
Unknessmn thiu kength compubied wiing meflects

Linknowm tFuu keragth compated wing Tetunsd DUT mssssor ismaensy

Note: The term 'Standards' is used here because this process can be thought of as the second in a '2-
tier' calibration. The first tier of the calibration must already be performed (the VNA calibrated)
before starting the AFR process. Another way of describing this step would be:

"How will you be measuring or loading the characterization of the Thru standard?"

e Thru - Both halves together.

¢ Both Thru halves separately. Specify either Open, Short, or Both at the end of each half of the standard.

Advanced Settings

This setting 1s used to describe any ADDITIONAL length between the halves of the Thru or added
to either of the individual halves.

If the electrical length of the Thru standard is identical to the test fixture, then make no changes to
the default settings (Known length = 0).

My Thru fixture has:

¢ Known thru length - Enter the length in nanoseconds. See a simulated length in the diagram between
the two halves of the Thru.

¢ Unknown thru length computed using reflects. This setting requires the two halves of the Thru fixture
be characterized separately with a reflect standard.

¢ Unknown thru length computed using fixtured DUT measurements. This setting requires an
additional characterization of the Fixture + DUT.
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3. Measure Standards

1. Deeswibse Finture | 2. Specify Standards | 3. Measure Standsds | 4, Remove Fodure | 5. Save Fistune
Maareune ofF Lo Cal Stardands

Fisturé A Opery b Wt Lo

= | Caloulsted Foctune Charscheristcs

Fehare A Q503005 o+ Fehee B 000230600 m = 1085130 ns

Meaugo

This step characterizes the Thru standards. This is done by either performing measurements or by
loading one or more *.snp files that describe the characterization of the Thru standards.

Connect the standards and click Measure, or click Load and navigate to the *.snp file that

describes the standard that is pictured.

Calculated Fixture Characteristics

Note: The fixture length must be 4 times the rise time. If not, an error message will be displayed.
For example, a measurement at 26.5 GHz has a rise time of 37.7 ps. Therefore, the fixture length

must be 4 * 37.7 ps = 151 ps.

The loaded or measured Impedance and Electrical Length of the fixture are calculated and displayed

here.

4. Remove Fixture
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1. Doscribe Fogune | 2 Specify Standards | 3. Measure Standaeds | 4 Remong bt | & S Fortute A
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& Advanced
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Comperaste for power
Prompt for neswy calset namae{z]
Apphy AFR bo other selected caloeds

Hack Pt Exit Halp

Note: First choose Select correction method, then make other selections, then click Apply
Correction.

Both operations can be performed, but only one at a time.

e Turning on Fixturing/de-embedding for channels. Usually only one channel is being used on the VNA,
so only one channel will appear in the choices of channels to be corrected.

¢ Select the channels to be corrected.
e Fixturing and de-embedding will be enabled for the selected channels in the VNA.
e Advanced settings

e Enable Extrapolation - When fixture data is loaded from a file and the frequency span of the
data is not as wide as that of the channel, check this box to calculate and use linearly-
extrapolated fixture data.

e Compensate for power - When checked, test port power is increased to compensate for
loss in the fixture.

¢ Modifying the calset(s) used on the channels. Usually only one calset is in use on the VNA, so only
one choice would be available.

e Advanced settings

e Enable Extrapolation - When fixture data is loaded from a file and the frequency span of the
data is not as wide as that of the measurement, check this box to calculate and use linearly-
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extrapolated fixture data.

e Compensate for power - When checked, test port power is increased to compensate for
loss in the fixture.

e Prompt for new calset names - When cleared, when you apply AFR to a calset, the calset
is overwritten. Once done, this process is NOT reversible. When checked, you are prompted
to enter a new calset name and the original is preserved. The new calset is written with AFR
correction.

e Apply AFR to other selected Calsets - When checked, allows you to apply AFR correction

to other calsets not currently in use on the VNA. Click Browse, then navigate to the calsets to
be corrected.

5. Save Fixture

-

. Describe Fuodure | 2 Specify Standards | 3. Measure Standands | 4. Remowve Fidure | 5. Save Fodure

Select File format to sawe fodure datac
& Touchstone
Touwdhstons 2

Crifile

Choose port Fsignment for saved fedure files:
PLTS Format
& PMA Format 1 2 2 1
ADS Format
Choozeé the daréctony and base names for saved files:
Save fiure files to directony: JiaT T Browse.
with a base file name: Fizeture i
Mate: Suffic"1" and "2" will e appended 1o the base file name far the two fidures.

Save Focbwre Files

Select File format to save fixture data:

e Touchstone (*.snp)
e Touchstone 2 (*.ts)
o Citifile (*.cti)
Choose port assignment for save fixture files:
The port assignments are interpreted differently when the file is opened in each program.

Choose which program software you will be using to open the saved file: PLTS, VNA, ADS.
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Choose the directory and base names for the saved files:
Click Browse to navigate to a directory folder.
With a base file name: The resulting filename will appear as follows (assuming a Touchstone
format):
e <base file name>_1.S4P - The left half of a Differential fixture.
e <base file name>_2.S4P - The right half of a Differential fixture.
o <base file name>_1.S2P - The left half of a single-ended fixture.

e <base file name>_2.S2P - The right half of a single-ended fixture.

Click Save Fixture Files to save the files to the specified directory.
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Port Extensions

Port extensions allow you to electrically move the measurement reference plane after you have performed a calibration.

Note: This feature is available in GCA and standard (S-Parameter) channels.

e Why and How to use Port Extensions
e Manual Port Extensions Procedure
e Port Extensions dialog and Toolbar
e Step Size dialog
e Automatic Port Extension dialog
See Also
Data Flow Map
Fixture Compensation features

Phase Accuracy

Comparing the VNA Delay Functions

Other Calibration Topics

Why use Port Extensions

1. You are unable to perform a calibration directly at your device because it is in a test fixture. Perform a
calibration at a convenient place, then use port extensions to compensate for the time delay (phase shift),
and optionally the loss, caused by the fixture.

2. You have already performed a calibration, and then decide that you need to add a length of transmission line
in the measurement configuration. Use port extensions to "tell" the analyzer you have added the length to a
specific port.
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Important Note: Port Extensions and VNA Data Flow
See VNA Data Flow diagram

Normally, Port Extensions are applied to individual S-parameters in the Phase Correction process
and only applies to displayed S-parameters.

However, when Fixturing is ON or when making a Balanced Measurement, Port Extension
compensation is applied in the Apply Error Terms process which affects ALL S-parameters,
whether displayed or not. This allows all underlying S-parameters to have proper extensions
applied.

Therefore, when using Port Extensions with features that require more than a single S-parameter
(such as k-factor in equation editor), do one of the following:

e Enable Fixturing - Individual Fixturing features are NOT required to be enabled.

e Use 8510 Mode Data Processing.

When Port Extension compensation is applied in the Apply Error Terms process, after a Data-to-
Memory operation has been performed, further changes to Port Extensions settings will NOT be
applied to the Memory trace.

How to use Port Extensions

If you know the electrical length of the fixture or additional transmission line, enter the value directly to the
Time setting.

If you know the physical length of the fixture or additional transmission line, enter the value directly to the
Distance setting.

If you do NOT know either the electrical or physical length of the fixture or additional transmission line, you
must be able to connect an OPEN or SHORT to the new reference plane - in place of the DUT. In most
cases, removing the DUT will leave a suitable OPEN at the new reference plane.

Port Extensions can then be added manually (as follows), or by using Automatic Port Extensions.

Manual Port Extensions Procedure

1.

Select a calibrated S11 measurement.

2. Select Phase format.
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3. With an OPEN or SHORT at the calibration reference plane, verify that the phase across the frequency span
is at or near zero.

4. Connect the fixture or added transmission line and attach an OPEN or SHORT in place of the DUT. In most
cases, removing the DUT will leave a suitable OPEN at the new reference plane. On the Port Extension
toolbar or dialog, increase either Time or Distance until the phase response is flat across the frequency span
of interest.

5. If you know the loss of the additional transmission line, enter the Loss Compensation values using either one
or two data points.

Note: Most OPEN and SHORT standards have delay. Therefore, adjusting delay with this method
results in a delay equal to two times the delay of the OPEN or SHORT.

How to set Port Extensions

Using Hardkey/SoftTablSoftkey

1. Press Cal > Port Extension > Port Extensions....

Prugramming Commands= }

Port Extensions dialog and Toolbar help
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Note: This feature is available to GCA and standard (S-Parameter) channels.
Port extensions settings affect all measurements on the active channel that are associated with a particular port.

Learn Why and How to use Port Extensions (scroll up).
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Port Select a port for delay and loss values. Port Extensions settings affect ALL measurements on
the active channel that are associated with a particular port.

Port Extension Turns ON and OFF port extensions on all ports.

Show Toolbar Check to show the Port Extensions toolbar. The toolbar allows you to make
adjustments to the port extensions while showing more of the screen. This is the only way to show
or hide the toolbar.

Delay

Enter delay in either Distance or Time by entering a value or clicking the up/down arrows. Click
|r_"J to start the Step Size dialog.

Time The amount of port extension delay in time. Enter a positive value.
Distance The amount of port extension delay in physical length. Enter a positive value.

Distance Units (Dialog ONLY) Select from Meters, Inches, or Feet. The Step Size setting will
not change automatically. Learn more.

Loss
The following settings allow the entire frequency span to be corrected for loss.

Loss at DC Offsets the entire frequency span by this value. Loss1 or Usel must also be checked.
To compensate for loss at DC, enter a positive value which causes the trace to shift in the positive
(up) direction.

Loss @Frequency Check the box, and enter values for Loss and Frequency
When Loss1 or Loss1/Loss2 are used, a curved-fit algorithm is used as follows:
Loss1 ONLY:

Loss(f) = Lossl * (f/Freql) ~ 0.5
Loss1 and Loss2:

Set the lower frequency to Loss1, and the higher frequency to Loss2.

Loss(f) = Lossl * (f/Freql) “ n

Where:
n = logl0 [abs(Lossl/Loss2)] / loglO0 (Freql/Freq2)

Note: abs = absolute value
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Velocity

Velocity Factor For each port, sets the velocity factor that applies to the medium of the device
that was inserted after the measurement calibration. The value for a polyethylene dielectric cable
1s 0.66 and 0.7 for PTFE dielectric. 1.0 corresponds to the speed of light in a vacuum.

Couple to system Velocity Factor When unchecked, the Velocity Factor is set for only the
specified port and only for Port Extensions. When checked, sets the Velocity Factor for all ports.
In addition, changing this value also changes this setting for the Electrical Delay and Time Domain
Distance Marker features.

Media
For each port, select the media of the added transmission line or fixturing.

Coax Select when the fixture or added transmission line is coax. Also specify the velocity factor
of the coax.

Waveguide / Cutoff Frequency Select when the fixture or added transmission line is
waveguide. Also enter cutoff (minimum) frequency of the waveguide.

Note: when using a Waveguide cal Kit, set System Z0 to 1 ohm before calibrating.

Couple to system Media Definition. When unchecked, the Waveguide Cutoff Frequency is set
for only the specified port and only for Port Extensions. When checked, sets the Waveguide
Cutoff Frequency for all ports. In addition, changing this value also changes this setting for the
Electrical Delay feature.

Reset All port extensions settings are changed to preset values. The Port Extension ON / OFF state
is NOT affected.

Auto Ext. Starts the Automatic Port Extensions dialog box

Note: Individual receiver port extensions (A,B, and so forth) cannot be set.
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Step Size dialog box help

Step Size m

" Auto
& User Defined |5 pm

oK cancel |

Changes the step size that occurs when the Time or Dist up/down arrows are pressed on the Port
Extension toolbar. The Units for step size are changed on the Port Extension dialog.

Auto Step Size is set to the default value.
User Defined Enter a step size value, then click OK.

This value remains the same when the units are changed. For example if a step size of 12 is entered
on this dialog, then you change the units from Inches to Feet, the step size of 12 inches becomes 12
feet, not 1 feet. Therefore, change the units first, then set the step size.

Learn about Port Extensions (scroll up)

Automatic Port Extension dialog box help

x|
b eazure either OPEM, SHORT . or bath. Selected Ports:
Meazure OPEN | beazure SHORT | |1, 2

Hide Configuration % | Flass |
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™ Active Marker —
¢ User Span Stop [E0.000GHz: [

Automatic Port Extension AUTOMATICALLY performs the same operation as Manual Port
Extension. By connecting a SHORT or OPEN, the reference plane is automatically moved to the
point at which the standard is connected. In addition, Automatic Port Extension will optionally
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measure and compensate for the loss of the additional transmission line.

Auto Port Extension is NOT available when:

e Sweep type is set to power sweep
e Frequency Offset is ON

e Media is set to Waveguide
Note: Turn OFF Equations that may exist on the active trace when using Automatic Port Extensions.

Auto Port Extensions Procedure

1. Connect the added transmission line or fixture. Attach an OPEN or SHORT to all affected ports at the
new reference plane. In most cases, removing the DUT will leave a suitable OPEN at the new reference
plane.

2. On the Port Extension toolbar, click Auto Port Ext. Click Show Configuration to make additional
settings.

3. Click Measure to perform the port extension calculations. The resulting delay and loss settings are
entered into the port extension toolbar. These settings are saved with Instrument Save or you can
manually record the values and enter them again when required.

Settings

Measure either OPEN, SHORT, or both Press a button to make the measurement of the
reflection standard.

Measure either OPEN or SHORT depending on which is most convenient. An ideal OPEN and
SHORT, with zero loss and delay, is assumed. Therefore, accuracy is most affected by the quality of
the standard. In most cases, removing the DUT will leave a suitable OPEN at the new reference
plane. When measuring both OPEN and SHORT standards, the average of the two is used and will
slightly improve accuracy.

Selected Ports Indicates the ports that currently have automatic port extension enabled. By default,
ALL analyzer ports are enabled. To disable a port, see Measure on Port Number below.

Note: Port Extensions settings affect ALL measurements on the active channel that are associated
with a particular port.

Show/Hide Configuration Press to either show or hide the following configuration settings in the
dialog box.
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Measure on Port Number
Select port number to enable or disable automatic port extension.

Enable Check to enable the specified port. All enabled ports will have their reference plane
automatically adjusted after performing Automatic Port Extension.

Include Loss Check to automatically measure the loss in the additional transmission line and
apply compensation. To calculate loss compensation, frequencies at 1/4 and 3/4 through the
frequency range are usually used as Freql and Freq2 values. Learn more about Loss Compensation.

Adjust for Mismatch Only available when Include Loss is checked. Mismatch adds ripple to the
S11 and S22 traces. If the ripple is large, S11 and S22 can appear greater than 0 dB which leads to
numeric instabilities in using the S-parameters. Adjust for mismatch increases the loss of the
fixture so that the peak of the ripples is below 0 dB. While this adds more error (all the error is
negative) it does allow the S-parameters to be used in simulators without numerical instabilities.

Check - Offsets the trace to cause all of the data points to be at or below zero.
Clear - Most accurate application of the curve-fit calculation, but allows positive responses.

Prompt for Each Standard Check to invoke a prompt when the Measure OPEN or SHORT
button is pressed. The prompt will indicate which standard to connect to which port.

Method

Select the span of data points which will be used to determine correction values for phase and loss
(optional). If a portion of the current frequency span does not have flat or linear response, you can
eliminate this portion from the calculations by using a reduced User Span.

To calculate loss compensation, Current Span and User Span methods usually use frequencies at 1/4
and 3/4 through the frequency range as Freql and Freq2 values. SeelLoss Compensation to learn more
about how loss is calculated.

Current Span Use the entire frequency span to determine phase and loss values.

Active Marker Use only the frequency at the active marker, and one data point higher in
frequency, to calculate phase and loss values. If a marker is not present, one will be created in the
center of the frequency span.

User Span Use the following User Span settings to determine phase and loss values.
User Span

Start Enter start frequency of the user span.
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Stop Enter stop frequency of the user span.
Learn about Port Extensions (scroll up).

See also Comparing Delay Functions
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Swap Adapters and Offset Delay Calibration Methods

The Swap Adapters or Offset Delay calibration method is used when you do NOT have calibration
standards with the same connector type as your DUT. In this case, the Offset Delay is the preferred
calibration method over the Swap Adapters method.

The Swap Adapters calibration method (also known as Swap Equal Adapters and Equal Length
Adapters) was used in the past as a quick alternative to the more tedious adapter removal method. This
method requires that the adapters be of equal electrical length. There are two adapters for each port.
The swap equal adapter method implicitly assumes the adapters have identical return loss. The finite
return loss of each adapter on each port degrades both the residual directivity and residual match terms.
The offset delay calibration only has one adapter. The return loss of this one adapter will degrade the
residual directivity and residual match error terms.

Note: For any other reason, these calibration methods are NOT recommended because the Unknown
Thru method is more convenient AND more accurate.

The Offset Delay calibration method uses the available standards for calibration then adds offset delay
to the measurement plane to account for each adapter used. This eliminates the need for adapters with
equal electrical length and is preferred over the Swap Adapters method.

Swap Adapters Procedure

The following is an example procedure showing how to perform a Swap Adapters 2-port calibration for
a non-insertable DUT. The DUT has 2.92 mm connectors. You do NOT have 2.92 mm calibration
standards, but you DO have 2.4 mm standards and adapters that have the same electrical delay as the
2.92 mm adapters.

Adapters Al and A2 = test port to 2.4 mm adapters

Adapters B1 and B2 = test port to 2.92 mm adapters
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1. Start the Cal Wizard and select Guided (Smart) Cal. Note: The VNA will NOT prompt you to connect the
adapters by name or when to swap the adapters.

2. Specify the connector type and gender and Cal Kit of the adapter that you will be using (2.4 mm) - NOT
the connector type of the DUT (2.92 mm). By specifying the connector gender, you are also specifying the
Thru method (flush thru for insertable and Unknown Thru for non-insertable.) For example, when both
DUT ports have female connectors, we will perform an Unknown Thru cal.

3. When prompted for reflection standards on port 1, connect Port 1 PNA Port 2
the Open, Short, and Load standards to Adapter A1.

4. When prompted for reflection standards on port 2, connect
the Open, Short, and Load standards to Adapter A2. ' '

5. When prompted for a Thru connection, swap Adapter A1
and A2 for B1 and B2. Connect the Thru device. This
could be any device that meets the requirements of the
Unknown Thru standard. In the case of a non-insertable
DUT, connect B1 and B2.

6. Make DUT measurements with Adapters B1 and B2 in
place.

Offset Delay Procedure

The following is an example procedure showing how to perform a 2-port calibration for a non-
insertable DUT using Offset Delay to account for the added delay of two adapters. The DUT has 2.92
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mm connectors. You do NOT have 2.92 mm calibration standards, but you DO have 2.4 mm standards
and adapters.

Adapters = test port to 2.4 mm (female)-to-2.92 mm (male) adapters

1. Start the Cal Wizard and select Guided (Smart) Cal.

2. Specify the connector type and gender and Cal Kit that you will be using (2.4 mm) - NOT the connector
type of the DUT (2.92 mm). By specifying the connector gender, you are also specifying the Thru method
(flush thru for insertable and Unknown Thru for non-insertable.) For example, when both DUT ports have
female connectors, we will perform an Unknown Thru cal.

3. When prompted for reflection Port 1 Port 2
standards on port 1, connect the
Open, Short, and Load standards.

4. When prompted for reflection ' l '
standards on port 2, connect the
Open, Short, and Load standards.

5. When prompted for a Thru connection,
connect the Thru device between port
1 and port 2. This could be any device
that meets the requirements of the
Unknown Thru standard. In this
example of a non-insertable DUT, a
female-to-female 2.4 mm barrel
adapter is used as the Thru device.

6. Click on Response, Cal, then select
Port Extension. The Port Extension

dialog is used to electrically move the [ e baemicrs ]
measurement reference plane after Pol = Port Extansions ON Shorer Tesclbar
you have performed a calibration to Deley Loss
account for the two adapters. Learn | D 0000000 g ) el Loss 5t DC  0.000000 22
more about Port Extensions. Thua D00OCCEpe Dbl Leas! 0 i @Freql 1,000 GHe
7. Select Port 1 and enter the delay of Cimcn Lnis | o Rl @feqZ 1000 Gz
the adapter connected to Port 1. Velocity Media
Wolonity Factor 1000000000 ! * Coax

= g Port Catalf Frog 45,000 MHz

# Couple to system Vielooity Facior n -

8. Select Port 2 and enter the delay of B e e

Rasst At Port v O el Halp

the adapter connected to Port 2.

9. Click OK.
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10. Make DUT measurements with
Adapters and DUT in place.

PNA
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Calibration Overview

The following is discussed in this topic:

What Is Measurement Calibration?

Why Is Calibration Necessary?

Conditions Where Calibration Is Suggested

What Is ECal?

See other Calibration Topics

What Is Measurement Calibration?

Calibration removes one or more of the systematic errors using an equation called an error model.
Measurement of high quality standards (for example, a short, open, load, and thru) allows the analyzer
to solve for the error terms in the error model. See Measurement Errors.

You can choose from different calibration types, depending on the measurement you are making and
the level of accuracy you need for the measurement. See Select a Calibration Type.

The accuracy of the calibrated measurements is dependent on the quality of the standards in the
calibration kit and how accurately the standards are modeled (defined) in the calibration kit definition
file. The calibration-kit definition file is stored in the analyzer. In order to make accurate
measurements, the calibration-kit definition must match the actual calibration kit used. To learn more,
see Accurate Calibrations.

Calibration Wizard provides the different calibration methods used in the VNA. See Calibration Wizard.

There are quick checks you can do to ensure your measurement calibration is accurate. To learn more
see Validity of a Measurement Calibration

If you make your own custom-built calibration standards (for example, during in-fixture
measurements), then you must characterize the calibration standards and enter the definitions into a
user modified calibration-kit file. For more information on modifying calibration kit files, see
Calibration Standards.

Note: Instrument Calibration is ensuring the analyzer hardware is performing as specified. This is not the
same as measurement calibration.
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Why Is Calibration Necessary?

It is impossible to make perfect hardware that would not need any form oferror correction. Even
making the hardware good enough to eliminate the need for error correction for most devices would be
extremely expensive.

The accuracy of network analysis is greatly influenced by factors external to the network analyzer.
Components of the measurement setup, such as interconnecting cables and adapters, introduce
variations in magnitude and phase that can mask the actual response of the device under test.

The best balance is to make the hardware as good as practically possible, balancing performance and
cost. Calibration is then a very useful tool to improve measurement accuracy.

Conditions Where Calibration Is Suggested

Generally, you should calibrate for making a measurement under the following circumstances:

You want the best accuracy possible.

You are adapting to a different connector type or impedance.

You are connecting a cable between the test device and an analyzer test port.

You are measuring across a wide frequency span or an electrically long device.

You are connecting an attenuator or other such device on the input or output of the test device.

If your test setup meets any of the conditions above, the following system characteristics may be
affected:

Amplitude at device input

e Frequency response accuracy
e Directivity

e Crosstalk (isolation)

e Source match

e Load match

What Is ECAL

ECal is a complete solid-state calibration solution. It makes one port (Reflection), full two and three-
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port calibrations fast and easy. See Using ECal.

e ltis less prone to operator error.

e The various standards (located inside the calibration module) never wear out because they are switched with
PIN-diode or FET switches.

e The calibration modules are characterized using a TRL-calibrated network analyzer.
e ECalis not as accurate as a good TRL calibration.

For information about ordering ECal modules, see Analyzer Accessories or contact your Keysight Support
Representative
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Measurement Errors

You can improve accuracy by knowing how errors occur and how to correct for them. This topic
discusses the sources of measurement error and how to monitor error terms.
e Drift Errors
e Random Errors
e Systematic Errors
e 3-Port Error Terms

e 4-Port Error Terms

e Monitoring Error Terms

See other Calibration Topics

Drift Errors

Drift errors are due to the instrument or test-system performance changing after a calibration has been
done.

Drift errors are primarily caused by thermal expansion characteristics of interconnecting cables within
the test set and conversion stability of the microwave frequency converter and can be removed by re-
calibrating.

The time frame over which a calibration remains accurate is dependent on the rate of drift that the test
system undergoes in your test environment.

Providing a stable ambient temperature usually minimizes drift. For more information, see Measurement
Stability.
Random Errors

Random errors are not predictable and cannot be removed through error correction. However,
there are things that can be done to minimize their impact on measurement accuracy. The
following explains the three main sources of random errors.

Instrument Noise Errors
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Noise is unwanted electrical disturbances generated in the components of the analyzer.
These disturbances include:
e Low level noise due to the broadband noise floor of the receiver.

¢ High level noise or jitter of the trace data due to the noise floor and the phase noise of the LO source inside
the test set.

You can reduce noise errors by doing one or more of the following:

¢ Increase the source power to the device being measured - ONLY reduces low-level noise.
e Narrow the IF bandwidth.

e Apply several measurement sweep averages.

Switch Repeatability Errors
Mechanical RF switches are used in the analyzer to switch the source attenuator settings.

Sometimes when mechanical RF switches are activated, the contacts close differently from when they
were previously activated. When this occurs, it can adversely affect the accuracy of a measurement.

You can reduce the effects of switch repeatability errors by avoiding switching attenuator settings
during a critical measurement.

Connector Repeatability Errors

Connector wear causes changes in electrical performance. You can reduce connector
repeatability errors by practicing good connector care methods. See Connector Care.
Systematic Errors

Systematic errors are caused by imperfections in the analyzer and test setup.

e They are repeatable (and therefore predictable), and are assumed to be time invariant.
e They can be characterized during the calibration process and mathematically reduced during measurements.

e They are never completely removed. There are always some residual errors due to limitations in the
calibration process. The residual (after measurement calibration) systematic errors result from:

o imperfections in the calibration standards

o connector interface
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O interconnecting cables

O instrumentation

Reflection measurements generate the following three systematic errors:

e Directivity
e Source Match

e Frequency Response Reflection Tracking

Transmission measurements generate the following three systematic errors:

e |solation
e Load Match

e Frequency Response Transmission Tracking

Notes about the following Systematic Error descriptions:

e The figures for the following six systematic errors show the relevant hardware configured for a forward
measurement. For reverse measurements, internal switching in the analyzer makes Port 2 the source and
Port 1 the receiver. 'A' becomes the transmitted receiver, 'B' becomes the reflected receiver, and 'R2'
becomes the reference receiver. These six systematic errors, times two directions, results in 12 systematic
errors for a two port device.

e For simplicity, it may be stated that ONE standard is used to determine each systematic error. In reality, ALL
standards are used to determine ALL of the systematic errors.

e The following describes an SOLT calibration. This does not apply to TRL or other types of calibration.

Directivity Error
All network analyzers make reflection measurements using directional couplers or bridges.

With an ideal coupler, only the reflected signal from the DUT appears at the 'A' receiver. In reality, a
small amount of incident signal leaks through the forward path of the coupler and into the 'A' receiver.
This leakage path, and any other path that allows energy to arrive at the 'A' receiver without reflecting
off the DUT, contributes to directivity error.
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Legend
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How the Analyzer Measures and Reduces Directivity Error.

1. During calibration, a load standard is connected to Port 1. We assume no reflections from the load.

2. The signal measured at the 'A’ receiver results from the incident signal leakage through the coupler and other
paths.

3. Directivity error is mathematically removed from subsequent reflection measurements.
Isolation Error
Ideally, only signal transmitted through the DUT is measured at the 'B' receiver.
In reality, a small amount of signal leaks into the 'B' receiver through various paths in the analyzer.

The signal leakage, also known as crosstalk, is isolation error which can be characterized and reduced by
the analyzer.

Legend
_ Faort1 -1 DUT {2 Port2
Ineid e nt m— i b
Leakage = CH
Loads |
@h“ -
Source
]
v
(R} Y] R eceiver Channels (B)

witda

How the Analyzer Measures and Reduces Isolation Error
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1. During calibration, load standards are connected to both Port 1 and Port 2.
2. The signal measured at the 'B' receiver is leakage through various paths in the analyzer.

3. This isolation error is mathematically removed from subsequent transmission measurements.

Source Match Error

Ideally in reflection measurements, all of the signal that is reflected off of the DUT is measured at the
'A' receiver.

In reality, some of the signal reflects off the DUT, and multiple internal reflections occur between the
analyzer and the DUT. These reflections combine with the incident signal and are measured at the 'A’
receiver, but not at the 'R' receiver.

This measurement error is called source match error which can be characterized and reduced by the
analyzer.

Legend
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How the Analyzer Measures and Reduces Source Match Error

1. During calibration, all reflection standards are connected to Port 1. Known reflections from the standards are
measured at the 'A’ receiver.

2. Complex math is used to calculate source match error.

3. Source match error is mathematically removed from subsequent reflection and transmission measurements.

Load Match Error

Ideally in transmission measurements, an incident signal is transmitted through the DUT and is
measured at the 'B' receiver.

In reality, some of the signal is reflected off of Port 2 and other components and is not measured at the
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'B' receiver.

This measurement error is called load match error which can be characterized and reduced by the
analyzer.

Legend
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How the Analyzer Measures and Reduces Load Match Error

1. The Port 1 and Port 2 test connectors are mated together for a perfect zero-length thru connection. If this is
not possible, a characterized thru adapter is inserted. This allows a known amount of incident signal at Port
2.

2. The signal measured at the 'A' receiver is reflection signal off of Port 2

3. The resulting load match error is mathematically removed from subsequent transmission and reflection
measurements.

Frequency Response Reflection Tracking Error

Reflection measurements are made by comparing signal at the 'A' receiver to signal at the 'R1' receiver. This is called a ratio
measurement or "A over R1" (A/R1).

For ideal reflection measurements, the frequency response of the 'A' and 'R1' receivers would be identical.

In reality, they are not, causing a frequency response reflection tracking error. This is the vector sum of all test variations in
which magnitude and phase change as a function of frequency. This includes variations contributed by:

e signal-separation devices
e test cables
e adapters

e variations between the reference and test signal paths
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Frequency response reflection tracking error can be characterized and reduced by the analyzer.
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How the Analyzer Measures and Reduces Frequency Response Reflection Tracking Error.

1. During calibration, all reflection standards are used to determine reflection tracking.
2. The average 'A' receiver response is compared with the 'R1' receiver response.

3. Complex math is used to calculate Frequency Response Reflection Tracking Error (see the following
diagram). This frequency response reflection tracking error is mathematically removed from subsequent DUT
measurements.

Legend
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Note: In reflection response calibrations, only a single calibration standard is measured (open or short)
and thus only its contribution to the error correction is used.

Frequency Response Transmission Tracking Error

Transmission measurements are made by comparing signal at the 'B' receiver to signal at the 'R1'
receiver. This is called a ratio measurement or "B over R1" (B/R1).

For ideal transmission measurements, the frequency response of the 'B' and 'R1' receivers would be
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identical.

In reality, they are not, causing a frequency response transmission tracking error. This is the vector sum
of all test variations in which magnitude and phase change as a function of frequency. This includes
variations contributed by:

o signal-separation devices

o test cables

O adapters

o variations between the reference and test signal paths

Frequency response transmission tracking error can be characterized and reduced by the analyzer.
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How the Analyzer Measures and Reduces Frequency Response Transmission Tracking Error.

1. During calibration, the Port 1 and Port 2 test connectors are mated together for a perfect zero-length thru
connection. If this is not possible, a characterized thru adapter is inserted. This allows a known amount of
incident signal to reach Port 2.

2. Measurements are made at the 'B' and 'R1' receivers.
3. Complex math is used to calculate Frequency Response Transmission Tracking Error (see the following

diagram). This frequency response transmission tracking error is mathematically removed from subsequent
DUT measurements.
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3-Port Error Terms

The following flow diagram displays the 3-port error term model:

PORT 1 DEVICE PORT 2
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where:
E = error term
DIR = Directivity
MAT = Forward Source Match and Reverse Load Match

TRK = Forward Reflection Tracking and Reverse Transmission Tracking

4-Port error terms
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A full 4-port calibration requires the following terms:

Learn about the port numbering convention for error terms.

Source Port
1 2 3 4
DIR LDM 1,2 LDM 1,3 LDM
1,1 1,4
TTRK 1,2 TTRK 1,3
RTRK TTRK
1 L1 XTLK 1,2 XTLK 1,3 1.4
SRM XTLK
1,1 1,4
LDM DIR 2,2 LDM 2,3 LDM
R 2,1 2.4
RTRK 2,2 TTRK 2,3
e|, | TTRK TTRK
2.1 SRM 2,2 XTLK 2,3 24
(¢
XTLK XTLK
2,1 2.4
P LDM LDM 3,2 DIR 3,3 LDM
3,1 3,4
o TTRK 3,2 RTRK 3,3
5 | TTRK TTRK
r 3.1 XTLK 3,2 SRM 3,3 34
t XTLK XTLK
3,1 3,4
LDM LDM 4,2 LDM 4,3 DIR
4,1 4.4
TTRK 4,2 TTRK 4,3
4 | TTRK RTRK
4.1 XTLK 4,2 XTLK 4,3 44
XTLK SRM
4,1 4.4

Reflection terms

e DIR: Directivity
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o RTRK: Reflection Tracking

e SRM: Source Match

Transmission terms

e LDM:Load Match

e TTRK: Transmission Tracking

e XTLK: Cross Talk

How can we measure only 3 THRU connections?

On a 4-port VNA, a full 4-port cal can be performed while measuring only 3 THRU connections.
Measuring more than 3 THRU connections on a VNA with four native ports can give higher accuracy

under some conditions.

By measuring all of the reflection terms, and 3 transmission THRU connections, there is adequate
information available to calculate the remaining transmission terms. The following is a high level
explanation of the concept. The actual calculations are much more complex.

To simplify, let's substitute letters (A,B,C,D) for port numbers from the diagram above so that they can
be combined without confusion. Also for simplicity, let's assume that the source match and directivity

€rrors arc zZE€ro.

A B C D
Al AA| AB| AC | AD
B I'BA | BB | BC | BD
CJCA|CB|CC]|CD
D DA | DB | DC | DD

e The reflection errors are all measured (AA, BB, CC, DD).

e Lets assume we measure a THRU between ports AB, AC, AD. The reverse direction for these THRUs are
also measured at the same time (BA, CA, DA).

e The terms left to calculate are BC, CB, BD, DB, CD, DC.

The following shows how the BC term is calculated from BA and AC:

Ba Y AL

B " oel, "

P

= B':
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Similarly:

e CB is calculated from CA and AB
e BD is calculated from BA and AD
e DB is calculated from AB and DA
e CD is calculated from CA and AD
e DC is calculated from DA and AC

Monitoring Error Terms using Cal Set Viewer

You can use Cal Set Viewer to monitor the measured data and the calculated error term. This will help
to determine the health of your VNA and the accuracy of your measurements.

By printing or saving the error terms, you can periodically compare current error terms with previously
recorded error terms that have been generated by the same VNA, measurement setup, and calibration
kit. If previously generated values are not available, refer to Typical Error Term Data in Appendix A,
"Error Terms", of the Service Guide.

Note: The service guide for your VNA is available at http://www.Keysight.com/find/pna

e A stable system should generate repeatable error terms over about six months.
e A sudden shift in error terms over the same frequency range, power, and receiver settings, may indicate the
need for troubleshooting system components. For information on troubleshooting error terms, see Appendix

A, "Error Terms", of the Service Guide.

e A subtle, long-term shift in error terms often reflects drift or connector and cable wear. The cure is often as
simple as cleaning and gauging connectors or inspecting cables.

Viewing Cal Set Data

e Existing measurement traces are unaffected by the Cal Set Viewer.
e The Cal Set data trace is presented in the highest unused channel number (usually 32) in the active window.
e The Cal Set data trace is labeled as S11 in the status bar regardless of the type of error term or standard.

e Only one Cal Set error term or standard data can be viewed at a time. However, a data trace can be stored
into memory and then compared to other data traces.

See the error terms equations.

How to access Cal Set Viewer
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Using Hardkey/SoftTablSoftkey

1. Press Cal > Cal Sets & Cal Kits > Cal Set Viewer ON|OFF

Prugramming Commands= }

How to use Cal Set Viewer

Cal et Dipiay. 7 Emot Teme: % Stadack
Jease 101 =l [FaizPm oL a5z =] P Endh

1. Use the down arrow to select a Cal Set. Then click either:

e Error Terms - calculated data.
e Standards - the raw measurement data of the Standard. ONLY available with Unguided Cal (not
ECal or Guided Cal).
2. Use the down arrow to select an error term or standard to view.

3. Select the Enable check box to view the data on the VNA screen.

Port numbering convention for error terms is the same as for S-Parameters:

E Term (Receiver, Source) with the following exceptions:

Load Match (2,1) - The match of port 2 which is measured by making an S11 measurement.

Load Match (1,2) - The match of port 1 which is measured by making an S22 measurement.

Transmission Tracking (2,1) - The port 2 receiver relative to the port 1 reference. (source=port 1).

Transmission Tracking (1,2) - The port 1 receiver relative to the port 2 reference. (source=port 2).

e And so forth for multiport calibrations.

E5080B has the receiver gain setting capability. Each port has high/low setting and each setting has
independent error term.

E Term (Receiver, Source) [reciever gain, source gain] (high:1, low:0 for
gain) with the following exceptions:

e Transmission Tracking (2,1) - The port 2 receiver relative to the port 1 reference with low gain for both 1
and port. (source=port 1)
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e Transmission Tracking (2,1) [1,0] - The port 2 receiver relative to the port 1 reference with high gain for
port 2, low gain for port 1. (source=port 1)

e Transmission Tracking (2,1) [0,1] - The port 2 receiver relative to the port 1 reference with low gain for
port 2, high gain for port 1. (source=port 1)

e Transmission Tracking (2,1) [1,1] - The port 2 receiver relative to the port 1 reference with high gain for
both 1 and port. (source=port 1)
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Accurate Measurement Calibrations

Calibration accuracy is affected by the type of calibration, quality of the calibration standards, and the
care with which the calibration is performed. This section provides additional information about how to
make accurate calibrations.

Measurement Reference Plane

¢ Effects of Using Wrong Calibration Standards
e Data-based versus Polynomial Calibration Kits
e Accuracy Level of Interpolated Measurement
o Effects of Power Level

e Using Port Extensions

e |solation Portion of 2-Port Calibration

Choosing a Thru Method

Learn how to determine the validity of your calibration.

See other Calibration Topics

Measurement Reference Plane

Most measurement setups will NOT allow you to connect a device under test (DUT) directly to the
analyzer front panel test ports. More likely, you would connect your device to test fixtures, adapters, or
cables that are connected to the analyzer.

A calibration takes place at the points where calibration standards are connected during the calibration
process. This is called the measurement reference plane (see graphic). For the highest measurement
accuracy, make the calibration reference plane the place where your DUT is connected. When this
occurs, the errors associated with the test setup (cables, test fixtures, and adapters used between the
analyzer ports and the reference plane) are measured and removed in the calibration process.
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Effects of Using Wrong Calibration Standards

Normally, a calibration is performed using a calibration kit that contains standards with connectors of
the same type and sex as your DUT.

However, your calibration kit may not always have the same connector type and gender as your device.
For example, suppose your device has 3.5mm connectors, but you have a Type-N calibration kit. If you
use an adapter to connect the Type-N standards to the 3.5mm test port, then the adapter becomes part of
the calibration and NOT part of the test setup. This will result in significant errors in your reflection
measurements.

Data-based versus Polynomial Calibration Kits

The Select DUT Connectors and Cal Kits dialog box offers a data-based model and a polynomial model for
the newest high-frequency cal kits. See Analyzer Accessories. The data-based models provide higher
accuracy for describing calibration standards than the polynomial models. It is RECOMMENDED that
the data-based model be used if the most accurate results are desired.

Data-Based Model Polynomial Model
How accurate is the model? Provides highest calibration Provides high calibration
accuracy. Eliminates the errors | accuracy.
that can be the result of
polynomial model
approximations.
How does the model define Uses S-Parameter Uses traditional four-term
calibration standards? measurements. polynomial calibration

standard modeling parameters.
How do I manually edit the Use the Advanced Modify Cal Kit | Use the Advanced Modify Cal Kit
definitions of the calibration | function. function.

standards when using the
model?
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How do I use the Calibration | Use only the SmartCal Use the SmartCal (Guided) or
Wizard with the model? (Guided) Calibration method. the Unguided Mechanical
Calibration methods.

Learn about the “Expanded Math” feature.

Effects of Power Level

To attain the most accurate error correction, do NOT change the power level after a calibration is
performed. However, when changing power within the same attenuator range at which the
measurement calibration was performed, S-parameter measurements can be made with only a small
degradation of accuracy. If a different attenuator range is selected, the accuracy of error correction is
further degraded.

To check the accuracy of a calibration, see Validity of a Calibration.

Using Port Extensions

Use the port extensions feature after calibration to compensate for phase shift of an extended
measurement reference plane due to additions such as cables, adapters, or fixtures.

Port extensions is the simplest method to compensate for phase shift, mismatch, and loss of the path between the calibration
reference plane and the DUT.

Learn how to apply port extensions.

Learn about characterizing a test fixture.

Isolation Portion of 2-Port Calibration

The isolation portion of a calibration corrects for crosstalk, the signal leakage between test ports when
no device is present. When performing an UNGUIDED 2-port calibration, you have the option of
omitting the isolation portion of the calibration.

Note: Isolation can be performed on a Smart (Guided) Calibration ONLY

Note: Isolation is supported only when the receiver gain are set at LOW for both ports.

The uncorrected isolation between the test ports of the analyzer is exceptional (typically >100 dB).
Therefore, you should only perform the Isolation portion of a 2-port calibration when you require
isolation that is better than 100 dB. Perform an isolation calibration when you are testing a device with
high insertion loss, such as some filter stopbands or a switch in the open position.
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The isolation calibration can add noise to the error model when the measurement is very close to the
noise floor of the analyzer. To improve measurement accuracy, set a narrow IF Bandwidth.

How to perform an Isolation Calibration

Isolation is measured when the Load standards are connected to the analyzer test ports. For best
accuracy, connect Load standards to BOTH test ports each time you are prompted to connect a load
standard. If two Loads are not available, connect the untested analyzer port to any device that will
present a good match.

Important Notes:

1. For best results, the average factor should be increased while measuring the isolation standards. Doing an
isolation without increasing averaging you are generally adding noise to the measurement rather than
correcting for isolation. This PNA automatically increases the average factor by 8 during the isolation steps of
a calibration to minimize the noise degradation that would otherwise be present.

2. SmartCal did not add the ability to do an isolation calibration from the GUI because it is usually only needed
in special cases. The isolation calibration can be done using the following commands:

o0 SENSe<ch>:CORRection:COLLect:GUIDed:ISOLation:AVERage:INCRement or
IsolationAveraginglncrement

o SENSe<ch>:CORRection:COLLect:GUIDed:ISOLation:PATHs or GetlsolationPaths and
SetlsolationPaths

3. Doing an isolation calibration is generally only useful when crosstalk is an issue-this may happen if the
fixture added contributes significant crosstalk.
Choosing a Thru Method

When calibrating for a non-insertable device, you must choose a method to calibrate for the THRU

error terms. This can have a significant effect on measurement accuracy. Learn more aboutchoosing a
thru method.
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Validity of a Calibration

This section helps you determine if your calibration is valid and how the analyzer displays correction
level information for your measurement.

e Frequency Response of Calibration Standards

e Validating a Calibration

e Quick Check

e ECal Confidence Check

e Determining Effects of Not Terminating Unused ECal Ports

e Verification Kit

See other Calibration Topics

Frequency Response of Calibration Standards

In order for the response of a calibration standard to show as a dot on the smith chart display format, it
must have no phase delay with respect to frequency. The only standards that exhibit such "perfect"
response are the following:

e 7-mm short (with no offset)

e Type-N male short (with no offset)

There are two reasons why other types of calibration standards show phase delay after calibration:

1. The reference plane of the standard is electrically offset from the mating plane of the test port. Such
devices exhibit the properties of a small length of transmission line, including a certain amount of phase
shift.

2. The standard is an open termination, which by definition exhibits a certain amount of fringe capacitance
and therefore phase shift. Open terminations which are offset from the mating plane will exhibit a phase
shift due to the offset in addition to the phase shift caused by the fringe capacitance.

The most important point to remember is that all standards are measured in order to remove
systematic errors from subsequent device measurements. As a result, if calibration standards with
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delay and fringe capacitance are measured as a device after a calibration, they will NOT appear to
be "perfect". This is an indication that your analyzer is calibrated accurately and working

properly.

Validating a Calibration

At the completion of a calibration or selection of a stored Cal Set, validation can accomplish the
following:

Improve Measurement Accuracy — Once a measurement calibration has been performed, its
performance should be checked before making device measurements. There are several sources of error
that can invalidate a calibration: bad cables, dirty or worn calibration standards that no longer behave
like the modeled standards, and operator error.

Verify Accuracy of Interpolation — You should validate the calibration if you are testing a device and
the measurements are uncertain because of interpolation. For more information see Interpolation
Accuracy.

Verify Accuracy of Cal Standards — To check accuracy, a device with a known magnitude and phase
response should be measured.

Quick Check

For this test, all you need are a few calibration standards. The device used should not be one of the
calibration standards; a measurement of one of these standards is merely a measure of repeatability.

The following reflection and transmission Quick Check tests can be applied to all test ports.

To verify reflection measurements, perform the following steps:

1. Connect either an OPEN or SHORT standard to port 1. The magnitude of S11 should be close to 0 dB (within
a few tenths of a dB).

2. Connect a load calibration standard to port 1. The magnitude of S11 should be less than the specified
calibrated directivity of the analyzer (typically less than -30 dB).

To verify transmission measurements:

1. Connect a THRU cable (or known device representative of your measurement) from port 1 to port 2. Verify
the loss characteristics are equivalent to the known performance of the cable or device.

2. To verify S21 isolation, connect two loads: one on port 1 and one on port 2. Measure the magnitude of S21
and verify that it is less than the specified isolation (typically less than -80 dB).
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Note: To get a more accurate range of expected values for these measurements, consult the analyzer's
specifications.

ECal Confidence Check

ECal Confidence Check is a method to check the accuracy of a calibration performed with mechanical
standards or an ECal module. The confidence check allows you to measure an impedance state in the
ECal module (called the confidence state), and compare it with factory measured data stored in the
module.

In order for this test to be valid, the test ports of the ECal module must connect directly to the
calibration reference plane (without adapters).

Note: In the N469x series of 2-port ECal modules, from the module minimum frequency up to
approximately 2 GHz, the confidence state has a very high amount of transmission loss. In this
frequency range, calibrated measurements of transmission S-parameters for the confidence state may
vary much more than expected from the Keysight-characterized data in the measurement memory trace.
When comparing the measurement trace and memory trace you, ignore the data for frequencies up to 2
GHz.

How to Perform ECal Confidence Check:

1. Connect ECal module to the analyzer with the USB cable. See Connect ECal Module to the VNA. Note:
Terminate any unused ECAL ports with a 50 ohm load. See below.

2. Allow the module to warm up for 15 minutes or until the module indicates READY.

3. Do one of the following to start ECal Confidence Check
Using Hardkey/SoftTablSoftkey

1. Press Cal > Cal Sets & Cal Kits > ECal > ECal Confidence Check....

Prugramming Commands= }

On the following ECal Confidence Check dialog box:
2. Click Read Module Data. The following occurs:

e ECal module is set to "confidence state".
e Analyzer reads and displays stored data.

e Analyzer measures and displays "confidence state".
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. To view a different parameter, select Change Measurement and select the check box for the desired

parameter. The default is the active channel parameter.
Select the viewing option in the Trace View Options block.

Compare the stored and measured data for each measurement parameter.

Notes:

¢ After exiting ECal Confidence Check, the ECal module remains in the same impedance state and the

factory (or user-characterized) data is still stored in the memory trace. Therefore, you can save both the
data and memory trace as a *.csv files and import them to a spreadsheet. Learn how.

If the two traces show excessive difference, there may be a loose or dirty connection at the test ports or
damage to the test cables. Carefully inspect the cables and connections. Then clean and gage each
connector, and re-calibrate if needed.

The User Characterization setting selects the user-characterization data instead of the factory
characterization data (available when a User-Characterization is stored in the ECal module).

Determining Effects of Not Terminating Unused ECal Ports

The following procedure can be used to determine the calibration errors when unused ECal ports are
not terminated.

1.

Connect the ECal module to one VNA test port through an adapter (eliminates the possibility of cable
movement errors being included) and leave the unconnected port(s) open.

Perform a 1-port cal (use 100 Hz IFBW) then save the calset.
Connect a load(s) to the unconnected port(s) of the ECal module.
Perform a 1-port cal then save the calset.

Compare the calset in step 2 with the calset in step 4 using Calset Viewer to evaluate the effect of leaving
the unused ECal ports open.

ECal Confidence Check dialog box help
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ECal Confidence Check E =]

Begin by Selecting Measurement. Then Use ECal Module.

—Measurement—————— — Use ECal Module

iChange Measurement§| Read Module D ata

511 |
[ Uzer Characterization

= race Wiew Dptions

£ Data and Memorny Crale ¥ Show Prompts
€ Data / Memony
1 Diata - femony Ok | Cancel | Help |

Compares the accuracy of corrected (calibrated) data with stored data in the ECal module. For the
check to be valid, the module test ports must connect directly to the calibration reference plane
(without an adapter). Learn more about ECal Confidence Check.

Measurement

Change Measurement Opens the Measure dialog box.

Use ECal Module

Read Module Data

e Copies stored data from the ECal module to Memory.

e Changes state of ECal module to confidence state.

e Measures and displays confidence state and Memory trace.

o Displays the factory and user characterizations data stored in the ECal module. Learn more.
Scale Opens the Scale dialog box.
Show Prompts Check to show a reminder for the connection (default).

Trace View Options
Data and Memory Trace Displays current measurement data and Memory trace.

Data / Memory Performs an operation where the current measurement data is divided by the
data in memory.
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Data + Memory Performs an operation where the current measurement data is added to the data
in memory.

Verification Kit

Measuring known devices, other than calibration standards, is a straightforward way of verifying that
the network analyzer system is operating properly. Verification kits use accurately known verification
standards with well-defined magnitude and phase response. These kits include precision airlines,
mismatch airlines, and precision fixed attenuators. Traceable measurement data is shipped with each kit
on disk and verification kits may be re-certified by Keysight.

See Analyzer Accessories for a list of Keysight verification kits.
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Calibration Standards

This following section explains the general principles and terms regarding calibration kit files. To learn
how to modify calibration kit files, See Modify Calibration Kits.

About Calibration Kits

Calibration Standards

Standard Type

Standard Definitions

Class Assignments

See other Calibration Topics

About Calibration Kits

A calibration kit contains a set of physical devices called standards. Each standard has a precisely
known or predictable magnitude and phase response as a function of frequency. All Keysight Cal Kits
and their standard definitions are stored in the analyzer. For a list of Keysight calibration kits, see
Analyzer Accessories.

Calibration Standards

Calibration standards provide the reference for error-corrected measurements in the network analyzer.
Each standard has a precisely known definition that includes electrical delay, impedance, and loss. The
analyzer stores these definitions and uses them to calculate error correction terms.

During measurement calibration, the analyzer measures standards and mathematically compares the
results with the definitions ("ideal models") of those standards. The differences are separated into error
terms that are later removed from device measurements during error correction. See Systematic Errors.

Standard Type

A standard type is one of four basic types that define the form or structure of the model to be used with
that standard. The following are the four basic standard types:

506



Standard Terminal Impedance

SHORT zero ohms

OPEN infinite ohms

LOAD system impedance, Z0
THRU/LINE no terminal impedance

Learn about other Calibration Standards:

Data-Based Standard

Sliding Load

Offset Load

Arbitrary Impedance Load

Standard Definitions

Standard definitions describe the electrical characteristics of the standards and the frequencies they will
be used. Standard definitions can be viewed from the Advanced Modify Cal Kit menu selection. Standard
definitions include:

Minimum Frequency Specifies the minimum frequency the standard is used for calibration.

Maximum Frequency Specifies the maximum frequency the standard is used for calibration.

Z0 Specifies the characteristic impedance of the standard (not the system characteristic impedance or the
terminal impedance of the standard).

Delay Specifies a uniform length of transmission line between the standard being defined and the actual
calibration plane.

Type Specifies type of standard (SHORT, OPEN, THRU/LINE, LOAD, ARBITRARY).
e Loss Specifies energy loss, due to skin effect, along a one-way length of coaxial cable.

Loss model equation:

m The value of loss is entered as ohms/second at 1 GHz.

m To compute the loss of the standard, measure the delay in seconds and the loss in dB at 1 GHz. Then use
the following formula:
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loss (o) _r_n(":u
Lnss[ ]
4 3429008 x delay(s)

Capacitance model equation:

Co0, C1, C2, C3. Specifies the fringing capacitance for the open standard.

m C=(C0)+(C1xF)+(C2xF?)+(C3xF?
m (F is the measurement frequency).
m The terms in the equation are defined when specifying the open as follows:
m CO term is the constant term of the third-order polynomial and is expressed in Farads.
m C1termis expressed in F/Hz (Farads/Hz).
m C2termis expressed in F/HzZ2
m C3termis expressed in F/HZ.

Inductance model equation:

L0, L1, L2, L3. Specifies the residual inductance for the short standard.

m L=(LO)+ (L1xF)+(L2xF?) + (L3 xF?)

m (F is the measurement frequency).

m The terms in the equation are defined when specifying the short as follows:
m LO term is the constant term of the third-order polynomial and is expressed in Henries.
m L1 termis expressed in H/Hz (Henries/Hz)
m L2 termis expressed in H/Hz2.

m L3 termis expressed in H/HZ3.

Class Assignments

Once a standard is characterized, it must be assigned to a standard "class". A standard class is a group
of standards that are organized according to the calibration of the network analyzer error model.

The number of classes needed for a particular calibration type is equal to the number of error terms
being corrected.
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A class often consists of a single standard, but may be composed of multiple standards. These may be
required for accuracy or to cover a wide frequency range.

Example: A response calibration requires only one class, and the standards for that class may include
an OPEN, or SHORT, or THRU. A 1-port calibration requires three classes. A 2-port calibration
requires 10 classes, not including two for isolation.

The number of standards assigned to a given class may vary from one to seven for unguided
calibrations. Guided calibrations allow as many standards as needed.

Calibration Classes are assigned in the Advanced Modify Cal Kit menu, SOLT or TRL tab.

The different classes used in the analyzer
S11A, S11B, S11C (S22A, S22B, S22C and so forth)

These are the three classes for port 1-reflection calibrations (three classes also for S22 and S33). They
are used in the one-port calibrations and the full two-port calibration. They are required in removing the
directivity, source match, and reflection tracking errors. Typically, these classes might consist of an
open, a short and a load standard for each port.

Transmission and Match (forward and reverse)

These classes are used to perform a full two-port calibration. The transmission class relates primarily
to the transmission tracking, while the match class refers to load match. For both of these classes, the
typical standard is a thru or delay.

Isolation

The isolation classes are used to perform a full two-port and the TRL two-port calibrations. The
isolation classes apply to the forward and reverse crosstalk terms in the network analyzer error model.

TRL THRU

These are used to perform a TRL two-port calibration. The TRL thru class should contain a thru
standard or a short line. If it contains a non-zero length thru standard, then the calibration type is called
LRL or LRM.

TRL REFLECT

This class is used to perform a TRL two-port calibration. The TRL reflect class should contain a
standard with a high reflection coefficient, typically an open or short. The actual reflection coefficient
need not be known, but its phase angle should be specified approximately correctly (+ 90 deg). The
exact same reflection standard must be used on both ports in the TRL calibration process.

TRL LINE or MATCH
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These are used to perform a TRL two-port calibration. The TRL line or match class should contain line
standards, load standards, or both. If a line standard is used, its phase shift must differ from that of the
TRL THRU standard by 20° to 160°. This limits the useable frequency range to about 8 to 1. Two or
more line standards of different lengths may be specified to get broader frequency coverage. It is also
common to include a load standard for covering low frequencies, where the line's length would be
impractically long. When a load is used, the calibration type is called TRM or LRM.

Note: For more information, read Specifying Calibration Standards and Kits for Keysight Vector Network
Analyzers (Application Note 1287-11)
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Modify Calibration Kits

The following topics discuss Modifying Calibration Kits:

In this Topic

How to Modify Cal Kits

Manage Cal Kits dialog

Cal Kits and Firmware Upgrades

Import Kit dialog

Using VNA CalKit Editor

Connectors Tab

Standards Tab

SOLT Tab

TRL Tab

Concepts

¢ Why Modify a Cal Kit

¢ VNA Cal Kit File Types

Procedures

e How to Create a New Cal Kit from an Existing Cal Kit
e Creating Custom Calibration Kits using a New Connector Family

e Noise Figure and TRL Cal (separate topic)
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How to Modify Cal Kits

The series of dialog boxes that follow allow you to modify the standard definitions or class

assignments of calibration kit files.
Using Hardkey/SoftTablSoftkey

1. Press Cal > Cal Sets & Cal Kits > Cal Kit...

Pru-gramming Commands ’

Manage Cal Kits

Using a mouse

1. Click Response
2. Select Cal
3. Select Cal Sets & Cal Kits

4. Select Cal Kit...

Manage Cal Kits dialog box help

Manage Cal Kits = | = ’E
Lin e sty Cal
Kits...
Standard Cal Kins
0 Wi Meese  Description
1 HE0&2ZE 25 mom with sliding boad
2 BEIGRD 5 e Callbration Kin
3 B50E3IVE 5325 mm Calibration K
4 BENGRC 25 wem SOLT/TRL Calbratson Kit
G BHOGGA 24 o with slideng load
6 B50560 2.4 mum Coalibration Kt
T My 87 282 mm Skding Loewd
8 Moury 87— 252 mm Brosdband Logd
9  HS05EK 24 282 mm with Broadband ...
10 BEOGEKOT 24 w2 82 mm with Skding Lod
11 850536 D_  1.85 mm Preoision Database Cal _
12 B&0SSE D.. 185 mm Econonny Database Gl .
13 BE0GEEF 185 mm (Reducad Accuracy)
14 BSDSSER ... 185 mm Enpmanny (Reduced Aoc_
15 BE0604 0., 100 mm Databssed Precision Cal
16 ARGRAR . 100 mm (Reddaisad Ancairsssh
Ei... Impoat... Sawe_ Inser... Dedete Frin.—

Cal Kit Workspaae

Savn Wiorkapaoe. ozl Whor ks pace: Rastore Defasis

O Canoel Halp

The Manage Cal Kits dialog allows you to define the cal kits in the active workspace. These cal kits

may be edited, created, or saved to a cal kit file.
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Cal Kits and Firmware Upgrades

o |If the firmware upgrade includes factory cal kits that are formatted differently than the factory cal kit
files in the instrument, then:

e The factory cal kit files will be overwritten.

e The custom cal kit files will not be changed.

e A backup of the active workspace will be saved.

¢ A new active workspace will be created and will contain only the new factory cal kit definitions.

e Under these conditions, if you want to use your custom cal kit definitions, you will need to import
these files into the active workspace. Learn how to import cal kit files.

Uncertainty Cal Kits (Only for PNA)

Uncertainty Cal Kits... Opens the Uncertainty Cal Kit Manager (Option S93015A/B enabled).
Learn more about Dynamic Uncertainty.

Standard Cal Kits
This group box lists all cal kits in the active workspace.

Edit... Starts the Connectors tab of the Edit Kit dialog box to modify selected calibration kit
definitions.

Import... Starts the Import Kit dialog box to add a cal kit definition from a file into the active
workspace.

Save... Saves the selected calibration kit definition into a cal kit file (using .xkt, .ckt, or .prn file
type). See VNA Cal Kit File Types.

Insert... Starts a blank Edit Kit dialog box to create a new calibration kit.
Delete Deletes selected calibration kit from the active workspace.
Print... Prints the contents of the selected cal kit to a .prn file.

Cal Kit Workspace

The active cal kit workspace is a collection of standard cal kits that are accessible by the VNA for
calibrations.
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Save Workspace... Saves the active workspace to a workspace file (*.xkw or *.wks).
Recall Workspace... Recalls a workspace file into the active workspace.

Restore Defaults Restores the active workspace and the factory cal kit files (*.xkt) to their
factory default definitions.

For more information see Creating Custom Calibration Kits using a New Connector Family.

Import Cal Kit dialog box help

Open
QO [ » Libraries » Documents » T|*,|I Y =)
QOrganize Mew folder = - i @
¢ Favorites Documents library i v Folde

Arrange oy older =
B Desktop Includes: 2 locations

3 Downloads

Mame Date modified Twpe

< Recent Places

B5032BE ikt 1171172014 946 A KT File| |
7 Libraries 85032Fxkt XKT File| |
. Documents B50330E.xkt XKT File =]
4 Music B5036BExkt HKT File| |

£ Pictures 850398 ikt KT File
B videos 8505205k XKT File| |
85054 20ct XKT File _

& Computer sl < in '
File name: + (XML Cal Kit (k) -

Open Cancel I

Note: There is no limit to the number of cal kits that can be imported. However, during an Unguided
cal, you can access ONLY mechanical cal kits #1 through 95.

Imports a cal kit file into the active cal kit workspace.

Files of type Select the file type of your Cal Kit. Learn more about VNA Cal Kit File Types
File name Navigate and select your cal kit file name.

Open Loads the selected file into the active cal kit workspace.

Note: See Cal Kits and Firmware Upgrades

Importing Cal Kits from "legacy" network analyzers

Cal kit files from "legacy" network analyzers (such as the 8510 or 8§753) may not contain
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information that this VNA requires. Therefore, this VNA may modify the cal kit name, description,
standards, and class assignments. You may need to correct these modifications after importing your
legacy cal kit to meet your specific requirements.

o "Legacy" cal kit files are referenced to the VNA test port gender while modern cal kit files are referenced
to the Device Under Test (DUT) connector gender. Therefore, when a legacy cal kit is imported, the
genders of the standards in the legacy cal kit will be automatically reversed in the new cal kit.

¢ Legacy cal kits do not contain connector definitions. If a coaxial legacy kit is imported, then male and
female coax connector definitions will be added to the kit. If a waveguide legacy kit is imported, then a
genderless waveguide connector definition will be added to the kit.
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Why Modify a Cal Kit

For most applications, the default calibration kit models provide sufficient accuracy for your
calibration. However, several situations may exist that would require you to create a custom calibration
kit:
e Using a connector interface different from those used in the predefined calibration kit models.
¢ Using standards (or combinations of standards) that are different from the predefined calibration kits. For
example, using three offset SHORTs instead of an OPEN, SHORT, and LOAD to perform a 1-port
calibration.
e Improving the accuracy of the models for predefined kits. When the model describes the actual performance
of the standard, the calibration is more accurate. For example: A 7 mm LOAD is determined to be 50.4 V]
instead of 50.0 U.

¢ Modifying the THRU definition when performing a calibration for a non-insertable device.

e Performing a TRL calibration.
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Creating a New Connector Family

To create a custom calibration kit that uses a new connector type, you must first define the connector
family. The connector family is the name of the connector-type of the calibration kit, such as:

o APC7

e 24 mm

e Type-N (50U)

Although more than one connector family is allowed, it is best to limit each calibration kit to only one
connector family.

If you are using a connector family that has male and female connectors, include definitions of both
genders. If you are using a family with no gender, such as APC7, only one connector definition is
required.

Use the following steps to create a custom calibration kit:

1.

10.

11.

12.

13.

Press Cal > Cal Sets & Cal Kits > Cal Kit....

Click Edit....

In the Connectors Tab, click Add to name the new connector family.
Enter the Kit Description for the custom cal kit.

Click Add in the Connectors section of the dialog box.
Enter a Connector Family name.

Enter a Description of the connector.

Select the Gender of one of the connectors.

Enter the minimum and maximum Frequency Range.
Enter the Impedance.

Click the down-arrow to select the Media.

Enter the cut-off frequency

Click Apply.
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14. Click OK.

15. If you need to add another connector gender, in the Connectors Tab, click Add in the Connectors section
again for the next connector gender.

16. If you are adding another connector gender, repeat step 3.

Note: If you have male and female versions of the connector family, you probably do NOT also have a
NO GENDER version.

Enter Standards
Now that the connector family is added to the custom cal kit, you are ready to add new calibration
standards.

1. In the Standards Tab, under the list of standards, click Add.

2. Select the type of standard (OPEN, SHORT, LOAD, or THRU), then click OK.

3. Complete the information in the dialog box for the standard you selected. Note that for banded standards, the
start and stop frequency may be different than the frequency range of the specified connector. Edit the start
and stop frequencies as needed. Click OK when all the settings are correct.

4. Repeat steps 2 - 3, as necessary, to add all standards and definitions to the new custom cal kit.

5. Assign each of the standards to a calibration class. This is done through the TRL Tab or SOLT Tab

6. Save the Cal Kit.
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How to Create a New Cal Kit from an Existing Cal Kit

You can create a new custom Cal Kit using an existing Cal Kit as a starting point.

Here is how:

1. Press Cal > Cal Sets & Cal Kits > Cal Kit....

2. Immediately click Save... and change the file name. Select either *.xkt or *.ckt, *.prn file type. Learn more
about these file types.

3. Make modifications to your new custom Cal Kit as required.

4. Routinely save your work by clicking Save.

See Also

About VNA Cal Kits and Firmware Upgrades
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VNA Cal Kit File Types

The VNA Cal Kit editor can open the following types of Cal Kit files:

VNA Families File Type

Cal Kits supported by current firmware of these * xkt
VNA models: PNA Series, ENA Series, FieldFox,
and PXI Series

Old PNA Series Cal Kits (PNA Firmware A.07.50 *.ckt

to A.09.90)

Old PNA Series Cal Kit (before A.07.50) *.ckl
Previous FieldFox format Cal Kits * xml
Previous ENA format Cal Kits * ckx
8510 Cal Kit .CK_ *
8753, 8752, 8719, 8720, or 8722 Cal Kit *.ck

The current revision of Cal Kit files can be downloaded at
http://na.support.keysight.com/pna/caldefs/stddefs.html

File Save (As)

The VNA Cal Kit Editor can save Cal Kits in one of three file formats:

o *.xkt - Newer format that is based on xml and is shared among VNA families.

e *.ckt - VNA binary format, provided for backwards compatibility with older VNA firmware revisions and may
not support future new cal kit capabilities, which is expected of the *.xkt format.

e *.prn - Cal kit print files. This is a text file format which can be read into spreadsheets, but the Cal Kit Editor
does not read-in these files. These files are only produced as a form of documentation.

About Opening Legacy VNA Kits

Cal kit files from Keysight "legacy" network analyzers (listed above) may not contain information that
the VNA requires. When loaded into the VNA Cal Kit Editor, the cal kit name and description, the cal
standards, and the cal class assignments will be modified in a best effort manner. You may need to
correct these modifications after importing your legacy cal kit to meet your specific requirements.

e "Legacy" cal kit files are based on the analyzer test port sex. Modern VNA cal kits are based on the Device
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Under Test (DUT) connector sex. Therefore, when the kit is imported the standard's label and description
are reversed and are noted as F- (female) and M- (male) .

¢ When a Coaxial standard is detected in the kit file, a pair of male/female connectors is typically created.
e Waveguide standards that are created as connector have no gender.

File Association

With the exception of *.xml, the above file types are automatically associated with the CalKit Editor if
they are not already associated with a different program. That means, after running CalKit Editor,
double-clicking any of the above file types (except *.xml) will open the file using CalKit Editor.

If you have already associated one of these file types with a different program and would like to change
it to CalKit Editor, do the following:

1. Right-click the file, then click Open With

2. Browse to the CalKitEditor install folder.

e C:\Program Files (x86)\Agilent\VNA Cal Kit Editor

3. Check Always use the selected program to open this kind of file.

4. Select CalKit Editor.
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Connectors Tab

......

Cal Kit Name Allows you to change the Name of the selected calibration kit.

Cal Kit Description Allows you to change the description of the selected calibration kit.

Connector Family .Click the down arrow to select the connector family associated with the Cal Kit.

Add Starts the Add Connector dialog box which allows you to add new connector type to the calibration
kit.

Delete Deletes - WITHOUT WARNING - the selected connector family.

Note: To modify a connector family or name, Add a new connector, then delete the old connector.

The following is the list of Factory-defined connector type strings:
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Type N (50) female

7-16 female X-band waveguide
Type N (50) male
7-16 male P-band waveguide
APC 3.5 female Type N (75) female
2.92 mm female K-band waveguide
APC 3.5 male Type N (75) male
2.92 mm male Q-band waveguide
APC 2.4 female Type F (75) female
1.85 mm female R-band waveguide
APC 2.4 male Type F (75) male
1.85 mm male U-band waveguide
APC7 Type A (50) female
1.0 mm female V-band waveguide
Type A (50) male
1.0 mm male W-band waveguide
Type B

Frequency Range

Min Allows you to define the lowest frequency at which the standard is used for calibration.

Max Allows you to define the highest frequency at which the standard is used for calibration.
Gender

Gendered - The connector family contains both Male and Female connectors.

Genderless - The connector family does NOT contain Male and Female connectors. APC7
connectors are an example of this connector type.

Impedance
Specify the impedance of the standard.

Media
The medium (or 'geometry') of the connector (COAX or WAVEGUIDE).
Cutoff Frequency If Media is Waveguide, type the low-end cutoff frequency.

Height/Width Ratio Used to calculate waveguide loss. This value is usually on the data sheet for
waveguide devices.

About Waveguide Cal Kits

If modifying or creating a waveguide cal kit, be sure to make the following settings. You cancreate a
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custom waveguide cal kit using an existing factory waveguide Cal kit as a starting point. The factory cal
kits already have these settings.

¢ Frequency Range: Min. frequency = Cutoff frequency.

e Gender: No Gender

e Impedance Z0: 1 ohm

e Media: Waveguide

For waveguide, choose TRL (Thru-Reflect-Line) calibration type . These calibration types are more
accurate and take fewer steps than SOLT.

Add Connector Family

M Add Connector. Family E|@|E|

Connactor Family | M}rNech-nna:tml |

[ Ok ] [ Cancel ]

Enter a name for the new connector family. Then click OK.

Available at the bottom of every tab
Save As - Allows you to save the cal kit to a new file name and type.
Save - Saves the cal kit to the same file name and type.

Close - Closes the cal kit editing session. The file is NOT saved automatically.
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Standards Tab
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Allows you to Add, Edit or Delete cal standards in a cal kit.

Add Standard (Open, Short, Load, Thru, or Data-based)

[ = ] [ o= ][ ]

Allows you to add standards to the calibration kit file.

Choose from:

e OPEN

e SHORT

e LOAD

e THRU

e DATA-BASED

e |SOLATION
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Standards dialog box help

The following fields apply to ALL standard types:
T TR g .

- E
Description | 3.5 mm mals open 2 E

The other areas of the dialog change depending on the type of standard selected.
Identification

Standard ID Number in list of standards

Label Type of standard. This usually appears in prompts for standards.

Description Description of standard.

The following fields apply to ALL standard types EXCEPT the Isolation type:

aaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaa

Connactor

Part1l |35 mm mals o

ke

Frequency Ramnge
Min| 0 MHz Max | 999000 MHz

e

xxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxx

Connector
Indicates the type and gender (Male, Female, None) of the standard.
Thru and Isolation standards have two connectors.
Data-Based standards MAY have two connectors.
Frequency Range
Min Defines the lowest frequency at which the standard is used for calibration.

Max Defines the highest frequency at which the standard is used for calibration.
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The Delay Characteristics fields apply to MOST standard types:

Iﬁélay Characteristics

xxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxx

Delay Characteristics
Delay Defines the one-way travel time from the calibration plane to the standard in seconds.
Z0 Defines the impedance of the standard.

Loss Defines energy loss in Gohms, due to skin effect, along a one-way length of coaxial cable.

Other fields are unique to standard type

Choose from:

¢ OPEN

e SHORT

e LOAD

e THRU

e DATA-BASED

e |ISOLATION

Open Standard

Co0, C1, C2, C3 Specifies the fringing capacitance.

aaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaa

colo Fle-15) cz |0 Fle-38)/Hz"2

2 ci(o Fle-27)/Hz 3|0 F(e-45)/Hz3

These are the unique fields of the dialog. See the areas that are common to all standards.
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Short Standard

L0, L1, L2, L3 Specifies the residual inductance.

L0 | O H{e-12) L2 0

xxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxx

Load Standard

Choose from the following

(&) Fixed Load
()sliding Load
() Offset Load

() arhitrary
Impedance

xxxxxxxxxxxxxxxxxxxxxxxxxxxxxxx

Fixed Load Specifies the load type as Fixed. The fixed load is assumed to be a perfect termination

without reflection.

Sliding Load

A sliding load is defined by making multiple measurements of the device with the sliding load
element positioned at various marked positions of a long transmission line. The transmission line is
assumed to have zero reflections and the load element has a finite reflection that can be
mathematically removed using a least squares circle fitting method.

A sliding load cal can be very accurate when performed perfectly. It can also be very inaccurate when
not using proper technique. For accurate results, closely follow the users manual instructions for

the sliding load.

Arbitrary Impedance

Arbitrary Impedance Parameters

Real | 50.4

H{e-33)fHz"2

Hie-42)/Hz"3 :

xxxxxxxxxxxxxxxxxxxxxxxxxxxx
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Specifies the load type that has an impedance value different from system Z0. An arbitrary
impedance device is similar to a fixed load except that the load impedance is NOT perfect. Early
firmware releases of the VNA series used a fixed resistance value. A complex terminating impedance
has been added to allow for more accurate modeling of circuit board or on-wafer devices.

The following Complex Impedance settings are available ONLY when Arbitrary Impedance is
selected.
e Real The real portion of the impedance value.

e Imaginary The imaginary portion of the impedance value.

Offset Load
Offset Load Parameters
First Offset | THRU v
Sacond Offset | 7-32 Line W
Load | ADPTR/LOAD -M- w

Using an Offset Load standard results in a more accurate calibration than with a Broadband Load.
Therefore, when performing a calibration using one of the modified Cal Kit definitions, you may be
prompted to connect more standards than before this change. To revert to using the Broadband Load
Standard without offset, do the following:

1. Press Cal > Cal Sets & Cal Kits > Cal Kit....
2.  Atthe Manage Cal Kit dialog box, click Edit....
3. Select the SOLT tab.

4. Under the Calibration Kit Classes, select SC (Loads)

5. Under Selected Standards, select Broadband Load, then click Move Up until the standard is at the top of
the list. This will ensure that the Broadband Load is used first.

About Offset Load

An offset load is a compound standard consisting of a load element and two known offset elements
(transmission lines) of different length. The shorter offset element can be a zero-length (Flush-thru)
offset. The load element is defined as a 1-port reflection standard. An offset load standard is used
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when the response of the offset elements are more precisely known than the response of the load
element. This is the case with waveguide. Measurement of an offset load standard consists of two
measurements, one with each of the two offset elements terminated by the load element. The
frequency range of the offset load standard should be set so that there will be at least a 20 degree
separation between the expected response of each measurement.

To specify more than two offset elements, define multiple offset load standards. In cases where more
than two offsets are used, the frequency range may be extended as the internal algorithm at each
frequency will search through all of the possible combinations of offsets to find the pair with the
widest expected separation to use in determining the actual response of the load element.

The following Offset Load settings are available ONLY when Offset Load is selected.

e First Offset Standard
e Second Offset Standard

e |oad Standard

Thru Standard

aaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaa

Coninectors
Port 1 | 3.5 mm female o
Port 2 |3.5 mm male W

Frequency Range
Min | 0 MHz Max | 38300 MHz

Delay Characteristics
Dlay | 0 pSec Loz=z | O Gohms/s

Connectors - Defines connector type at both ends of the Thru standard.
Virtual Device

Most cal kits have only one Thru standard definition for SOLT calibrations. For these cases, use the
default selections (checked for zero-length Thrus and cleared for non-zero-length Thrus).
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This checkbox is used to make forward and reverse measurements of your Thru standard for the same
pair of ports in two separate steps. This is NOT common for zero-length (Flush) Thru standards.

When checked, calibration prompts involving that Thru will omit the Description. For example
“Connect port 1 to port 2”. This is the common prompt for Flush-Thru standards.

When cleared, calibration prompts for that Thru will include the Description. For example “Connect
<standard description> between ports 1 and 2”.

To make forward and reverse measurements of your Thru standard for the same pair of ports as two
separate steps, do the following:

1.  Create separate definitions of the Thru standard(s) using the same settings, except for the Label and
Description. Clear this checkbox for BOTH definitions.

2. For one Thru definition, in the label and description include the word 'FORWARD' to prompt the operator to
use this standard for the forward measurement. Assign this standard to the SOLT “FWD TRANS” and
“FWD MATCH?” classes of the cal kit.

3. For the Thru definition, in the label and description include the word 'REVERSE' to prompt the operator to
use this standard for the reverse measurement. Assign this standard to the SOLT “REV TRANS” and
“REV MATCH? classes of the cal kit.

4.  When you perform SOLT calibrations using this cal kit, the forward measurements of the Thru will be
measured in one connection step, and the reverse measurements in another.

Data-Based Standard

Response Data Summary

Number of Response Data Variables = 4

index = 0: Number of Data Variable Values = 500
Data Variable Mame = 511

index = 1: Number of Data Variable Values = 500
Data Variable Mame = 521

Load Data File...

Accuracy Data Summary

Standard contains no accuracy data

Load Data File...

Virtual Device

xxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxx
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Note: To learn how to modify data-based standard files, visit http:/na.support.keysight.com/pna/dbcal.html

Learn about the relative accuracy of Databased versus Polynomial Cal Kits.
The modified file can then be uploaded into the VNA.
Upload Data From File

Click Load Data File, then navigate to the *.dat or *.dsd file which is provided with the data-based
Cal Kit. Both Response data and Accuracy (Uncertainty) data is provided in a single *dat or *.dsd
file.

For Advanced Users
Response data can be loaded from a *.s2p or *.cti file.
Accuracy data can be loaded from a *.cti file.
Virtual Device
This checkbox is displayed for a Data-Based cal standard when the standard has been defined to have 2

ports.

e When Cleared (default) calibration prompts for that standard will include it's Description. For example
“Connect <standard description> between ports 1 and 2.

o When Checked, calibration prompts for that standard will NOT include its Description, so the prompt will be

worded as if the data-based standard is a zero-length Thru connection. For example “Connect port 1 to port
2’

Isolation Standard

X

Isolation Standard

Standard 1D iz Label | Load - M| Load -F

Description | 3-5 mm myf broadband leadd

Isolation Standands
Port 1 | Broadband Load «M- -
Port 2 | Broadband Load -7 w

The pair of loads are considered one standard.
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Both loads are connected to the VNA and measured with the same prompt.

Available at the bottom of every tab
Save As - Allows you to save the cal kit to a new file name and type.
Save - Saves the cal kit to the same file name and type.

Close - Closes the cal kit editing session. The file is NOT saved automatically.
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SOLT Tab

Edit Kit s
Cal Kit Mame  B5052C Cal Kit Description 3.5 men SOLT/TRL Calibration Kit

Cal Kt Version
| Connectors | Standards S0LT | TRL

Calibration Kit Classes

@ 5A FWD TRANS REV TRAMNS UNKNOAWN THRU
5B PWD MATCH REV MATCH ISOLATION
5C | Link PWD TRAMS, FWD MATCH, REV TRANS, and REV MATCH

Sh Labal OFEN

Broadband Loa 3.5 mm male broadbs

(-2 | pad M- -2 GH male kb han
n v ‘ m v

SA Available Standards 54 Selected Standards
D Standard Description = D Standard Description
1 9.2%-37 Offset| 9.26-32 GHz male off| = 7 OPFEN -M- 3.5 mm male cpen
2 525926 Offse 5.26-9.26 GHz malke o L3 14  OPEN -F- 3.5 mm female open
3 3-5.26 Offset Lt 3-5.26 GHz male offs
4  ADPTRALOAD - Male load connected
5
'

Maowve Down

Expanded Calibration [applies to reflection classes SA, 5B, and 5C)

Measure all mateabls standards in class Use expanded math when possible

[ Save.., | | Cloge | Help

Note: This dialog looks similar to the dialog that appears after the Cal Wizard View / Modify dialog.
However, setting changes in that dialog affect ONLY the calibration that is in progress. These settings,
accessed through Modify Cal Kit, changes the cal kit for all future calibrations that use this cal kit.

Allows you to assign single or multiple standards to SOLT Calibration Classes.

Click the TRL tab to assign standards to TRL Calibration Classes.

1. For each Cal Kit Class, select Available Standards from the left list, then click >> to copy the standard to the
Cal Kit.

2. Use MOVE UP and MOVE DOWN to change the ORDER of the standards. The order is used in guided
calibrations to determine which standards in that class will be used in calibrations that involve the frequency
ranges over which the standards are defined. Guided cals will include standards in the order in which they
appear in this class list, and in the case where standards in the class list have frequency ranges that overlap,
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the order also determines which standard is used for frequencies in the overlap range. For example, let's
assume that you define a broadband Short from Min Freq.= 0 Hz and Max Freq.= 999 GHz, and that
standard is listed first in the SB or TRL REFLECT class. If you then list a frequency-banded Short with the
same connector below the broadband short in those same classes, then guided calibrations would not use
the frequency-banded Shorts because the broadband Shorts would always be given priority.

SOLT <cal class> Label

The cal standard category label that appears in the VNA’s user interface duringunguided SOLT
calibrations.

Calibration Kit Classes

For each calibration class, select Available Standards, then click >> to move to the Selected
Standards list.

e SA - OPEN Standards (standards in the SA class are not always Opens)
¢ SB - SHORT Standards
e SC - LOAD Standards

e FWD /REV Trans and Match - THRU Standards. Most Cal Kits do NOT include a physical THRU standard,
but assume that an Insertable Thru will be used.

e UNKNOWN THRU - Unknown Thru Cal is the preferred THRU method of calibrating the analyzer to
measure a non-insertable device. The Unknown Thru calibration is also known as Short-Open-Load-
Reciprocal Thru (SOLR) calibration. Learn more.

e ISOLATION - Isolation standard. For VNA analyzers, ISOLATION calibration is not usually recommended. It
could be beneficial in some situations where custom user-supplied test set hardware is being used.

Link FWD TRANS, FWD MATCH, REV TRANS, and REV MATCH Check to automatically
assign the standard definition for FWD TRANS to FWD MATCH, REV MATCH, and REV TRANS.
Clear to separately assign FWD MATCH, REV MATCH and REV TRANS classes (SOLT calibrations
only).

Expanded Calibration

The following two check boxes apply ONLY during Guided Calibrations. For Unguided
Calibration, these check boxes are ignored, including the case where the multiple standards dialog box
is presented.

Measure all mateable standards in class Check this box to attain the very highest accuracy
possible. For example, if a cal kit contains several load standards, during the calibration process you
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will be prompted to measure each of the standards. This could require a significant amount of
calibration time. When checked, the "Use expanded math when possible" box is also checked
automatically.

Use expanded math when possible Some kits contain multiple calibration standards of the same
type that together cover a very wide frequency range. (For example: multiple shorts, or a lowband
load and a sliding load.) If a calibration requires more than one standard to cover the calibration
frequency range, there can be regions of overlapping measurements. When this checkbox is selected,
the VNA automatically computes the most accurate measurement in the overlap regions using a
"weighted least squares fit" algorithm. This function improves accuracy without slowing the
calibration speed.

e  Manually select this checkbox only when using a cal kit that contains multiple standards of the
same type. (For example: multiple shorts, or a lowband load and a sliding load.)
e The checkbox is cleared by default when a polynomial model is selected from the cal kit menu.
e The checkbox is selected by default when the 85058B or 85058E data-based model is selected
from the cal kit menu.
Available at the bottom of every tab
Save As - Allows you to save the cal kit to a new file name and type.
Save - Saves the cal kit to the same file name and type.

Close - Closes the cal kit editing session. The file is NOT saved automatically.
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TRL Tab

On the image below, click a setting area to learn more.

S o

Fit el Ty P

i, W Rl O

Allows you to assign single or multiple standards to Calibration Classes.

1. For each Cal Kit Class, select Available Standards from the left list, then click >> to copy the standard to the
Cal Kit.

2. Use MOVE UP and MOVE DOWN to change the ORDER of the standards. The order is used in guided
calibrations to determine which standards in that class will be used in calibrations that involve the frequency
ranges over which the standards are defined. Guided cals will include standards in the order in which they
appear in this class list, and in the case where standards in the class list have frequency ranges that overlap,
the order also determines which standard is used for frequencies in the overlap range. For example, let's
assume that you define a broadband Short from Min Freq.= 0 Hz and Max Freq.= 999 GHz, and that
standard is listed first in the SB or TRL REFLECT class. If you then list a frequency-banded Short with the
same connector below the broadband short in those same classes, then guided calibrations would not use
the frequency-banded Shorts because the broadband Shorts would always be given priority.

Note: The TRL LINE/MATCH class has a slight exception to these prioritization behaviors. In
general, Line standards are given a higher priority than Match standards. So if a Line standard and a
Match standard are defined to have the same frequency range and the Match standard is listed above
the Line standard in the class order, a guided TRL cal will still prefer to use the Line standard rather
than the Match standard.

TRL <cal class> Label

The cal standard category label that appears in the VNA’s user interface duringunguided TRL
calibrations.
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Cal Kit Classes

For VNA analyzers, ISOLATION calibration is not usually recommended. It could be beneficial in some
situations where custom user-supplied test set hardware is being used.

TRL THRU

Note: All THRU calibration methods are supported in a TRL Cal EXCEPT Unknown Thru.

The THRU standard can be either a zero-length or non-zero length. However, a zero-length THRU is more
accurate because it has zero loss and no reflections, by definition.

The THRU standard cannot be the same electrical length as the LINE standard.

If the insertion phase and electrical length are well-defined, the THRU standard may be used to set the
reference plane.

The THRU standard and LINE standard have the same characteristic impedance and are perfectly matched.
They define the reference impedance of the calibration.

If a THRU standard with the correct connectors is NOT available, an adapter removal cal can be performed.

TRL REFLECT

The REFLECT standard can be anything with a high reflection, as long as it is the same when connected to
one or more VNA ports.

The REFLECT standard on each port is identical.
The actual magnitude of the reflection need not be known.
The phase of the reflection standard must be known within 1/4 wavelength.

If the magnitude and phase of the reflection standard are well-defined, the standard may be used to set the
reference plane.

TRL LINE

The LINE and THRU standards establish the reference impedance for the measurement after the
calibration is completed. TRL calibration is limited by the following restrictions of the LINE standard:

Must be of the same impedance and propagation constant as the THRU standard.

The electrical length need only be specified within 1/4 wavelength.
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e Cannot be the same length as the THRU standard.

e A TRL cal with broad frequency coverage requires multiple LINE standards. For example, a span from 2 GHz
to 26 GHz requires two line standards.

e Must be an appropriate electrical length for the frequency range: at each frequency, the phase difference
between the THRU and the LINE should be greater than 20 degrees and less than 160 degrees. This means
in practice that a single LINE standard is only usable over an 8:1 frequency range (Frequency Span / Start
Frequency). Therefore, for broad frequency coverage, multiple lines are required.

e At low frequencies, the LINE standard can become too long for practical use. The optimal length of the LINE
standard is 1/4 wavelength at the geometric mean of the frequency span (square root of f1 x f2).

Note: The TRL LINE standard must have a delay that is greater than 0 (zero) ps. Otherwise,
calibration correction calculations will contain unpredictable results.

TRL MATCH
If the LINE standard of appropriate length or loss cannot be fabricated, a MATCH standard may be
used instead of the LINE.

e The MATCH standard is a low-reflection termination connected to both Port 1 and Port 2.

e The MATCH standard may be defined as an infinite length transmission line OR as a 1-port low reflect
termination, such as a load.

e When defined as an infinite length transmission line, both test ports must be terminated by a MATCH
standard at the same time. When defined as a 1-port load standard, the loads are measured separately. The
loads are assumed to have the same characteristics.

e The impedance of the MATCH standard becomes the reference impedance for the measurement. For best
results, use the same load on both ports. The load may be defined using the data-based definition, the
arbitrary impedance definition, or the fixed load definition.

Calibration Reference Z0 (TRL only)

System Z0 The system impedance is used as the reference impedance. Choose when the desired test
port impedance differs from the impedance of the LINE standard. Also, choose when skin effect
impedance correction is desired for coax lines.

Line Z0 The impedance of the line standard is used as the reference impedance, or center of the
Smith Chart. Any reflection from the line standard is assumed to be part of the directivity error.

Testport Reference Plane (TRL only)

Thru Standard The THRU standard definition is used to establish the measurement reference
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plane. Select if the THRU standard is zero-length or very short.

Reflect Standard The REFLECT standard definition is used to establish the position of the
measurement reference plane. Select if the THRU standard is not appropriate AND the delay of the
REFLECT standard is well defined.

Also, select If a flush short is used for the REFLECT standard because a flush short provides a more
accurate phase reference than a Thru standard.

LRL line auto characterization
Note: This setting ONLY applies if an LRL Cal Kit is being modified AND Testport Reference Plane
is set to Thru Standard AND the TRL Thru class standard and the TRL Line/Match class standard both
have the same values for Offset Z0 and Loss. Otherwise, this setting is ignored.
e Check the box to allow the VNA to automatically correct for line loss and dispersion characteristics.
o Clear the box if anomalies appear during a calibrated measurement which may indicate different loss and
impedance values for the Line standards.
Available at the bottom of every tab
Save As - Allows you to save the cal kit to a new file name and type.
Save - Saves the cal kit to the same file name and type.

Close - Closes the cal kit editing session. The file is NOT saved automatically.
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Markers

Markers provide a numerical readout of measured data, a search capability for specific values, and can
change stimulus settings. There are 15 regular markers and one Reference marker (used with Delta
markers) available per trace. This topic discusses all aspects of markers.

Note: Marker Readout can be turned ON/OFF and customized from the Customize Display dialog
box. Learn more.

Number of General Purpose and Reference Markers

Creating and Moving Markers

Marker Setup

e Coupling Method

Searching with Markers

e Maximum and Minimum Search
e Peak Search

e Multi Peak Search

e Target Search

e Multi Target Search

e Bandwidth and Notch Search

e Compression Search

e PSAT Search

PNOP Search

Search Domain

Search Range Indicators

Marker Functions (Change Instrument Settings)

SA Analysis Markers (Spectrum Analyzer channel markers)
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e SA Mrkr Function (Modulation Distortion channel markers)
e Marker Display

e Marker Table

Note: Marker Readout can be turned ON / OFF and customized from the View/Display menu. Learn
more.

Other Analyze Data topics

Creating and Moving Markers

How to Create Markers

Using Hardkey/SoftTablSoftkey Using a mouse
1. Press Marker > Marker 1-7 | Marker 8-15 / 1. Move the cursor on a trace.
Reference.

2. Right-click on the trace then select Add
2. Click left side Marker N or Reference small Marker....

button.
Prugramming Commands= }

Moving a Marker

To move a marker, make the marker active by selecting its number in any of the previous 3 methods.
The active marker appears on the analyzer display as V. All of the other markers are inactive and are
represented on the analyzer display as A. Then change the stimulus value using any of the following
methods:

Type a value.

e Scroll to a stimulus value using the up / down arrows. The resolution can not be changed.

e Click the stimulus box, then use the front-panel knob.

e Click and Drag Markers using a finger (touchscreen) or by left-clicking and holding a marker symbol. Then

drag the marker to any point on the trace. This feature is NOT allowed in Smith Chart or Polar display formats
or with a Fixed Marker type.

Marker Setup
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How to set the Marker Setup.

Using Hardkey/SoftTablSoftkey Using a mouse
1. Press Marker > Marker Setup. 1. Move the cursor on a marker.
2. Set the value or select desired setting for each 2. Right-click on the marker then select
softkey. Marker....

Prugramming Commands= }

Marker dialog box help

Marker -F

Marker 1 - S On Stmulus 132550000000 GHz |
Delta marker
Discrete
Fixed Format | Travee Dofault -
Coupled Markers Coupling Method | All x

Adl Ot Ok Cancel Hilp

Marker Specifies the current (active) marker number that you are defining.
On Check to display the marker and corresponding data on the screen.

Stimulus Specifies the X-axis value of the active marker. To change stimulus value, type a value,
use the up and down arrows, click in the text box and use the front-panel knob, or drag the marker
on the screen.

Delta (and Reference) Markers Check to make the active marker display data that is relative to
the reference (R) marker. There is only one reference marker per trace. All other markers can be
regular markers or delta markers. When a delta marker is created, if not already displayed, the
reference marker is displayed automatically. A delta marker can be activated from the Marker dialog
box or the Marker Toolbar. See Also: Number of General Purpose and Reference Markers.

Discrete Marker Check to display values at only the discrete points where data is measured. Clear
to display values that are interpolated from the data points. The interpolated marker will report y-
axis data from ANY frequency value between the start and stop frequency.

Fixed Check to cause the marker to have a fixed X-axis and Y-axis position based on its placement
on the trace when it was set to fixed. It does NOT move with trace data amplitude. It can be scrolled
left and right on the X-axis by changing the marker stimulus value. Use this marker type to quickly
monitor "before and after" changes to your test device. For example, you could use fixed markers to
record the difference of test results before and after tuning a filter.
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Clear the box to create a Normal marker, which has a fixed stimulus position (X-axis) and responds
to changes in data amplitude (Y-axis). It can be scrolled left and right on the X-axis by changing the
marker stimulus value. Use this marker type with one of the marker search types to locate the
desired data.

(Marker) Format Displays the marker data in a format that you choose. The Trace Default setting
has the same marker and grid formats. Choose from the following:

Log/Phase Log Real Fahrenheit
Mag

Linear/Phase  Linear Imaginary Celsius
Mag

Real/Imag Phase = Phase Unwrapped Noise

RHX SWR  Phase Positive

(complex

impedance)

G+jB Delay  Kelvin

(complex

admittance)

Noise Marker Format (IMSpectrum and SA measurement classes only) - For comparison
purposes, electronic noise measurements are often displayed as though the measurement was made
in a 1 Hz Res BW. However, making an actual measurement at a 1 Hz Res BW is impossible, and
at 10 Hz, extremely slow.

A Noise Marker mathematically calculates the noise measurement at that single data point as
though it were made using a 1 Hz bandwidth.

To accurately measure noise, the Noise Marker should NOT be placed on, or too close to, a signal.
The distance from a signal depends on several factors. To know if an accurate reading is being
made, move the Noise Marker until consistent measurements are displayed in adjacent data points.

Noise Marker Format (Modulation Distortion measurement class only) - In a Modulation
Distortion channel, the noise is calculated from the current power reading divided by the tone
spacing of the modulation being used: PIn(W/Hz) = PIn(W) / [Tone Spacing (Hz)].

All Off Switches OFF all markers on the active trace.

Coupled Markers
Note: This function is not supported by the ESO80A.

The coupled markers feature causes markers on different traces to line up with the markers on the
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selected trace. Markers are coupled by marker number, 1 to 1, 2 to 2, 3 to 3, and so forth. If the x-
axis domain is the same (such as frequency or time), coupling occurs. Trace markers in a different
x-axis domain will not be coupled. If a trace marker has no marker to couple with on the selected

trace, the marker remains independent.

Coupling Method - Determines the scope of coupling. Choose from the following:
e All - A marker on one trace is coupled to the same-numbered markers on all channels, all windows and
all traces.

e Channel - A marker on one trace is coupled to the same numbered markers on traces which share the
same channel number as the original trace.

Coupled Markers Model
This model simulates the use of coupled markers in the VNA:

Model Reset Button

[T Coupled Markers (Nt on Analyzer)

2
Trace A Y
& Y
1 Jj4
2
Trace B ¥
i i
4 1

1. Click Trace A or Trace B
2. Click Coupled Markers
3. Notice the following:
e Markers on the unselected trace move to the x-axis position of the selected trace.
¢ If a marker number on the unselected trace has no corresponding marker on the selected trace, no

movement occurs for that marker.

4. Click Reset to run the model again. There is no Reset for coupled markers on the VNA.

Searching with Markers
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You can use markers to search and return data for the following trace criteria:

Max and Min: find the highest or lowest points on the trace

Peak, then move to other peaks (left, right, next highest)

Multi Peak

Target Value: find a specific Y-axis value
Multi Target:

Bandwidth (Filters)

Notch (Filters)

Compression Point (Amplifiers)

About PSAT and PNOP Markers

e Power Saturation (Amplifiers)
e Power Normal Operating Point (Amplifiers)
Search Domain

Search Range Indicators

How to Search with Markers
Using Hardkey/SoftTablSoftkey

Using a mouse

1.

Press Search > Main / Peak | Target | Multi Peak
& Target/ Bandwidth & Notch /| Compression &
Saturation /| Normal Op Pt.

1. Move the cursor on a marker.

2. Right-click on the marker then select
Search...to show the Marker Search
Dialog box for define the search
parameters.

3. From Search Type of Marker Search
dialog box, select the desired search
function.

4. Press Execute or check Tracking. Learn
more.

Prugramming Commands }

Marker Search dialog box help
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Marker Seardh

Marker Search Type
e -] [ETSTEMSEOTNN -] Exeous [ ox ]
Bmck-off IWE—I r Tracking Cancal

Search Domain:

|F ull Span - Pin Offsat 0.000 4B EI ﬁ

Marker Specifies the marker that you are defining. Not available for search types that deploy
specific markers.

Search Domain Defines the area where the marker can move or search. For full span, the marker
searches for specified values within the full measurement span. For user span, the marker searches
for specified values within a measurement span that you define. Learn more about Search Domain.

Search Type

Note You must either press Target Search or check Tracking to initiate all search types. If there
is no valid data match for the search type, the marker will not move from its current position.

e Target Search Click to cause the marker to search for the specified criteria.

e Tracking Check to cause the marker to search for the specified criteria with each new sweep. The
searches begin with the first sweep after Tracking has been checked, based on the current search type
and domain information. Therefore, make sure that the search criteria are in the desired state before

using the data. You cannot manually change the stimulus setting for a marker if Tracking is selected for
that marker.

Maximum Marker locates the maximum (highest) data value.

Minimum Marker locates the minimum (lowest) data value.

Peak - See below.

Next Peak - Marker locates the peak with the next lower amplitude value relative to its starting
position.

Peak Right - The marker locates the next valid peak to the right of its starting position on the X-
axis.

Peak Left - The marker locates the next valid peak to the left of its starting position on the X-axis.

Multi Peak - A function that search for peaks that match the multi-peak search excursion value and
multi-peak polarity value. Learn more about Multi Peak Search.
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e Threshold - Minimum amplitude (dB). To be considered valid, the peak must be above the threshold
level. The valley on either side can be below the threshold level.

o Excursion The vertical distance (dB) between the peak and the valleys on both sides. To be considered

a peak, data values must "fall off" from the peak on both sides by the excursion value.

Target - A function that searches for a target that matches the pre-defined target value and
transition types (positive, negative or both (positive and negative)) and then moves the marker to
that target. Learn more about Multi Target Search.

Target Left - A function executes the search from the current marker position to the smaller
stimulus values and moves the marker to first target encountered.

Target Right - A function executes the search from the current marker position to the larger
stimulus values and moves the marker to first target encountered.

Multi Target - A function that search for targets that are of the multi-target value and multi target
transition value. Learn more about Multi Target Search.

e Target - Value in dB.

Compression - A function used the active marker to find the specified gain Compression Level.
Learn more about Compression Search.

e Compression - Value in dB.

Bandwidth and Notch searches are accessed by pressing Search > Bandwidth & Notch > BW Ref to
or Search > Bandwidth & Notch > Notch Ref to.
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Bandwidth - A function for determining the bandwidth of the trace, center frequency, cut-off points
(on the higher frequency and the lower frequency sides), Q and insertion loss based on the position
of the active marker (if search mode set to Marker) or the peak marker (if search mode set to

Peak). Learn more about Bandwidth Search.

e Bandwidth peak mode search

¢ If level is negative, search is relative to the maximum peak.
e If level is positive, search is relative to the minimum peak.
e Bandwidth level in dB.

Notch - A function is used to obtain the bandwidth, center frequency, cutoff points (high-frequency
side and low-frequency side), Q and insertion loss of a trace based on the position of the active
marker (if search mode set to Marker) or the peak (if search mode set to Peak). Learn more about

Notch Search.

¢ Notch peak mode search
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o If level is negative, notch search is relative to the minimum peak.
o If level is positive, notch search is relative to the maximum peak.
e Notch level in dB.

The default behavior for searches based on the active marker or peak marker can be set using the
Marker: On Preset, set BW/Notch search reference to Peak preference.

Power Saturation - Learn more about PSAT Search.

¢ PMax Back-off -Value in dB.

Normal Operating Pt - The output power where the input is offset from the back-off input power
by the Pin Offset. Learn more about PNOP Search.

¢ Back-off - Value in dB.

¢ Pin Offset - X-axis value in dB.

Maximum and Minimum Search

How to create Maximum and Minimum Search

Using Hardkey/SoftTab/Softkey Using a mouse
1. Press Search > Main. 1. Move a cursor on a marker.
2. Click Max Search or Min Search. 2. Right-click on the marker and then select
Search....
3. Optionally click Tracking to search for the
specified maximum or minimum level with each 3. From Search Type of Marker Search dialog
sweep. Learn more. box, select Maximum / Minimum.

4. Press Execute or check Tracking. Learn more.

Prugramming Commands }

You can search for the maximum or minimum measured value on the trace and move a marker to that
point.
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Measured value

Maximum |-,

Minimum

Stimulus value

Search for maximum (Max Move active marker to point on trace where

Search)

measured value is greatest.

Search for minimum (Min Move active marker to point on trace where

Search)

measured value is lowest.

Note: When the data format is in Smith chart or polar format, execute the search only for the main
response value.

Peak Search

How to create Peak Search
Using Hardkey/SoftTab/Softkey

1.

2.

Press Search > Peak.

Click Peak Search to show the markers on the
peak.

Click Peak Right >> Search, << Peak Left
Search or Next Peak Search to move the
marker to the peak.

Click Threshold to enter the value of peak
threshold.

Click Excursion to enter the lower limit value
of peak excursion.

Click Peak Polarity to select a peak polarity.
Optionally click Tracking to search for the

specified peak level with each sweep. Learn
more.

Using a mouse
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1.

2.

Move a cursor on a marker.

Right-click on the marker and then select
Search....

From Search Type of Marker Search
dialog box, select Peak / Peak Left /
Peak Right / Next Peak.

Enter the value of Threshold and Excursion.

Press Execute or check Tracking. Learn
more.
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A peak is a measurement point whose value is greater or smaller than the adjoining measurement
points on its right and left sides. Peaks are classified into the following two types depending on the
difference in magnitude from the measurement points on either side of it.

What Is a "Peak"?
You define what the analyzer considers a "peak" by selecting the following two peak criteria settings:
e Threshold - Minimum amplitude (dB). To be considered valid, the peak must be above the threshold level.
The valley on either side can be below the threshold level.

e Excursion - The vertical distance (dB) between the peak and the valleys on both sides. To be considered a
peak, data values must "fall off" from the peak on both sides by the excursion value.

Peak

Polarity: Definition:

Positive A peak whose measured value is greater than those of the
measurement points on either side of it.

Detect positive peaks which are larger than Threshold.

Negative A peak whose measured value is smaller than those of the
measurement points on either side of it.

Detect negative peaks which are smaller than Threshold.

Both A peak whose measured value is smaller and greater than those of
the measurement points on either side of it.

Threshold value is not used when polarity is set to both.

About Peak Excursion Value

The peak excursion value is the smaller of the differences in measured values from the adjoining peaks
of the opposite polarity.
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e Positive polarity peak
e Negative polarity peak
Eis Peak deviation

Measured value

Stimulus value

Executing a Peak Search

The following 3 methods are available for executing the peak search:

Next  Moves the marker to the maximum peak when peak polarity is Positive
Peak  or Both.

Moves the marker to the minimum peak when peak polarity is
Negative.

Peak  Executes the search from current marker position to the smaller
Left stimulus values and moves the marker to first peak encountered.

Peak  Executes the search from current marker position to the larger stimulus
Right values and moves the marker to first peak encountered.
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* Peak that matches
the definition of a peak

Peak Right

."-'.

il

Measured value
Measured value

Peak Left

Stimulus value Stimulus value

Note: Peak right, peak left and next peak may not be tracked. If these searches are selected and then
tracking is turned on, the peak tracking is enabled.

When the data format is in Smith chart or polar format, execute the search for the main response
value of the two marker response values.

Changing the settings of peak excursion value or peak polarity executes new search for multiple
peak.

Example:

Threshold Setting: -10dB

Excursion Setting: 1dB

Scale = 1 dB / Division

Mouse over the graphic to find a valid peak.
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e Peak A = Valid Peak (Above Threshold and Excursion Settings)

e Peak B = Invalid Peak (Below Excursion Setting)

e Peak C = Invalid Peak (Below Threshold Setting)

Multi Peak Search

How to create Multi Peak Search
Using Hardkey/SoftTab/Softkey

1.

2.

The multi peak search function enables you to display markers on multiple peaks on traces. Depending

Press Search > Multi Peak & Target.

Click Multi Peak Search to show the markers
on the multi peaks.

Click Peak Threshold to enter the value of
peak threshold.

Click Peak Excursion to enter the lower limit
value of peak excursion.

Click Peak Polarity to select a peak polarity.
Optionally click Tracking to search for the

specified multi peak level with each sweep.
Learn more.

Using a mouse

1.

2.

Move a cursor on a marker.

Right-click on the marker and then select
Search....

From Search Type of Marker Search dialog
box, select Multi Peak.

Enter the value of Threshold and Excursion.

Press Execute or check Tracking. Learn more.

Prugramming Commands=s }

on the number of detected peaks, markers 1 through 15 are displayed from the start frequency. The
reference marker is not affected.
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Multiple peak search has threshold, excursion and polarity as user defined values. This search may have
tracking enabled.

When the multiple peak search is executed, previous markers search and tracking are disabled and the
settings for the multiple peak search are used.

Note: Do not use individual marker settings or marker domain.

Put markers on each valid peak, using up to 15 markers.

Target Search

How to create Target Search

Using Hardkey/SoftTab/Softkey Using a mouse

1. Press Search > Target. 1. Move a cursor on a marker.

2. Click Target Search to enable the target 2. Right-click on the marker and then select
search. Search....

3. Click Target Right >> Search or << Target 3. From Search Type of Marker Search dialog
Left Search to move the marker to the target. box, select Target/Target Left/Target Right.

4. Click Target Value to input the value of target 4. Enter the value of the Target.
search.

5. Press Execute or check Tracking. Learn
5. Click Transition to select a transition type. more.

6. Optionally click Tracking to search for the
specified target level with each sweep. Learn

more.
Prugramming Commands=s }

The target search is a function that searches for a target that matches the pre-defined target value and
transition types (positive, negative or both positive and negative) and then moves the marker to that
target.
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@ Positive target transition type
@ Negative target transition type

Measured value

Target value

Stimulus value

Target Transition Types

A target is a point that has a specific measured value on the trace. Targets can be divided into the 3
groups shown below depending on their transition type.

Transition

Function:

Type:

Positive The target value is larger than the measured value immediately
preceding it.

. The target value is smaller than the measured value immediately

Negative o
preceding it.

Both The conditions for either Positive or Negative transition are

satisfied.

Executing a Target Search
The following 3 methods are available for executing the target search:

Target  Executes the search from the current marker position to the smaller
Left stimulus values and moves the marker to first target encountered.

Target  Executes the search from the current marker position to the larger
Right  stimulus values and moves the marker to first target encountered.

Multi  Executes the search for targets that are of the multi-target value and
Target multi target transition value. See Multi Target Search.
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Stimulus value

Note: Target right and target left cannot have tracking enabled. If target left or target right is the
selected search and then tracking is enabled, target tracking is enabled.

When the data format is in Smith chart or polar format, execute the search for the main response
value of the 2 marker response values.

Changing the settings of target value or transition type executes new search for multiple target.

The marker moves to the first occurrence of the Target value to the right of its current position.
Subsequent presses of the Target Search softkey cause the marker to move to the next value to the right
that meets the Target value. When the marker reaches the upper end of the stimulus range, it will "wrap
around" and continue the search from the lower end of the stimulus range (left side of the window).
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e If Discrete Marker is OFF, the marker locates the interpolated data point that equals the target
value.

e IfDiscrete Marker is ON and there are two data points on either side of the target value, the
marker locates the data point closest to the Target value

Multi Target Search

How to create Peak Search

Using Hardkey/SoftTab/Softkey Using a mouse
1. Press Search > Multi Peak & Target. 1. Move a cursor on a marker.
2. Click Multi Target Search to show the markers 2. Right-click on the marker and then select
on the multi target. Search....
3. Click Target Value to enter the value of target. 3. From Search Type of Marker Search

. o " dialog box, select Multi Target.
4. Click Transition to select a transition type.

5. Optionally click Tracking to search for the 4. Enter the value of the Target.

specified multi target level with each sweep. 5

Learn more. . Press Execute or check Tracking. Learn

more.

Prugramming Commands= }

The multi target search is a function that searches for targets that match to pre-defined target value and
transition types (positive, negative or both of positive and negative) and displays markers on the targets
being searched.

Depending on the number of detected targets, markers 1 through 15 are displayed from the start
frequency. The reference marker is not affected.

When the multi target search is executed, search and tracking settings for markers 1 through 15 are
ignored and the settings for the multi target search are used.

Note: Put markers on each found target value, using up to fifteen markers. Reference marker is not
affected. Do not use individual marker settings or marker domain. Search range is applied.

Multiple target search has target and transition types as user defined values. This search may have
tracking enabled. When this search is executing, previous marker searches are disabled.

Bandwidth and Notch Search
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Bandwidth and notch search behavior depends on whether the preference called Marker: Use single
marker for marker search is set or not. When set, only one marker is used for a marker search. Sub

markers are displayed and used for Bandwidth and Notch searches. When cleared, multiple markers are

used for a marker search. The default is cleared.

How to create Bandwidth and Notch Search
Using Hardkey/SoftTab/Softkey

1.

2.

Press Search > Bandwidth & Notch.

Click left side Bandwidth Search or Notch
Search small button to turn it ON/OFF.

For Bandwidth search, click BW Ref To >
Marker or Peak.

For Notch search, click Notch Ref To > Marker
or Peak.

Specify the BW Level or Notch Level in dB
from the peak or valley where bandwidth /
notch is measured.

Optionally click Tracking to search for the
specified bandwidth or notch level with each
sweep. Learn more.

Using a mouse

1.

2.

Move a cursor on a marker.

Right-click on the marker and then select
Search....

From Search Type of Marker Search
dialog, select Bandwidth or Notch.

Specify the Level in dB from the peak or valley
where bandwidth / notch is measured.

Press Execute or check Tracking. Learn
more.

Prugramming Commands=s }

Bandwidth Search

The bandwidth search is a function for determining the bandwidth of the trace, center frequency, cut-
off points (on the higher frequency and the lower frequency sides), Q and insertion loss based on the
position of the active marker or peak marker. The definitions of the parameters determined through the
bandwidth search are shown in below.
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Measured
value

Active marker
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Value defined l
as the bandwidth ¥._|..
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Notch Search

The notch search function is used to obtain the bandwidth, center frequency, cutoff points (high-
frequency side and low-frequency side), Q and insertion loss of a trace based on the active marker or
peak marker position. The notch search function starts from the left side of the active marker position
and ends when points that meet the conditions are found.

The figure and the table below shows the definition of parameters obtained by notch search function.
The notch value in figure below must be specified by the user.
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Response
value

loss -

Value defined
as the notch

Active marker

Stimulus value

The following values are displayed for Bandwidth and Notch Search:

Bandwidth/Notch
Parameter:

Bandwidth (BW)

Center frequency (cent)

Lower frequency cut-off

point (Low)

Higher frequency cut-
off point (High)

Q

Insertion loss (loss)

Definition:

The difference in frequency between the higher
frequency cut-off and lower frequency cut-off points
(High - Low).

Frequency at the middle point between the lower
frequency cut-off and higher frequency cut-off points.
(High +Low)/2.

Lower frequency of 2 measurement points, both
separated by the defined bandwidth / notch value from
the active marker position.

Higher frequency of 2 measurement points, both
separated by the defined bandwidth / notch value from
the active marker position.

Ratio of Center Frequency to Bandwidth (Center
Frequency / Bandwidth).

The measured value of the position of the center
frequency at the time the bandwidth/notch search is
executed.

e Bandwidth / Notch Search can be used ONLY with Log Mag display format.
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e To use Bandwidth Search on a peak or valley other than the maximum or minimum values,
change the Search Domain.

Compression Search

Uses the active marker to find the specified gain Compression Level.

Note: Valid ONLY for S21 (Gain) measurements with a Power Sweep.

How to create Compresssion Search

Using Hardkey/SoftTab/Softkey Using a mouse
1. Press Search > Comp & Sat. 1. Move a cursor on a marker.
2. Click Compression Search to turn ON/OFF. 2. Right-click on the maker and then select
Search....

3. Specify the Comp Level in dB.
3. From Search Type of Marker Search dialog

4. Optionally click Tracking to search for the box, select Compression.
specified compression level with each sweep.
Learn more. 4. Enter the Y-axis (Power OUT) difference
between the first point and the compression
marker.

5. Press Execute or check Tracking. Learn
more.

Programminq Commands= }

Linear gain is defined as the Y-axis value (gain) of the first data point of the Search Domain (Full Span
by default).

7.9181dBm  7.9274 dB|
Comp Pin: = -7.9181 dBm|
Comp Pout  0.00017 dBm
Comp Level: 1.0000 dB

Marker > N - X-axis value and Y-axis value.

Comp Pin - Input power (marker X-axis value).

563



Comp Pout - Output power (Pin + gain).

Comp Level - Compression level found.

e  When Discrete is OFF (default setting), the marker finds the exact specified compression,
interpolated between the two closest data points and calculates the Comp Pin and Comp Pout
value for that point.

e The marker can move from one actual measurement point to another. Because it is interpolated,
it can also move in the space between measurement points.

e  When Discrete is ON (not interpolated), the marker resides on the closest data point to the
requested compression level.

e A marker moves only between actual measurement points. When a specific marker stimulus
value is specified as a numerical value, the marker is placed at the measurement point closest to
the specified value. A marker that is placed between interpolated points with the discrete mode
off automatically moves to the nearest measurement point when the discrete mode is turned on.

Comp. Not Found - Displayed when the requested compression level is not found.

About PSAT and PNOP Search

Compression measurements based on the Pout vs Pin curves are common in the satellite test industry.
In the case of Travelling Wave Tube (TWT) amplifiers, PSAT markers identify the normal operating
point near saturation, and the amplifiers are operated with the power slightly backed-off
approximately 0.03 to 0.1 dB. For TWT amplifiers, the saturation curve always "folds over" and
produces a maximum power out.

For Solid State Power Amplifiers (SSPA), the saturation is not as well defined. A common reference is
the Normal Operating Point, which is a power backed-off by 8 to 10 dB from the maximum power. In
this case, the normal operating point marker replaces the Psat with the PNOP values. Also, because the
backoff is important, the backoff output and input powers are displayed (PBO Out), (PBO in) as well as
gain at back off (PBO Gain).

Power Saturation (PSAT) Search

If the Marker: Use single marker for marker search preference is cleared, this search uses Markers
1, 2, and 3 to quickly identify output power saturation parameters of an amplifier. If the Marker: Use
single marker for marker search preference is set, then only one marker is used for the search and 2
notational markers are displayed. The notational markers may not be moved. These markers are for
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display purposes only.

Back-off is a point at which the output power is sufficiently lower than the saturated output power so
that the device under test behaves in a more linear fashion.

Note: Valid ONLY for Power IN vs Power OUT measurements.

How to make Power IN (X-axis) vs Power OUT (Y-axis) measurement
Using Hardkey/SoftTab/Softkey

1.

2.

Press Preset.
Press Sweep > Main > Sweep Type.

Select Power Sweep.

Press Trace > Trace Setup > Measure... and set Trace Meas to "B" Receiver

Connect DUT input to port 1.

Connect DUT output to port 2.

Prugramming Commands= }

How to create PSAT Search
Using Hardkey/SoftTab/Softkey

1.

Press Search > Comp & Sat.

Using a mouse

1.

Move a cursor on a marker.

2. Click left side Saturation Search small button 2. Right-click on the marker and then select
to turn ON/OFF. Search > Search....
3. For PMax Back-Off, enter the Y-axis (Power 3. From Search Type of Marker Search dialog
OUT) difference between the Max Power box, select Power Saturation.
marker (3) and the Back-off marker (2).
4. For PMax Back-Off, enter the Y-axis (Power
4. Optionally click Tracking to search for the OUT) difference between the Max Power
specified power saturation level with each marker (3) and the Back-off marker (2).
sweep. Learn more.
5. Press Execute or check Tracking. Learn

more.

Prugramming Commands= }
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This setting uses three markers to calculate and display 10 values.

The three markers:

e Marker 1: Linear gain; the first data point in the sweep.
e Marker 2: Specified output power Back-off from max power.

e Marker 3: Max Power output; usually the last data point.

The 9 displayed values:

Param Description Calculated from...
PSat Out  Output power at the saturation point. Marker 2 Y-axis value
PSatIn Input power at the saturation point. Marker 2 X-axis value
Gain Sat  Gain at the saturation point. Psat Out - Psat In
Comp Sat  Compression at the saturation point. Gain Sat - Gain Linear
PMax Out Maximum output power. Marker 3 Y-axis value
PMax In Input power at the maximum output Marker 3 X-axis value
power.
Gain Max  Gain at the maximum output power. PMax Out - PMax In
Comp Max Compression at the maximum output Gain Max - Gain Linear
power.
Gain Linear gain at the first data point. Marker 1 - Y-axis value MINUS X-axis
Linear value

e Comp. Not Found is displayed when the requested Back-off point is not found.
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¢ When Discrete marker is NOT selected (the default setting), the three markers find an interpolated value
between the two closest data points.

¢ When Discrete marker is selected (NOT interpolated), the three markers reside on the closest data points.

Power Normal Operating Point (PNOP) Search

If the Marker: Use single marker for marker search preference is cleared, this search uses Markers
1, 2, 3, and 4 to quickly identify Normal Operating Point parameters of an amplifier. If the Marker:
Use single marker for marker search preference is set, then only one marker is used for the search
and 2 notational markers are displayed. The notational markers may not be moved. These markers are
for display purposes only.

Back-off'is a point at which the output power is sufficiently lower than the saturated output power so
that the device under test behaves in a more linear fashion.

The power normal operating point is the output power where the input is offset from the back-off input
power by the Pin Offset.

Note: Valid ONLY for Power IN vs Power OUT measurements.
See Power Saturation to learn how to make a Power IN (X-axis) vs Power OUT (Y-axis) measurement.

How to create PNOP Search

Using Hardkey/SoftTab/Softkey Using a mouse
1. Press Search > Normal Op Pt. 1. Move a cursor on a marker.
2. Click left side Normal OP Search small button 2. Right-click on the marker and then select
to turn ON/OFF . Search > Search....
3. For Back-Off, enter the Y-axis (Power OUT) 3. From Search Type of Marker Search dialog
difference between the Max Power marker (3) box, select Normal Operating Pt.

and the Back-off marker (2).
4. For Back-Off, enter the Y-axis (Power OUT)
4. For Pin Offset, enter the X-axis (Power IN) difference between the Max Power mar